Reference Manual

VP index V4
HYBRID SOFTWARE

VPIndex
VPIndex lite

softelec®
Creating Hybrid Advancement
www.softelec.com

Joseph-Seifried-Strasse 8 • D-80995 Muenchen - Germany
Phone: +49-89-158-1430 • Fax: +49-89-158-143-33
email: info@softelec.com • website: www.softelec.com
SOFTWARE COPYRIGHT AND LICENSE AGREEMENT

Grant of Limited License

softelec gmbh (hereafter called softelec) grants a limited, non-exclusive right to use the software installed on computers (PC’s) - workstations or a network server. In addition, softelec grants the right to only one (1) user or - in the event of network licenses - to the number of user stated in the network license agreement to activate and use the software at any one time once the user of the software has registered with softelec and thereafter received the corresponding authorization code. The license(s) and thereby the value of the purchased software product(s) is personified in the delivered hardlock. If a hardlock gets lost or stolen softelec will only deliver a new hardlock at full cost of the initially purchased software. softelec strongly recommends to insure the hardlock with the value of the purchase software to protect the investment. This limited, non-exclusive license agreement supercedes any other previous released agreement unless granted in writing and signed by softelec.

For the demonstration version of the software, unlimited multiple installations are permissible.

Copyright

The contents of the software (recorded on CD’s) and the associated manuals are the sole property of softelec and are protected by applicable copyright laws. This software may not be multiplied, copied, altered, decrypted, decompiled, changed, or disassembled in any manner without written authorization from softelec. A single backup copy is authorized. The user agrees not to transfer title of this software at any one time without first notifying softelec. All rights are reserved. No part of the manuals may be reproduced, transmitted, transcribed, stored on a retrieval system or translated into any language or computer language, in any form or means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise without the express written consent of softelec as punishable by applicable copyright laws. softelec is registered licensee of SZKI Recoginta AG (OCR) for the use exclusively with VP products.

The use of this software constitutes agreement to the terms said herein. If you do not agree with the terms of this agreement - DO NOT OPEN AND INSTALL THE SOFTWARE, promptly return the software, including manuals, binders, hardware lock key, written material, and containers to the location from which you obtained them for refund.

Terms

This license agreement becomes effective on the day of purchase and remains in full force until termination. softelec may terminate the license in the case the purchaser fails to comply with any of the terms and conditions of this agreement. The purchaser may terminate the license agreement at any time by returning the complete software (recorded on diskettes and/or CD’s), including manuals, binders, hardlock key, written material, and containers.

Disclaimer

softelec reserves the right to modify the hardlock key, the manuals and/or the associated software at any time, particularly with the intent of further development, and undertakes no guarantee to issue notification of modifications, additions, or further developments; nor does the company obligate itself to implement such modifications, additions, or further developments in earlier versions of the manual or the software. Any such modifications are considered upgrades in which the registered license holder shall have the option to purchase. The license holder is granted the right to obtain license upgrades at no extra costs which become available within a maximum of 90 days after the date of his written purchase order.

Limited Warranty

softelec warrants that the media containing the software is free from defects in material and workmanship. This limited warranty is valid for a period of ninety (90) days from the date of delivery as evidenced by a copy of receipt, provided any faults or defects that may, in spite of the care taken in manufacture, become apparent are reported to softelec within thirty (30) days of their occurrence. The only entitlement granted by this warranty is repair or replacement of the supplied product at the sole discretion of softelec. Regardless of the nature of any damage or loss in any way connected with the software, sole and exclusive liability to be borne by softelec shall not exceed the purchase price of the product.

This program is provided “as is”, softelec specifically disclaims all other warranties, expressed or implied, including but not limited to implied warranties for merchantability and fitness for a particular purpose with respect to defects in the CD, diskette, hardlock, or documentation, and the software license granted herein in particular, and without limiting operation of the software license with respect to any particular application, use or purpose. In no event shall softelec be liable for any loss of profit or any other commercial damage, including but not limited to special, incidental, consequential or other damages.

Legal Action

This agreement shall be construed, interpreted, and governed by the laws of the Federal Republic of Germany. Venue for any cause of legal actions shall be in the city of Munich.

Trademarks

Windows and its derivations are registered trademarks of Microsoft Corporation. AutoCAD and AutoCAD LT are registered trademarks of Autodesk, Inc. Recognita Plus is a registered trademark of SZKI Recognita AG. Other registered product names are proprietary to their respective owners.

softelec logo, Greek head design, VPHybridCAD, VPstudio, VPmap, VPmax, VPlite, VPraster, VPindex, VPview, and RasterDWG (RDWG) are registered trademarks of softelec gmbh.
# TABLE OF CONTENT

## SECTION 1  INTRODUCTION

- Welcome to VPindex ................................................................. 1
- VPindex optimizes your drawing archive .................................... 1
- Concept of this Manual .............................................................. 3
- Before you start ........................................................................ 4

## SECTION 2  INSTALLATION

- Introduction .............................................................................. 5
  - Software License Control (Hardlock) ........................................ 5
  - Package Contents .................................................................. 6
- Installing VPindex ..................................................................... 7
  - General .................................................................................. 7
  - Performing the Installation ...................................................... 8
  - First Start after Installation and Registration ......................... 9
  - Uninstalling ........................................................................... 10
  - Updating / Upgrading / Service Pack ...................................... 10
  - System Requirements ............................................................ 10
- Installing the VPLicenseManager .............................................. 11
  - Requirements ....................................................................... 11
  - Installation ............................................................................ 11
- Monitoring the VPLicenseManager ............................................ 12
  - VPNetManager - Introduction ............................................... 12
  - Manage License Servers ....................................................... 12
  - Manage Users ...................................................................... 15

## SECTION 3  SYSTEM SETTINGS, GENERAL FUNCTIONS

- General Information ............................................................... 18
  - Program Start ....................................................................... 19
- General Handling ..................................................................... 21
  - Manual, Online Help ............................................................ 21
  - Toolbars ............................................................................... 21
  - Dialog Boxes ........................................................................ 23
  - Status Display ...................................................................... 24
  - Display Control Functions .................................................... 24
  - Zoom Functions .................................................................... 25
  - Pan Functions ....................................................................... 27
  - Using the Mouse .................................................................... 28
  - Command Line ...................................................................... 29
  - List Commands ..................................................................... 32
- File Menu .................................................................................. 33
  - New [Ctrl + N] ..................................................................... 33
  - Open [Ctrl + O] .................................................................... 33
  - Import .................................................................................. 36
  - Save [Ctrl + S] ..................................................................... 37
  - Save As ................................................................................. 39
  - Export .................................................................................. 39
SECTION 4  DOCUMENT SETTINGS, DOCUMENT FUNCTIONS, BASIC EDITING.... 81

General Information .................................................................................................................. 81

Page Control ............................................................................................................................ 81
    Page Display ......................................................................................................................... 81
    Insertion and Deletion of Pages ............................................................................................ 82
    Import of Pages ..................................................................................................................... 83
    Moving Pages ....................................................................................................................... 85
    Scanning Pages ..................................................................................................................... 87
    Organizing Pages .................................................................................................................. 88

Layer Manager ......................................................................................................................... 90
    Transfer to Current Layer ...................................................................................................... 93

Project Bar ................................................................................................................................ 94

Linetype Manager ..................................................................................................................... 97
    Assign Current Linetype ....................................................................................................... 99

Text Style Manager .................................................................................................................. 100
    Assign Current Text Style ................................................................................................. 102

Color Manager ......................................................................................................................... 103
    Assign Current Color .......................................................................................................... 105

User Coordinate System .......................................................................................................... 106
    Place / Adjust Data .............................................................................................................. 108
### Image Settings
- B/W Images ................................................................. 109
- Gray Scale and Color Images .................................................. 110
- Select Active Image ............................................................. 111
- Image Palette ..................................................................... 116
- Create B/W Image ............................................................... 117
- Display B/W Image .............................................................. 117

### Entity Selection and Handling ................................................................. 119
- Vector Entity Selection .......................................................... 119
- Raster Selection .................................................................... 119
- Direct Raster Selection ......................................................... 119
- Direct Raster Selection Settings [F8] ......................................... 121
- Raster Object Selection .......................................................... 121
- Quick Selection [Ctrl]+[F] ....................................................... 123
- Select All [Ctrl]+[A] ............................................................. 126
- Snap Functions ................................................................... 127
- Undo [Ctrl]+[Z] / [Alt]+[Backspace] ......................................... 130
- Redo [Ctrl]+[Y] ................................................................... 130
- Delete Entities ...................................................................... 131
- Explode Entities (Origin) ......................................................... 131
- Drag & Drop ........................................................................ 131
- Cut [Ctrl]+[X], Copy [Ctrl]+[C], Paste [Ctrl]+[V] ....................... 132
- Measure Distance [F2] .......................................................... 133
- Redraw [Ctrl]+[R] ................................................................ 134
- Properties [F3] ..................................................................... 135
- Change Properties ............................................................... 136
- Draw Order ......................................................................... 136

### Rasterize Functions ................................................................................. 138
- New Raster ........................................................................... 138
- Rasterize .............................................................................. 140
- Rasterize to Paper Format ...................................................... 141

### Raster Edit Functions ................................................................................ 147
- Auto Cleanup ........................................................................ 147
- Raster Functions ................................................................. 148
- Automatic Cut ..................................................................... 149
- Cut Window, Cut Polygon .................................................... 149
- Crop Window, Crop Polygon ................................................ 150
- Deskew ............................................................................... 150
- Autodeskew ........................................................................ 151
- Invert ................................................................................... 151
- Rotate Quadrantal ............................................................... 152
- Rotate Arbitrary ................................................................. 152
- Horizontal Mirror ............................................................... 153
- Vertical Mirror ................................................................... 153
- Remove Speckles ................................................................ 153
Smooth Raster .................................................................................................................. 154
All Raster Operations ........................................................................................................ 155
Morphology ....................................................................................................................... 156
Cut to Drawing Format ..................................................................................................... 158
Scale ................................................................................................................................. 160

SECTION 6 RUBBER SHEETING, 4 POINT DRAWING CALIBRATION, SPLIT FILE, MERGE FILES ...
General Information ......................................................................................................... 161
Rubber Sheeting Functions ............................................................................................... 161
Multi Point Rubber Sheeting ............................................................................................ 163
  Set Up User Coordinate System .................................................................................. 163
  Rubber Sheet Settings .................................................................................................. 164
  Calculation Mode .......................................................................................................... 164
  Options .......................................................................................................................... 165
  Target Reference Points ............................................................................................... 165
  Input of Reference Points ............................................................................................ 171
4 Point Drawing Calibration ............................................................................................... 174
  Preparation .................................................................................................................... 174
  Calibration ..................................................................................................................... 176
Split a File (only VPHybridCAD) ...................................................................................... 177
Merge Raster Files ............................................................................................................ 179

SECTION 7 COLOR REDUCTION, SEPARATION, FILTERS ............................................ 182
General .............................................................................................................................. 182
Scanning Colors ............................................................................................................... 183
Color (Gray Scale) Reduction .......................................................................................... 184
Automatic Color Cleanup (Reduction) ............................................................................. 193
  Save Palette .................................................................................................................. 194
  Palette Transformation ............................................................................................... 194
Color Filter Operations .................................................................................................... 199
  Custom Filter Table ...................................................................................................... 202
Fill Function ....................................................................................................................... 203
Color Image Conversion .................................................................................................. 204
  Convert Image Palette/Type ......................................................................................... 204
Color Classification .......................................................................................................... 207
  General ......................................................................................................................... 207
  Color Classification ..................................................................................................... 207

SECTION 8 CAD TOOLS ................................................................................................. 210
General Information ......................................................................................................... 210
Raster Settings .................................................................................................................. 210
CAD Options .................................................................................................................... 213
Draw Functions ................................................................................................................. 221
  Pixel .......................................................................................................................... 221
  Line .......................................................................................................................... 222
  Polyline.................................................................................................................... 222
  Closed Polyline ...................................................................................................... 223
  MPolyline ............................................................................................................... 223
  Rectangle ............................................................................................................... 223
  Spline ..................................................................................................................... 224
  Arc (3-point).......................................................................................................... 224
  Arc (4-point).......................................................................................................... 224
  Arc (with tangential connections, only Windows) .................................................. 225
  Circle (Radius) ...................................................................................................... 225
  Circle (2-point) ..................................................................................................... 225
  Circle (3-point) ..................................................................................................... 225
  Ellipse ................................................................................................................... 226
  Filled Rectangle (WINDOWS only) .......................................................................... 226
  Polygon .................................................................................................................. 227
  Text ....................................................................................................................... 227
  Multiline Text ....................................................................................................... 229
  Dimension Arrow ................................................................................................. 230
  Pointing Arrow .................................................................................................... 231
  Point ..................................................................................................................... 231
  Stamp ................................................................................................................... 232
  Hatch (Fill) .......................................................................................................... 234
  Edit Hatch ............................................................................................................. 235
  Hatch Style Manager ............................................................................................ 236
  Make Corner ........................................................................................................ 237
  Trim ....................................................................................................................... 237
  Extent ................................................................................................................... 238
  Auto Trim ............................................................................................................. 238
  Cut ......................................................................................................................... 239
  Break ..................................................................................................................... 239

Blocks (Windows only) .................................................................................................. 240
  General Information ............................................................................................ 240
  Create Block ........................................................................................................ 241
  Combine to (Existing) Block ................................................................................ 244
  Modifying Block definitions ................................................................................. 245
  Insert Block ......................................................................................................... 250

SECTION 9  HYBRID EDITING TOOLS ........................................................................... 253
  General Information ............................................................................................ 253
  Raster Text ............................................................................................................ 254
  Search Raster Symbols ......................................................................................... 258
  Edit Object(s) ..................................................................................................... 260
    Move .................................................................................................................. 260
    Copy .................................................................................................................. 260
    Delete Entities ................................................................................................. 261
    Explode Entities (Origin) .................................................................................. 261
SECTION 10 DIMENSIONS ................................................................. 281

General Information ................................................................. 281
Dimension Modes ........................................................................ 281
  Manual Mode (on/off) .............................................................. 281
  Text Mode (on/off) ................................................................. 281
Dimension Style ......................................................................... 282
  Dimension Style Manager ....................................................... 282
  Transfer to Current Dimension Style ...................................... 289
Dimension Types ....................................................................... 290
  Linear Dimension .................................................................... 290
  Aligned Dimension .................................................................. 290
  Radial Dimension .................................................................... 291

Scale .......................................................................................... 261
Rotate ........................................................................................ 262
Mirror ....................................................................................... 262
Array ......................................................................................... 262
Offset ......................................................................................... 264

Combining Elements .................................................................... 265
  Combine to Line ....................................................................... 265
  Combine to Orthogonal Line ...................................................... 265
  Combine to Polyline .................................................................. 266
  Combine to Closed Polyline ...................................................... 266
  Combine to MPolyline .............................................................. 266
  Combine to Closed MPolyline ................................................... 266
  Combine to Polygon .................................................................. 267
  Combine to Spline ..................................................................... 267
  Combine to Closed Spline ......................................................... 267
  Combine to Arc ......................................................................... 267
  Combine to Circle .................................................................... 267
  Combine to Ellipse ................................................................... 268
  Combine to Elliptical Arc .......................................................... 268
  Combine to Text (Interactive Text Recognition) ......................... 268
  Combine to MText (Multiline Text Recognition) ....................... 270
  Combine to Hatch ..................................................................... 271
  Combine to Options ................................................................. 271

Adjust Text .................................................................................. 275
  Align Left ................................................................................. 275
  Align Right .............................................................................. 275
  Center Horizontally ................................................................. 275
  Align Top ................................................................................ 276
  Align Bottom ......................................................................... 276
  Center Vertical ....................................................................... 276
  Align with Line Space .............................................................. 276
  Assign Same Height ................................................................. 278
  Assign Same Angle ................................................................. 278

Special Tools .............................................................................. 279
  Review Text ........................................................................... 279
SECTION 11 TABLE RECOGNITION................................................................................. 294
  General Information.................................................................................................. 294
  Table Recognition...................................................................................................... 294
    Output settings ....................................................................................................... 295
    Content of table / Text ............................................................................................ 295
    Shape of Table / Cells ............................................................................................ 297
    Copy raster structures ............................................................................................ 298
    Finish the Table Recognition ................................................................................. 298

SECTION 12 INTERACTIVE TRACING........................................................................... 299
  General Information.................................................................................................. 299
  Trace Settings ............................................................................................................ 299
    General Tab ............................................................................................................. 300
    Contour/Interactive Trace Tab ................................................................................ 301
    Erase Raster Background ....................................................................................... 303
  CAD Trace ................................................................................................................ 304
  Contour Trace .......................................................................................................... 305
    Contour Trace Edit Commands .............................................................................. 305
  Interactive Trace .................................................................................................... 309
    Edit Polyline/Spline .............................................................................................. 310

SECTION 13 BATCHMANAGER / BATCHEXECUTOR, SCRIPTING USER COMMANDS ......................................................................................... 313
  BatchManager .......................................................................................................... 313
    Create Batch Job .................................................................................................... 314
    Settings ................................................................................................................... 315
  BatchExecutor .......................................................................................................... 319
  Command Script ...................................................................................................... 320
    Procedure ............................................................................................................... 320
  User Commands ...................................................................................................... 321
    Available Settings .................................................................................................. 321
    Commands ............................................................................................................. 322

SECTION 14 REDLINING............................................................................................. 324
  General Information.................................................................................................. 324
  Redlining Functions ................................................................................................. 324
    Activate Redlining .................................................................................................. 324
    Import ..................................................................................................................... 325
    Export ..................................................................................................................... 325
    Settings .................................................................................................................. 325
Redlining Review ...................................................................................................................327
Delete Redlining Entities...................................................................................................... ..327
Insert Ellipse ................................................................................................................. .........328
Insert Cloud ................................................................................................................... ........328
Insert Arrow ................................................................................................................... ........328
Insert Transparent Rectangle ................................................................................................329
Redlining Configuration ................................................................................................. 330
Configure Redlining Users/User Groups.............................................................................331

SECTION 15 PROCESS SETTINGS .................................................................................. 334
General Information ............................................................................................................ ......334
Create Settings with Wizard Support ................................................................................335
Start Wizard ................................................................................................................... ........335
Drawing File Selection (Task 1) ..........................................................................................338
Load Sample Drawing (Task 2)............................................................................................341
Raster Cleanup (Task 3)........................................................................................................ 342
Paper Format Selection (Task 4) ...........................................................................................347
Indexing Templates (Task 5) ......................................................................................... 350
Data Field Definition (Task 6) .............................................................................................358
Export to Database (Task 7) .................................................................................................362
General Output Settings (Task 8) .......................................................................................364
Ready to Go.................................................................................................................... .......366
Settings via Tableau .............................................................................................................368
Process Settings ............................................................................................................... .....369

SECTION 16 RUNNING A PROCESS ............................................................................. 379
General Information ............................................................................................................ ......379
Start Indexing .......................................................................................................................379
Unattended Process ................................................................................................................381
Go.........................................................................................................................................381
Pause....................................................................................................................................381
End .......................................................................................................................................382
Review .............................................................................................................................. 384
Interactive Processing ...........................................................................................................389
Start .......................................................................................................................................389
Pause....................................................................................................................................389
Data Retrieval .................................................................................................................... 390
Indexing Results .................................................................................................................. 391
Indexing Quickstart ..............................................................................................................392
Current Settings File .............................................................................................................392

SPECIFICATIONS
General Specifications (VPindex / VPindex lite).................................................................393
VPindex (additional Specifications).....................................................................................394
APPENDIX

Supported Raster Formats....................................................................................................... 397
Supported Vector Formats....................................................................................................... 398
Individual Extensions for File Formats (Alias Extensions) ................................................... 398
Supported Scanners ............................................................................................................. 399
Default Command Alias Names .......................................................................................... 401
Keyboard Shortcuts ............................................................................................................. 402
DDE and OLE ....................................................................................................................... 404

INDEX ..................................................................................................................................... 409
SECTION 1
INTRODUCTION

Welcome to VPindex

Congratulations to your VPindex product from softelec, the specialist and market leader in hybrid (raster and vector) editing, color management, and raster-to-vector conversion. Since its introduction in 1990, VP software products have been constantly improved on quality and productivity. New algorithms and programming techniques have resulted in extraordinary quality improvements, outstanding features, unique functions, needle pegging conversion speeds, and convincing user friendliness. softelec technology guarantees that you are obtaining the finest in professional products for your scanning, archiving/indexing, raster and vector editing, or conversion tasks for all applications in CAD/CAM, AEC, FM, GIS, or EDM.

VPindex optimizes your drawing archive

Capture, organize, update

VPindex provides a most efficient and easy-to-use way to transfer graphic documents directly to any digital archive or database. Within short time hundreds of drawings can be recorded and updated. Also, documents in existing archives can easily be updated and re-organized with VPindex. Customizable workflows and Wizard-guided operation make VPindex a perfect time-saver for documentation departments or service providers.

With a vast number of image processing tools raster drawings can be stored in any desirable paper format and in optimum digital quality for best productivity. Capturing document information from CAD- and raster drawings – e.g. contained in title blocks – is supported by automatic and interactive routines. They provide seamless document access, distribution, and retrieval.

Selected VPindex Features:

- Batch processing of CAD and scanned drawings into a digital archive
- Batch processing of AutoCAD and hybrid drawings
- Automatic and interactive modes
- NEW: VPindex lite (interactive mode)
- Direct Large Format Scanner interface
- „Wizard”-supported workflow setup
- Automatic cleanup of scanned drawings
- Extensive correction and editing tools (VPindex)
- Automatic file format and paper format conversion
- Automatic rasterization of AutoCAD drawings (VPindex)
- Defining new file names and automatic assignment
- Automatic rotation to title block position
- Recognition of title block cell content with OCR
- NEW: OCR data capture from isolated cells
- NEW: Barcode and checkbox recognition
- Data export via ODBC

Setting up a workflow is a breeze with VPindex. First, take a complete collection of drawings from various folders or scan directly into VPindex. Then, just follow the Wizard to set up your desired task list. Guidance is provided for each task in the workflow:

1. Importing, if necessary: clean-up and formatting
2. Defining relevant data cells inside or outside of a title block
3. Capturing and recognizing data from drawings
4. Review and final check
5. Check-out to database/EDM system

For maximum flexibility, all tasks can be processed sequentially and unattended in a batch or in interactive mode document by document.

**VPindex** includes several automatic functions to clean, correct, and optimize raster drawings. Of course, cleaning up raster drawings and converting them to other file formats can be part of a batch process, even without indexing.

**VPindex** will detect the title block’s position automatically, no matter if drawings are rotated by any orientation. Thus, all drawings in a batch can be rotated uniformly to their title blocks’ position.
VPindex can automatically capture detail data from drawings which are mainly contained in title blocks. These data may refer to drawing numbers, project details, dates of issue, revisions, part descriptions, and many more. This "index" information can be exported into an EDM system (Electronic Drawing Management), or into an existing database. Since VPindex supports the standard ODBC interface all data transfer operations can be done from inside the program.

VPindex can capture information from data cells at arbitrary positions in drawings, independent from a title block. This "index" information can be exported into an EDM system (Electronic Drawing Management), or into an existing database.

VPindex provides a control review of indexing results prior to a database transfer. Once the indexing process is completed, the review function allows to compare and correct the contents of data cells with the extracted data from each field. Moreover, exporting data with thumbnail images of the header or the total drawing is another perfect option for creating a complete index CD-ROM.

VPindex supports ODBC compliant databases like SQL, Oracle, Access, Excel, etc. Therefore, it interfaces to ODBC compliant EDM systems. Output options in ASCII format with selectable delimiters (.CSV format) even increases on export flexibility.

Concept of this Manual

This manual has been organized to help you to quickly find operation terms, commands, and description of functions and to supply you with brief, but sufficient explanations. The manual applies to the following VP products:

VPindex, VPindex lite

The icon at the top on each page indicates the product(s) to which the information and/or commands apply. If specific commands on a page are limited to other products or product groups this is marked with a corresponding icon at the corresponding command.

Please, see the product listings on the upper right on each page (see above).

When filled, the marks in front of a product name indicate the availability of the described function for a specific product. When not filled, the described function is not available in the respective product:

Great efforts have been made to define each function and each setting of a parameter only once in detail. Therefore, an alphabetic index provides a quick means of finding these descriptions.
Keys and key combinations are represented by [ ] enclosing the keys' designation. For example, the "Enter" or "Return" key is shown as [Enter] whereas a key combination (shortcut) opens as [Ctrl + C].

Functions that can be mouse-clicked for activation/deactivation in a check box are represented as {on/off}.

All titles/headlines which are program functions are marked with an underline: Draw Line.

Command line commands – if available for a particular function – are indicated with "CMD:" followed by the command term.

The given value ranges do not necessarily define an internal limitation, but specify a meaningful range – be aware that using values outside of the "normal" range can cause unexpected results. Default values represent values either set up during installation or values to be used, e.g. when parameter values are reset.

Before you start

This manual should familiarize you with all functions available in VPindex. It is meant to be both, a source of reference and a guideline to the latest archiving technology of technical drawings. The most expedient way to learn how to use VPindex professionally and effectively is to start with the Tutorial (Lesson 14). Once completed, you will have a better command on your VPindex that will significantly increase your productivity.

Reminder: please, do not forget to register your VPindex with softelec (online or by mail, fax,) within 30 days after installation to receive an unlimited license code.

To secure that you will always have the latest VPindex program version available you may wish to enter into a “Software Maintenance Agreement”. This way you will benefit from automatic deliveries of all upcoming releases and program extensions. Please refer to your VP software supplier for more details.

We wish you good success with VPindex!

Visit our website at http://www.softelec.com for the latest product information, for technical support, for available updates, upgrades, and service packs.
SECTION 2
INSTALLATION

Introduction

VPindex requires for operation Microsoft Windows XP/Vista/7. Depending on the configuration of your computer network you may install the software using local licensing or network licensing.

The purchased VPindex product is delivered with a 30 days time limited operation license. The user is required to register the software within that time frame with softelec using either the online registration accessible from within the software, or sending the completed registration form to softelec by mail or fax. Softelec will then return a code to the user which extends the license for unlimited use.

Software License Control (Hardlock)

Any VPindex Full Version product requires a hardlock (dongle) controlling the product license. Without a proper installed hardlock any product will only operate in the Demo Mode (no hardlock for the license control required).

The hardlock may contain one or more product licenses. Regardless of the installation mode and the number of licenses controlled by the hardlock there are two methods of operation:

1. **Local Licensing**: you need to attach the parallel port hardlock (dongle) to one of the parallel ports or the USB hardlock to one of the USB ports of the computer where VPindex is installed. Typically, this method of operation is used if the hardlock contains a single license only. Then, for every additional VPindex installation an additional single license hardlock is required.

2. **Network Licensing**: this method of operation is preferable if two or more VPindex licenses are to be controlled by one hardlock, but may also be used for a single license ("floating" license), where you can access the VPindex license on any network computer, but only operate one license at a time. You need to attach the hardlock to a workstation serving as "VP network server" or "dongle server" (usually your network server) executing the VPLicenseManager so that the license(s) is/are accessible by other workstations.

   The **VPLicenseManager** has to be installed on the workgroup server and can only operate under Windows NT 4.0/2000/XP/2003/Vista/7.

   Local Licensing does not require the installation of the **VPLicenseManager**.
Hardlock Driver

The workstation or server controlling the hardlock needs a system driver for proper operation. This driver is provided with your package and is installed together with VPindex. You may also install it manually by following the instructions found in the file README.TXT on the CD.

⚠️ In order to install the hardlock driver during the standard installation or manually, you need **administrative rights**.

⚠️ The installation routine will **not** install the hardlock driver(s) if the selected software is installed as a **Demo Version**! If, at a later state, you want to use the software as a full version (together with the purchased hardlock), you need to manually install the hardlock driver.

Attaching the Hardlock (Dongle)

The driver software will be installed automatically with the VPindex program (full version). If required, it can also be installed separately later. Installation files can be found on the VP software CD or are available at [www.softelec.com](http://www.softelec.com) – downloads – utilities/drivers.

**USB:** Attach the hardlock only **after** a successful software installation to one of your computer's/server's USB-Ports.

**Parallel:** Attach the **male** side (the side with the pins) of the hardlock to one of your computer's/server's parallel ports (LPT1, 2, or 3). Typically, up to five hardlocks can be stacked together including a printer to the parallel port device(s). If a printer is connected, it should be turned on to provide proper termination, otherwise the hardlock may see false signals (due to reflections) that will cause the program to request a hardlock installation.

⚠️ It is not recommended to install the hardlock on a parallel port together with a scanner or any parallel port device other than a printer!

Package Contents

Your VPindex package contains the following:

- 1 User tutorial manual
- 1 **VP Software** CD
- 1 Hardlock (dongle)
- 1 Registration form
Installing VPindex

General

The install program SETUP_VP.EXE guides you through each step to successfully install and configure the software of your choice and the required hardlock driver on your computer. If your CD function autorun is enabled, the initial screen will pop up automatically upon insertion of the VP software CD offering you several choices. Select VPindex and follow the advice:

The required hardlock drivers (Sentinel) will be installed or updated automatically if VPindex Full Version is installed.

The installation setup allows you to specify several options. These include the target location and the required components of VPindex.

Prior to starting the setup routine please terminate any running application and read the file README.TXT if available on the VP software CD.

Administrator rights are necessary to install the hardlock driver.

After a successful installation of the software or the hardlock driver it is often necessary to reboot the computer in order to allow the operating system to update the DLLs. A dialog box will appear, asking the user to restart the computer now or at a later stage.
VPindex

Performing the Installation
The setup starts automatically after inserting the CD into the CD-ROM drive (autorun). Only if
your Operating System (OS) does not support this feature or autorun is disabled you have to
start the setup program SETUP_VP.EXE manually from the root directory of the CD as
follows:
double-click SETUP_VP.EXE directly from the Explorer.
In the initial setup window click the item "VPindex", select "Full Version" or "Demo
Version" (as desired) and select the desired program language from the appearing dialog. In
the sequel you are guided through the setup dialogs allowing user defined settings. We
recommend to choose "typical" as the setup type.

Local Licensing
During setup you will be asked whether your hardlock resides locally or on the VP network
server. Choose "Local".

Network Licensing
If you want to operate the software on a network (you have either multiple licenses purchased
or you want to use a single license floating) you need to install your hardlock on the server.
Therefore, choose "Network Server". The next dialog prompts you for the name of the server
bearing the hardlock ("dongle server").
Enter the name, not the IP-address of the server!
There are different ways to specify the server:
COMPUTERNAME
Name of the computer as entered during the installation of the Windows OS. Leading
backslashes ("\\") are not required!
COMPUTERNAME:192.168.0.1
The IP-Address can be enter after the computer name separated by ':'. This is useful in
larger networks and can speed up the rooting to the server and thus the license.
COMPUTERNAME:COMPUTERNAME.DOMAINNAME
In some 'heterogeneous' networks operating with Windows NT 4.0 and Windows
2000/XP/Vista/7 it might be necessary to use this combination to clearly resolve the server
name (e.g. DHCP).
When working with multiple dongles on different servers please use the following syntax:
COMPUTERNAME1; COMPUTERNAME2
The computer names of the servers must be separated by semicolon.

8

Section 2

Installation

V4 / E


If you don't know the name of the "dongle server" (= "VP network server") you may leave the entry empty and proceed with the installation. You may change the dongle server name in VPindex (Options->Settings->License) later.

In order to use Network Licensing, the **VPLicenseManager** (see below), the hardlock driver, and the hardlock (dongle) must be installed on the same computer (server).

**First Start after Installation and Registration**

Unless you have purchased special VPindex licenses such as Multi Licenses or Educational Licenses, which require a pre-registration, your software operates on a 30 days time limit allowing for execution of the required registration with softelec. At any start of VPindex a dialog opens remembering you to register and displaying the expiration date of the license. After the expiration date the software will only run in demo mode, unless the code for unlimited use has been entered. This code will be send to you as soon as you have registered with softelec.

You can register online from within VPindex (press button "Register On-line" in the dialog box or select menu **Help ► Register VPxx on the Internet**) or fill out the attached registration form **completely** and **legibly** and send or fax it back to **softelec**. After checking the registration contents softelec returns a code to be entered with the next software start.

You will receive technical support and update/upgrade notices from softelec only if you have **properly registered** VPindex. Registration of VPindex products with your dealer **does not constitute a proper registration**.

All user data received will only be used for internal expenditure within the softelec sales and support cycle and will not passed over to third parties!
Uninstalling

To remove a VPindex product from your computer click on the icon Uninstall and follow the instructions.

The hardlock driver(s) will NOT be removed. If the driver is not required by any other program, you can uninstall those using "Add/Remove Programs" from the Control Panel.

Updating / Upgrading / Service Pack

Software upgrades (to a higher VPindex product level) or updates (to a new release of the same VPindex product) may require a password that is issued to you upon purchase. After installing the upgrade or update and starting it for the first time you will be asked to enter the password. With a successful entry the password can be discarded.

⚠️ For updating a VP network license hardlock (the lock is attached to the VP network server) use the program UPDATELOCK.EXE residing in the CD directory VPHardlock for entering the update code. For more information please read the text file ReadMe.TXT in the route directory of the CD.

Service packs are released from time to time for bug fixes and smaller software improvements. They can be downloaded from our website and are usually self-installing.

You may install and use the new VPindex release together with a previous release although this is not recommended. However, do not install the new version into the same directory!

System Requirements

Proper operation requires a specific configuration of hardware and software to guarantee overall functionality. The fastest CPU in your PC is the most desirable! The software requires at least 256 MB of RAM, but this is not recommended and today's PCs often have higher memory installations. Drawing formats of DIN A0 (E size) and larger, gray scale or color images of any size require a minimum of 512 MB. More is recommended for large size color images. File size and entity contents of a drawing define the actual amount of RAM required. In general: the larger and denser the drawing and the more recognition options are selected, the larger will be the amount of RAM required. Otherwise, disk swapping will become necessary and will noticeably slow down program operations.
VPindex

Installing the VPLicenseManager

The VPLicenseManager needs to be installed only if you have a computer network and the hardlock is attached to a remote computer ("dongle server"). This software controls and manages the VPindex licenses in the network.

Requirements

The VPLicenseManager may be installed as a service only on computers (server or workstation) operating under Windows NT 4.0/2000/XP/2003/Vista/7.

- The VPLicenseManager will not operate under Windows 98 or ME!
- As a maximum number, ten concurrent users are allowed to connect to a license server running with either Windows 2000 prof. or Windows XP prof. This is a restriction of the operating system, not of the VPLicenseManager. More users can connect using a server operating system like Windows Server 2003.

The software clients may run under Windows XP/Vista or 7. It is necessary that the clients have access to the "dongle server" (an account must exist for each user). We strongly recommend installing the VPLicenseManager on the Domain Controller Server!

An alternative solution is to create a share with a default user name and a respective password. Every user that needs to access the "dongle server" has to connect this share with this specific name and the specific password. This can be done by either using the Windows Explorer, with a special logon script, or by using the VPNetManager.

Installation

- For the following steps you have to be logged on to the dongle server as "Administrator"!
- Attach the hardlock (dongle) only after a successful software installation.

1. Install the VPLicenseManager software either
   - by choosing Network / Hardlock - VPLicenseManager in the installation’s main window, or
   - by running VPLicenseManagerSetup.exe from the VPLicenseManager folder on the VP software CD.

2. Apply the dongle to a USB or parallel server port.

   In general, a reboot of the server is not required! In some cases it might happen that the VPLicenseManager service is not started automatically after installation. In this case you can start the service manually through the computer administrative console. To check whether the VPLicenseManager has been installed and is running, please use the VPNetManager (described below) for checking.

   The VPLicenseManager service is installed with the startup option 'automatic'. That means the service will be automatically restarted after any reboot of the computer.
Monitoring the VPLicenseManager

VPNetManager - Introduction

The VPNetManager allows monitoring the VPLicenseManager servers in your network. The number of the available licenses, the licenses in use, and the users accessing the VPLicenseManager servers can easily be overlooked.

The VPNetManager.EXE application is located in the CD directory VPNetManager. It can be started from the installation menu (Network / Hardlock ➤ Run VPNetManager) or it can be installed (by copying) on any computer (Windows 98/ME or Windows NT 4.0/2000/XP or higher) in the network.

After the first start of the application the following dialog appears:

Manage License Servers

If started for the first time or if no server is listed to be monitored the application will automatically search the entire network for VPLicenseManager servers (see Search Servers).

Search Servers

Menu: Servers, Function: Search Servers

The application will search the network for any VPLicenseManager servers. The search may be stopped by clicking the icon again.
Depending on the size of your computer network the search may take a long time. You can speed up this process by adding the server name manually (see below).

If you don't have an account on a computer that is currently being checked a dialog opens asking you to logon with a different user name and password. See also VPLicenseManager - Requirements.

When the search has been completed the left window frame displays the symbols for the found VPLicenseManager server(s) (green screen) and those for the connected hardlock(s).

Add Server

Menu: Servers, Function: Add Server

Enter the name of a VPLicenseManager server:

If you don't have an account on the computer a dialog opens asking you to logon with a different user name and password. See also VPLicenseManager - Requirements.

When successfully completed, the server and the attached hardlock(s) will be displayed in the left window frame:

The green screen indicates that the VPLicenseManager server is working in normal mode.

A red screen indicates that the computer could not be found in the network, i.e. the net path may be wrong or the computer is not operating.

The blue screen indicates that the computer is not a VPLicenseManager server, i.e. the VPLicenseManager has not been installed or the program was stopped.

A yellow screen indicates that the computer is operating, but another error has occurred. An additional error message is displayed in the status bar of the VPNetManager.

If the hardlock is not attached to the VPLicenseManager server the symbol for the hardlock will not be displayed.
Remove Server

Menu: Servers, Function: Remove Server

The currently selected server will be removed from the list and will not be monitored any more.

Default Server

Menu: Servers, Function: Default Server

A dialog opens displaying a list of all VP applications installed on the local computer and the respective license server settings:

Instead of checking and changing the server settings in each program you can easily do this with this function. Double-click on the program you want to modify and choose a new server:

You can also assign the setting (No Server) meaning that a locally attached hardlock will be used by the selected program.
Sample

The following sample dialog shows an active **VPLicenseManager** on the computer LICENSESERVER with two hardlocks containing 9 product categories, each marked by a key symbol. Each category may contain several licenses of that product.

![Sample dialog showing VPLicenseManager](image.png)

In this sample one license of **VPstudio** is currently in use by the user **VPuser**.

Manage Users

A user has to be a member of a user group (user type). There are two types of user groups: group **Administrator** or group **Monitor**. Monitor users have the right to monitor the license servers, the available licenses, and the licenses in use. Administrator users have additional rights to create or delete users.

After the installation of the **VPLicenseManager** only two users are defined:

<table>
<thead>
<tr>
<th>Name</th>
<th>Password</th>
<th>User group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Administrator</td>
<td>Administrator</td>
</tr>
<tr>
<td>MonitorUser</td>
<td>no password required</td>
<td>Monitor</td>
</tr>
</tbody>
</table>

⚠️ With the first logon the Administrator's password should be changed immediately!

When starting the **VPNetManager** you are automatically logged on as the default user **MonitorUser**. If this default user is deleted on a license server, only the server name and the status of the **VPLicenseManager** is displayed, however there will be no information on licenses. This way administrators can control the access to any license information: delete the standard user **MonitorUser** and create new individual user accounts.
Logon

Menu: General, Function: Logon

The user will be logged on to the selected server. Note that the user name and the password entry are case sensitive! Additionally, the VPNetManager will try to log on the user to any listed VPLicenseManager server. If this fails for a server the user will be prompted again to enter a username and a password for this server. With Cancel the process is aborted.

Change Password

Menu: User, Function: Change Password

This function is available for all users except for the default user MonitorUser. Users of the group Monitor may only change their own passwords while users of the group Administrator may change the passwords of all users.

Create

Menu: User, Function: Create

This function is available only for users who are members of the user group Administrator. A new user can be created either on the selected server or on all listed servers:
Depending on the selected option a new user of the selected group, either of type **Administrator** or **MonitorUser** will be created. With the activated option **On All Servers** the system will try to register the user on all listed servers. The password default is the user name.

**Delete**

Menu: **User**, Function: **Delete**

This function is available only for users who are members of the user group **Administrator**. A dialog appears to delete users from the user list. All registered users of the selected server are displayed. The user will be deleted without a warning message.
SECTION 3
SYSTEM SETTINGS, GENERAL FUNCTIONS

General Information

VPindex is in full compliance with the graphic user interface conventions of Windows. VPindex has a Multi Document Interface (MDI) allowing for opening an unlimited number of documents at the same time and edit/process the contents of the documents simultaneously. You can open raster files, vector drawings, or hybrid files containing raster and vector entities.

Anyone document can contain one or more raster images and/or vector data. The data maybe organized all in one page or in different pages of the same document (Multi Page Document), whereby the Page Control function controls the pages. In a multi page document only one page can be displayed at anyone time. For Multi Page TIFF Files the page control function also allows to select a particular raster image for editing/processing the contained data.

Most functions and routines can be activated through graphic symbols (icons), by selecting the appropriate command from the menus and submenus, or by invoking the adequate commands at the command line. [F1] offers access to an extensive online help at any time.
Program Start

(new Start VPindex with this Icon.

Main Menu Sample: VPindex showing all Toolbars
Start from command prompt

For normal operation you should start VPindex using the shortcut listed above. In some cases, however, you may want to start it directly from a Windows command prompt. The application you have to start is main.exe in the VPindex installation directory.

      [/PT <FILENAME> <PRINTER> <DRIVER> <PORT>] [/B <SCRIPT>]
      [/T <TEMPLATENAME>]

/?  Show dialog with usage
FILENAME  File to open on start
/DDE  Start up and await DDE command
/AUTOMATION  Start up as an OLE automation server
/EMBEDDING  Start up to edit an embedded OLE item
/P <FILENAME>  Print file to default printer
/PT <FILENAME> <PRINTER> <DRIVER> <PORT>  Print file to specific printer
/B <SCRIPT>  Script file to execute
/T <TEMPLATENAME>  Template file to load
General Handling

Manual, Online Help

VPindex is delivered with an extensive product documentation. An Online Help system is also included and provides retrieval of specific function descriptions.

<table>
<thead>
<tr>
<th>Menu: Help, Function: Help Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD: VPHELP</td>
</tr>
</tbody>
</table>

The Online Help is provided in various manners:

Help Menu
You will find Online Help in the menu item Help - Help Topics.

Command Line
Enter vphelp at the command line.

F1 Key
Using the [F1] key. When a dialog has been opened specific information regarding this dialog will be displayed.

Help Button
Click on this button first, then on any other button in the program for obtaining related information.

Toolbars

Upon the first start of VPindex a selection set of the available toolbars is displayed. All toolbars can be switched on/off according to individual user preferences. They can also be positioned by following the Windows conventions.

Icon and pull-down menu commands that cannot be activated in the program's current status (e.g. no raster loaded) appear "grayed".

Each toolbar can be customized individually by removing or adding icons as they are needed. Only Windows: a mix of icons between different toolbars is not possible.

A specific positioning of toolbars can be saved as permanent and will be available at any time when it is needed.
Toolbar Context Menu

A right mouse click on a docked toolbar will open a toolbar context menu providing that toolbars can be customized.

Status Dialog

Menu: *Options*, Function: *Toolbars*
CMD: VPTOOLBARS <Tor-file>

To activate or disable a particular toolbar, just click the corresponding check mark.

Customize

You can customize most of the toolbars by removing unwanted icons. If a particular toolbar cannot be customized then the button **Customize** is "grayed". Select a toolbar and click the button **Customize**.
The following dialog opens:

Select the icon you want to Add (on the left) or to Remove (on the right) and press the corresponding button. Reset activates the default settings.

Buttons Move Up and Move Down allow for changing an icon's position in the toolbar.

When Show Tool Tips is activated and the cursor (arrow) is placed on an icon without clicking it, a short description of the function is displayed as a tool tip. The description also appears in the status line at the bottom of the window. Corresponding tool tip information also appears in dialogs and in the work space.

**Toolbar State**

This list displays all setting files (*.tor) available in the VP Support subfolder.

**Save**

Saves the current toolbar arrangement to a file.

**Load**

Loading a previously saved file containing Toolbar settings (*.tor) from any folder location.

**Load Selection**

A selected Toolbar settings file will be loaded from the Support folder.

**To/From Registry {on/off}**

Saves/Loads a toolbar arrangement to/from the registry instead to/from a separate file.

**Dialog Boxes**

VPIndex uses fixed size and re-sizeable dialog boxes. Once you have set up the size of a variable dialog box this size will be saved and re-used the next time you call this dialog.

If a dialog box uses columns for displaying matching information, the width of each column will be adjusted. You may use keyboard commands according to Windows conventions to modify the arrangement of columns. However, these individual arrangements will not be saved:
Status Display

There is a **comment box** at the lower left screen margin showing:

- **Activated function**, or
- **Required activities to proceed**, or
- **Messages**, or
- **Progress during execution**.

On the right there are 2 boxes for:

- **Count for selected elements**
- **The local RGB color value** if the cursor is positioned on a colored or gray scale image.

When no function has been activated the comment box remains empty, while a 'For Help, press F1' indication appears on the left.

Display Control Functions

**Raster** [F4] {on/off}

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Menu: View, Function: Show Raster</td>
<td>CMD: VPRDISPLAY ► {on/off}</td>
</tr>
</tbody>
</table>

This function toggles the display of raster data on and off. When you load a raster file, the display of raster data is enabled automatically. The item in the menu will be indicated accordingly.

**Vector** [F5] {on/off}

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Menu: View, Function: Show Vector</td>
<td>CMD: VPVDISPLAY ► {on/off}</td>
</tr>
</tbody>
</table>

This function toggles the display of vector data on and off. When you load a vector file the display of vector data is enabled automatically. The item in the menu will be indicated accordingly.
Bird's Eye {on/off}

Menu: View, Function: Bird's Eye

CMD: VPBIRDEYE ► {on/off}

This function toggles the display of a separate window showing the whole drawing. Your actual zoom position is indicated by a green frame. Clicking and dragging inside this bird's eye window performs a dynamic pan of your current view. Clicking the right mouse button and drawing a rectangle will zoom to the rectangle area. Using the mouse wheel zooms into or out of the view's center.

Zoom Functions

Zoom Extents [NUM x]

Menu: View ► Zoom, Function: Zoom Extents

CMD: VPZOOMX

The drawing is displayed to its full extents. The drawing's center is mapped to the center of the display.

Zoom Selection

Menu: View ► Zoom, Function: Zoom Selection

CMD: VPZOOMSEL

This function is only available when objects are selected. After selecting objects the function sets a new zoom window, so that all selected objects are displayed in the drawing area.

Zoom Window

Menu: View ► Zoom, Function: Zoom Window

CMD: VPZOOMW

Define a window in your document to enlarge a section.

You can also use the Fast Zoom Window function by holding down [Ctrl+Space] and then defining a zoom window.
Zoom Pixel [NUM 

Menu: View ➤ Zoom, Function: Zoom Pixel

CMD: VPZOOMPIXEL

Enlarges the display to show each pixel, i.e. each raster pixel is represented by one dot on the screen.

Zoom In

Menu: View ➤ Zoom, Function: Zoom In

CMD: VPZOOMIN

This function zooms in incrementally to the maximum pixel viewing level while maintaining the viewing center point.

Zoom Out

Menu: View ➤ Zoom, Function: Zoom Out

CMD: VPZOOMOUT

This function zooms out incrementally maintaining the screen center point in view, if possible.

Zoom Previous

Menu: View ➤ Zoom, Function: Zoom Previous

CMD: VPZOOMPREV

This function lets you work your way back through previous zoomed views. The program remembers a maximum of 32 views. It does not recall pan operations.

Zoom Dynamic

Menu: View ➤ Zoom, Function: Zoom Dynamic

CMD: VPDYNZOOM

This function lets you zoom dynamically by clicking with the left mouse button onto the screen and move the mouse up (zoom in) or down (zoom out).
## Pan Functions

### Pan [Cursor Keys]

<table>
<thead>
<tr>
<th>Menu:</th>
<th>View ➤ Pan, Function: Pan Right, Pan Left, Pan Up, Pan Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD:</td>
<td>VPPANRIGHT, VPPANLEFT, VPPANUP, VPPANDOWN</td>
</tr>
</tbody>
</table>

You can pan using the scroll bars at the bottom and right of the active window, or using the pan keys on the keyboard.

### Pan Page [Shift]+ [Cursor Keys]

<table>
<thead>
<tr>
<th>Menu:</th>
<th>View ➤ Pan, Function: [Shift]+Pan Right, Pan Left, Pan Up, Pan Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD:</td>
<td>VPPAGERIGHT, VPPAGELEFT, VPPAGEUP, VPPAGEDOWN</td>
</tr>
</tbody>
</table>

You can pan using the scroll bars at the bottom and right of the active window, or using the pan keys + [Shift] on the keyboard.

### Dynamic Pan

<table>
<thead>
<tr>
<th>Menu:</th>
<th>View ➤ Pan, Function: Pan Dynamic</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD:</td>
<td>VPDYNPAN</td>
</tr>
</tbody>
</table>

Click with the left mouse button onto your document and move (pan) as required. Release the mouse button to stop panning. You can also initiate the Dynamic Pan function by holding down [Space] or the center mouse button. The function is active as long as you are holding the key or button.
Using the Mouse

Display Modes of Mouse Position

Within the work area the mouse position is displayed as a Cross cursor by default. When moving to toolbars, menus or to the status area it will be displayed as a standard Windows Arrow cursor. At the command line it will be displayed as a standard Text cursor.

A triple white frame box (instead of the standard crosshair) indicates that with the next mouse click this area will be zoomed in to allow for a precise positioning with the then following click. To configure the zoom size use the General tab in the System Settings dialog.

Using the Mouse to Select Elements

Use the left mouse button to pick for Selection.

Elements to select can be in raster or vector format (Direct Raster Selection mode “Vector/Raster Selection” or “Vector/Raster Selection incl. Stop at Intersections”; all other Direct Raster Selection modes will only work on raster data. See Section 4). When vector elements are overlaying raster elements only vector elements will be selected initially, while raster elements need to be selected again. The appearance of elements changes to indicate their current state of selection. They bear grips for individual modification and their colors may change or appear in a brighter hue, or become highlighted in another line type.

Selecting entities in an image can be done in three different ways:

Clicking

Click on the respective element within the cursor’s snapping range. Only one element will be selected per click.

Window

You specify a rectangle by holding down the left mouse button and dragging the mouse from left to right. All elements completely enclosed by the rectangle will be selected. The rectangle will be displayed with a full frame.

Crossing

You specify a rectangle by holding down the left mouse button and dragging the mouse from right to left. All elements touched or enclosed by the rectangle will be selected. The rectangle will be displayed with a dashed frame.
Deselection of selected Elements

To deselect elements from a previous selection hold the [SHIFT] key and repeat your selection (see above for selection modes).

To cancel a selection or to deselect all selected elements, press the right mouse button for the context menu, or press [ESC].

Context Menus

Use the right mouse button to open context menus. There is a general context menu defined in the software registry. Other menus depend on active functions or commands.

Zoom

You can use the mouse center wheel to
- zoom in/zoom out.
- move up/move down (scroll) when holding the [Ctrl] key.
- move left/move right when holding the [SHIFT] key.
- move the display arbitrary when holding down (pan).

Combined Mouse Keyboard Operation

Angle Snap

Pressing [Shift] while moving the mouse limits the angle of the following movement:
- With 2 point lines including positioning or other help lines (such as text direction etc.) only \( n \times 45^\circ \) directions are possible.
- With polylines the drawing direction of the second and all further segments is limited to only follow a multiple rectangle \( (n \times 45^\circ) \) with reference to the first segment. This allows for drawing rectangle polygons having a base (1st segment) at any angle.

Create a Raster Object

By holding the [Ctrl] key and by dragging a rectangle with the left mouse key a raster object can be simply created from an existing raster structure. It can be processed by using the available functions from the context menu.

Command Line

VPindex offers a command line input and execution via keyboard. All functions can be initiated by command line input. Commands are only available (executable) if a document has been opened, except for specific commands like Open, New, Help, etc. Processing a command sequence can be initiated by using a Scripting File.
The command line window is sizeable, dockable/undockable, and can be switched off when not needed. It automatically reappears on keyboard input. To activate and display the switched-off command line just press [Shift]+[Return]. Command line inputs may look like this:

![Command Line Window](image)

Commands can only be started when the command line shows the Command> prompt. Otherwise, the command line prompts for specific input due to the running command.

However, using a command with a preceding single tick mark (‘) will start the command regardless of the command line state. This can be useful, for instance, when during the drawing of a line (VPDRAWLINE) a zoom command shall be executed (‘VPZOOMX).

The available commands are listed with the corresponding functions in this manual.

A command string consists of the **command header** and can be extended by **options/parameters**. Any command starts with the two letters "VP" followed by the command name. The command header is the main command for any particular function or operation. For entering you may use upper and/or lower case letters. Enter [Return] for execution.

The command syntax is as follows:

```
VPXXXX <X1>,<X2> <X3> [/P|Parameter <X1>, <X2>]
```

The preceding characters VP may be omitted.

**Options <X1>, <X2>,<X3>**

Options are command supplements which may be required to execute the command. As indicated in the dialog **Registered Commands** some commands do not allow options at all, some may have options, and some always require options. The values X1, X2 etc. can be separated by either comma(s) or space(s). This delimiter strategy allows for entering an extended command string prior to executing the complete command with [Return].

**Parameter [/P|Parameter <X1>]**

Parameters are always optional. Therefore, they are listed in this manual in brackets. A parameter definition starts with a "/" (slash) followed by a parameter’s name or abbreviation. Names and abbreviations will be displayed with a separating "|" (dash), e.g. "/P|Parameter". A parameter can require options, which are demanding if the parameter is used at all. These parameters are shown within the brackets enclosing the parameter and the required options.
Delimiter

Options and parameters have to be separated with a delimiter. As delimiters either a **comma** or a **space** character are available. Multiple spaces and/or commas between two option values are interpreted as one delimiter.

If a parameter uses either a space or a comma as part of the parameter - e.g. if you use a file name as the parameter to the command **VPOPEN** which carries space(s) - you need to enter this parameter in quotations marks: **VPOPEN "C:\VP SAMPLE.TIF"**.

Command Query

If you enter any command followed by a slash and a question mark, e.g. **VPDRAWLINE /?**, the system will display all options/parameters for this command.

Repeating Commands

Entered commands can be repeated by using [↑] and [↓] cursor keys.

Completing Commands

You may use the [TAB] key to complete a command. A repeated pressing on [TAB] will prompt the next command option in alphabetical order. Using [SHIFT] + [TAB] reverses this order.

Example: "**VPDRA**" and [TAB] will prompt "**VPDRAWPIX**".
"**VPDRA**" and [SHIFT]+ [TAB] will prompt "**VPDRAWCOPY**".

Alias Names

The command header of a command string may be replaced by an **alias name**, usually a short abbreviation being especially useful with commands which are often used. The file **ALIASES.PGB** located in the **SUPPORT** subdirectory contains alias names which may be modified or extended at users discretion. The default alias names are listed in the APPENDIX.

Entering Coordinate Values

Coordinates can be entered in absolute values as x,y, in relative values as @x,@y, in length and angle values as l<phi, or only as length I value (while the angle value will result from the current mouse cursor position and the last coordinate value pair). A mixed entering of absolute and relative values is also possible, e.g. @x,y or x,@y.

The last coordinate value pair is prompted in the command line as <x,y>. You can confirm values with [Enter] or change values with [Tab].

![Warning]

A **comma** is always considered as a separating symbol. Thus, to enter decimal values a decimal **point** must be applied, regardless of any other settings in your Windows system.
Command Line {on/off}

Menu: View, Function: Command Line

CMD: VPCMDLINE

Switches the command line on and off.

Activate Command Line

Menu: View, Function: Command Line

CMD: VPACTCMDLINE

Activates the command line at any program state.

List Commands

Menu: Options, function: Registered Commands

CMD: VPLISTCOMMANDS

A list of all available commands will be displayed:

You can double-click Yes in the column Command Parameters to access the parameters that are available for the respective command. When changes have been made leave the dialog with OK to use the command with new parameters.

Example for the VPSPECKLES command:
File Menu

This menu manages the loading, saving, import and export of raster and vector files. When a scanner device is connected drawings can be scanned directly into the software. You can also load program extensions, print/plot hybrid (raster and/or vector) data and exit the program.

All functions are in compliance with standard Windows conventions. Hence, descriptions will only be given in detail regarding differing functions or on those which are of high importance.

**New [Ctrl + N]**

Menu: *File*, Function: *New*

CMD: VPNEW

A new document opens. If a prototype drawing file has been assigned it will be read and the environment of the new document is set accordingly.

If you want to create a new (empty) raster image for a document (new or containing data) use the function *New Raster* from the *Edit Menu* (see Section 4).

**Open [Ctrl + O]**

Menu: *File*, Function: *Open*

CMD: VOPEN ► Dialog

CMD: VOPEN <File Name> [P|Page <value>]

When clicking this command a dialog box opens to select one or more files (raster, vector, or hybrid) for loading into a new document.
All common files are displayed. When selecting a file a **preview** is shown if the function **Preview** is switched **on** and the file format is supported.

The list of supported formats can be found in the **Appendix**.

The name of the loaded file appears in the title bar. In case of a raster file, it will be loaded into the default layer **Raster**, and the **Prototype Drawing** file will be read, if assigned (see **General Settings**). The environment of the document is set accordingly.

When more than one file has been selected the following dialog appears to control how the individual files are going to be opened:

- **All files into one doc**
  All selected files are loaded as separate raster objects in one document
- **All files into one doc, but to individual pages**
  Creates a multi page document
- **Create individual documents**
  Opens each selected file as separate document
Multi Page Documents [P|Page <value>]

For multi page files you can select to either open all pages or only a particular page (page no.).

Default: All pages

Options

Some file formats offer additional settings through the Options button. For more information see File Format Options below in this section.

The native VP format RVD replaces the formats VCF and VCI used in earlier VP products. However, input filters still allow for loading or importing those formats into V8.

CGM: the import of raster is limited to uncompressed 1bit (b/w), 8bit (indexed color), 24bit (true color), and RLE compressed 1bit data.

When opening a raster file containing coordinate settings and placing information (e.g. TFW or GeoTIFF) a dialog will ask how to handle this information.

Update Coordinate System (UCS): The data of a TIFF file is used to update the coordinate system; the image is placed accordingly.

Transform Data to current UCS Settings: The existing coordinate system remains unchanged; the insertion point's coordinates of the image are transformed accordingly.

Ignore Placing and UCS Information: The existing coordinate system remains unchanged - no transformation is performed; the image is inserted at the position (0,0).

Default: Update Coordinate System (UCS)
Import

Menu: File, Function: Import

CMD: VPIMPORT ► Dialog

CMD: VPIMPORT <File Name(s)> [P|Page <PageNo>][/m|Mode <Mode>]
[f|x|XInsert <XInsert>]/[y|YInsert <YInsert>][[/s|x|ScaleX <ScaleX>]
[/y|ScaleY <ScaleY>][a|Angle <Angle>]

The content of a file is merged with the active document. Existing document settings in the active document, e.g. layer names, will be kept; the layer settings of the files are discarded. This may lead to a different display of the imported file, e.g. if the layer properties are different in the active document.

The Import dialog equals the Open dialog (see above). It contains, however, the additional option Specify Insertion Point.

⚠️ When using a multiple file selection together with the option Create individual documents the Open command is used instead of Import!

Specify Insertion Point {on/off}

If you set this parameter to on you can define the insertion point for the file you are going to import. A dialog box opens for specification:

You can either select Specify on Screen or enter values for the parameters Insertion Point, Scaling, and Rotation. You may also pick the Base Point on the import file. Otherwise, the base point is at the lower left corner of the file.

When importing a file which contains coordinate settings and placing information (e.g. GeoTIFF) they will be recomputed to the actual UCS settings.

Default on
(Positioning) Mode /m
This command line option specifies how the imported file is to be positioned:

0 - use (Positioning) data from file
1 - ignore all data
2 - interactive
3 - use subsequent data

In interactive mode (2) the Specify Insertion Point dialog is displayed for positioning. For a direct input of insertion point values, scaling, and rotation use mode 3.

Save [Ctrl + S]

Menu: File, Function: Save
CMD: VPSAVE ▶ Dialog
CMD: VPSAVE <File Name(s)>

If you use this command the first time after loading a document, the Export dialog pops-up to ask for a file name. As Default the name and extension of the opened file will be offered. Any future save of this file will automatically overwrite the previous save without any message.

If the selected file format does not support all data of the document (e.g. any raster file format does not support any vector information) a warning will pop up on first use.
Preview

You can switch the preview on or off. The preview displays the data which will be saved.

Options

For some file formats the **Options ...** button will be enabled. In this case there are additional options available to specify how to save the data. For details please refer to the **File Format Options** later in this section.

Layers

The dialog **Layer Manager** is displayed for modifications of the layers’ export settings. See **Section 4: Document Settings, Document Functions** for details.

Multi Page Document

If your document is a multi page document you can save all pages into a multi page document or all pages into single files (i.e. each page into a separate file). The options **All as multi page file** is only available for specific file formats (e.g. TIFF).

If you select **Page No. "n"**, only this page will be saved into a separate file.

⚠️ If you select/specify an already existing file (name) and this format supports multi page (e.g. TIFF), on **Save** you will be asked whether you want to override the existing file or append your current document as new page to the existing file.

Only selected (on/off)

Only the selected entities and/or images are exported.

**Default:** on (if entities are selected)

Georeferencing

An additional file with placing data is created if the option **Write Placing File** is set to **on**. These files are used mainly by geographic applications (GIS). The file name equals the name of the raster file. The file extension is assigned according to the placing format (e.g. TFW or TAF).

⚠️ In order to produce a valid TFW file the **User Units** of user coordinate system must be set to **Meters [m]**. Otherwise, an error message is displayed.
Save As

Menu: File, Function: Save as
CMD: VPSAVEAS ► Dialog

Similar function as Save, except that the dialog always opens for assigning a file name.

Export

Menu: File, Function: Export
CMD: VPEXPORT ► Dialog
CMD: VPEXPORT <File Name(s)> [P|Page <value>] [O|Options <options string>]

This function is very similar to Save with the difference that the document name is not changed to the name of the export file.

Close

Menu: File, Function: Close
CMD: VPCLOSE

Closes the active document. If the document has been modified a message will ask, if the modified file should be saved or not.

Close without Safety Prompt

CMD: VPCLOSEALWAYS

Closes the active document without safety prompt ("Save changes?"). The purpose of this command lies mainly in script processing, when after a file export the document is still marked as modified but shall be closed anyhow.
File Format Options

Some file formats allow for setting additional parameters. The dialogs can be opened with the Options buttons in the Open/Import and Save/Export dialogs respectively.

The available options for file formats are described below.

Geo Referencing

If the option Write Placing File is checked a separate file will be generated and saved under the name of the raster file but with the extensions TFW or TAF containing the positioning information of the raster image. This placing information will often be used in GIS applications for a correct placing with regards to the coordinate system.

⚠️ In order to generate a valid TFW file the User Units must be set to Meter [m]. Otherwise, an error message appears.

JPEG Export Options

When exporting raster data to JPEG you can specify the Quality of the created JPEG-file.

Low Quality means high compression (small files), but also high color quality loss, High Quality means the opposite.

Default: 75%.

GIF Export Options

The GIF file format allows you to specify a color via which should be transparent (not displayed). This color can be specified for all following exports to GIF.
Do not write Transparency {on/off}

This option turns off the transparency (none of the colors will be set to transparency).

Default: on

Transparency by Palette Index

The color according to the palette index displayed in the Image Palette dialog will be set to transparency.

Default: off

Use Image Transparency where available

Use the color, that is set under Transparency in the Image Palette dialog.

Default: off

Transparency by RGB Value

The color defined by its RGB value will be set to transparency. Since only palette entries can be set transparent and often the RGB value does not exactly match a palette entry, there is an additional switch to find the nearest color in the palette.

Default: off

Match Nearest Color {on/off}

If checked on the closest index value matching the defined RGB value will be used to set this color to transparency.

Default: off
TIFF Export Options

Exporting raster images using the TIFF file format provides a choice of several compression methods and strip sizes. The current settings are saved and will be used for future TIFF export operations. Modifications in the settings are recommended only if problems are encountered when loading exported files into other applications.

For most images the default settings produce the smallest file sizes and can be loaded into most applications.

When clicking the Default button all options are reset to default values.

Strip Control

TIFF data can be written in whole (single strip) or in strips. Select between:

- **Auto** calculates the strip size so that it amounts to roughly 8 KB of uncompressed data.
- **Single Strip** writes the file in whole.
- **Multi Strips** The number of Rows Per Strip can be entered into the edit field.

**Default:** 512

A large number of strips result in large file sizes. Also, do not choose the option Auto with very wide images (> 6.000 pixels).
Color Options

The compression method affects the resulting file size substantially. Colored images can be compressed as follows:

- **Uncompressed** the data will not be compressed.
- **LZW** Typically generates the smallest file sizes.
- **Packbits** Compresses data using the Packbits method.

Default: LZW

Monochrome Options

The compression method affects the resulting file size substantially. Monochrome (b/w) images can be compressed as follows:

- **Uncompressed** the data will not be compressed.
- **CCITT Group 4** Generates highly compressed data.

Default: CCITT Group 4
PDF Export Options

With the export into PDF the compression of raster data can be controlled. The compression method affects the resulting file size substantially.

PDF/A conformity

This will generate a PDF file for long-term archiving. Description... opens a dialog to enter optional information on Author, Theme and Keywords.

Color Images

Colored images can be compressed as follows:

- **LZW**  Lossless compression.
- **DCT/JPG** Compression with possible losses. Use the slider button to determine the compression degree (Quality). **Low Quality** will result in a high degree of data compression, however, with high losses of detail information. **High Quality** will result in a reverse effect.
- **Uncompressed** Data will no be compressed.

**Default:**  **LZW**  
75% (with DCT/JPG compression)

Black&White Images

Black& White images can be compressed as follows:

- **Uncompressed**  the data will not be compressed.
- **CCITT Group 4** Generates highly compressed data.

**Default:**  **CCITT Group 4**
## DWG/DXF Import Options

### Layout Mode

Determines which layout of the DWG / DXF file is to be loaded. You can either select the saved **active layout** or the standard **model space**. Alternatively, and prior to opening, a dialog can be displayed for individual layout selection (**Show list with all available layouts**), or to load all available layouts (**Load all layouts (multipage mode)**).

**Default:** Open drawing in saved layout

### Password Protected Files

- **Ask for the password on open**
  
  On opening a password protected file the password has to be entered in a dialog.

- **Always use this password**
  
  If many files use the same password it can be entered here for usage with all protected files. For safety it is saved in encrypted form. On opening a file no dialog is displayed.

- **Do not open password protected files**
  
  Password protected files are not loaded. No dialogs or messages are displayed.

**Default:** Ask for the password on open.
Convert drawing

The display of DXF / DWG drawings may differ from the display in AutoCAD. This may occur
e.g. with line types, text styles, or polylines with assigned widths and bulges. For a display
more true to the original all entities may be converted into basic entities like lines, polylines,
and splines on import.

⚠️ The conversion is only advised if the drawing shall be rasterized. Since the conversion
produces a large number of entities the import may take a very long time.

Default: No conversion

Line widths

VPindex uses absolute line widths, i.e. the display is independent of the zoom scale factor.
With some drawings this may result in disproportionately thick entities. In this case use the
option Set all line widths to 0.0. Alternatively, line widths may be adapted in the Layer
Manager after loading.

Default: Do not convert line widths

Hatches

Specify a directory where you want to search for hatch pattern styles.

Default: \VPxx directory\SUPPORT\n
Character Set

You can determine which character set should be applied on import of non-unicode text.
Choose between Determine character set automatically (character set saved in the
imported file) and Always use this character set (pre-defined character set).

Default: Determine character set automatically

Measurement

You can determine which measuring unit will be used in the imported file. Automatic will
assign the unit according to the currently active document (like on Import).

Default: From file
**DWG/DXF Export Options**

**File Format**

Determines in which format DWG or DXF files will be saved.

**Default:** AutoCAD 2007 compatible

**Raster**

If you want to save raster data you can choose between RasterDWG and AutoCAD format.

The RasterDWG format developed by softelec allows to save all raster image data inside one DWG file together with all vectors. Otherwise, you have to handle two or more files for one document (the DWG file and the raster file(s)).

The RasterDWG format conforms to the DWG specifications. That is why RasterDWG files may be loaded into every standard AutoCAD product. However, you need a RasterDWG driver for AutoCAD in order to display the raster data. Otherwise, only empty frames with a message are displayed. This RasterDWG freeware utility is available on your softelec product CD and at www.softelec.com. Once installed with AutoCAD, it allows for viewing and printing of both raster and vector data in any AutoCAD based product.

**Default:** Save in AutoCAD Format

**Save Raster file(s) automatically** generates file names without prompting the user.

**Default:** off

**Seedfile**

If a Seedfile is specified it is opened and its content will be added to the document to be saved. This allows for establishing basic settings, such as grid, limits, coordinate system, or entities (company logos, drawing headers) in all DWG files.

**Standard:** void
Conversion of VP entities

Polygons can be exported either as **Hatches** or as **Polylines** using the option **Export polygons as**.

Default: **Hatches**

Character Set

Determines the file’s character set (codepage). The exact setting can be important, e.g. if a file is to be opened on a computer with a different active codepage setting.

Default: currently active system character set

DXF: Floating-point precision

The number of decimal places can either be set **automatically** according to settings in the current file, or it can be set as **user defined**.

Default: **Automatic**

DGN Import Options

![DGN Import Options](image)
Model Mode

Determines which DGN file model will be loaded. You can choose between the saved active model and a permanent default model. You can also choose to display all available models for an individual model selection prior to opening (Show list with all available models).

Default: Always load active model

Linewidth

VPindex uses absolute linewidth values, i.e. their display depends on the zoom stage. In some drawings this may lead to displaying disproportionate thick elements. In these cases you can use the option Set all lineweights to 0.0. All linewidth values can also be adjusted individually in the Layer Manager.

Default: Scale linewidths by 10.0

Scaling

VPindex uses absolute length values for linetypes, i.e. their display depends on the zoom stage. In some drawings this may cause details to disappear from the display. In these cases you can change the scaling value accordingly.

Default: Scale linetypes by 1.0

Convert Drawing

The display of DGN files in VPindex may differ from their display in MicroStation©. This may occur e.g. for linetypes, textstyles, or polylines with specific widths or curves. To ensure a proper display these elements can be converted to basic element structures, such as lines, polygons and arcs.

The conversion is only recommended if you want to rasterize the loaded DGN file. The conversion may also cause to generate very many basic elements. Thus, loading the file may take considerable more time.

Default: No Conversion
DGN Export Options

The following DGN export options are available in the **Options** dialog.

### File Format
Files can only be saved in **V8 Format**.

### Seedfile
Activate and specify if you want to use a specific seedfile.

**Default:** off

### Line widths
Line widths can be changed to a fixed width of 1 pixel or to a specific pixel number per 1mm.

**Default:** Set all line widths to 1 pixel

### Raster
Raster data can be saved in two different ways. Either, they can be **embedded in the DGN file** or they can be **saved in an extra file** as an attachment to the DGN file.

**Default:** Embed Raster in DGN File
Save Raster File(s) automatically will generate separate Raster files with no user prompting.
Default: off

Attributes
Specify whether attributes will be exported as text with the given Textheight in user units.
Default: on; Textheight: 3.0

Advanced
A dialog opens to determine Master Units and Sub Units:

Master Units always refer to the current User Units. Sub Units may be set automatically depending on the Master Units, or you set them individually.

List of automatic settings Master Units – Sub Units:

<table>
<thead>
<tr>
<th>Master Units</th>
<th>Sub Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>mm - µm</td>
<td>in - µi</td>
</tr>
<tr>
<td>cm - mm</td>
<td>ft - in</td>
</tr>
<tr>
<td>m - mm</td>
<td>yd - in</td>
</tr>
<tr>
<td>km - m</td>
<td>mi - ft</td>
</tr>
<tr>
<td></td>
<td>nm - ft</td>
</tr>
</tbody>
</table>

Default: Depending on Master Units

[Diagram of DGN Advanced Export Options]
CGM Export Options

To export a CGM file options for CGM Version, Parameter Type (Precision), Layer Information, and type of Raster Export within the CGM file can be defined.

**CGM Version**

Select between Version 1, 3, or 4.

**Default:** Version 3

**Parameter Type**

Choose between Real (i.e. all data are saved as floating point values, larger coordinate values are possible; this may be necessary if the drawing size is very large) and Integer (all data are saved as integer values). With Integer either 16-bit (small drawing size) or 32-bit (large drawing size or higher precision) can be specified.

**Default:** Real

**Layer Information**

Since the CGM-format does not contain layer assignment, this setting allows for keeping the layer information of VPindex by the entity color: all elements are assigned to the color of their layer and therefore, can easily be identified in another CGM-program.

**Default:** off

**Raster**

If Write out Raster is on the raster data will be saved inside the CGM file. b/w raster can be saved either uncompressed or RLE-compressed; colored raster will always be saved uncompressed.

**Default:** off
SVG/SVGZ Export Options

The following options are available when exporting in SVG/SVGZ format:

Output Size

You can choose between Keep original Size or Scale to fix Size. For the latter you can specify custom maximum Width and Height values.

Default: Keep original Size

Precision

Coordinate precision (digits) may be specified either directly (Exact n digits), or it may be calculated automatically by the program.

Default: Automatic
This function allows for operating connected scanners either using a **TWAIN Interface** or by the built-in **Large Format Scanner Interface**. Major large format scanners can be operated directly from within the program. Depending on the type of scanner a corresponding dialog box opens to enter the essential parameter settings according to the respective scanner’s specifications. For more information regarding supported scanners see the **Appendix**. If more than one scanner is attached you can select the desired scanner from the upcoming dialog.

**L|Lastscanner**  
The dialog for the scanner selection is suppressed.

Scanners controlled by the TWAIN interface have individual user interfaces for setting-up and operating the scanner. If a TWAIN driver is available on system level (i.e. installed and activated) then VPindex will offer to operate this scanner.

Using the built-in large format scanner interface the following dialog appears:

Scanner Dialog for Large Format Scanners
Functions

Depending on the connected scanner, the software supports the following scan modes:

- Black/White
- Grayscale
- Color (Indexed, 256 colors max.)
- Truecolor

All other options will be activated or deactivated according to the specifications of the connected scanner device.

The upper area of the dialog is divided into two areas:

**Left window:** Display of an area of the scan in 1:1. Use the slider of the right window to specify the horizontal position of the area.

**Right window:** Overview window: a small frame indicates which area is currently displayed in the left window.

**Buttons:**

- **Scan** Start scan.
- **Stop** Stop scan.
- **Close** Close scan dialog.

**General Functions:**

- **Scan Mode** Sets the current scan mode (b/w, gray scale, and color).
- **Scan Width** Depending on scanner type: **Format** and/or **Variable**
  With CalComp, Océ, Contex scanners:
  - **Variable:** paper is left or right aligned (0 position)
  - **Format:** paper is centered
  Scan Width is set according to scale (units) on scanner.
- **Resolution** Depending on scanner type: fixed and/or variable.
- **Append Page** The image will be appended as a new page to the current document.
- **Palette** Scan using a previously generated palette (only in color mode).

**Black/White Options:**

Depending on the scanner type the following functions are available:

- **Line Enhancement** Increases the line thickness.
- **Dynamic Enhance** Increases the contrast.
- **Adaptive Threshold** Threshold depending on Area.
- **Threshold** Standard threshold (0 - 255).
- **Adaptive Level** Contrast threshold (0 - 100).
- **Background Suppression** Suppression of speckles (0 - 100).
Color and Grayscale Options:

**Brightness**  Range: -128 - 128.

**Contrast**  Range: 10 - 1000 (in %).

**Blur**  Filter to reduce dithering in color scans: 0 - 3.

When executing a 256 color scan, the following dialog box appears after pressing **Scan**:

![Scan Colors dialog box]

**Computed Color Map**  The system performs a prescan to calculate an optimized palette for the current drawing. The palette size can be selected between 4 and 256 colors.

**Linear Color Map**  A standard palette will be used for the scan. The palette represents the whole color space. 8, 16, 27, 125, 216 and 256 colors can be selected.

**Load Palette**  Load a specific palette (*.VPL) which has been previously generated (by Save Palette).

### Description of Terms

Different manufacturers use different terms for the same functions of their scanners. The following table shows the terms used by VPindex and their equivalents:

<table>
<thead>
<tr>
<th>VPindex Dialog</th>
<th>Scanner Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adaptive Threshold</td>
<td>Adaptive Area Threshold</td>
</tr>
<tr>
<td></td>
<td>2D-Adaptive Threshold</td>
</tr>
<tr>
<td>Adaptive Level</td>
<td>Area Brightness</td>
</tr>
<tr>
<td>Background Suppression</td>
<td>Variability</td>
</tr>
<tr>
<td>Line Enhancement</td>
<td>Edge Enhancement</td>
</tr>
<tr>
<td>Dynamic Enhancement</td>
<td>Dark Enhancement</td>
</tr>
</tbody>
</table>
Print [Ctrl + P]

Menu: File, Function: Print

CMD: VPPRINT ► Dialog

Any printer or plotter device installed under the operating system may be used for printing raster and/or vector data. However, the capability of processing raster data not only depends on the printer/plotter model, but also on the installed Windows drivers. A dialog box opens to determine scale, offset, paper format, and printing area. Raster and/or vector data can be selected for printing according to the monitor screen display.

The printer dialog opens for selection and specification. When the command line is used the last used printer is selected:

Select the Print Range and the number of Copies. Other options are:
Extents

Choose between **Whole Drawing**, **Current View**, or **Window**. For the latter check the button right to the **Window** option and set a window with two click points in the preview area. The selected window area will be displayed with a red frame.

Printing Options

Choose between **Use Printer Driver** (default setting) or **Print as Image**. If you encounter problems when printing hybrid data (i.e., a mix of raster and vector data) or with large formats due to limitations of the standard printer driver use the option **Print as Image**. Then, **VPHybridCAD** rasterizes all entities into a temporary plot file and sends this file to the printer/plotter. Use the option **Print as Black&White** to print color vector data on black&white printer with a better quality.

Linewidth Definitions

With the option **Scale Linewidths** vector linewidths will be printed with a scaling factor set in **Scaling**. Without this option linewidths will always be printed according to their settings. If the **Use Color Width Table** option is on, the **Settings** button will pop-up a dialog, which allows to the specify the width for each color. You can also save and load these settings.

Otherwise the **Layer Manager** will pop-up to specify the width for each Layer.

Scaling

Allows for arranging the image size according to user demands in terms of scaling and offset. With **Fit Paper Size** the selected **Extents** will be scaled to fill the entire paper space. **Drawing Scale** and **Fixed Scaling** will scale elements in the selected extents with the given factor or percentage.

Preview Area

The preview area’s display can be adjusted with the buttons on top of the dialog. A green frame display the printer’s current paper settings. The outer frame refers to the paper extents while the inner frame refers to the print space. When **Fit Paper Size** is switched off the paper extents position can be moved with the mouse. When releasing the mouse button the move values will be updated. The zoom factor can be changed with the mouse wheel.
Print Preview

Menu: File, Function: Print Preview

The Preview option allows for previewing print results to support an accurate positioning.

Print Setup

CMD: VPPRINTSETUP ➤ Dialog

A printer/plotter can be selected and activated.
Load Extensions

Menu: **File**, Function: **Extensions**

**CMD:** VPEXTENSIONS ▶ Dialog

Loads the software extensions to the program. A dialog box opens, listing all available extensions and showing their status. An extension can be loaded and installed (activated for use). The program usually loads and installs all necessary extensions:

![Extension List]

Exit

Menu: **File**, Function: **Exit**

**CMD:** VPEXIT

Exits the program. If there is modified data in memory which you have not saved yet, a box opens asking you to save before the program terminates.
System Settings

The system settings define the general operation environment of your program.

Menu: Options, Function: System Settings
CMD: VPSYSTEMSETTINGS ➤ Dialog

A dialog box opens to define the system's general setting values.

General Tab

![System Settings Dialog]

Drawing Units

Choose either mm or inches. The drawing units you select determine how the raster image will be interpreted in terms of units of measure. The units have an effect on the X/Y coordinate system and on all depending values and parameter settings.

Default: mm

Default Text Font

Selection of the default text fonts for text style creation. All existing and scaleable True Type Fonts in your Windows system are available.

Default Font: Arial
Zoom-In on First Click

This option controls the automatic zoom for commands that use the "triple frame" cursor, e.g. the VPDESKEW command.

Default: 1:16

Pick Box Size

This setting controls the size of the cursor square box (in pixels of the monitor screen) used when elements are selected (pick area). It also defines the grip size of the selected entities.

Default: 8 [pixels]

Cmd Echo {on/off}

Set to on the command name is displayed in the command line window whenever the command is started via menu or toolbar button.

Default: on

Display Info

Show Context Menus

When set to on, the default context menu appears when clicking with the right mouse key. The default context menu will be replaced by other special menus, depending on the active function.

Default: on

Show Status Tooltips

When set on status messages will be displayed as tooltips next to the mouse cursor.

Default: on

Show Warnings

Current Layer off

When set on a warning will come up upon switching off a current layer setting.

Default: on

Current Raster off

When set on a warning will come up upon switching off a current raster setting.

Default: on
Colors Tab

Some of the screen colors can be defined individually:

<table>
<thead>
<tr>
<th>Category</th>
<th>Screen color: white on black</th>
<th>Screen color: black on white</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window Background</td>
<td>(black)</td>
<td>(white)</td>
</tr>
<tr>
<td>Cursor</td>
<td>(green)</td>
<td>(black)</td>
</tr>
<tr>
<td>Active Image Border</td>
<td>(red)</td>
<td>(red)</td>
</tr>
<tr>
<td>Raster Selection</td>
<td>(red)</td>
<td>(red)</td>
</tr>
<tr>
<td>Speckles</td>
<td>(green)</td>
<td>(green)</td>
</tr>
<tr>
<td>Raster Holes</td>
<td>(red)</td>
<td>(red)</td>
</tr>
<tr>
<td>Move Grip</td>
<td>(black)</td>
<td>(white)</td>
</tr>
<tr>
<td>Other Grips</td>
<td>(black)</td>
<td>(white)</td>
</tr>
</tbody>
</table>

The System Default values (in brackets) can be reactivated when clicking on the white on black or black on white buttons.
Files / Paths Tab

![System Settings](image)

**Auto Save (on/off)**

While working with the program an automatic save of open documents will occur at selectable intervals. You can specify the Interval and the Drive and the Path for the Auto Save individually.

Default: **on**  
Default Directory: no entry = document's current directory

For the auto save operation the system uses the filename of each document extended by "_" (underscore) + numbering. The extension is **RVD**. Sample: **ARCH.TIF** will be auto saved as **ARCH_0157.RVD**

Default interval: **60 [minutes]**

**Purge Auto Save Files on Close**

If you set purge auto save files on close to **on** the system will delete all auto save files on closing a session.

Default: **off**

⚠️ We strongly recommend not to switch off **Auto Save**.
Prototype Drawing

The prototype file will be read on program start and with File Open or File New. It contains document settings that override the defaults. Creating a specific prototype drawing file allows customizing your VPindex setup to your individual needs.

Create your individual environment or load a file containing all settings the way you want to have the document set on start. You then save the empty file (erase all possible data) under a name of your choice. Enter this name (including drive and path) into the field Prototype Drawing or browse and select the desired file (including drive and path). Now, with any subsequent start of your VPindex the prototype drawing will adjust the document settings accordingly.

Default Drawing: \VPxx directory\SUPPORT\PROTO.RVD

⚠️ Please note: if you Open a document the settings of your prototype drawing may be changed by the settings of this document.

Support Path

The directory of files containing parameters, prototypes, and other auxiliary information.

Default directory: \VPxx directory\SUPPORT

SHX-Font File Search Paths

These directories are used by the software to search for SHX font files.

Standard: Empty
Open / Save Tab

You can specify which folder you want to use as a standard for open, import, save and export.

License Tab
Enable Full Version {on/off}
Activates a VPindex full version product permanently. Otherwise, the software operates in demo mode and will not search for a license (hardlock).

If you have your VPindex installed as Network License(s), enter the Server Name to search for an available license or browse for the server computer.

Enable Network Search {on/off}
If set to on, the whole network will be scanned for a valid VPindex Network License, if no license can be found at the predefined location. This operation may take some time.

Install Hardlock Driver
If the proper driver for the hardlock (Sentinel or Hasp) is not yet installed, the button Install hardware lock driver is active. Click on the button for driver installation.

To install the hardlock driver administrator rights are required.

Raster Image Tab

Default Resolution
If a loaded/imported raster image does not contain a valid resolution (DPI) a standard value will be set.
Default: 300 DPI
Move Raster Images to active Layer {on|off}

The currently active layer will be assigned automatically to a new loaded/imported raster image.

Default: off

Move Raster Images to this Layer {on|off}

The named layer will be assigned automatically to a new loaded/imported raster image. The layer will be created automatically if it has not been created before.

Default: on, Raster

Highlight active image {on|off}

The active raster image will be highlighted with a colored frame. The frame color can be defined in the Colors tab.

Default: on

Raster Selection Tab

This tab controls how entities are created when using the Direct Raster Selection. For more details on Direct Raster Selection see Section 4.

CAD Entity Recognition {on/off}

If switched on the Direct Raster Selection tries to generate CAD Entities. Depending on the additional settings these can be arcs, circles, lines, or more complex entities.

Default: on
Arcs & Circles {on/off}
If switched on the Direct Raster Selection tries to generate arcs and circles.
Default: on

Complex Entity Recognition {on/off}
If switched on the Direct Raster Selection tries to generate complex entities like dashed lines, hatchings, or text. This can be controlled in more detail with the options described below.
Default: off

Max. Recognition Area
The area range in the drawing that is examined to find complex entities. The larger the value, the more processing time will be needed to find entities. The value (in base units) is the edge length of a square which is centered around the click point. Only entities that are completely inside this square will be considered.
Default: 100 [mm] or 3.937 [inch]

Dashed Lines {on/off}
If switched on the Direct Raster Selection tries to generate dashed lines.
Default: off

Hatching {on/off}
If switched on the Direct Raster Selection tries to generate hatchings.
Default: off

Text {on/off}
If switched on the Direct Raster Selection tries to generate text while the text settings can be changed using the Advanced button.
Default: off

Advanced
A dialog opens which controls text search details:

![Advanced Text Settings dialog](image)
Max. Text Height

Defines the maximum size of isolated structures to be processed during entity recognition. Choose a maximum text height for searching text structures up to the specified height.

Default: 4 mm, 0.157 inch

Search Directions

The search for different text orientations can be limited. With more active options the text interpretation process will take longer respectively.

Search Directions are:
- Only Horizontal
- Horizontal and Vertical
- Arbitrary

Default: Arbitrary

Only Polylines {on/off}

If switched on the Direct Raster Selection tries to generate only polylines which stop at intersections.

Default: off

Redlining Configuration Tab

Enable or disable access restrictions.

Enable Access Restrictions

If Enable Access Restrictions is activated the path to the redlining configuration file is required. Then, a logon to the redlining session using user name and password is required.
Change Password

Clicking Change Password opens a dialog box to modify the password for redlining.

Shortcuts Tab

For frequent insertions you can define up to 35 ASCII character strings as character shortcuts, especially those which are not available from a direct keyboard entry. Use the Windows character map (CHARMAP.EXE) for selection. While entering or correcting text strings use [Alt + 1] - [Alt + 9] and [Alt + A] - [Alt + Z] to insert them.

Also, shortcuts are helpful for supporting quick insertion of repeatedly used text strings, prefixes, suffixes, etc.

Default shortcuts: see Dialog Box above
User Interface Look Tab

Here you can change the look of the User Interface. Several designs are offered for selection. Depending on your Windows version the User Interface may look slightly different from the displayed preview.
**OCR Options**

Menu: *Options*, Function: *OCR Options*

**CMD:** VP SHOW OCR DIALOG

The following dialog opens:

![OCR Settings Dialog](image)

**Character Set** defines the recognizable characters and/or numbers.

The text recognition may be adjusted to the specific content of a drawing. These options are available:

- **Recognize any characters of this language {on/off}**
  - Characters of the selected language are to be recognized. Upper case and lower case characters and numbers can be distinguished additionally.
  - **Default:** on, English

- **Recognize numbers only {on/off}**
  - Only numbers are to be recognized. As an option, a separate recognition for Handwritten numbers can be used.
  - **Default:** off

- **Recognize additional characters only {on/off}**
  - Only characters, special characters and numbers defined in Additional Characters are to be recognized.

**Recognition Level** allows the setting of a tolerance threshold to define the acceptance level for each recognized character. A character having a lower level will be rejected and displayed as a question mark instead. Some trials may be required for extremes in drawings. However, please do not expect an improved OCR of poor raster text.

- **Range:** 0 - 99%
- **Default:** 36%
Additional Characters

All characters, special characters and numbers defined here are to be recognized in addition to those characters defined in Character Set.

Default: none

Remove space characters

All gaps between characters which are recognized as space characters will be deleted.

Default: off
Symbol Library

Menu: **Edit**, Function: **Symbol Library Manager**

**CMD:** VPSYMLIB

The following dialog opens:

You can read data from any directory of your harddisk and load accessible files into the library manager. With **Drag & Drop** symbols, blocks, or even complete drawings can be copied from the symbol library into a document and vice versa. Symbol Library display options and modes can be set in the menu **Options ► Symbol Library Configuration.**

Search and select the directory from where you want to load data into the **Library Manager.** The folder history list displays a maximum of 20 entries.

Wildcards can be used to preview only files which match a specified name pattern. For example, if you want to see only files that start with the character "b" you can use wildcard patterns like b*, b*.*, b*.tif, *.tif, etc. (according to standard conventions).

All formats accepted by VPindex can be loaded.
Functions

Drag & Drop

Import a file with a left mouse click in the Symbol Library and dragging the file into an existing document. The file will be opened in a separate window when dragging it onto a toolbar or when no document has been opened. Files may also dragged and copied into a Windows Explorer folder; with holding [Shift] files will be moved.

To add individual elements from a document to the Symbol Library select them and click on any position, however, by avoiding an element grip. Wait until the cursor changes to Drag&Drop mode. Now, drag the element into the Symbol Library (file format is always the internal RVD). A file name will be assigned automatically. To change the file name click the file with the right mouse button and use Rename from the context menu.

Copy

The clipboard provides a convenient way to exchange files, especially when a specific file needs to be used several times in sequence. Click the file with the right mouse button and Copy. The file may then be inserted multiple times with Edit ► Paste.

Data from the clipboard may also be added from the context menu with Paste to the current Symbol Library folder.

Paste

A double left mouse click in the Symbol Library will insert a file to the active document. There are three different modes which can be defined in the Symbol Library Configuration.

Delete / Rename

Files can be renamed or deleted directly. Click the right mouse button on the respective file and select the command from the context menu.

Show Blocks

In vector drawings this context menu command will display all block definitions of the respective file.
Symbol Library Configuration

Menu: **Options**, Function: **Symbol Library Configuration**

Context menu: **Symbol Library Configuration**

**CMD:** VPSYMBBIBKONFIG

**General Tab**

Symbols with a folder symbol attached to the upper left corner will not be inserted on a double click. Instead, the content will be displayed like in a subdirectory. In general, this will happen with multi-page files or with block definitions.

With the option **Include subdirectories** all files in a subdirectory of the current Symbol Library folder will be displayed.

**Default:** off

The option **Enable directory navigation** displays the superior directory and all existing subdirectories with a folder symbol. With a double click the selected directory will become the new Symbol Library folder.

**Default:** on

When switched on the option **Expand multipage files** displays an individual symbol for each page of a multi page document.

**Default:** off

The option **Expand contents of items** displays a folder symbol in the upper left corner of a document when block definitions or more than one page are contained.

**Default:** on
Insert

These options provide control of how files are inserted with a double click.

When **Show insert dialog** is switched **on** the insert dialog will appear.

**Default:** off

![Insert dialog](image)

With **Use Merge for positioning** the Merge command will be started and completed for the selected file, i.e. it will be merged with the document's active raster image.

**Default:** off

With **Insert at default position** the selected file will be placed according to the contained placement information in the file.

**Default:** on

Display Tab

Thumbnail / List

The display mode can be switched between **Thumbnail** and **List**. **Thumbnail** will provide an image preview, **List** will provide file information in detail.

**Default:** Thumbnail

![Symbol Library Configuration](image)

**Columns** controls the number of thumbnails in a row in the Symbol Library. **List** provides various options for displaying file information in detail.
Paper Format Manager

Menu: **Options**, Function: **Paper Format Manager**

**CMD:** VPPAPERMANAGER

The following dialog appears:

![Paper Format Manager dialog](image)

**Add/Edit**

A dialog opens for adding or modifying a paper format. The format properties are interpreted as values in drawing units (mm or inch).

![Add/Edit Paper Format dialog](image)

The properties of the selected paper format are preset. A new paper format is created when the **Name** is changed. Otherwise, the selected format will be modified.

**Width**

The new **Width** of the selected format. If **As Desired** is **on**, the **Width** field will be grayed. In any case the width of this format is the full width of the image to be processed.
Height
The new **Height** of the selected format. If **As Desired** is **on**, the **Height** field will be grayed. In any case the height of this format is the full height of the image to be processed.

Margins
The 4 margins determine the distances between the **drawing frame** and the physical **paper limits** (= **Width** and **Height**). For example, the length of the paper form (taken from edge to edge of the paper) minus both margins (**left** and **right**) defines the actual frame length of the drawing.

Different Margins {on/off}
If not selected only one margin value serves for all 4 margins of the drawing.

Default: **off**

Reset Forms
Discards all modifications on the standard formats (incl. deletion). User defined formats are deleted.

Delete Format(s)
Deletes the selected paper format(s).
SECTION 4
DOCUMENT SETTINGS, DOCUMENT FUNCTIONS, BASIC EDITING

General Information

These settings define your CAD environment for each document such as layers, linetypes, colors, text styles, image settings for raster files etc. You may use the Prototype Drawing to set up your personal environment. The prototype drawing will be loaded automatically to a new document or whenever you start with a raster file into a new document. If you save a document to RVD format or export a document to RVD, RDWG, DWG, or another vector or hybrid format your environmental settings will be saved or exported (as far as the export format allows for) to that file.

Page Control

If a document has more than one page you can use the page control toolbar for page selection and manipulation. Inaccessible icons are grayed. The commands are grouped in the Page menu item.

Page Display

First Page [Pos 1]

Menu: Page ► View ► , Function: First
CMD: VPFIRSTPAGE
Displays the first page.

Previous Page [Page Down]

Menu: Page ► View ► , Function: Previous
CMD: VPPREVPAGE
Displays the previous page.
Next Page [Page Up]

Menu: Page ► View ► , Function: Next

CMD: VPNEXTPAGE

Displays the next page.

Last Page [End]

Menu: Page ► View ► , Function: Last

CMD: VPLASTPAGE

Displays the last page.

Select Page

The selection box displays the actual page no. out of the total number of pages in this document. You can select any other page.

Direct selection of a Page

Menu: Page, Function: Go To

CMD: VPGOTOPAGE ► Dialog

CMD: VPGOTOPAGE <Value>

A dialog opens for selecting the page to display. The page number can also be entered directly at the command line.

Insertion and Deletion of Pages

Insert page to first position

Menu: Page ► Insert, Function: First Position

CMD: VPPINSERTFIRST

Inserts a new page before the first page.

Insert page before active page

Menu: Page ► Insert, Function: Before

CMD: VPPINSERTBEFORE

Inserts a new page before the active page.
Insert Page after active page

Menu: Menu: Page ► Insert, Function: After

CMD: VPPINSERTAFTER

Inserts a new page after the actual page.

Insert page to end

Menu: Page ► Insert, Function: Last Position

CMD: VPPINSERTLAST

Adds a new page after the last page.

Delete Page

Menu: Page, Function: Delete Page

CMD: VPDELETEPAGE ► Safety prompt

CMD: VPDELETEPAGE [Start] [End] [/a|Always]

Deletes the current page.

Start: The number of the first page to be deleted.
Default: active page

End: The number of the last page to be deleted.
Default: same as Start

/a|Always: Suppress the safety prompt (for use in scripts and batch processing).
Default: off

The deletion of pages cannot be undone. For this reason the safety prompt has to be answered with "Yes" first.

Import of Pages

When importing pages with any command, the option Edit ► Undo is not available. Use Page ► Delete Page instead.
Import to first position

Menu: Page ► Import, Function: First Position

CMD: VPPIMPORTFIRST ► Dialog
CMD: VPPIMPORTFIRST <File> [p|Page <Value>]

The Import dialog opens for selection of a single page to be imported as a new page before the first page.

- **File**: File name to be imported.
- **Page**: Page to be imported.
- **Default**: Page 1

Import page before active page

Menu: Page ► Import, Function: Before

CMD: VPPIMPORTBEFORE ► Dialog
CMD: VPPIMPORTBEFORE <File> [p|Page <Value>]

The Import dialog opens for a selection of a single page to be imported as a new page before the active page.

- **File**: File name to be imported.
- **Page**: Page to be imported.
- **Default**: Page 1

Import page after active page

Menu: Page ► Import, Function: After

CMD: VPPIMPORTAFTER ► Dialog
CMD: VPPIMPORTAFTER <File> [p|Page <Value>]

The Import dialog opens for a selection of a single page to be imported as a new page after the active page.

- **File**: File name to be imported.
- **Page**: Page to be imported.
- **Default**: Page 1
Import page to end

Menu: Page ► Import, Function: Last Position

CMD: VPPIMPORTLAST ► Dialog
CMD: VPPIMPORTLAST <File> [/p|Page <Value>]

The Import dialog opens for a selection of a single page to be imported as a new page after the last page.

- File: File name to be imported.
- Page: Page to be imported.
- Default: Page 1

Moving Pages

⚠️ Moving of pages - regardless of the used command - cannot be undone with Edit ► Undo. Instead, use a command from the group Page ► Move once again to restore the previous page order.

Move page(s) to first position

Menu: Page ► Move, Function: To First.

CMD: VPPMOVEFIRST [Start] [End]

Move one or more pages to first position.

- Start: Number of the first page to be moved.
- Default: active page
- End: Number of the last page to be moved.
- Default: same as [Start]

Move page(s) towards the beginning


CMD: VPPMOVEBEGIN [Start] [End] [Destination]

Move one or more pages towards the beginning.

- Start: Number of the first page to be moved.
- Default: active page
End Number of the last page to be moved.
Default same as [Start]
Destination Number of the page where the pages will be moved to.
Default one page towards the beginning
Example: VPPMOVEFORW
The active page is moved one position before.
VPPMOVEFORW 8 11 5
Pages 8-11 (included) are moved before page 5.

Move page(s) towards the end

**Menu:** Page ► Move, Function: Towards End.

**CMD:** VPPMOVEEND [Start] [End] [Destination]

Move one or more pages towards the end.
Start Number of the first page to be moved.
Default active page
End Number of the last page to be moved.
Default same as [Start]
Destination Number of the page where the pages will be moved to.
Default one page towards the end

Move page(s) to end

**Menu:** Page ► Move, Function: To Last.

**CMD:** VPPMOVELAST [Start] [End]

Move one or more pages to the last position.
Start Number of the first page to be moved.
Default active page
End Number of the last page to be moved.
Default same as [Start]
Scanning Pages

⚠️ Scanning of pages - regardless of the used command - cannot be undone with Edit ► Undo. Instead, use the command Page ► Delete Page.

Scan page to first position

Menu: Page ► Scan, Function: To First Position

CMD: VPSCANFIRST ► Dialog
CMD: VPSCANFIRST [/q|Quiet]

The Scan dialog opens. Upon confirmation with OK the scanned page is inserted as the first page.

q|Quiet  The dialog for the scanner selection will be suppressed and the last used scanner is selected.

Scan page before the active page

Menu: Page ► Scan, Function: Before

CMD: VPSCANBEFORE ► Dialog
CMD: VPSCANBEFORE [/q|Quiet]

The Scan dialog opens. Upon confirmation of the dialog with OK the scanned page is inserted before the active page.

q|Quiet  The dialog for the scanner selection will be suppressed and the last used scanner is selected.

Scan page after the active page

Menu: Page ► Scan, Function: After

CMD: VPSCANAFTER ► Dialog
CMD: VPSCANAFTER [/q|Quiet]

The Scan dialog opens. Upon confirmation of the dialog with OK the scanned page is inserted after the active page.

q|Quiet  The dialog for the scanner selection will be suppressed and the last used scanner is selected.
Scan page to end

Menu: Page ► Scan, Function: To Last Position

CMD: VPSCANLAST ► Dialog

CMD: VPSCANLAST [/q|Quiet]

The Scan dialog opens. Upon confirmation of the dialog with OK the scanned page is inserted as the last page.

q|Quiet The dialog for the scanner selection will be suppressed and the last used scanner is selected.

Organizing Pages

Menu: Page, Function: Organise

CMD: VPORGANIZE ► Dialog

The dialog Organize Pages opens.

The dialog is structured in three main groups. A preview of the selected page is shown together with display options on the left side. In the dialog’s center a list of pages of the active document is displayed. Commands for changing the page order are available on the right side.

The display options and commands (Zoom in, Zoom out, Zoom window, Zoom pixel, Zoom extents, Show raster and Show Vector) equal the commands in main document windows.
One or more pages can be selected for processing in the pages list using the standard Windows selection methods. Each page has a **Number** and a **Location**. The Number reflects the number of the page at the time the dialog was opened and remains unchanged until the dialog is closed. Location shows either **Loaded** or **Not Loaded** depending on whether the page already resides in memory or not. A preview is only shown for loaded pages. Otherwise “N/A” is displayed in the preview window. The commands will also work on pages that are not loaded.

**Delete:** The selected pages are deleted.

**Load:** The selected pages are loaded to memory for preview.

**To Top:** The selected pages are moved to the top.

**Up:** The selected pages are moved up.

**Down:** The selected pages are moved down.

**To Bottom:** The selected pages are moved to the bottom.

**OK:** Confirms the changes for the document. Since delete operations cannot be undone a safety prompt is displayed if the command **Delete** has been used.

**Cancel:** The dialog is closed and the modifications are discarded. Pages that were loaded into memory using **Load** are not unloaded and will be kept in memory.
Layer Manager

Menu: **Options**, Function: **Layer Manager**

**CMD:** VPLAYERS

If you have not set up additional layers the following dialog box opens (default):

![Layer Manager dialog box](image)

As default settings you will find **Layer 0**. Layer 0 is intended to host preferably vector entities; linetype is continuous and width is set to 0.00. This layer may also be used for raster and/or hybrid entities. **Default:** Layer 0

The Layer Manager allows for setting up an unlimited amount of layers with different options according to user requirements. For each layer you can define the following settings:

- To be the Active Layer (current layer)
- Layer Name
- Layer Name on Export
- Linetype of Layer
- Color, Status, and Width of Display, when Printing, with Rasterize, on Export

All settings follow standard CAD conventions. The dialog box can be defined by **Table Type** for displaying the settings for **All**, or separately for **Display**, **Print**, **Rasterize**, or **Export**. If the table type is set to **All** the dialog box appears as follows:
Table Type
Select items the dialog should display: All, Display, Print, Rasterize, or Export respectively.

Default: Display

Active Layer (Current Layer)
Select which layer becomes the active layer. You may also change the selection at any time using the layer selection box from the toolbar:

Default: Layer 0

New
Create a new layer. A dialog appears where you can define Name, Status, Linetype, Color, and Line Width for the new layer. The dialog comes up with 5 default values identical for all tables and assigns Layer 1, 2, ..n as layer and export layer name. You can modify any default values. Clicking some of the entries will bring up a list box for selection (e.g. Colors):

If you need to have different values for Display or other options (e.g. Print, Rasterize, Export) you can modify these values after OK in the Layer Manager dialog.

Default values: see Dialog
Copy

Create a copy of the settings of the selected layer. The layer name receives a number as a suffix which will be incremented with every copy command. Select the copied layer in the dialog for any modification.

Delete

Any layer without entities assigned to this layer can be deleted.

Export Name

If required special names may be assigned to a layer only for exporting the data of a document.

Default: Layer Name

Linetype

You can assign a linetype to a layer. If the Active Linetype (see: Linetype Manager) selection box is set to "By Layer" then all entities drawn in that layer are drawn with the linetype assigned to that layer. If such entities are transferred to other layers having different linetypes assigned to them the entities change their linetypes accordingly.

As default the linetype is continuous. Other linetypes are available in the selection box if they have been defined. If a new linetype is required, select Other. Then, the Linetype Manager dialog opens for setting up a new linetype. Next, the system returns to the layer manager dialog.

Default: Continuous

Color

Select a color for the layer. You can select different colors for the display, for printing, for rasterizing entities, and for export. The 8 standard colors are available. With selecting Others the Color Manager appears where you can select any desired color.

Default: All White

Status {on/off}

The layer can be switched on or off. You can switch the layer on or off separately in the display, for printing, for rasterizing entities, and for export.

Default: All on
Status Locked {on/off}

The layer can be locked. This property may only be useful when editing a drawing as it controls whether elements in this layer can be selected, thus modified, or if they are unaccessible.

Default: Unlocked

Width

Set the width of (vector) entities to the desired values. Width 0.00 is the standard setting in a CAD environment. You may want to have a different setting for Rasterize and/or Print in order to display the entities with their actual width.

A special width assignment is "By Entity". It means that entities having various width values may be assigned to this layer. Also, they may show no width value in the display, since the display has been set to width 0.00. However, they can still be rasterized or plotted with a different width if other width values have been assigned while drawing these entities (using the width spin wheel).

"By Color" means that the color of an entity controls the width. Assign a width to a color in the Color Manager.

Default: All 0.00

Transfer to Current Layer

Menu: Edit ► Transfer to, Function: Current Layer

CMD: VPSHIFTAYER <Name>

The selected entities are transferred to the current layer or the specified layer.
**Project Bar**

**Menu:** Options, **Function:** Project Bar

**CMD:** VPPROJECTBAR

This command opens the dialog window **Project Bar:**

![Project Bar dialog window]

It displays the tree structure of all currently available layers and - as sub-entries to each layer - all loaded raster images. The currently active layer is shown with a **highlighted** name. The currently active raster image is indicated in **bold letters**.

The **Check Box** in front of each layer or entry indicates the display status: **visible** or **non-visible**. Clicking on a check box toggles the display status of this entry.

The **Color** of each layer/entry is indicated by an according colored square.

- [ ] This icon indicates the **Color 7**, which is **black** on a white background and **white** on a black background.

Clicking on a layer name with the left mouse button sets this layer as **Active Layer**, clicking on a raster image name sets this image as **Active Raster**.

The **Draw Order** can be changed by dragging (left click+move) a layer to a new position in the tree. On drop (release left mouse button) the layer will be inserted below the actual (highlighted) layer and the draw order will be re-arranged accordingly. The entities of the layer on top position of the tree will be drawn first, the entities of the layer on bottom position of the tree will be drawn last (its entities will be drawn **above** all other entities).

- [ ] Raster Images will always be drawn first (**below** the vector entities). All new created entities will always be drawn on top, regardless of their layer position in the tree.

Pressing the [Ctrl] key on drop will assign the dragged layer as sub-layer to the actual (highlighted) entry. This way families of layers can be arranged and then easily switched on and off together by clicking the checkbox of the main layer.
Dragging the name of a raster image changes the layer of this image. The [Ctrl] key has no function.

On right mouse click inside the project bar dialog one of the three following menus appear:

Expand All Items

All sub items are displayed in the tree structure.

Import

Imports a new file into this project. If the selected file is a raster image and the mouse was positioned on top of a layer, then the imported image will automatically be assigned to this layer. See File Import for details.

Export

Exports the selected document/image. See File Export for details.

Layer Manager...

The Layer Manager dialog pops-up and allows to create/edit all layers.

Redraw

The draw order of all entities will be re-arranged according to the actual tree structure and the document will be redrawn.
All Layers On
   All layers become visible.

All Layers Off
   All layers become invisible.

Properties (Raster selected)
   Opens the standard properties dialog for the selected raster.

Image Settings (Raster selected)
   Opens the image settings dialog for the selected raster.

Delete (Raster selected)
   Deletes the selected raster.

Change Color (Raster selected, Layer selected)
   Opens the color manager dialog for the selected item.

Set to Active (Raster selected, Layer selected)
   Sets the selected item as active item.

Cancel Menu
   Closes the context menu without changes.
Linetype Manager

Menu: Options, Function: Linetype Manager
CMD: VPLINETYPES

The following dialog opens. The same dialog appears from the Layer Manager for defining new linetypes to be assigned to a layer. It displays all linetypes with their settings:

The first line showing the name "By Layer" is not a linetype. Instead, it is used in the linetype selection box (below) to indicate that the linetype used for an entity will be controlled by the linetype assigned to the layer. If such an entity is transferred to different layers it may have different linetypes.

**Active Linetype**

Select the active linetype. You may also change the selection at any time using the linetype selection box from the toolbar.

Default: By Layer

**New**

Creates a new linetype with the default settings. You can modify the names, the description, the "Continuous" mode, and assign segments (one or more), each of which consists of a gap and a dash in order to create dashed and dash dotted linetypes.

**Delete**

Any linetype not assigned to a layer and/or entity can be deleted.
Import...

New line types can be imported from AutoCAD-compatible LIN files— even more complex types including text and/or symbols. The following dialog appears:

Choose a LIN file via the file symbol or enter a LIN file path. The contained line types will be listed. Click to select the line types you want to import – multiple selection with [Ctrl] or [Shift]. OK confirms the selection and import.

Export Name

If required special names may be assigned to linetypes only for exporting the data of a document.

Default: Same as Name

Description

Allows for a graphical description of the designed linetype.

Continuous {on/off}

If continuous is set to on a linetype assigned to a polyline is arranged in a way that the 'dash' - 'gap' periods continue also at corners (vertices). Hence a corner becomes "invisible" in case there is no dash.

Default: on

Global Scale Factor

Dash and Gap length for all linetypes can be scaled. This may be necessary for adjustments to a specific User Coordinate System.

Default: 1.0
Segments

A linetype other than continuous may consist of one or more segments - each of them containing a gap and a dash. A maximum of 16 segments may be assigned to one linetype. Fields appear grayed when the selected line type contains text or symbols.

Default: 0

Dash

Define the dash length for each segment. A dash length of 0.00 represents a "dot".

Default: 0.00

Gap

Define the gap length for each segment.

Default: 0.00

Assign Current Linetype

Menu: Edit ► Transfer to, Function: Current Linetype

CMD: VPSHIFTLINTYPE <Name>

The current or specified linetype will be assigned to the selected entities.
The text style manager allows for defining text styles. All text fonts available in your Windows Operating System can be used and assigned to text styles for successive use in VPindex. By default settings the dialog looks like this:

You can select any available text style in the list for modification or deletion. When clicking New an additional text style will be listed. Settings will be copied from an existing style. Use the tools for modifications.

**Active Text Style**

Select the active text style. You may also change the selection at any time using the text style selection box from the toolbar.

Default: Text

**New**

Defines a new text style by copying the setting from the last selected one or from the last entry respectively. You can modify the names, the fonts, the style, and assign height and width/height ratio individually.

The Preview displays the selected font. You may enter (edit) the displayed standard text in order to see the text style with a particular text string.
Delete

Any text style not being assigned to a layer and/or entity can be deleted.

Export Name

If required special names may be assigned to text styles only for exporting the data of a document.

Default: Text

Height

Assign the height to the text style.

Default: 10.00

Width to Height Ratio

Assign a width/height ratio.

Default: 0.70

Font

Select any available font from the drop list.

Default: Arial

Export Font

Select any available font from the drop list if you want a different font for data export.

Default: Same as Font

Select between the styles Regular, Bold, Bold Italic, and Italic.

Default: Regular

Big Font

Additionally, a Big Font can be set up for Asian characters or other symbols when a SHX font has been selected. This field is grayed for TrueType fonts.

Default: none
Select Shortcuts

Clicking on this mini button "εb" displays the list with shortcut definitions.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ø</td>
<td>All+0</td>
</tr>
<tr>
<td>¼</td>
<td>All+1</td>
</tr>
<tr>
<td>Dimension</td>
<td>All+2</td>
</tr>
<tr>
<td>±</td>
<td>All+3</td>
</tr>
<tr>
<td>%0</td>
<td>All+4</td>
</tr>
<tr>
<td>°</td>
<td>All+5</td>
</tr>
<tr>
<td>–</td>
<td>All+6</td>
</tr>
<tr>
<td>¥</td>
<td>All+7</td>
</tr>
<tr>
<td>€</td>
<td>All+8</td>
</tr>
</tbody>
</table>

If you click "Edit Entries" this dialog opens:

Assign Current Text Style

Menu: **Edit ► Transfer to**, Function: **Current Text Style**

CMD: **VPSHIFTSTYLE <Name>**

The current or specified text style will be assigned to the selected texts. Other selected entities will be ignored.
Color Manager

Menu: **Options**, Function: **Color Manager**

CMD: **VPCOLORS**

The color manager allows for selecting and assigning colors wherever required.

A dialog box opens:

The icon in the main toolbar shows the actual color (here: white) and the inside cross mark indicates that the **Current Color** is set to "By Layer".

If you select a new color the cross mark will disappear. You can assign this color to entities. After another active layer was selected the icon takes on the cross mark again and shows the color of this layer.

**All Colors**

This selection field shows all 256 colors of the system palette. If you select a color from that field it will be shown in the section **Selected Color**. Also, the RGB values are indicated at the bottom of that field.

**Standard Colors**

This selection field displays the 8 standard colors which are identical with the first 8 colors shown in the section **All Colors**.
Selected Color

Any selected color from the color field is indicated through the color tone, the corresponding RGB and CMY values, and the color name or palette position number:

![Selected Color](image)

By Layer

This button assigns the color of the active layer as selected color **By Layer**. You have to assign the layer color in the **Layer Manager**. The color of the active layer will be displayed.

By Block

This button assigns the color of the block as selected color. If you use this option for entities which will be assembled to a block you may assign any color to that block.

⚠️ In this case **all entities** forming the block must have assigned the color **By Block**.

User Colors

You may create your own colors in this section. Selecting **New** opens a dialog for defining a color:

![Modify Color](image)

You can enter the RGB or CMY values or pick from a color file loaded. You are requested to enter a color Name, Export Name (by default identical with Name) and the line width assigned to the color (see below).

**OK** closes the dialog and displays the new color in the color manager dialog. The button **Modify** allows for modifying a user color. **Select** confirms the selected user color to be the **Selected Color**.
Width

You can assign a line width to a color. Entities drawn with this color will display the assigned width if their residing layer has been assigned a width **By Color**.

The width assignment to a color is most important when printing/plottting or for rasterizing entities. For example, setting the width for all layers in the section Print (Layer Manager) to **By Color** allows for adjusting the plot output line width by the entity color, regardless of the layer location of an entity. All red entities will then be plotted with the assigned width. The same applies for rasterizing elements.

Automatic color creation

This icon is active when a colored raster image is loaded and you can pick a pixel from a colored image. A new user defined color will be created with a default name and width and is selected as the active color. The color manager is closed with OK.

This icon is active when a colored raster image is loaded and you can pick a pixel from the active image’s palette. A new user defined color will be created with a default name and width and is selected as the active color. The color manager is closed with OK.

Assign Current Color

Menu: **Edit** ➤ **Transfer to**, Function: **Current Color**

CMD: `VPSHIFTCOLOR <NAME>`

The current or the specified color will be assigned to the selected entities.
User Coordinate System

Menu: Options, Function: User Coordinate System

CMD: VPUSERCOORDS

VPindex supports a **Standard (Cartesian) Coordinate System** and also a wide range of predefined **Projections**. Additional individual **User Defined** projections can be defined.

The icon opens a dialog box for setting up the user coordinate system:

![User Coordinate System Dialog Box]

By entering values for
- **Coordinate System / Projection** (only VPmap Series)
- **User Units**
- **Drawing Scale**

the coordinate system can be adjusted to specific requirements of the active document.

**Coordinate System / Projection** (only VPHybridCAD)

This field always appears greyed and contains **Standard (Cartesian)**. However, when a file is opened containing Coordinate System information (e.g. GeoTIFF) a Coordinate System with a specific projection can be displayed. In this case **Parameter** becomes available to check on projection parameters. However, these cannot be changed.

⚠️ To set up and edit a specific Coordinate System with projections you will need to apply softelec’s **VPmap Series** products (VPmap, VPmap pro).
User Units / Drawing Scale

The **User Units** and the **Drawing Scale** should be set to a value which corresponds to the document data. This information may either be part of the legend/drawing header in a raster image or it needs to be known due to other information. This allows for measurements (using function [F2]) in the document or for a direct use of real coordinate values for e.g. construction (see section 8) or rubber sheeting (see section 6).

Display

Choose between **Display Coords. in User Units** and **Display Coords. Unprojected (in Degrees)**. The second option is only available when a coordinate system with projection has been selected. When selected all coordinate input requiring coordinate values in **User Units** must be entered as degree-minutes-seconds (DMS). Possible formats are:

<table>
<thead>
<tr>
<th>Input Format</th>
<th>Sample Input</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;d&gt;°&lt;m&gt;'&lt;s.nn&gt;&quot;</td>
<td>-48°15'30&quot;</td>
<td>-48°15'30&quot;</td>
</tr>
<tr>
<td>&lt;d&gt;°&lt;m.nnnn&gt;'</td>
<td>-48°15.5'</td>
<td>-48°15'30&quot;</td>
</tr>
<tr>
<td>&lt;d.nnnnn&gt;</td>
<td>-48.258333</td>
<td>-48°15'30&quot;</td>
</tr>
<tr>
<td>&lt;d&gt;°&lt;m&gt;'&lt;s.nn&gt;[EWNS]</td>
<td>48°15'30&quot; S</td>
<td>-48°15'30&quot;</td>
</tr>
</tbody>
</table>

Instead of using signed values the post-fix **East/West** and **North/South** can be used to specify the direction.

Instead of using the degrees (°), minutes (′), or seconds (″) signs you can also separate the values by a double point (:) (<d>:<m>:<s.nn>). This may especially be necessary for complex command line input or scripting to differ the coordinate values from e.g. long file names with (″).

**Precision** defines the number of decimal places.

Default: **Display Coords. in User Units**  
Precision: **0.00**

Place Raster and/or Vector Data on OK {on/off}

If set to **on** after confirming the **User Coordinate System** settings with **OK** a dialog pops up to specify a new origin for the existing raster and/or vector data. See the following command.

**OK**

If the coordinate system has been modified another dialog pops up on **OK** to specify whether existing document data should be transformed to the new coordinate system or not:
Keep actual Coordinate Values

Use this option when the coordinate values in the document are already displayed correctly. Typically, this is the case when a vector drawing with no or wrong coordinate system information, but real coordinate values has been imported. AutoCAD drawings may be examples (*.DWG) when they have been created in an English (inch) environment, but were drawn with Metric (millimeter or meter) coordinates. Also, ESRI shape files (*.SHP) may be another example when no corresponding projection file (*.PRJ) is available. Especially, typical GIS formats like MapInfo MIF files and ESRI SHP files may contain vector data with coordinate values in degrees. In these cases the Values are in Degrees option needs to be applied.

Adjust Coordinate Values to the new Coordinate System

Use this option when the coordinate values displayed for the document are "paper" units. Typically, this is the case when a raster image without any placing and coordinate system information has been imported.

Place / Adjust Data

Menu: Edit  Function: Place / Adjust Data

CMD: VPPLACE ➤ Dialog

When a drawing already contains Raster and Vector data the following dialog appears to place/adjust data accordingly:

The option Active Raster Image only applies to this object. Whole Drawing applies to all objects in the drawing.

An individual Selection can be made in case no previous selection has been made. Specify your selection after OK (see status message).

After OK or in case the drawing only contains one raster image the following dialog appears:
After **OK** or in case the drawing only contains one raster image the following dialog appears:

By choosing **Select Point** or **Select Distance** consecutively you can specify an arbitrary number of reference points or reference distances. After choosing either option click on a point/distance in the drawing first (distance click positions must be close to horizontal or vertical). Then, enter a target position value/target distance value in **User Units**. Target values can also be taken from the drawing, e.g. from a reference vector element. The Vector Snap is available.

Measurement entries can be deleted from the list with **Delete Entry**.

With **OK** adjustment, rotation and scaling (anisotropic) will be calculated from all entries, depending on the number and form of the selected reference points or distances.

For a simple placement **one reference point** is sufficient. For a simple and accurate scaling **one reference distance** is sufficient. It is recommended to specify a preferably long distance with a known actual value in the drawing.

**Image Settings**

Menu: **Options**, Function: **Image Setting**

**CMD:** VPIMAGESETTINGS ▶ Dialog

**CMD:** VPIMAGESETTINGS [/M|METHOD <METHOD>] [/E|EXACT <EXACT>]

[/T|THRESHOLD <THRESHOLD>] [/C|COLORMODE <COLORMODE>]

[/FG|FOREGROUNDCOLOR <RED;GREEN;BLUE>]

[/BG|BACKGROUNDCOLOR <RED;GREEN;BLUE>]

[/DPI|RESOLUTION <RESOLUTION>] [FILE]
Displays the raster file settings and allows for modifications. Use this function to define the **Image Characteristics** for vectorization and tracing and - most important for gray scale and color images - the **Active Color Definition**.

**B/W Images**

With b/w raster files the image settings dialog looks like this:

It displays the **Path** of the image (may be void for new images), the **Image Characteristics**, and the **Image Properties**.

**Image Characteristics [/[M]METHOD <METHOD>]**

The image characteristics define the main structure of an image. They have a successive influence on the conversion process when vectorizing or tracing. Select according to the prevailing entity type in the image, or according to the one you are looking for during the edit and conversion process. Choose either:

- Predominantly lines /M 0
- Predominantly areas /M 1
- A mixture of areas and lines with the width threshold at "n.nn" [baseunits] for switching to outlines (area) /M 2 /T n.nn.

**Exact {on/off} [/[E]EXACT <EXACT>]**

Especially with dense contour drawings containing thin contour lines you can set this parameter to on (/E 1) in order to increase the preciseness of following the contours. Be aware though, that this setting will increase the amount of vertices with polylines significantly and also the amount of you vector data!

**Image Properties**

Displays **Resolution (DPI)**, **Image Size** in pixel (**Width** and **Height**), and **Image Type**.
Gray Scale and Color Images

The basic image settings dialog opens like this:

The upper sections are the same as with b/w raster files. The image specifications (path, resolution, image size, and image type) are displayed. Define the Image Characteristics according to the prevailing entity type in the image.

In the lower sections you can set the **Foreground/Background Definition** and the **Color Definition**.

**Foreground/Background Definition**

Since gray scale and color images contain multiple gray scales or colors, the foreground color needs to be specified. The advantage of defining the foreground color of the image individually is that it allows to select color patterns (i.e. multiple colors) to serve as "one" active color. The image can then be treated like a b/w raster file and the foreground color may be traced, converted, or used to select entities or snap to entities while editing. You can save a color pattern definition to a file and re-load it at any time to the same image as long as the color palette of the image has not been modified (e.g. with color reduction functions). This way you can change the foreground color definition with respect to the entities you want to trace, redraw, vectorize etc.

⚠️ **It is highly recommended to only use uncompressed raster formats or lossless compression formats when scanning document originals! Do not use JPEG or similar compression formats implying losses of information.**

Use the **Color Reduction** function first in order to reduce the amount of colors as far as possible - especially minor colors should be converted to their nearest major colors, thus creating images with significantly less colors without a loss of information.
You have the choice between three different definition modes:

**Automatic /C 0**
An automatic algorithm calculates which colors are foreground colors and which colors are background colors.

**Define Foreground /C 1**
The colors set with **Advanced Settings** are treated as foreground colors and, thus, form the active pixels which can be picked and modified.

**Define Background /C 2**
The colors set with **Advanced Settings** are treated as background colors and, thus, form the inactive pixels which compose the document's "paper" space.

**Advanced Settings**

With most images it will be very difficult or even impossible to reduce the colors to an extent that different types of entities are assigned to different but solid colors. Instead, you need to select a color pattern in order to group all major pixels of an entity into the active color. Clicking the advance settings button brings up an extended dialog:
Active Color Palette Calculation

Use the tools from this section to define the active color:

When an active color has not been defined in the previous dialog, yet, use the pipette cursor button and pick a new active color from the image. Zoom functions will support your selection.

Region around Active Color

Click this radio button and pick a representative color from your image. This color appears at the color indicator and all pixels having this color are displayed with the complementary color in the image:

Use the zoom buttons to view the most significant area of your drawing for picking the reference color.

An expanded definition of the active color will be possible with this function. It will generate a color pattern based on the color region of the active color. Use the slider control to define the color region (see below Variation), or pick single additional colors from the image for fine tuning your selection.

Variation

Moving this slider creates a widening color corridor around the selected color. Colors with an increasing distance to the selected color will be included and added to the color pattern which composes the active color (more and more pixels are getting highlighted).
Range defined by Active Color and Second Color

Click this radio button if the entities in your image are composed from a variety of lighter and darker colors of the same kind, or if they are composed from two base colors. You can define the color corridor’s direction by selecting the colors at both ends of the range.

Use the zoom and pan functions for picking the active color and the second color. Then use the variation slider to create a proper entity selection:

Switching to the **B/W View** you can check the quality of color pattern selection:
Color Map

Clicking this button adds another section to the dialog and displays the palette of the active image. All selected colors composing the active color are marked:

The palette has been organized in a way that the active color selected first is in the upper left corner, while all other colors are arranged according to their distance to the active color. Colors in the two upper display rows have been selected for the second color and with the slider variation.

Additional colors have been selected and picked to avoid interruptions along entities.

Save Map

Once you have composed a proper active color you can save this color map for later use. This allows for creating different maps for different entity selections.

Load Map [FILE]

Re-loads a previously saved map for an active color setting. A re-load is only possible if the palette of the image has not been modified after the map was saved.
Foreground Color

Specifies the color that is used to rasterize modified raster entities back into the image.

Pick Color

If your gray scale or color image contains only few colors, each of which represents a different type of information entity (for example: roads are straight red, rivers are straight blue, forest areas are green etc.), you can pick the color of your choice from your image (pipette cursor button) or the image palette (image palette button) and set this color as foreground color. The selected color or gray scale value will be indicated.

Background Color

For erasing or moving entities in gray scale or color images you can specify the background color to be filled in instead of the former entity.

Pick Color

Pick the color from your image (pipette cursor button) or the image palette (image palette button).

⚠️ The background color must be different from the foreground color!

Select Active Image

Menu: **Edit**, Function: **Select Active Image**

CMD: `VPSELECTACTIMAGE [NAME]`

This function will be enabled if a document contains more than one image. Select an image to become the active image and click this icon. You may also select the active image from the current image selection box:
Image Palette

Menu: View, Function: View Image Palette
CMD: VPIMAGEPAL

Displays the current palette of the active image (maximum 256 colors):

Palette Colors
This section shows all colors contained in the image. If you move the cursor over the color fields (without selecting), the RGB values and the palette position of the respective color are displayed below the palette matrix.

Selected Color
Clicking a particular color displays its RGB and CMY values. You can modify colors by entering new values into the corresponding fields. Changes will be displayed in the color field as soon as you remove the cursor focus from the field. Instead of modifying the selected color directly, you can also use the Windows Color Dialog.
Transparency  {on/off}

If you want a color to be transparent switch this option to on and select a palette index. The color can be selected from the active image using the pipette button. The option is disabled for true color images. The transparency setting is used e.g. when working with the GIF file format.

Default:  off

Create B/W Image

Menu: Raster, Color Function: Create B/W Image

CMD: VPCREATEBWRASTER [/D][DELETE 0/1]

When a colored image is the active image this command creates a B/W version of the image as a separate raster object overlaying the original image. If no color map has been assigned the automatic settings will be used. The original color image can be deleted with entering /d 1 in the command line or in a script.

Display B/W Image

Menu: View, Function: B/W Display

CMD: VPBWRASTER

When a color map has been assigned to the active image this command displays the image as if it were a B/W image. The command is a switch. A second call will restore the original color view of the image.
Entity Selection and Handling

Vector Entity Selection

The selection mode is CAD-like. Pick any vector entity. The selected entities are displayed in a highlight mode (dashed) and contain grips (handles) for entity modifications. The base point grip is marked with a cross. All standard CAD operations are possible.

Raster Selection

Unless raster editing is limited to the Active Image (see Section 8) any raster entity or object can be selected regardless to which raster image it belongs.

There are 2 ways of selecting raster entities/objects:

- **Direct Raster Selection** (Pick, Window, Crossing) for single raster entities (line, circle, arc, polyline etc.) and,
- **Raster Object Selection** for raster entities consisting of complex raster structures, which should not be broken up into their entities.

Raster selection with gray scale or color images will be handled like b/w images once the active color has been defined using the function *Image Settings*.

**Direct Raster Selection**

Menu: *Edit*, Function: *Direct Raster Select*

CMD: VPDSEL

If switched on raster and/or vector entities can be selected using pick mode, windowing, or crossing. If switched off only vector entities will be selected.

If switched on a toolbar is displayed offering different selection modes:

Blue buttons offer hybrid selections.:  

**Vector/Raster Selection**

**Vector/Raster Selection Stop at Intersection**

Raster and/or Vector elements can be selected while using pick mode, window selection, or cross selection.

Click on a Raster element or window selection of a Raster structure

The program will generate Vector elements from the selection including width values. When using the Stop at Intersection mode single vectors will end at intersections as existing in the selected Raster structure.
When pressing [Ctrl] while using window selection all image elements will be selected to one coherent Raster object.

Elements are displayed with grips in the Raster selection’s current color. Each selected element can be modified just as a „conventional“ vector element.

The remaining selection modes refer to Raster structures exclusively.

**Raster Selection Rectangle**

![Rectangle](image)

All Raster structures inside a window selection will be selected.

**Raster Selection Polygon**

![Polygon](image)

All Raster structures inside a closed polygon selection will be selected.

The polygon selection is confirmed with a double click or with [Enter].

**Raster Selection Pick**

![Pipette](image)

The cursor changes to a Pipette symbol. Clicking on the Raster (active color is assigned) will select all Raster structures joined with the click position.

**Raster Selection Line**

![Line](image)

Generates a 2-point line.

The underlaying Raster is selected. Crossing Raster structures will be ignored.

**Raster Selection Arc**

![Arc](image)

Generates an arc element with three points:

- **First click point** = Start point arc
- **Second click point** = End point arc
- **Third click point** = Radius and direction arc

The underlaying Raster is selected. Crossing Raster structures will be ignored.

**Raster Selection Circle**

![Circle](image)

Generates a circle element with three points (see above).

The underlaying Raster is selected. Crossing Raster structures will be ignored.

With „End Command“ in the context menu (right mouse click), the generated Vector elements will be converted back to Raster elements if elements have not been transferred to a Vector layer.

**Default:** on
If vector entities are located inside the selection area (selected by window or crossing) only vector elements are selected. You need to repeat the selection process for the raster entities (second window or crossing selection).

**Direct Raster Selection Settings [F8]**

Menu: *Edit*, Function: *Direct Raster Selection Settings*…
CMD: *VPDSELSSETTINGS* ► Dialog

Opens the **Raster Selection** tab in the **System Settings** dialog. For a detailed description of the dialog and the available options please see **Section 3**.

**Raster Object Selection**

Menu: *Edit*, Function: *Raster Select*
CMD: *VPSELRASTER* ► Toolbar

This function allows for selecting more complex raster structures and multiple raster entities combined to a raster object. The following set of icons appear after activating this function for choosing an appropriate raster object selection mode:

Raster structures generated with any of the selection modes are displayed in the current raster selection color (default: red).

Repeated selection will expand the object continuously if the "+" button is active. [Shift] toggles the actual state temporarily.

If the "-" button is active while re-selecting any previously selected raster entity or structure this part will be deselected from the total selection. [Shift] toggles the actual state temporarily.

Undo's the last selection or de-selection command.

Clicking on this button or pressing [Enter] confirms the selection.
Select Rectangle

The complete raster inside a rectangle window will be selected.

Select Polygon

The complete raster inside a closed polygon will be selected.

Close the polygon with a double mouse click or with [Enter].

Select Pick Raster

The cursor is replaced by a pipette symbol. If you click on the raster (with the active color assigned to it) all raster structures connected with the click point will be selected.

Select CAD Entities

Selects standard CAD entities (line, circle, arc). The cursor changes to a Needle and Thread cursor as long as this selection mode is active.

Select Arc

Generates an arc object by defining three points:

- 1st click point = start point arc
- 2nd click point = end point arc
- 3rd click point = arc curvature and direction

A raster arc underlying the construction arc is selected. Crossing raster structures will be ignored.

Select Circle

Generates a circle object by defining three points (see above).

A raster circle underlying the construction circle is selected. Crossing raster structures will be ignored.

Select Line

Generates an individual 2-point line.

A raster line underlying the construction line is selected. Crossing raster structures will be ignored.
Select Inside Window

Raster elements will be selected if they are located entirely inside the selection window. Elements which extend beyond the frame will be ignored. Crossing raster entities are ignored.

Select Crossing Window

Selects all raster elements which are located completely inside the selection frame, and also those elements which are located only partially inside the selection frame.

Select Fence

Selects all raster elements touched by a selection polyline (fence).

Select Dirt Inside Window

Selects all objects inside a dragged window, except for crossing lines, circles, arcs.

Quick Selection [Ctrl]+[F]

Menu: Edit, Function: Quick Selection...

CMD: VPQSELECT ► Dialog


This function allows for selecting entities through user defined rules. The result is a specific entity selection that can be used for further operations. Also, an existing selection of entities can be reduced or expanded.

A Command can be specified for immediate execution after the selection is finished. This option is especially useful for script processing.
When the dialog is suppressed using the p
(Pick) option you have the choice between three
different selection modes:

/p a: Pick all elements in the drawing.
/p p: Pick elements using the mouse.
/p l: Pick last element that has been modified/created. A special registry key
(\Selection\SelCount) controls how many elements from the history are selected
when using this option.
/p f: Depending on the following filter parameters /T (Type) and/or /prop (properties)
with /O (operator) and /V (value) one or more elements will be selected. When a
selection list has already been set up this will serve as a base.
/p w Window selection. The window is specified with these subsequent coordinates:
<x1> <y1> <x2> <y2>
/p c Cross selection. The window is specified with these subsequent coordinates: <x1>
<y1> <x2> <y2>
/t Selection according to type of element, such as Line, Arc, Circle, etc.
/prop Selection according to a specific property of one or more elements. All element
properties that are available in the properties dialog are acceptable; e.g. Layer and
Linetype, but also geometric properties such as Xm (= x-value of circle
centerpoint, Ym (= y-value of circle centerpoint), R (= radius).
/o Relational operator. Available are: "=" (equals), "<>" (not equal), "<" (less than) und
">" (more than) und "*" (name or text comparison with wildcards). Operators are
available depending on the individual filter property.
/v Comparative value. Depending on the parameters above this can e.g. be a layer
name or a number value. When filtering text content you can also use these
wildcards: * (arbitrary number of arbitrary characters) and ? (arbitrary character.
/m 0: a new selection list will be generated. 1: the existing selection list will be
changed.. Default value is 0.

The three additional options /nor (NoRaster), /nov (NoVector) and /rdl (Redlining) control
which basic entity types (raster, vector, redlining) are selected when using the p option.

Example 1: Selection of all circle elements with a radius of less than 5 drawing units:
 VPQSELECT /p f /t Circle /prop R /o > /v 5

Example 2: Deletion of all circle elements in layer L1 with a radius of more than 5 drawing
units. This requires two subsequent commands:
 VPQSELECT /p f /t Circle /prop R /o > /v 5
 VPQSELECT /p f /t Circle /prop Layer /o = /v L1 VPDELETE
Apply to: The filter criteria can be applied to the Whole drawing or the Current selection. Current selection is only available if entities were selected before starting the command.

Pick Object: Temporarily closes the dialog for selecting entities from the document by using the mouse.

Object type: Shows the types of the entities in the selection or in the drawing and (if there are different types) All.

Properties: Determines the criteria for filtering. The property list changes according to the selected Object Type. Selecting a property changes the available options for Operator and Value. In order to select a property the Operator must not be set to Select All!

Operator: Controls the value range for the filter. Depending on the selected property the following operators are offered: Select All, = Equals, <> Not Equal, > Greater Than, < Less Than, and * Wildcard Match. Not all operators are available for each property.
Value

The property value for the criterion. If known values exist for the selected property they are provided in a selection list. Otherwise type in a Value.

Filtered entities meet the filter criteria
Those entities that meet the filter criteria are selected.

Filtered entities do NOT meet the filter criteria
Those entities that do NOT meet the criteria are selected.

Selection (Modify existing set)
An existing selection set is reduced or expanded according to the filter criteria.

Selection (Create new set)
A new selection set is generated from the result of the filtering.

Select All [Ctrl]+[A]

Menu: Edit Function: Select All
CMD: VPSELALL

Selects all elements which are visible and not on a locked layer (exception: redlining elements). As a default the command VPQSELECT /p a is started. This can be changed using the registry key ..\Selection\SelAllCmd.
Snap Functions

Drawing Aids [Shift]+[F8]

Menu: Options ► Snap, Function: Drawing Aids
CMD: VPSNAPSETT ► Dialog

A dialog box opens to specify settings for Grid, Snap to Coordinates, Ortho and Polar Snap, Vector Snap, Raster Snap and the Snap Modes.

Coordinate Snap [F9] {on/off}

Menu: Options ► Snap, Function: Coordinate Snap
CMD: VPSNAPCOORD ► {on/off}

The Coord Snap can be specified in the menu Drawing Aids (Windows only). The option can be switched on/off clicking this icon or using [F9]. Values for X- and Y-spacing refer to the user coordinate system.

Default: X = Y = 1
Grid [SHIFT]+[F9] {on/off}

Menu: Options ► Snap, Function: Grid
CMD: VPSNAPGRID ► {on/off}

The Grid can be specified in the menu Drawing Aids (Windows only). It can be switched on/off clicking this icon or using [F9]. Values for X- and Y-spacing refer to the user coordinate system.

Default: \( X = Y = 5 \)

Ortho Snap [F10] {on/off}

Menu: Options ► Snap, Function: Ortho Snap
CMD: VPSNAPORTHO ► {on/off}

The Ortho Snap limits the directions while drawing entities to \( n \times 45^\circ \).

Polar Snap [SHIFT]+[F10] {on/off}

Menu: Options ► Snap, Function: Polar Snap
CMD: VPSNAPPOLAR ► {on/off}

The Polar Snap corrects deviations to the ortho directions \( (n \times 45^\circ) \) within the value angle while drawing entities. The value for angle is given in degrees.

Default: \( 3^\circ \)
Raster Snap [F11] {on/off}

Menu: Options ▶ Snap, Function: Raster Snap
CMD: VPSNAPR ▶ {on/off}

Clicking this icon or using [F11] allows for switching the snap on or off. The raster snap operates on b/w, gray scale, and color images, where snapping occurs to the active color defined in Image Settings. The Snap Mode toolbar allows for activating snap modes.

Default: off

Vector Snap [F12] {on/off}

Menu: Options ▶ Snap, Function: Vector Snap
CMD: VPSNAPV ▶ {on/off}

Clicking this icon or using [F8] switches the snap on or off. The Snap Mode toolbar allows for activating snap modes.

Default: off

Snap Modes

Whenever the Snap function is activated, a toolbar opens for snap mode selection:

If both snaps functions are activated the snap priority also needs to be defined in the toolbar.

Default: snap priority on vector

Any of the five available snap modes can be activated, even simultaneously:

Nearest  snaps to the nearest point of an element
Intersection  snaps to the nearest intersection of elements
End Point
snaps to the nearest end point of an element

Center
snaps to the center of the nearest circle or arc

Quadrant
snaps to a quadrant (0°, 90°, 180°, 270°) of the nearest circle or arc

Midpoint
snaps to the nearest midpoint of an element

Perpendicular
snaps to an element perpendicularly

Tangent
snaps to an element tangentially

The active mode can be changed clockwise to a different snap mode with [TAB]. The different snap modes are displayed with their symbols as listed in the dialog box.

Use the selection boxes Marker Size and Marker Color to modify the symbols’ display.

Default: Marker Size : 6 pixels
Marker Color: Yellow

Undo [Ctrl]+[Z] / [Alt]+[Backspace]

Menu: Edit, Function: Undo

CMD: VPUNDO

This function will Undo a previous command or function. The command can be repeated for a maximum of 32 steps per page or 50 steps per document. The icon (and menu command) is grayed if to be undone.

Redo [Ctrl]+[Y]

Menu: Edit, Function: Redo

CMD: VPREDO

Repeats the last command or function which has been undone. The icon (and menu command) is grayed if there are no commands in memory.
Delete Entities

Menu: Edit ➤ Delete Function: Delete Entities
CMD: VPDELETE

Deletes the selected entities. You can also use [DEL] on your keyboard.

Explode Entities (Origin)

Menu: Edit Function: Explode Entities
CMD: VPEXPLODE

Breaks up the structure of the selected elements. Blocks, Hatch, Polylines, Splines, and Text are exploded and separated into their composing base elements. This allows for corrections of misinterpretations resulting from a vectorization.

Drag & Drop

Use this standard Windows function to move entities, objects, images, drawings between document windows in VPindex to or from the symbol library, and to or from other applications.

Supported formats are: RVD (native VP format), Bitmap, Enhanced Metafile, Text, AutoCAD (paste only), Windows Explorer files. When two or more files are dragged together from, for instance, the Windows Explorer to the main application window, the Multiple File Selection dialog pops up. For more information, please see the Open command in Section 3.
Cut [Ctrl]+[X], Copy [Ctrl]+[C], Paste [Ctrl]+[V]

- **Menu**: *Edit* Function: *Cut*
  - **CMD**: VPCUT

- **Menu**: *Edit* Function: *Copy to Clipboard*
  - **CMD**: VPCLIPCOPY

- **Menu**: *Edit* Function: *Paste*
  - **CMD**: VPPASTE [<X>,<Y>]

These standard Windows functions allow for exchanging entities, objects, images, drawings between other applications and VPindex.

- Supported formats: RVD (native VPindex format), Bitmap, Enhanced Metafile, Text, AutoCAD (paste only).

Cut/Copy

Click *Cut* or *Copy* and select the entities/objects you want to copy. Confirm the selection with [Return]. For raster object selection, use the function *Select Raster* from the context menu (right mouse click). You may also select entities/object first and confirm the selection. Then, click *Cut* or *Copy*.

Paste

Entities appear with their base point attached to the cursor. Place them at the desired position or enter the destination coordinates in the command line.
Measure Distance [F2]

Menu: View, Function: Distance

CMD: VPMEASURE

Pressing the [F2] key opens the Measure Distance Dialog. The white area shows the current cursor position and the values are permanently updated when moving the cursor in the work space. The upper section shows the values in base units, either [mm] or [inch] depending on the system settings (Options - Settings). The lower section displays the same values according to the settings in the user coordinate system.

Measurement results will be displayed in the lower gray area (pane).

Three basic operation types are available which can be set with the left three buttons in the dialog’s far upper section:

- Accumulate the measurement results indicated by (+) in the result pane.
- Subtract the measurement results, indicated by (-) in the result pane.
Take one measurement at a time.

Different values can be measured using the buttons on the dialog’s right hand side:

- Measure the length and angle of a line by clicking two points in the drawing.
- Measure an angle by clicking three points in the drawing. The center point is the intersection of the two lines forming the angle you want to measure.
- Measure an angle by clicking four points in the drawing.
- Measure the length of a polyline by clicking its vertices. Complete the measurement with a double-click or press **ENTER**.
- Measure the circumference and area of a closed polyline through clicking its vertices. Finish the measurement using a double-click, or using **ENTER**.
- Click an element. Different properties are displayed depending on the element type.

This function is very helpful for measuring parameter values that rely on information from a drawing. You can click the parameter field and select **F2**. The result will be inserted directly into the parameter field.

**Redraw [Ctrl]+[R]**

**CMD:** **VPREDRAW**

This option redraws the current display.
Properties [F3]

Menu: Edit, Function: Properties
CMD: VPPROPSHOW ➤ Dialog

The properties dialog opens and displays the properties of the selected entity or the common properties of entities:

You can modify the properties of any raster or vector entity as far as modifications are feasible.

Selected Raster Entities

Pick-selected raster entities (appearing in red color by default) are converted into special vector entities and remain in that color and condition after leaving the properties dialog. You can either return to the previous state using Undo commands or rasterize the entities into the image.

This "intermediate" state allows for modifications. For example, if you assign a raster line to an active vector layer the line becomes a vector entity after confirmation but stays in red color. Using the function Assign Current Color the color display can be changed.
Changing Properties

In the **General** field combo boxes open for modifications when clicking into the corresponding value fields. Select from the available choices.

In the **Geometry** field you may enter new values (keyboard or [F2] function).

**Change Properties**

**CMD:** VPCHANGEPROP [/prop|Property <property>] [/v|Value <value>]

This command can be used to change almost any properties of previously (!) selected elements. It is primarily meant for using it with scripts or in a batch process.

/prop Specific properties of one or more elements will be changed. All property entries listed in the properties dialog for an element are available, e.g. **Layer** and **Line Type**, but also geometric properties such as **Xm** (= X-value of circle center points), **Ym** (= Y-value of circle center points), **R** (= radius). Exceptions include special properties, such as single vertices of polylines, or dimension properties referring to dimension styles.

/Value Defines a new property value.

**Draw Order**

Enables the draw order of raster and vector entities relative to each other whereby all raster entities are always positioned behind all vector entities. This means, raster and vector entities/objects form two separate areas of front-to-rear orders, e.g. a raster entity can never be drawn in front of vectors and vice versa.
In Front [Shift]+[Pg Up]

Menu: Edit ► Draw Order, Function: In Front
CMD: VPDRAWFRONT

The selected entity/entities will be drawn in front (on top of all other entities). Activate this function and select the entities. Confirm the selection with [Return]. You may also select the entities/objects first and then call the function.

To Back [Shift]+[Pg Dn]

Menu: Edit ► Draw Order, Function: To Back
CMD: VPDRAWBACK

The selected entity/entities will be drawn in the back (behind of all other entities). Activate this function and select the entities. Confirm the selection with [Return]. You may also select the entities/objects first and then call the function.

Above Entity

Menu: Edit ► Draw Order, Function: Above Entity
CMD: VPDRAWABOVE

The selected entity will be drawn above a certain reference entity. Activate this function and select the entities. Confirm the selection with [Return]. You may also select the entities/objects first and then call the function. Then select the reference entity above the first selected entities should be drawn.

Behind Entity

Menu: Edit ► Draw Order, Function: Behind Entity
CMD: VPDRAWBEHIND

The selected entity will be drawn behind a certain reference entity. Activate this function and select the entities. Confirm the selection with [Return]. You may also select the entities/objects first and then call the function. Then select the reference entity behind the first selected entities should be drawn.
Rasterize Functions

New Raster

Menu: Raster Function: New Raster

**CMD:** VPNEWRASTER ➤ Dialog


Creates a new "empty" raster image into the current document. A dialog opens for specifications:

![New Raster Dialog](image)

You can specify **Color Format**, **Background Color**, **Format** and **Resolution**. You can also define the **Position** of the new raster in the document.

**Color Section [/cf /b /p]**

Choose the color format for the new raster image (b/w, gray scale, 256 colors (indexed), RGB full color). If you select 256 colors you can either choose a standard palette, or load an existing palette (e.g. from another raster image), or create a palette with the used layer and entity colors.
Size Section [/f /o /w /h /u]

Define the image format. From the combo box you can select available standard formats. With Format Manager existing formats can either be customized or new formats can be created. Also, by pressing the button Specify on Screen you can draw a window for the size (this format will be listed as Custom). The button Best selects the best fitting standard format, including all entities in the document. Also, the best orientation will be chosen automatically.

By entering a Margin [/m] in [mm] you can create an additional border around the image.

Activate Fit to Format Size [/sf] if you want the entities to be scaled to match the selected paper format.

Scaling and Resolution control the quality of the new image as well as the required amount of memory. With colored or large drawings setting a lower resolution or a bigger scale factor can be used to reduce the amount of memory - and with that the workload of the computer.

Default: 1 : 1
Default: 300 DPI

Position [/ce /x /y]

With checking on Center to Entities the new raster is positioned around the entities.

With Insert at: you can either enter an offset position in reference to document's origin, or by pressing Specify on Screen you can define the insertion position with the mouse.

Name

Enter a name for the new raster image. This name is suggested as the file name for export.

Standard: Unnamed 1
**Rasterize**

**Menu:** *Raster* **Function:** *Rasterize*

**CMD:** VPRASTERIZE ▶ Dialog
**CMD:** VPRASTERIZE [<RTB-File>] [/dw|Default Width <Default Width>] [/fw|Fixed Width <Fixed Width>] [/r|Raster <1|0>] [/v|Vector <1|0>] [/e|Erase <0|1>] [/s|Selection <0|1>] [/d|Delete <1|0>] [/ct|Color Table <0|1>] [/opt|Optimize Palette <1|0>]

Rasterizes the selected entities/objects into the target raster image. A dialog opens for specifications of the rasterization process:

**General Tab**

**Target Raster Section**

The **Target Raster** is always the active image. Use Rasterize to Paper Format to rasterize into a new image (see below).

If the target raster is an indexed image you can activate **Optimize Palette** in order to create a new palette for best color representation of all entities that will be rasterized.
Rasterize Entities Section

Click the entity type (Raster Entities/Objects and/or Vector Entities) you want to rasterize. If you check on All all entities of the selected type will be rasterized. Otherwise, you need to select the entities prior to the rasterize command.

With the setting Erase Mode to on all raster pixels underlying the vectors are erased.

Delete Entities after Rasterization {on/off}

Deletes all selected entities after they have been rasterized.

Layer Settings Tab [/dw /fw]

Lists all layer settings with respect to the Raster mode. You can especially switch on or off layers and modify line widths of vector layers for rasterization. Modified values will also appear in the Layer Manager and saved to the document. A standard line width can be assigned for all unspecified layers at the command line using /dw. With operator /fw a specific line width can be assigned for all elements.

With Save and Load you can save and reload the settings in the RTB format (e.g. for processing with the Batch Manager). AutoCAD plot style tables (CTB files) can be loaded but they cannot be saved.

Use Width by Color Table {on/off}

You may want to assign different width values by color instead of assigning the same width to all entities of a layer. Checking this parameter on brings up all 256 colors for assigning a width to the ones in use.

Rasterize to Paper Format

Menu: Edit Function: Rasterize to Paper Format

CMD: VPRASTERIZEPF ► Dialog
CMD: VPRASTERIZEPF ALL PARAMETER FROM VPNEWRASTER AND VPRASTERIZE

This function operates the same way as Rasterize, except that a new raster (Fit to the Extents) will always be generated. When desired you may select other formats.

Selecting all entities (raster and vector) and checking Delete Entities after Rasterization will result in a new raster image fitting to the extents of all entities. The "old" raster will be deleted.
In order to change the size and type of the target raster click the **Setup** button:

![New Raster dialog](image)

The dialog options are described in **New Raster** above.

**Mosaic**

Instead of creating a single target raster image you can optionally choose to rasterize into an array of tiles by activating **Create Tiles**. When clicking the **Tile Size** button the dialog for setting up the tiles opens:

![Mosaic dialog](image)

All tiles will receive an equal size. This means that the image might be extended in all directions when creating the tiles.
The number of tiles can be specified directly by selecting **Number of Sections** and entering **X-Count** and **Y-Count**. Alternatively, the tile size can be specified in these two edit boxes when **Size in** and the desired units are selected.

**Tile Size** shows the currently defined absolute size of each tile in pixels as a reference.

The option **Size in** creates quadratic tiles by default. By setting **Non-Quadratic** to **on** you can specify the tile height independently from the tile width.

Moreover, you may specify a **Reference Position** where the split operation should start. Valid options are:

- **UCS Grid Position**: Origin of the UCS.
- **Image: Upper Left**: Upper left corner of image.
- **Image: Lower Left**: Lower left corner of image.
- **Image: Upper Right**: Upper right corner of image.
- **Image: Lower Right**: Lower right corner of image.
- **Image is Centered**: Image is centered on the tiles.

**Export to Files** {on/off}

This option allows to export each created tile into a separate file (when set **on**).

On closing the dialog with **OK** you are requested to enter the **base file name** for all split files. Two digits in parenthesis will be appended as (0-0), (0-1), etc. The first digit indicates the row (top to bottom), the second digit indicates the column (left to right).

**Default**: off

**Create Image Tiles in Document** {on/off}

Set this option to **off** to avoid the creation of the tiles in the document. This will save processing time and memory if the tiles are exported and are not needed in the document for modifications.

**Default**: on
SECTION 5
RASTER FILE EDITING, CUT TO DRAWING FORMAT, SCALE FILE

General Information

The main menu Raster contains editing functions for all kinds of raster data. Some raster file editing functions on gray scale or colored images need proper Active Color and Background Color settings. The Image Settings dialog will then pop-up automatically. The raster file editing functions always affect the entire raster file. Especially, they provide functions for quick clean-up of scanned raster data.

On gray scale or color images (i.e. non-B/W) some raster edit functions cause a re-sampling/interpolation. In the menu Options ► Resampling Settings... this process can be specified.

If a document contains multiple raster images, the Active Raster Image will always be processed, unless you have selected an raster object. Then, this raster object will be processed instead.

Resampling Settings...

Menu: Options, Function: Resampling Settings...
CMD: VPROPSETTINGS ► Dialog

When colored or gray scaled raster images are transformed (e.g. rotated, scaled, or rubber sheeted etc.) a proper setup of the Resampling Settings will improve the quality of the output due to the specified method since the program needs to perform an interpolation or integration during the transformation process. Depending on the performed action (scale up or scale down) and the type of the raster data (paletted or true color) different methods should be used.

Any transformation method other than Nearest Neighbour might increase the processing time significantly due to extended calculation methods.
A dialog opens for selection of the appropriate process settings:

### Resampling / Interpolation

The option **Do not resample / interpolate** allows to turn off the re-sampling process.

There are three levels of scaling: **No/Low Scaling, Scale down, Scale up**. For each level the re-sampling method can be defined independently. The **No/Low Scaling** selection method will be used if the image size changes by less than 20% up or down (e.g. scale factor approx. 0.8 through 1.2). This applies to rotations and most rubber sheeting transformations.
The re-sampling methods can be divided into three different types:

<table>
<thead>
<tr>
<th>Method</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nearest Neighbour</td>
<td>Resample / Interpolate</td>
<td>No resampling (Default)</td>
</tr>
<tr>
<td>Bilinear</td>
<td>Resample / Interpolate</td>
<td>Four point interpolation</td>
</tr>
<tr>
<td>Cubic Convolution</td>
<td>Resample / Interpolate</td>
<td>Interpolation by a cubic function</td>
</tr>
<tr>
<td>Hermite</td>
<td>Filter, can be used for up and down scaling</td>
<td>The color of an individual output pixel is the filter value (kind of weighted mean value) of a number of input (source) pixels.</td>
</tr>
<tr>
<td>Bell</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B-Spline</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mitchell</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lanczos 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lanczos 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 - Point Gauss</td>
<td>Integration, mainly used for down scaling</td>
<td>The color of an individual output pixel is the integrated color value of the colors of a number of (now removed) input pixels.</td>
</tr>
<tr>
<td>9 - Point Gauss</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16 - Point Gauss</td>
<td></td>
<td></td>
</tr>
<tr>
<td>25 - Point Gauss</td>
<td></td>
<td></td>
</tr>
<tr>
<td>36 - Point Gauss</td>
<td></td>
<td></td>
</tr>
<tr>
<td>49 - Point Gauss</td>
<td></td>
<td></td>
</tr>
<tr>
<td>64 - Point Gauss</td>
<td></td>
<td></td>
</tr>
<tr>
<td>81 - Point Gauss</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 - Point Gauss</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Use the **Resample / Interpolate** type for No/Low Scaling. For higher scaling values (up or down) the **Filter** or **Integration** methods might significantly improve the results.

Due to the limited number of colors in paletted images, the re-sampling does not have the same effect as in true color images!

The **Apply to RGB / Grayscale** and **Paletted** checkboxes allow to assign the selected re-sample / interpolate functions accordingly.

### Palette Options

**Recalculate Palette {on/off}**

If checked on a new palette will be calculated for the image, when a re-sampling method other than **Nearest Neighbour** has been defined.

**Quantization Method, Number of Samples**

Select the quantization method and the number of samples for the recalculation. The **Quantization Method** defines the way how the palette is calculated from the samples. Again, choosing a high value for **Number of Samples** (e.g. 25%) will increase the conversion time by about the same amount!
Auto Cleanup

Most raster files from (orthogonal) technical drawings need to be deskewed and despeckled. This function starts an automatic despeckling, filling raster holes, and deskewing of the active raster file. The maximum size of the removed speckles or filled holes is 128 pixels. Speckles with a regular outline (e.g. dots, dots of dashed lines, decimal dots) will not be removed. Deskewing is performed by selecting a major vertical line in the image.

For color/gray scale images the Active Image Settings for active color and background color will be used to remove/fill speckles accordingly.

Auto Cleanup of poor drawings, e.g. weak, thin, and fragmented raster elements will show an increasing degeneration of the image due to despeckling. Be aware of that!

Raster Functions

- Automatic Cut
- Cut Window, Polygon
- Crop (Trim) Window, Polygon
- Deskew
- Invert
- Rotate Quadrantal
- Rotate Arbitrary
- Horizontal Mirror
- Vertical Mirror
- Remove Speckles
- Smooth
- Morphology

These editing functions can be run individually. Some frequently used operations can be combined into a single process (see All Raster Operations).

Automatic Cut

The empty margin regions of a raster image are cut automatically.
Cut Window, Cut Polygon

Menu: Raster ► Raster Operations, Function: Cut

CMD: VPCUTWINDOW ► Define Window
CMD: VPCUTWINDOW ► x1 y1 x2 y2

This function cuts a section from the active raster file for further processing. You determine the desired image area by dragging a Window with the mouse or with specified window coordinates. The new raster file contains information according to the selected window frame.

Menu: Raster ► Raster Operations, Function: Polygon Cut

CMD: VPPOLYCU T ► Draw Polygon
CMD: VPPOLYCU T ► x1 y1 x2 y2 x3 y3 ....

A polygon area can be defined with the cursor or by clicking on a closed vector polyline. Please note that for the latter option the polyline must be clicked first before starting the Cut Polygon function. A new rectangle raster file limited by the extents will be generated.

Crop Window, Crop Polygon

Menu: Raster ► Raster Operations, Function: Trim / Crop

CMD: VPCROP ► Define Window
CMD: VPCROP ► x1 y1 x2 y2

This function erases all raster information from the active raster file outside of the selected window area. The original raster file size remains (width and height in pixels).

Menu: Raster ► Raster Operations, Function: Polygon Trim

CMD: VPPOLYCR O P ► Draw Polygon
CMD: VPPOLYCR O P ► x1 y1 x2 y2 x3 y3 ....

This function erases all raster information from the active raster file outside of the selected polygon area (for selection of polygon areas see above Cut Polygon). The original raster file size remains (width and height in pixels).
Deskew

Menu: **Raster ► Raster Operations**, Function: **Deskew**

**CMD:** **VPDESKEW ► Draw Reference Line**

This function lets you correct small skewing errors that frequently occur during scanning. The whole file is aligned with a **horizontal** or **vertical reference line**.

When you choose this function, the cursor appears with a triple **frame box** to be positioned at the first starting point of the reference line you wish to define. When you click on the first point, the area is enlarged to a ratio of 1:1. The standard screen cursor appears allowing you to accurately pick the starting point of the magnified reference line with a mouse click. Then, the program zooms back to the extents and the cursor returns with a triple frame box again. You apply the box in the same way to pick the end point of the reference line.

The program begins the transformation of deskewing the image. A progress indicator is displayed.

⚠️ The **Raster Snap [F8]** should be switched off for optimum deskew accuracy.

Autodeskew

**CMD:** **VPAUTODESKEW**

This function can be initiated from the **All Raster Operations** dialog or by a remote command. The function works on a long vertical line as reference for executing the auto-deskewing on the active raster image. The function is part of the **Auto Cleanup** function.

For color/gray scale images the **Active Image Settings** for active color will be used to find a reference line.

Invert

**Menu:** **Raster ► Raster Operations**, Function: **Invert**

**CMD:** **VPINVERT**

This function inverts the pixel color in the active raster file. With b/w raster data black pixel become white and vice versa. With gray scale or color images the composite color will be assigned to each pixel.
Rotate Quadrantal

Menu: Raster ► Raster Operations, Function: Rotate Quadrantal

CMD: VPROTATE90 ➤ Define Top Side (mouse click or NUM keys)
CMD: VPROTATE90 <Number of 90° sections: -3 - 3>

This function rotates the whole raster file by 90°, 180°, or 270°. You use a rotation box attached to the cursor to click the side of the image that is to be at the top of the display after the rotation.

Rotate Arbitrary

Menu: Raster ► Raster Operations, Function: Rotate Arbitrary

CMD: VPROTATE ➤ Dialog
CMD: VPROTATE <Angle>

This function rotates the whole raster file through any angle you wish. A dialog box appears where you enter the rotation angle and select the basis of rotation.

Specify the angle by entering the value via keyboard (absolute rotation angle) or by drawing a reference line using [F2]. In the latter case, North will rotate the raster file in such a way that the reference line is vertical after rotation. Horizontal will rotate the raster file until the reference line becomes horizontal.

Entry: keyboard or [F2]
Range: - 360° - +360°
Default: 0°

Horizontal Mirror

Menu: Raster ► Raster Operations, Function: Horizontal Mirror

CMD: VPHMIRROR

The raster file is mirrored across the vertical axis (y-axis).
Vertical Mirror

Menu: **Raster ► Raster Operations**, Function: **Vertical Mirror**

**CMD:** VPVMIRROR

The raster file is mirrored across the horizontal axis (x-axis).

Remove Speckles

Menu: **Raster ► Raster Operations**, Function: **Remove Speckles**

**CMD:** VPSPECKLES ► Dialog

**CMD:** VPSPECKLES [A ► Automatic] [D ► Dirt <value>] [H ► Hole <value>] [R ► Review]

This function clears artifacts (unwanted isolated clusters of pixels, i.e. "speckles" or "dirt") from the b/w raster data or fills in vacant pixels (holes) in the raster. A dialog box opens to enter a pixel size value for clearing speckles or filling holes. The speckle and/or hole size can also be entered by picking a sample speckle and/or hole from the raster file.

![Remove Speckles dialog box](image)

On OK you will be prompted to define a window or polygon area. Detected raster elements will be deleted or filled, or the program continues with **Review Results** when activated.

For color/gray scale images the **Active Image Settings** for active color and background color will be used to remove/fill speckles.
Options

Automatic [A|AUTOMATIC]

This mode uses the maximum size of 128 pixels for removing speckles or filling holes. Any found speckles with a regular outline (e.g. dots, dots of dashed lines, decimal dots) will not be removed. If this command is used in the command line including /a, or if it is used in a script, the respective maximum size of 128 can be adjusted with the subsequent d or h parameters.

User Defined

Any isolated pixel area/hole smaller than or equal to the selected Dirt/Hole Size will be recognized regardless of its shape.

Dirt Size [D|Dirt <value>]

Specify the number of pixels or pick a reference structure from your image that constitutes the maximum size of artifacts you want to remove. In conjunction with the parameter A (automatic) the max. dirt size will be limited.

Range: 0 - 255 pixels
Default: 0

Hole Size [H|Hole <value>]

Specify the pixels required to fill the largest hole or pick a reference structure from your image. In conjunction with the parameter A (automatic) the max. hole size will be limited.

Range: 0 - 255 pixels
Default: 0

The maximum limit of 255 Pixels (or 128 for automatic mode) is the recommended default value. For larger values (e.g. due to an image with a high resolution (DPI) ) adjust these values in the registry editor (regedit.exe) manually at:

HKEY_CURRENT_USER\Software\softelec gmbh\V4\<VPmap|VPmap pro>\Rfedit

or

HKEY_CURRENT_USER\Software\softelec gmbh\V11\<VPxx>\Rfedit

Values:

- MaxSpeckleSize Maximum dirt- and hole size for mode User Defined.
- MaxAutoSpeckleSize Maximum dirt size for mode Automatic.
- MaxAutoHoleSize Maximum hole size for mode Automatic.
Larger values here will consume system resources (memory) and time in any case. Even if you have not specified the maximum values for dirt and hole size in the dialog or at the command line.

Area

Whole Drawing  The whole drawing will be processed.
Rectangular Area  Choose this option to perform despeckling only inside a window area.
Polygon Area  Choose this option to perform despeckling only inside a polygon area.

Review result before rasterizing {on/off} [R|Review]
If set to off all detected raster elements (dirt, holes) will be deleted/filled immediately.

If set to on, all detected raster elements (dirt, holes) will be displayed as follows:

\[
\begin{align*}
\text{Dirt} & = \text{green} \\
\text{Holes} & = \text{red}
\end{align*}
\]

These elements can be reviewed. When elements shall not be deleted/filled they can be removed from the selection (see below Window De-Selection). With [Return] the remaining elements are removed (dirt) or filled (holes).

Several modes are available via command line input:

Window De-Selection

[w] starts the de-selection mode (default: active). Marked elements (green or red) can be de-selected by drawing a rectangle around one or more structures (window selection). These will be displayed in magenta color.

De-selected elements can be re-selected by pressing [SHIFT] and a repeated window selection.

Polygon De-Selection

[p] will switch into a polygon de-selection mode.

Add Dirt

With [a] single dirt elements can be added for deletion.

Presettings for color display of dirt and hole elements can be modified in the menu Options – System Settings.
Smooth Raster

Menu: Filter, Function: Smooth Raster
CMD: VPSMOOTH [NR] [NF] [L <Value>]

The Smooth Raster function eliminates rough surfaces, isolated pixels, and fills small holes in raster data. The process requires several runs (max.: 16) detecting relevant elements or structures.

For color/gray scale images the Active Image Settings for the active color and background color will be used to remove/fill the pixels.

Options

No Cleanup [NR]
Pixels will not be deleted.

No Filling [NF]
Holes will not be filled.

Max. Number of Runs [L <Value>]
Maximum number of runs to delete pixels or raster holes.
All Raster Operations

Menu: Raster ► Raster Operations, Function: All Raster Operations

CMD: VPRFE ► Dialog

This function opens a dialog box where several frequently used raster file editing functions can be activated for sequential processing.

For details on the available raster file editing functions see the above descriptions.
Morphology

Menu: Filter, Function: Morphology

CMD: VPMORPHO ➤ Dialog

CMD: VPMORPHO <D|Dilatation|E|Erosion|C|Closing|O|Opening> <Value1> <Value2>

The Morphology function allows to improve a raster file by increasing/thickening (Dilatation) or decreasing/thinning (Erosion) the raster (mainly lines), or Closing Area or Opening Area (mainly raster areas).

For color/gray scale images the Active Image Settings for the active color and background color will be used to perform the operation.

Clicking this icon opens a dialog box displaying a small section of the raster according to the window box on the active raster image. You can click the cursor into an area of interest on the raster image which will then be displayed in the dialog box. Select an appropriate function and define the Diameter (in pixels). The result of the operation can be reviewed online. Use the Pan and Zoom functions for checking. Clicking with the cursor into another area of the raster file will show the operation results there.

Click OK to execute the operation on the whole raster file.

Options

Dilatation (Thickening) [D|Dilatation]

The raster structures are enlarged around their contours by the number of pixels specified by Diameter. This way, thin raster line structures can be improved. Larger values bear the risk of line interconnections.

Default: Dilatation
Erosion (Thinning)  [E|Erosion]

The raster structures are stripped down around their contours by the number of pixels specified by Diameter. This way, raster line structures can be thinned out. Larger values bear the risk of broken lines.

Original Raster  Thinning (Diameter=1)  Thickening (Diameter=2)

Closing Area  [C|Closing]

This is a combination of Thickening and Thinning the raster structure with the same value of Diameter. It allows to closing narrow interruptions inside raster areas without changing the contour of the area, e.g. closing the interruption of a road or river crossing a forest area. This happens especially when exporting colors into a b/w raster file.

Opening Area  [O|Opening]

The opposite to Closing Area. Small interconnections, especially in raster areas will be removed without changing the contour of the area.

Leave Skeleton  <Value2>

When Erosion and Opening is specified you can turn on this switch to avoid that entities (lines or points) are entirely removed. The specified value is the minimum thickness of a line or point in pixels.

Intensity  <Value1>

This value defines (in pixels) the intensity of the above operations.

Default: 0 pixel
Cut to Drawing Format

Menu: Raster, Function: Cut to Drawing Format

CMD: VPCUTTOPAPER ► Dialog

This function allows for cutting a raster file to fit to a selected format (size).

The cut to drawing format function can only be executed on an image which is not scaled or displayed with an angle (review and/or modify with the function Properties). Otherwise, the following message appears:

If you don’t allow the software to modify those values the function will be cancelled.
A dialog box appears to select a drawing format or to define a new format with its settings.

After selecting Paper Format, Layout Orientation, and Margins click OK for execution. The cursor will then be replaced by a rectangle (or a double rectangle if margins have been specified) representing the new image boundaries. Place the (inner) rectangle at the desired position with a left mouse click. To rotate the rectangle by 90° press [Ctrl] or use the right mouse button while positioning the rectangle. A new raster image will be generated according to the outer rectangle boundaries. If Crop/Trim to Margin has been selected the area between the inner and outer rectangle will be erased (cropped).

The drawing should be deskewed and rotated to the desired orientation prior to starting this procedure.
Options

Use Auto Selection {on/off}
If set to on the Paper Format that matches the raster image best is selected. Otherwise, the last used format is selected.

Default: on

Paper Format
The majority of standard formats are available for selection. In addition, individual values for Width and Height can be entered.

Margins
The 4 margins determine the distances between the drawing frame and the physical paper limits (= paper size). For example, the length of the paper form (taken from edge to edge of the paper) minus both margins (left and right) defines the actual frame length of the drawing.

Different Margins {on/off}
If not selected only one margin serves for all 4 sides of the drawing.

Default: off

Crop/Trim to Margin {on/off}
This function erases all raster information within the specified margins (i.e. between the two rectangles).

Default: off

Format Manager
The Format Manager provides a customization of existing formats or new formats can be defined (see Section 3).
Scale

Menu: Raster, Function: Scale

CMD: VPSCALE ➤ Dialog
CMD: VPSCALE <X-Scale> [Y-Scale]
CMD: VPSCALEDP <DPI>

Allows for scaling a raster drawing in Isotropic, Non-Isotropic, or Resolution(dpi) mode. A dialog box opens to select the scaling method and to enter the required values.

Isotropic Mode

The drawing will be scaled with equal values in x and y direction. Enter the actual value via keyboard or use [F2] to take it from the drawing; then, enter the adequate target value, or use the [F2] function again.

Default: 1:1

Non-Isotropic Mode

This mode allows for different scaling values in x and y directions. The actual reference values can also be taken from the image using [F2]. The target values can be entered via keyboard, or by also using the [F2] function.

Default: (x = y) = 1:1

Resolution (dpi) Mode

Scale the drawing by specifying a new resolution for the raster image. The extents in base units (mm or inch) will remain constant. The actual value is grayed and displays the actual resolution of the raster image. Enter the desired resolution as target value.

Default: 400 dpi
SECTION 6
RUBBER SHEETING, 4 POINT DRAWING CALIBRATION,
SPLIT FILE, MERGE FILES

General Information

To complete the rubber sheeting of raster files efficiently, especially in cartographic and cadastral applications, the following parameter settings and functions should be considered:

1. Step: Adjustment of the coordinate system according to the specific map.
2. Step: Rubber sheeting set-up.
3. Step: Entering of reference points, including correction values, where necessary.
4. Step: Execution of the rubber sheeting with previously selected transformation function.

The user will be guided through all necessary steps automatically.

Rubber Sheeting Functions

You can choose one out of 9 Polynomial functions or the Triangular (Exact) Transformation Function supporting different rubber sheeting requirements. With the polynomial functions the setting Automatic (default setting) the software will select the highest possible function (up to Cubic) after entering the reference points. With each function, the minimum number of coordinate values (reference points) is indicated. For a successful calibration the input of more than the minimum number of reference point is recommended:

<table>
<thead>
<tr>
<th>Function</th>
<th>Min. no. of ref. points</th>
<th>Original state</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helmert</td>
<td>2</td>
<td>Rotated square</td>
<td>Orthogonal</td>
</tr>
<tr>
<td>Affine</td>
<td>3</td>
<td>Arbitrary parallelogram</td>
<td>or</td>
</tr>
<tr>
<td>Linear</td>
<td>4</td>
<td>Arbitrary rectangle</td>
<td>or</td>
</tr>
<tr>
<td>Projective</td>
<td>4</td>
<td>Arbitrary quadrangle</td>
<td>aligned</td>
</tr>
<tr>
<td>Quadratic</td>
<td>6</td>
<td>Arbitrary quadrangle incl. local distortion</td>
<td>aligned</td>
</tr>
<tr>
<td>Cubic</td>
<td>10</td>
<td>Arbitrary quadrangle incl. increased local distortion</td>
<td>aligned</td>
</tr>
<tr>
<td>Quartic</td>
<td>15</td>
<td>Cushion and local distortions</td>
<td>square</td>
</tr>
<tr>
<td>Quintic</td>
<td>21</td>
<td>Cushion and local distortions</td>
<td></td>
</tr>
<tr>
<td>Sextic</td>
<td>28</td>
<td>Cushion and local distortions</td>
<td></td>
</tr>
<tr>
<td>Exact</td>
<td>3</td>
<td>Any distortion</td>
<td></td>
</tr>
</tbody>
</table>

Reference points should be distributed evenly across the image. If this is not the case, local distortions can have a major impact on the entire raster file.
Higher functions (quadratic and cubic) should be performed with about twice the minimum number of points. When using a grid a minimum of 16 points (quadratic) or 25 points (cubic) is recommended. Also, there should be an even number in each of the x and y directions.

The Triangular (Exact) function corrects any (nonlinear) distortion in a raster file. It is especially useful if you need to correct particular points to exact positions. However, high deviations of the displacement direction within an area may lead to bent or cornered lines.

A warning message will appear in cases where the mathematical equation cannot be solved properly. Entering additional reference points or - if these do not exist - choosing a lower transformation function can solve the problem.

Imagine a square with different grades of distortion. Rubber sheeting functions can correct the following distortions:

- Helmert
- Affine
- Linear
- Quadratic
- Cubic
Multi Point Rubber Sheeting

Menu: Raster ► Rubber Sheeting, Function: Multi Point Rubber Sheeting

CMD: VPRUBMULTI ► Dialog

Starts the rubber sheeting function on the active raster image. Follow the system's advice to set up a proper environment for the rubber sheeting process.

Set Up User Coordinate System

The dialog box User Coordinate System appears allowing for setting up the user coordinate system for a particular raster image. This includes some specific values to define for the rubber sheeting process:

By entering values for

- Coordinate System / Projection (only VPmap Series)
- User Unit
- Drawing Scale

the coordinate system can be adjusted to the specific requirements of a rubber sheeting process.

Coordinate System / Projection (only VPHybridCAD)

This field always appears greyed and contains Standard (Cartesian). However, when a file is opened containing Coordinate System information (e.g. GeoTIFF) a Coordinate System with a specific projection can be displayed. In this case Parameter becomes available to check on projection parameters. However, these cannot be changed.

To set up and edit a specific Coordinate System with projections you will need to apply softelec’s VPmap Series products (VPmap, VPmap pro).
Coordinate System / Projection (only VPmap Series)

Select a Standard (Cartesian), a User Defined projection, or one of about 2,000 predefined Coordinate Reference Systems. If User Defined or a predefined System is selected the Parameter button is enabled to view and/or edit the Projection parameters.

User Units / Drawing Scale

The User Units and the Drawing Scale should be set to a value which corresponds to the document data. This information may be either part of the legend or the drawing header in a raster image or it must be known due to other information sources. This allows for measurements (using function [F2]) in the document and for direct use of real coordinate values for the target points of rubber sheeting.

See Section 4 for detailed information about VPindex’s coordinate system settings and options.

Rubber Sheet Settings

After having set up the User Coordinate System you need to define the rubber sheeting parameters:

Calculation Mode

Choose between the polynomial calculation functions and the triangular function.

Polynomial

The polynomial functions calculate the correction of the distortion at all reference points with an integral polynomial equation. The higher the polynomial function, the smaller the remaining distortions will become after rubber sheeting. However, there may be remaining distortions. The advantage of these functions is the lack of bends along straight lines. With setting Automatic the highest possible polynomial function will be selected automatically with reference to the number of entered input points.

Default: Automatic
Triangular (Exact)

This function splits the image into triangles between all reference points. It will reliably correct distortions at all reference points. Still, you need to consider that lines crossing different triangles may be bend at the limits of a triangle section. However, there will be no offsets.

Options

For any modifications on the User Coordinate System you can call this dialog again.

Automatic Zoom Factor

Whenever the function requires a picking of a reference point from the raster image and the frame box cursor appears, the system zooms in using this zoom factor.

Default: 1:1

Specify Input Window

This option is only available if the Input of Reference Points is either set to From File or to From Grid. It allows to specify a window to limit the area of the raster file reference point input. Nevertheless, the rubber sheeting function is executed on the whole image.

Target Reference Points

Here you can select the way of entering or marking (on screen) the Target Reference Points for later calibration. All Actual Reference Points are always taken from the raster image (see Input of Reference Points).

1. Manual (Edit Target Points)

This selection allows you to pick the reference points on your raster image and to enter the corresponding target positions via keyboard.

After clicking OK the main rubber sheeting dialog appears. You then need to click Input Points to start the process of entering the reference points. The cursor switches to a frame box allowing for zooming in with the next click. The standard cursor appears for clicking the actual reference point on the drawing/map. The edit point dialog opens for entering the target position of that reference point:
Weighting of Point

Allows for weighting the influence of a particular reference point with respect to other reference points on the polynomial equitation. With the triangular calibration method this value cannot be modified.

Default: 1

Control Point

If you check this parameter when editing a reference point this point will not be rubber sheeted. Instead, it is intended to serve as a control point. This parameter is always reset for the next editing.

On clicking OK the dialog is closed and the values appear in the main rubber sheeting dialog. Repeat this process until all reference points have been entered. Then click OK in the main rubber sheeting dialog to execute the rubber sheeting.

For further processing see Rubber Sheeting Dialog.

2. Manual (Pick from Vector Drawing)

Use this mode if you have a vector drawing to which you want to rubber sheet the raster image in a way that it fits with its reference points to corresponding points on the vector drawing. Import the vector drawing and ensure that the layer containing the vectors is switched on. Activate the vector snap and use appropriate snap modes.
After clicking OK the main rubber sheeting dialog appears. Click Input Points to start the process of entering the reference points (i.e. the Actual Position) on your raster image. The cursor switches to a frame box allowing for zooming in with the next click on the area of the first reference point. The standard cursor re-appears for clicking the precise position. From that position a green line is stretched to the cursor. Then, click the corresponding point (i.e. the Target Position) on the vector drawing. Use the Pan and Zoom functions, if necessary; here, the vector snap supports precise positioning. The frame box cursor re-appears for clicking the area of the next reference point. The software zooms in again for clicking the precise position. Proceed in the same way until all reference points and target positions have been defined. The values are displayed in the main rubber sheeting dialog. The best suitable polynomial rubber sheeting function will be selected automatically. Execute the rubber sheeting with OK in the dialog.

Sample

3. Use Intersections of Vector Entities

Use this mode to calibrate a drawing according to intersections between vector elements, such as lines and polylines, or to the center of (small) circles. You will be asked to select the vector elements. The system will calculate and display all intersections (numbered automatically) between the elements. For each intersection which serves as a Target Point you need to pick the respective actual position on the image. The system supports precise inputs by zooming in and out automatically (frame box cursor). All reference points will be listed in the main rubber sheeting dialog and the best fitting rubber sheeting function will be selected automatically.

Click OK for starting the rubber sheeting process. For entering the actual positions of the reference points see Input of Reference Points.
4. Input from File

For target reference points stored in a text file you can use this function to read the target coordinates. If the target reference points are not distributed all over the raster file you can limit the area of interest for entering the actual positions of the points by specifying a window (check Specify Input Window in Options). Nevertheless, the rubber sheeting process will be executed on the whole image.

Clicking **OK** in the dialog **Rubber Sheet Settings** allows you to specify and read the contents of a text file. A subsequent dialog contains specific settings.
After confirming the settings with [OK] a dialog displays the number of the required actual input points.

**Begin Coordinates with Row**

Coordinate files that have been generated by other applications may contain additional text information. If it is located at the beginning of the file you can skip this part by entering the line number where the import of coordinate values starts. You can get the line number from the displayed list. Then, all preceding data is removed from the list and the row number is set to 1.

**Default:** 1

**Separator**

Select the characters that are used in the text file to separate consecutive coordinate values from each other. In the displayed list you may check the correct settings. **X** and **Y** coordinates must be displayed in individual columns.

**Select Columns for X and Y coordinate**

Here you can enter the column numbers (see the display list's header) for the target values of **X** and **Y** coordinates. When a projection has been specified in the current coordinate system the option „**Degrees**“ will offer to define target values in geographical coordinates.

**Actual**

As for the target values, you can also enter the actual values of a distorted document. When activated the columns for **X** and **Y** coordinates need to be specified. The option **Pixel** will interpret all imported values as pixel coordinates (origin at upper left).

**OK** brings you to the main rubber sheeting dialog for entering the actual reference points.

**5. From Grid**

If the reference points are evenly distributed throughout the drawing on an even or irregular grid you can choose this procedure for a system supported input of the reference points. You need to specify the grid distance for the **X** (or **X** and **Y**) coordinate by entering the value or using [F2] function to measure the distance between two points on the raster image. Then, round the values so they comply to the original grid. For precise positioning of the grid with respect to the actual reference point do not forget to define the USC origin at the lower left reference point (see **Set Up User Coordinate System**).

**Default X:** 100
Different Grid {on/off}

If the grid has a different spacing in X and Y direction switch on this option and enter the corresponding spacing values into the X and Y fields.

Default: off

Grid Angle

If the grid on the map is rotated enter the rotation angle in this field.

Default: 0°

Keep the Grid Angle {on/off}

You can check this option on if you want to keep the grid angle of your map after rubber sheeting. Otherwise, the map will be rotated to an orthogonal orientation of the grid.

Default: off

This way a grid for all target points will be generated and automatically assigned to the actual points on the raster image. If the grid does not cover the entire raster file you can limit the area of interest by specifying a window (check Specify Input Window in Options). Nevertheless, the rubber sheeting process will be executed on the whole image.

Clicking **OK** shows the specified grid on the map or asks for dragging a window for a limitation of the area. Then, the main rubber sheeting dialog appears.
Input of Reference Points

After completing the Rubber Sheet Settings, the main rubber sheeting dialog box appears prompting for the entry of reference points and the choice of a rubber sheeting function.

Input Points {on/off}

If you have selected the modes 3 or 4 (User Intersections of Vector Entities or Input from File) in the Rubber Sheet Settings you will find all target reference points listed in the dialog. With all other modes the listing in the dialog will be empty at this stage.

The button Input Points for picking the actual reference points from the raster image/map can be clicked to start the process.

With modes 3, 4, or 5 the system zooms in according to the selected zoom factor to the first point (a green line is stretched from the target point to the cursor), so you can pick the actual position from the raster image. The system then jumps to the area of the second reference point and so on. After all required reference points have been picked the system zooms out and displays in the dialog actual and target position of each point.

With mode 1 and 2 the actual and the target reference points need to be entered/edited as explained above. If the Automatic Zoom Factor in the Rubber Sheet Settings is on the cursor switches to the zoom frame box at each initial positioning click.

For picking the actual points you can switch on the raster snap, although this is only recommended if the reference points on the raster are very clear and crisp.

As soon as the minimum number of reference points is entered (according to the selected rubber sheeting function), the remaining offset (Error) from the target position for each reference point after the rubber sheeting process will be calculated and displayed. If the calculation mode Polynomial has been selected the system will automatically select a higher transformation function with increasing number of reference points and will calculate the errors accordingly.
If the cursor jumps to an area with a missing or unclear reference point (sometimes you may even look at an "empty" screen), you should first zoom out for control using the (−) zoom icon. If there is no actual reference point or you have moved beyond the map's extents skip this point by using the right mouse button.

At each reference position cross marks and vectors indicate the following:

- **Label No. of the Reference Point**
- **Red cross** = actual value
- **Green cross** = target value
- **Yellow cross** = attainable correction
- **Distance green/yellow** = remaining offset from the target value

After all reference points have been entered switch off the button **Input Points**.

**Rubber Sheeting Function**

With the **Polynomial Calculation Mode** you can select the desired rubber sheeting function or **Automatic**. With Automatic the program suggests a suitable function automatically and will calculate correction values concurrently while in the input mode. In proportion to the number of entered reference points the system will suggest a higher transformation function, i.e. providing the highest attainable rubber sheeting precision. A lower transformation function can always be chosen.

⚠️ If the mathematical equation cannot be solved properly, a warning message will appear. In this case more reference points ought to be entered or a lower function should be selected.

**Button Functions**

**Save** allows saving of reference values and settings to a file (extension .RYP) preferably in the raster file's directory. You also can export a text file (select the extension .TXT) containing all information of the current rubber sheeting setup for documentation (e.g. reference point coordinates).

**Load** will load a .RYP file to continue with rubber sheeting operations.
**Error Statistics** opens an info box showing error statistics:

![Error Statistics](image)

**Delete Point** deletes the current reference point.

**Edit Point** opens another dialog box to edit a reference point. The actual value can be taken directly from the raster drawing by using [F2].

**Grid/UCS** brings you back to the Rubber Sheet Settings dialog (see before).

**Cancel** will terminate rubber sheeting operations at any time.

**OK** starts the rubber sheeting. The progress indicator appears. After completion the corrected file will be displayed containing **yellow** and **green** cross signs to review the accuracy of rubber sheeting. Termination with **OK**. The new file should be saved.
4 Point Drawing Calibration

Menu: Raster ➤ Rubber Sheeting, Function: Calibrate to Drawing Format
CMD: VPRUB4POINT

This function is especially designed for rubber sheeting of technical drawings based on a drawing's paper format. Usually, technical drawings are created on transparencies with a drawing frame bearing an orientation to the paper format. This drawing frame will be used as a scale reference for the necessary rubber sheeting process. It is also assumed that the drawing's contents will remain in the desired scale after the rubber sheeting process.

Preparation

The 4 point drawing calibration function can only be executed on an image which is not scaled or displayed with an angle (review and/or modify with the function Properties). Otherwise, the following message appears:

If you don't allow the software to modify those values the function will be cancelled.
When invoking the command or clicking the above icon a dialog box appears to select a drawing format or to define a new format with its settings:

![Calibrate to Drawing Format dialog box]

This function allows for rubber sheeting a raster file to fit to a selected format (size).

**Options**

**Use Auto Selection {on/off}**

If set to **on** the **Paper Format** that matches the raster image best is selected. Otherwise, the last used format is selected.

Default: **on**

**Paper Format**

The majority of standard formats are available for selection. In addition, individual values for **Width** and **Height** may be entered.

**Margins**

The 4 margins determine the distances between the **drawing frame** and the physical **paper limits** (= paper size). For example, the length of the paper form (taken from edge to edge of the paper) minus both margins (**left** and **right**) defines the effective drawing frame's length.

While each paper format can bear different values for margin distances, **Save as Default** saves the actual margins for permanent use with the selected form size.

**Different Margins {on/off}**

If set to **off**, only one margin serves for all 4 sides of the drawing.

Default: **off**

**Crop/Trim to Margin {on/off}**

This function erases all raster information within the specified margins (i.e. between the two rectangles).

Default: **off**
Format Manager

The **Format Manager** provides a customization of existing formats or new formats can be defined (see **Section 3**).

Calibration

After selection of the **Paper Format** and **Margins** and clicking **OK** a rectangle representing the selected paper form is placed on your drawing. If there are margins specified a double rectangle will be displayed instead. The cursor appears with a frame box linked to the upper left corner of the (inner) rectangle of the drawing format. Click the upper left corner of the raster image for zooming into this area and then place the appearing standard cursor precise on the frame corner of your raster drawing. The system jumps to the next corner (upper right) and the frame box is now linked to the corresponding corner of the (inner) rectangle. Proceed as before. After having clicked all 4 corners the rubber sheeting process is executed and the final raster image appears on screen for saving.

⚠️ The drawing should be deskewed and rotated to the desired orientation prior to starting this procedure.
You can manually split a raster file into a maximum of 625 sections by positioning up to 24 horizontal and 24 vertical split lines on the drawing or automatically by specifying a tile size (or count) in order to generate equal-sized tiles (mosaics). The tiles can be saved into separate files or will replace the current raster in the document.

The split function can only be executed on an image, which is not displayed with an angle (review and/or modify with the function Properties). Otherwise, the following message appears:

If you don’t allow the software to modify this value the split function will be cancelled.

Normally, a dialog opens to define the number of tiles in the raster image:

Arbitrary

On OK you can position the split lines on the image.

The status line calls for a positioning of the first horizontal split line. Follow these steps to position all horizontal, and then all vertical split lines:

- Click where the first line should be positioned. Zoom and Pan commands are available.
- The split line appears in green.
- Clicking the right mouse button opens the context menu. You can delete the last split line with Undo and re-position it again.
- Continue until all horizontal split lines have been set. Select Add Vertical Split Line(s) from the context menu and set the desired vertical split lines.
- After positioning the last line select Finish Input from the context menu to start processing.
The new raster images which are going to be created will be named according to the original image and their position in correspondence to the original file:

**First digit:** Horizontal position (row, top to bottom)

**Second digit:** Vertical position (column, left to right)

The origin (0-0) resides at the upper left.

**Fixed <X-Count> <Y_Count>**

Select the number of Vertical Sections (X-Direction) and Horizontal Sections (Y-Direction). On OK you will be asked to position the split lines on the image.

The status line calls for positioning of the first horizontal split line. Follow these steps for positioning all horizontal, and then vertical split lines:

- Click where the first line should be positioned. **Zoom** and **Pan** commands are transparent.
- The split line appears in **green**.
- Clicking the right mouse button opens the context menu. You can delete the last split line with **Undo** and re-position it again.
- Continue until all horizontal and vertical lines have been selected. After positioning the last line the process starts.

The new raster images which are going to be created will be named according to the original image and their position in correspondence to the original file:

**First digit:** Horizontal position (row, top to bottom)

**Second digit:** Vertical position (column, left to right)

The origin (0-0) resides at the upper left.

**Export to Files {on/off} [/E]**

This option allows to export each created tile into a separate file (set on).

In the dialog mode you are requested to enter the **base file name** for all split files. In the command line mode the filename of the image is automatically used as the **base file name**. Two digits in parenthesis will be appended as (0-0), (0-1), etc. The first digit indicates the row (top to bottom), the second digit the column (left to right).
Merge Raster Files

Menu: Raster ► Raster Operations, Function: Merge
CMD: VPMERGE ► Dialog

Two raster images can be merged into one image. The active raster image is always the base image to which a second image will be positioned, scaled, and merged. If you select another raster image (if available) prior starting the command, then this image will be merged to the active raster.

If no other image (already imported into the document) has been selected, the system opens the import dialog and requests to load a raster file as second image for merging.

Thereafter, a dialog box appears to select the appropriate merging method:

Options

As is

Merges the two images as they are displayed on screen.

Specific Corner

Enlarges the dialog and offers to select the position of the second image with respect to the active image. This function is designed for quick and easy positioning of raster images with no margins:
Move

Allows the raster object to be moved with respect to the active raster image without scaling and/or rotation according to one moving vector. You are requested to draw a line (the move vector) defining the move distance and angle. Then both files are merged.

Fit

Calls for two moving vectors. This way, the raster object can be scaled, moved, and/or rotated according to the two vectors with respect to the active raster image. Then both images are merged.

Cut Edge

This function is similar to Fit, as it also uses two moving vectors for fitting the second image to the active image. However, this function cuts both images along a line through the 2 target points of the drawn vectors. With the following dialog you can switch between 2 remaining images:

**Draw Line {on/off}**

Allows for drawing a user defined line for cutting both images instead of the line through the target points.

**Update View {on/off}**

Updates the display after entering each of the moving vectors to show the actual position of the 2 images.

**Opaque (B/W images only) {on/off}**

If checked on b/w raster images are treated opaque, i.e. the section of the active image underneath the moved raster image is not visible.

**Keep as separate Images {on/off}**

If checked on the two images will not be merged into one new image, but stay as two separate images adjusted to each other.
Any two image formats can be merged. When merging different color, gray scale, and b/w raster images, a dialog may open to select the target color depth:

If you merge two paletted images based on different palettes, you can choose either to calculate a new palette or to create a true color image (recommended).
SECTION 7
COLOR REDUCTION, SEPARATION, FILTERS

General

When color or gray scale originals are scanned with applicable scanner devices, you will generate very large raster files containing millions of colors. To process these files in CAD programs, it is important to optimize the color and gray scale information. This can be done either by reducing minor colors, combining colors, or by leveling color transitions to reduce the information for each of the remaining colors, thus render a proper interpretation possible.

To accomplish this, VPindex's built-in scanner interface allows you, besides executing full color (24 bit) scans, to limit the number of colors to be captured to 256 colors or less by using a color conversion table (image palette). This table is based on either a standard color palette or on an adaptive palette created during a prescan. Thus, an indexed color image will be generated.

An indexed image contains 256 or less colors/gray scales. Each index represents a specific color by its portions of the three basic colors red, green, and blue (each basic color having a value from 0 to 255) that have been assigned during the scan process to a palette. Hence, a palette is a table where each of the image's colors (256 or less) is assigned proportions of the basic red, green, and blue color (i.e. RGB).

Using the color reduction process, the original total number of colors can be reduced to create solid colors. Thus, the original file size may be reduced dramatically, while the image's representation may improve at the same time. The overall goal is to reduce the number of colors or gray scale tones and to condense the contained information on base colors.

The color separation process allows only for reducing colors but also for creating (and, if necessary for exporting) bi-level (b/w) raster images from remaining or individually selected colors. These images can be processed just like any other "regular" b/w file.

For further processing color images can be treated as bi-level images. In this case the active (foreground) pixels are composed from a color or gray scale pattern. (Function: Image Settings, see Section 4).
Scanning Colors

After inserting an original document and setting up the scanner (see your scanner manual and/or Section 3), the assignment of a palette can be activated. Also, an existing palette can be selected if you don't want to scan in full color. A dialog box appears to define the palette (color map) for the color reduction to a maximum number of 256 colors:

When choosing **Linear Color Map** a conversion will be executed according to the standard color palette.

When choosing **Computed Color Map** a prescan will follow to detect the existing colors in the actual original. From these colors an individual color palette will be generated.

In the selection box the desired maximum number of colors can be specified.

The dialog box closes on **OK** followed by the prescan and the calculation of the color palette. Then, the selected scan function will be executed.

After every **Stop** action in the scan menu or when reaching the end of the document, the current calculated palette will no longer be valid. When repeating the scan action, a new palette will be calculated and assigned. If you switch from **Forward** to **Scan** directly, though, the same palette will be used.
**Color (Gray Scale) Reduction**

Menu: Raster ▶ Color, Function: Color Reduction

CMD: VPREDUCE ▶ Dialog

CMD: VPREDUCE [RM|RedMethod <VALUE>] [C|Color <Value>] [P|Palette <Filename>]

If the active raster file is a full color image (RGB) or contains more than 256 colors/gray scales a dialog box appears for selecting an automatic color reduction method and the number of colors after this first step:

- **Default:** Color Reduction Method: Median Cut
  Reduce to Colors: 256

The active raster image will be converted to a indexed file with the selected amount of colors. Then, the dialog box for color manipulation appears, displaying all existing colors in the raster image:
The dialog boxes contain two main areas: the lower **Preview Area** displays the image as it will look after any step of color manipulation/reduction, while the upper **Histogram Area** presents the colors currently contained in the image.

In the preview area the default cursor is a pipette which allows colors to be selected from the raster image by clicking with the left mouse button on anyone pixel. To select the color of an area click and drag the mouse for a window selection of all colors enclosed. Use **Pan** and **Zoom** functions for a precise selection.

To deselect colors from within the Preview hold the **[Shift]** key while re-selecting as described above. Colors can also be deselected by clicking again on a selected color in the histogram area. The first selected color will flash in the histogram area. It serves as the **Target Color** for the subsequent operation(s).

Preview Area ttern selected in the histogram or preview area will be displayed in the preview area corresponding with the selected preview modes: **On**, **False Color**, and **Flash**.

**On**
Activates the display of selected and/or modified colors in the preview. Selected colors are displayed in the preview with their **Target Color**.

**False Color**
For better distinction check false color. It shows the selected colors not in the target but in its complementary color.

**Flash**
Toggles the view of the selected colors on and off automatically.
Pan and Zoom

To move around the Preview you can use the scrollbars. There are several zoom commands available:

- **Zoom Extents** shows the entire image in the preview window. This is the initial state when the dialog opens.
- **Zoom Window** switches the cursor in the preview into a crosshair for selecting an image area to zoom in. Then, the cursor switches back to a pipette.
- **Zoom 1:1** switches the cursor to a magnifier glass in the Preview. Click the desired center of the view with the left mouse button for zooming in. Then, the cursor switches back to a pipette.
- **Zoom In**.
- **Zoom Out**.
- **Zoom Previous** shows the previous view of the image.
- **Zoom Next** shows the view before the Zoom Previous state.

Processing Buttons

**OK**

Executes all color reduction operations on the active raster image and leaves the dialog. Use the function **Undo** if you want to return to the status prior to starting Color Reduction.

**Cancel**

Closes the dialog box without changes in the original image.

**Reset**

Rejects all modifications of the color reduction process. It restores the original palette.
Load

Opens the load dialog for loading a color reduction palette (Raster Palette, .RPL). Included in this file are the image's original and reduced palettes. You can only load a color reduced palette if the original palette and the saved reduced palette match. In case you want to apply a certain color reduced palette to several scanned images make sure that these images have been scanned to the same palette.

Save

Opens the dialog for saving a color reduction palette (Raster Palette, .RPL). You can load the palette with Load in this dialog or in the Scan dialog.

Histogram Area ge colors are represented either as Columns (if 50 or less colors remain) or as a Button Array, with one button for each color. The buttons can be clicked for selecting colors (if not picked from the image). In pressed status they indicate which colors have been selected. Clicking the right mouse button on the color button array and dragging a window, while keeping the mouse button pressed selects all included buttons.

The first selected color flashes in the histogram area. It serves as the target color for reduction. Deselecting this color by clicking the color button again will cancel the selection of colors.

The column height in the histogram indicates the frequency rate of colors in the image. There is also an action button below each column. Clicking the action button adds or removes this color to or from the list of selected colors.

When the Histogram is displayed a slider on the right can be moved up and down to scale the frequency bars of the histogram. This option is intended for a better view of minor frequency rates.

The context menu (right mouse click) offers some of the major functions: Combine Colors, Export Color(s) to Raster File(s), De-select All.

Color Sort Options Sort Options available:

Count Sort

Shows all colors in the order of their frequency rate in the image. The most frequently contained color is displayed in the upper left position of the button array and as the first left column respectively.
Color Sort

Shows all colors sorted according to their relative color distance. The darkest color is displayed in the upper left position of the button array and as the first left column respectively.

Count Sort:

Color Sort:

Modify a Color

If you want to change a color, select this color in the color button array (or in the column histogram) or pick from the image and then click on this icon. The standard Windows color dialog opens for selecting a new color:

Color and Pixels Area:

When clicking on a color button or the respective color bar the color's frequency rate in the entire image is displayed in the Color and Pixels Area:
Automatic Color Reduction

Clicking this icon in the color reduction dialog starts the automatic color reduction. A dialog box opens displaying the actual number of colors used and asks for entering the desired number of colors after reduction (minimum number = 10) and offers the selection of a reduction method:

![Color Reduction Dialog]

**Default:** Median Cut

With **OK** the image will be updated and displayed in the preview dialog window with the reduced color palette.

Interactive Color Reduction

Clicking this icon in the color reduction dialog executes the color reduction of all selected colors to the **Target Color**. The number of remaining colors is reduced accordingly. If less than 51 colors remain the color display in the histogram area changes to a column representation.

The **Target Color** receives a double frame in the button array for a better distinction between a target color and those to be combined.

There are different ways to select colors for reduction: you can click on the respective button in the histogram area or on an image pixel in the preview area. In the latter case, the cursor appears as a pipette. Multiple colors can be selected in the histogram area while keeping the right mouse button pressed and dragging a window, and in the preview area by dragging a window while keeping the left mouse button pressed. The selected colors are indicated by an inverse (pressed) button state in the histogram area. The color selected first will be the **Target Color**, thus receiving a highlighted frame and a flashing display.
To deselect a color click on the corresponding color button or click on a pixel of the respective color in the Preview while pressing [Shift]. If the target color is deselected, all other selected colors will also be deselected.

Split (Explode) Color if other colors have been combined to previously (by automatic or interactive color reduction) you can click this icon to explode the color back into its components.

Reduce only Minor Colors to a selective automatic color reduction of minor colors in the image to their adjacent major colors. A dialog box opens:

Moving the slider or entering a value (max. 10%) will select all minor colors (from the end of the color histogram in count mode) controlled by the percentage with respect to the whole image and according to the remove mode. This process provides a quick reduction of all minor colors in an image which usually do not represent any valuable information.

Accumulated for All Colors
The displayed value is the total percentage of all selected minor colors.

Absolute for Singular Colors
Those colors are selected each of which has a share of the displayed percentage or less in relation to the whole image.
Convert Image to B/W

Click this icon to convert the image into a b/w raster file. The colors of the image will be converted to b/w according to the standard b/w conversion palette.

Undo, Redo

Undo and Redo will undo or redo the individual reduction steps. This way you can test the effects of reduction on a varying number of colors. The number of undo steps is limited to 32.

Export Selected Colors

Click this icon to export the currently selected color(s). A dialog box opens for defining the export process:

Export to File(s)

Generates an individual b/w raster file for each selected color. After entering a file name all files will receive a suffix: "_sepNN" (NN starts counting from 01) and saved in TIFF format. The colors will be numbered from left to right and from top to bottom according to the selected colors in the histogram area.
Add to Active Document

Creates new layers to the active image each of which contains the b/w raster of one of the selected colors. If Automatic Layer Definition is checked the system assigns the RGB values as names for each layer. Otherwise the following dialog opens allowing the selection of any available layer or creating new layers for each exported color:

All Selected Colors in one Image

Creates a new raster image containing all selected colors. A b/w image will be created by default. With the following option you can create a colored image:

Create Colored Image

Creates a colored image containing the currently defined background color and all selected colors.

Color Filling

Click this icon to fill areas. In the preview area the cursor changes to a fill cursor. It allows to fill a color pattern area in the image with one solid color by clicking into the area. The fill function calculates a mean color value of the pattern and fills the area with the closest palette color. If you have selected a color prior to activating this function, this color is used for filling.

The Color Filling function stays active until it is switched off again. The filling Color can only be modified (selected) when the Color Filling function is switched off.
Single Pixel Pen

Select the active color (either click on a color button of your choice, define a new color being active, or select the active color with the pipette from the image). Then click this icon to change a single pixel to the active color by a left mouse click.

Add New Color

If you want to fill with a specific color you can either select it from the histogram area (i.e. click on the desired color) or add a new color to the palette by clicking this icon. Adding colors is only possible if less than 256 colors are used in the image.

Automatic Color Cleanup (Reduction)

Menu: Raster ► Color, Function: Automatic Color Cleanup

CMD: VPCOLORCLEAN

Click this icon to perform an automatic color reduction. The algorithm searches for the main colors in the image and combines color pattern to solid colors as far as possible. For remaining color pattern use the interactive color reduction process.
Palette Functions  **Color**, Function:  **Load Palette**  
**CMD:** VPPALLOAD ➤ Dialog

This icon opens the load dialog for selecting a palette file (format: .RPL). The selected file is loaded to the active raster image.

**Save Palette**

**Menu:** Raster ➤ **Color**, Function: **Save Palette**  
**CMD:** VPPALSAVE ➤ Dialog

Click this icon to save the current palette from the active image to a file. This function is only available with indexed raster images. The palette will be saved in the format .RPL.

**Palette Transformation**

**General**

The transformation of a palette compensates for possible scan weaknesses (e.g. contrast or brightness) or lets you modify an image's color representation to individual needs. Especially converting gray scale images to false color images allow for a better distinction of specific information.

There are several palette transformation functions to choose from, depending on how the image should look like after it has been transformed. However, each transformation function will not change the index structure of the image palette but only the assigned values for the three basic colors. Thus, the original pixel information remains untouched.

**Transformation**

**Menu:** Raster ➤ **Color**, Function: **Palette Transformation**  
**CMD:** VPPALTRANS ➤ DIALOG

Click this icon to open the dialog box for the palette transformation. It is organized in three sections:

- Transformation Area
- Output View
- Input View
Transformation Area determines how palette entries will be modified. The input and output areas both contain views of the actual image, however, the output view shows the image based on the currently transformed palette.

In the transformation area you select the transformation function and define process values if required. The graphical representation of the transformation is shown on the right and allows for adjustments.

The vertical axis in the transformation view represents the output values of the current palette (black is on the bottom, white on top). In case you have chosen a colored image the axis is displayed in red, green, and blue. Otherwise, it will appear in gray. The palette’s input values are represented accordingly by a horizontal axis (black is on the left, white on the right). The Output axis’ color succession can be reversed using the Invert checkmark. The following diagram shows how to read the Transformation View.

With two different transformation functions used in this example above the same value of the input palette is transformed into two different output values.
Transformation Functions

The combo box allows selection of one of the available transformations:

- **Automatic Brightness/Contrast***
- **Brightness/Contrast***
- **Automatic Smooth***
- **Smooth***, #
- **Gamma Correction**
- **S-Gamma Correction**
- **Steps**
- **Lines**

The transformations marked with (*) bear a default setting when selected depending on the image. "Automatic" transformations do not carry settings that can be modified. Transformations marked with (#) can only be modified in the numerical view. Selecting a new transformation changes both the numerical and the transformation view. To modify the transformation settings you can edit in both views.

**Connect (on/off)**

When this checkmark is on and a color image is to be processed, then the three basic colors red, green, and blue will be treated together. Thus, only one curve is displayed in the Transformation View.

**Handles**

Moreover, the combined treatment of the three basic colors with Connect will set a primary active color. It is the one that carries handles, even if the Handles checkmark is not set. It is also highlighted in the numerical view, or it is the only color that is represented by a curve (if Show RGB is deactivated). With Connect, the active color's current attribute values will be assigned to the remaining two basic colors.

**View RGB**

If this checkmark is on and Connect is off with a color image, there are three curves, each with a different color.

To modify only one color set Connect to off. Then the active color's curve (red, green, or blue) is displayed. Depending on the View RGB checkmark setting the other two colors will either be accessible, too, or they are not displayed.

There are three ways to select a specific color for modification:

- Select the desired color (Red, Green or Blue) in the numerical view.
- Click with the right mouse button in the transformation view window. A popup menu appears for selecting a color.
- Set the Handles checkmark and click on the desired color's curve handle.

The parameter settings of a transformation can be modified in the numerical view or in the transformation view.
In the numerical view, select the parameter by expanding (i.e. double clicking) the desired color, and click on one of the parameters. You can modify the value either by moving the slider or by entering the desired value in the edit field. The affected handle will be indicated by changing to a brighter color. The transformation area and the output view show the new setting accordingly.

In the transformation view, dragging any one of the curve handles can modify the transformation. To move the transformation curves with the appropriate handle the cursor symbol changes. The numerical area and the output view show the new setting accordingly.

**Steps and Lines**

The **Steps** and **Lines** transformations do not carry curve handles by default. However, you can place optional handles on the curves in the Transformation View by clicking with the left mouse button. To remove a handle click on it with the right mouse button.

**Reset**

Sets the actual transformation back to its initial state.

**Cancel**

Closes the dialog without modifying the image's palette.

**OK**

Closes the dialog, confirming the modifications to the image's palette.

**Output Area**

The output area is organized in two sections: the output view and a set of buttons to modify the output view and, thus, the image's palette.

**Red, Green, and Blue** display an image in the corresponding colors of the palette. **Gray** generates a gray scale representation of a color image while **All** displays an image in all of the three basic colors.

The output axis of the transformation view reflects a modification to these settings. Selecting **Red, Green, Blue,** or **Gray** can also change the numerical view and the transformation view.

With **Move** set to on, the output view will be synchronized with the movements of the input view sliders.

**Input Area**

The input view shows the whole image by default. The view can be modified using the two sliders and the **Zoom In [+]** and **Zoom Out [-]** buttons. The maximum zoom in displays a 1:1 view of the image.

The output view changes according to the modifications of the input view.
Palette Transformation Table

<table>
<thead>
<tr>
<th>Transformation</th>
<th>Effect</th>
<th>Value, Handle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic Brightness/Contrast</td>
<td>The palette is stretched to fit the whole dynamic range without loss of information.</td>
<td>-</td>
</tr>
<tr>
<td>Brightness/Contrast</td>
<td>The brightness and contrast of the image can be adjusted.</td>
<td>Brightness(X), Brightness(Y), Contrast,</td>
</tr>
<tr>
<td>Automatic Smooth</td>
<td>The palette is modified so that in the Output every palette entry has the same frequency.</td>
<td>-</td>
</tr>
<tr>
<td>Smooth</td>
<td>The palette is modified so that in the Output each palette entry has the same frequency. The scale factor modifies the transformation.</td>
<td>Scale factor,-</td>
</tr>
<tr>
<td>Gamma Correction</td>
<td>Black and white remain unchanged while the intermediate palette values are modified: Gamma&lt;1: stretching of lighter values, compression of darker values. Gamma &gt;1: stretching of darker values, compression of lighter values.</td>
<td>Gamma,</td>
</tr>
<tr>
<td>S-Gamma Correction</td>
<td>Black, white, and the Turnpoint remain unchanged while intermediate palette values will be modified. Gamma&lt;1: stretching of lighter and darker values, compression of values within the Turnpoint range Gamma&gt;1: compression of lighter and darker values; stretching of values within the Turnpoint range.</td>
<td>Gamma, Turnpoint,</td>
</tr>
<tr>
<td>Steps</td>
<td>A range of Input values is transformed to one Output value.</td>
<td>Handle X, Handle Y,</td>
</tr>
<tr>
<td>Lines</td>
<td>Multiple effects depending on individual value settings (handles).</td>
<td>Handle X, Handle Y,</td>
</tr>
</tbody>
</table>
Color Filter Operations

Menu: Raster ► Filter, Function: Color Filter Operations
CMD: VPFILTER ► DIALOG

With these filter functions, you can improve the quality of your color or gray scale images. For quality reasons use filters only on full color or at least 256 gray scale raster files.

Click this icon to start filter operations on the active image. The following dialog opens:

![Filter Dialog](image)

Select the desired filter and the results are displayed in the output section. With respect to the selected filter the following options apply.

**Size**

Select the desired filter size. The size value indicates the border length of a square (matrix). The filter calculation will be based on the pixels within the range of this square.

![Filter Options](image)

**Weight**

Weight controls the filtering result being multiplied with the entered value, thus stretching or compressing the generated result (contrast).

Default: 1.0000
Same Average {on/off}

This check box provides for a selection whether the filter's coefficient should be weighted in a way that the average value in the original remains unaffected. This option has no meaning for filters bearing a coefficient sum of 0. For this kind of filters the image's dynamic range will be shifted to enable the display of possibly generated negative values.

Default: off

Offset

Offset moves the filtering result to brighter values with a positive offset and to darker values with a negative offset (brightness).

Default: 0

Create Different Image {on/off}

If checked on the color differential between the original and the filtered image will be created and displayed.

Default: off

Apply

If the results in the output section are satisfying, click on Apply to execute the filter on the active image. The filter dialog disappears.

Change Image Palette

If the active image is based on a palette (i.e. it is not a true color image) you can create a New Palette or convert the file to True Color.

Fast Median and Fast Blur (Average)

These filters are used to decrease noise in an image. However, border transitions will be diffused. The Median filter is slower than the Average option, but it has a lower blur effect on color transitions. Neither will affect the color palette.

All other blur filter have a fixed size setting, ready for use. The size setting is indicated but cannot be changed.

Edge Detection (Sharpen) Filter

Select from the listed filters. There are mainly two well known basic filter groups available: Kirsch and Laplace. The filter matrices can be viewed in the Filter Matrix dialog box (click on Edit after you have selected a filter).
Effect

Select from the listed filters.

Custom

Design your own filter matrix. The application of filters in image processing is a very complex subject that cannot be described in detail in this manual. Only those with color processing experience should work on the items in this section, since unpredictable and unwanted image manipulations are likely to occur otherwise!

New

The Filter Matrix dialog opens:

```
Enter a name and select the desired values for your filter.

This dialog allows for defining several filter options. With three, five, and seven you can switch between the available filter sizes. If a matrix size applies to a filter it will be listed. Otherwise the filter will not be listed and the matrix elements receive a 0 as default value.

  Rotate - 90°  rotates the displayed filter a quarter-turn clockwise.
  Rotate +90°  rotates the displayed filter a quarter-turn counter clockwise.
  Rotate - 45°  rotates the displayed filter an eighth-turn clockwise.
  Rotate +45°  rotates the displayed filter an eighth-turn counter clockwise.

Edit

Allows reviewing and/or modifying any available filter matrix. If you modify a listed filter you will be asked if you want to overwrite the existing definition. You may also assign the new filter to another section or even create a new filter section.
```
Delete

Deletes a selected filter.

Custom Filter Table

<table>
<thead>
<tr>
<th>Filter Type</th>
<th>Name</th>
<th>Size</th>
<th>Direction</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>Blur Filters</td>
<td>Blur</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Gaussian</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Crosshatch</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Edge Detection Filters</td>
<td>Horizontal</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Vertical</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>kirsch_e</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>kirsch_n</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>kirsch_ne</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>kirsch_nw</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>kirsch_s</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>kirsch_se</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>kirsch_sw</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>kirsch_w</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>l2rdiagonal</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>laplace1</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>laplace2</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>laplace3</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>sharpen</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>speckle</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>sobel_horiz.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>sobel_vert.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Effect Filters</td>
<td>north</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>south</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>west</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>east</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>3d</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>deppress</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>jigglevert</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>woodcut</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
Fill Function

Menu: **Raster ➤ Color**, Function: **Fill**

**CMD:** VPFILL

This function operates only on paletted or b/w images.

Click this icon. The cursor changes to a fill cursor. Click into the desired area of your active raster image.

**Default Filling**

As a default the system generates from the pattern around the clicking position the mean value of the found colors and fills the area with the closest color from the palette. With the option **Fill Exact** only a coherent area will be filled which carries the same color value as the pixel clicked.

**Filling Options**

Clicking the right mouse button allows to select different filling modes from the context menu:

A) **Paletted Images**
   - Use Mean Color of Region (default)
   - Use Active Color of Image (defined in dialog **Image Settings**)
   - Use Background Color of Image (defined in dialog **Image Settings**)
   - Use Active Color
   - Fill Exact

B) **B/W Images**
   - Fill with Raster
   - Erase Raster

Clicking repeatedly into the same region at slightly different positions generates best filling results, even though the color pattern may vary.
Color Image Conversion

Convert Image Palette/Type

Menu: Raster ► Color, Function: Convert Image Palette/Type

CMD: VPCONVERTPAL ▶ DIALOG

CMD: VPCONVERTPAL /cv <value> [/rm <value>] [/c <value>] [/lp <value>] [/sp <value>]
      [/gray <value>] [/bw <value>]

This conversion function lets you easily convert an image with regards to the contained colors/gray scales. A dialog opens for specification of the conversion process:

Convert to True Color  [/cv 0]

Select this option to convert the image into a full color file (RGB).
Convert to Palette       [/cv 1]

Select this option to convert the image into an indexed file with a maximum of 256 colors.

Color Reduction      [/rm <method>] [/c <number of colors>]

Select an automatic color reduction method and the number of colors you wish to reduce to.

Load Palette/Reduction      [/lp <palette>]

Choose a system palette or load your previously saved palette or color reduction file (*.RPL). The current image palette will be reduced and mapped to the selected one.

Set Palette      [/sp <palette>]

This option is only available for indexed images. The current image palette will be replaced by a system palette or a loaded palette. The colors are not mapped to the selected palette.

Convert to Grayscale      [/gray <Channels>]

Converts the image palette to grayscale. You can also choose the channel for conversion:

- All Channel  <0>
- Red Channel  <1>
- Green Channel <2>
- Blue Channels <3>

Convert to B/W      [/bw <threshold>]

Binarizes the image. Select a threshold by moving the slider for setting up the separation between black and white.

Default Threshold: 128
Pan and Zoom

Use the slider buttons to navigate inside the preview. There are several zoom options available.

- **Zoom All** displays the entire image in the preview. This will be the active view after opening the dialog.
- **Zoom Window** switches the cursor to a crosshair in the preview to select an image area for a zoom command.
- **Zoom 1:1** switches the cursor to a magnifier glass in the Preview. Click the desired center of the view with the left mouse button for zooming in.

- **Zoom in.**
- **Zoom out.**
Color Classification

General

The classification of colors is an alternative method to reduce the number of colors (i.e. the amount of data) in an image – especially of color patterns. The process as featured in VPindex and described in this chapter is a combination of user interaction and automatic routines.

The principal concept of color classification is based on combining color patterns scattered over an image into a single color automatically. This is based upon probes taken from the image and then extracting the color pattern information into "class" information.

Imagine a scanned map having many shades of blue colors that represent water areas. In order to reduce the number of these different blue tone patterns, they will be gathered, then "classified" automatically and assigned as a single class with the color BLUE. At the end, this color will be given a title "nickname" to symbolize "water areas" in the map. Hence, now the color graphic information has been simplified, such as "blue" for water, "brown" for land, "green" for vegetation, "red" for streets, "black" for text, and so on.

To attain a proper automatic classification, you need to initially set the program to the colors you want to assign as these color group classes. This is done by assigning color probes from representative areas in the image. The program will then process and generalize this information to be used for the entire image. The operational steps are described as follows.

Color Classification

Menu: Raster ► Color, Function: Color Classification
CMD: VPCLASSIFICATION ► Dialog
Load a color or grayscale image and start this function. The **Classification** dialog appears:

There are 16 classes available. Each name and color of a class can be modified with **Modify Class**. The color of a class (target color) can be specified independent from the actual color to be classified.

These steps are required to run a classification process:

- **Pick Probes**: Link classes with areas of similar colors/color patterns in the image. Not all classes need to be applied.
- **Process Probes and Test Classification**: Test whether the selected probes cover all actual color areas in the image appropriately. Improve on results by adding or removing probes.
- **Run Classification**: The image will be converted according to selected probes and specified classes.

**Pick Probe**

![Pick Probe](image)

Click on a list item in **Classes** to activate a class. Depending on the active **Pick Probe** option the cursor will appear as a bucket symbol (Area) or as a pipette symbol (Line/Text).

Select probes for the active class by clicking on different color areas in the image or use window rectangle selection. Matching areas in the image will then be displayed in the active class color. If the picked probe is not appropriate for a specific class click the right mouse button to discard it or click on the button: **Remove Probe**

If you take more probes for a particular class, the classification quality can improve. This is especially important if color patterns vary in different areas. It is recommended that you do not reduce colors until you have completed classification of colors. This may improve on the color classification process.
Save Probes

Selected probes will be saved. You also can use these probes for other, structurally similar images.

Load Probes

Loads saved probes. Corresponding image areas will not be displayed.

**Process Probes, Test Classification**

Click on **Process probes** to generate a new classification according to the probes.

A hit rate will be calculated for each probe (in percentage). High percentages indicate that similar color areas may be classified in the image just as well. Low percentages indicate that probes do not cover color areas in the image appropriately. Probes with lower hit rates have a negative effect on the overall classification process. Thus, they should be removed and replaced by new probes taken from the image.

For each class and its probes, the minimum hit rate will be displayed in a list field (**Min.Hit Rate**). Check all classes and delete probes (**Remove Probes**) with low hit rates (<10-20%). Consider to pick and add new probes for better results.

The classification must be re-calculated (**Process Probes**) if probes have been added or removed.

Check the current classification setup by clicking on **Test Classification**. Now you can select a sample image area to test your classification setup. According to your results you can modify your setup for individual classes (delete and add probes). You can test several different sample image areas.

Click **Save Classification** to keep your results. You can now use this classification setup for other, structurally similar images (**Load Classification**).

**Test Areas**

Results of image test areas can be made visible/invisible (**Show on/off**) or deleted (**Clear**).

**Run Classification**

Click **OK** to run the **Classification** on the entire image. The dialog closes and the function is finalized. **Cancel** leaves the dialog without prompting to save a classification setup.
General Information

VPindex offers a wide range of CAD drawing functions. Each of them is supported by a set of Drawing Aids (see section 3) e.g. snapping, grid etc. All coordinates/values can also be entered via Command Line (see Section 3). Coordinate values can be entered absolute as x,y, relative as @x,@y; or relative as length and angle as d<phi. You can also mix absolute and relative values (e.g. @x,y or x,@y).

The last used coordinate/value is offered in the command line as <x,y> and can be taken over as is with [Return], or for editing with [Tab].

Raster Settings

All drawing functions can be executed in respect to the raster below (if any). This can be an immediate rasterization of the CAD entity, or a smart erase of the underlaying raster pixel structure.

The following functions allow for defining several drawing features. The functions are valid for any kind of raster image (b/w, gray scale, color).

Active Image only {on/off}

Menu: Edit, Function: Work only on Active Image

CMD: VPSIMAGE

When switched on the subsequent raster edit operations will only be executed on the Active Image.

Line Width

CMD: VPLINEWIDTH <X>

This function is only available if the active layer is set to the Line Width (Display) "By Entity". It defines the line width when drawing entities into the active layer. The display field indicates the actual line width.
The line width of an entity is determined by the layer where the entity resides. There are 3 possibilities:

- A particular width is assigned to a layer. This may be 0.0 or any other value.
- The width "By Entity" is assigned to a layer. The individually assigned width of each entity residing in this layer is active.
- The width "By Color" is assigned to a layer. The color of an entity determines the width (if the entity's color is set to "By Layer" it is the layer color).

See Section 4 (Layer Manager, Color Manager, etc.)

In the command line enter the value for the line width.

**Dynamic Width {on/off}**

Menu: *Edit*, Function: *Dynamic Width*
CMD: **VPDYNAMICWIDTH**

This function is only available if the active layer is set to a Line Width (Display) "By Entity". Setting Dynamic Width to on allows for automatically assigning the line width of the underlying raster entity where the draw command starts. This assigned line width remains fixed until a new width is detected. The detected line width is indicated in the line width field.

Due to the possible roughness of raster entities the Dynamic Width derived from an entity may differ by 1-2 pixels.

**Erase Raster Background {on/off}**

Menu: *Edit*, Function: *Erase Raster Background*
CMD: **VPERASERASTER**

When drawing Erase Raster can be used to erase the raster original in the background simultaneously.
This function can be only activated (set to on) if a raster image is available in the document.

With color or gray scale images the background will not be erased. Instead, the background pixels to be erased will be filled with the Background Color defined in Image Settings.

### Rasterize Online {on/off}

<table>
<thead>
<tr>
<th>Menu: Edit, Function: Rasterize Online</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD: VPRASTERIZEONLINE</td>
</tr>
</tbody>
</table>

This function can be only activated (set to on) if a raster image is available in the document. Then, drawn entities are rasterized immediately into the underlying raster using the assigned width. If the active layer has been assigned the "Rasterize" width setting "By Entity", the line width of the raster entity can be defined (functions Line Width, Dynamic Width) and is used for the rasterization. Otherwise the "Rasterize" width of the layer will be used.

The original drawn vector entity will be deleted.

With color or gray scale images the entities are rasterized in the color they have, or in the closest color available from the color palette.

### Erase Online {on/off}

<table>
<thead>
<tr>
<th>Menu: Edit, Function: Erase Online</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD: VPERASEONLINE</td>
</tr>
</tbody>
</table>

This function can only be activated (set to on) if a raster image is available in the document. Then, drawn entities are rasterized immediately similar to the function Rasterize Online. However, the rasterize entities will be erased from the underlying raster.

The original drawn vector entity will be deleted.

With color or gray scale images the "erase" entities are rasterized into the image with the background color defined in Image Settings.
CAD Options

Defines the default behavior of some/all CAD Tools

Menu: *Options*, Function: *CAD Options*

CMD: *VPDRAWOPTIONS* ➤ Dialog

A dialog box opens for selection and value input. The settings apply to all drawing functions.

**General Tab**

![CAD Options Dialog Box]

**Show Grips {on/off}**

If set to on the grips of all entities are displayed while drawing. This provides help for designing new entities by snapping to existing start, end, and center points.

**Zoom-in on First Click {on/off}**

If set to on the program zooms in on the first mouse click of a set point while in drawing mode for a more precise positioning (with the second mouse click).

**Zoom Factor** specifies the factor of zooming in from the current zoom state.

Default: **off**
Default Zoom Factor: **1 : 4**
Special Tab

![CAD Tools Settings](image)

Arrowhead

The length of a **Pointer Arrowhead** (Leader) and a **Dimension Arrowhead** can be defined. Values can be entered according to the selected drawing unit. The values only affect new entities.

**Defaults:** 3.0 [mm] or 0.1 [inch]

**Set to Nearest End Point (on/off)**

If set to **on** the **Pointing Arrowhead (Leader)** will be positioned at the nearest end of a selected line automatically (one click). Otherwise you have also to define the direction of the pointing arrowhead (two clicks).

**Default:** off

Text

Defines the procedure for creating text entities:

**Place Text then Enter String**  
First the insertion point and rotation is specified, then the text is entered.

**Enter String then Place Text**  
First enter the text, then specify the insertion point and rotation.

**Default:** Place Text then Enter String
Defines the settings to generate filled polygons.

Specify on Draw
While drawing a polygon a dialog will pop up to specify the fill pattern individually for each polygon to draw.

Fixed
All polygons will be created with the respective specified pattern.

Hatch Style
Select the fill pattern from a list of hatch styles.
The fields Opacity, Scale, Angle, and Spacing are available for editing depending on the selected style. There are three predefined Hatch Styles:

- **SOLID**
  - The edit field Opacity is available for entering a value from 0-100%

- **LINES**
  - The edit fields Angle and Spacing are available for specifying a line based fill pattern.

- **CROSSHATCH**
  - The edit fields Angle and Spacing are available for specifying a crosshatched fill pattern.

For all other Hatch Styles the edit fields Angle and Scale are available to rotate or stretch/squeeze the fill pattern.

Default: SOLID
Opacity: 50%
Scale: 1.0
Angle: 45°
Spacing: 1

Draw Border
When on the border lines of the polygon are drawn.

Default: on
Polyline Tab

![Polyline Tab Diagram]

As Multiline {on/off}

If set on a number of single 2-point lines will be generated instead of a polyline. Each line can be assigned to a different layer, color, or linetype while in drawing mode.

Default: off

Create Block from Polyline {on/off}

A block is created after drawing a polyline (or MPolyline or Rectangle). The block consists of the element and the attributes of a specified Prototype Block (the geometry of the latter will be ignored). A dialog appears to enter attribute details:

![Attributes Dialog]

Example: Prototype Block Area

The Prototype Block AREA will be offered as default. The block contains Parcel Number, Area (default value @area) and Circumference (default value @circumference). Default values will be filled automatically.

For more default value options with attributes see below: Create Block ► Attributes ► Attribute Definition Properties.

Default: off
Default Block Prototype: AREA
Allow Line Picking {on/off}

When activated existing lines or polylines can be picked, so that they also become part of a new polyline. Thus, these vertices will be doubled, belonging to the existing lines and to the new polyline.

Default: off

Insert Vertex in Underlying Line/Polyline {on/off}

If you draw a polyline and set a vertex on a underlying line or polyline, then this underlying entity will be edited automatically. It will receive an additional vertex at the same position as the new polyline. A line will be modified to a polyline.

In case the new polyline only crosses without setting a vertex then the underlying line/polyline will not be modified.

Default: off

⚠️ You can use only one of the two above options at a time!

Fixed Distance between two Vertices {on/off}

When on the next vertex can only be placed in a defined Distance from the previous one. This way you can digitize an underlying raster polyline with a predefined accuracy.

Default: off

Distance: 3.0 [mm] or 0.1 [inch]

MPolyline Tab

Distance

Define the Distance between the two borderlines of the MPolyline.

Default: 3.0 [mm] or 0.1 [inch]
Draw Center Line {on/off}

When on the Center Line of the MPolyline is also drawn. Also, a special Linetype for the Center Line can be specified.

Default: off
Linetype: By Layer

Filled {on/off}

When on the area between the two borderlines of the MPolyline will be drawn in the specified Color and Opacity.

Default: off
Color: By Layer
Opacity: 100%

Draw Line Caps {on/off}

When on flat Caps will close an MPolyline at start and end points.

Default: off

Draw Upper Line {on/off}

When off the upper border line of the MPolyline will not be drawn.

Default: on

Draw Lower Line {on/off}

When off the lower border line of the MPolyline will not be drawn.

Default: on

⚠️ The terms Upper Line and Lower Line are defined when drawing a line from left to right.
Stamp Tab

Defines settings for the **Stamp** function.

⚠️ To use the Stamp function blocks/block definitions are needed. Block definitions containing attributes can be filled with values automatically or manually depending on the name or the default value. See below in this section for more information on **Creating/Modifying Block definitions**.

**Stamp File**

The path and name of a file which is to be used as a stamp pattern. A sample file is provided in the VP support folder (**StampSample.rvd**).

The following settings are only relevant for stamp files containing block definitions with attributes:

**Values from an INI file**

Path and name of an INI file containing default values for a stamp block. The file **needs** to begin with the entry **[Stamp]**. The **Names** of the stamp block’s attributes follow, including the respective values in quotation marks:

\l<attribute name>"="<value>"\r

A sample file is provided in the VP support folder (**StampSample.ini**).

Default: on
Add Values Automatically

When on and depending on their Default value specific attributes of the stamp block will be assigned automatically.

<table>
<thead>
<tr>
<th>Default value of attribute</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>@UserName</td>
<td>Name of the registered user</td>
</tr>
<tr>
<td>@Date</td>
<td>Current date</td>
</tr>
</tbody>
</table>

For more default value options with attributes see below: Create Block ► Attributes ► Attribute Definition Properties

Default: off

Check/Edit Values

When on the stamp block’s attributes will be displayed in a dialog prior to the actual stamping. Also, at this stage attributes can be edited manually:

Default: off
Draw Functions

Drawing always occurs in the active layer, with the active line type and the active color. If the active line width and/or the color are set to "By Layer" the assignments of the active layer are used. Otherwise, the selected settings are displayed in the corresponding fields. (see Section 4).

Orthogonal Drawing

Activating the Ortho Snap or pressing the [Shift] key while executing a drawing command constrains the drawing direction to \( n \times 45^\circ \) of the coordinate system. Also, when Drawing Polylines additional segments will be drawn with orthogonal orientation in relation to the first line segment. The latter may be drawn without an orthogonal orientation. For example: draw a rectangle at any angle (Closed Polyline) and do not use the Ortho Snap in the first place. Instead, press the [Shift] key after drawing the first line.

Pixel

Menu: Vector ► Draw, Function: Pixel
CMD: VPDRAWPIX ► Toolbar

For freehand drawing or freehand erasing in a raster image.

Drawing Color: The color used for drawing (only for grey level or color images). The Color Manager opens on click.

Pick Color: Provides a direct selection of a drawing color with a click in an image (only for grey level or color images).

Pixel Size: Drawing width in pixel.
**Dynamic Width:** When active a drawing width will be assigned directly according to the raster structure (e.g. a line) picked in an image (only for b/w images).

**Draw Pixel:** Drawing with the selected Drawing Color (grey level or color images) or in the raster color (b/w images).

**Draw Pixel (Foreground Color):** Drawing with the defined foreground color in Image Settings (see Section 4) (grey level or color images) or in the raster color (b/w images).

**Erase Pixel:** Erasing pixel with the defined foreground color in Image Settings (see Section 4) (grey level or color images) or in the raster color (b/w images).

The [Tab] key allows for a fast switch between Draw and Erase functions. You can increase or decrease the pen width with [>] and [<] keys.

**Line**

Menu: Vector ► Draw ► Line, Function: Line

CMD: VPDRAWLINE <X1>, <Y1>, <X2|@X2>, <Y2|@Y2|°Y2>

Draws a 2-point line.

In the command line enter 4 coordinates or 2 coordinates (start point), and a relative coordinate (@X2, @Y2), or length (@X2) and angle (°Y2 or <Y2).

**Polyline**

Menu: Vector ► Draw ► Line, Function: Polyline

CMD: VPDRAWPOLY <X1>, <Y1>, <X2>, <Y2> [Xn, Yn, .....]

Draws a polyline with any number of vertices. Complete the polyline by double-clicking the left mouse button or press [Enter]. Close an open polyline by selecting the appropriate function from the context menu.

In the command line enter the coordinates of all vertices.
Closed Polyline

Menu: Vector ► Draw ► Line, Function: Closed Polyline
CMD: VPDRAWCPOLY <X1>, <Y1>, <X2>, <Y2> [<Xn>, <Yn>, ......]

Draws a closed polyline with any number of vertices. Complete the polyline by double-clicking the left mouse button or pressing [Enter].

Press and hold the [Shift] key to draw orthogonal vertices to a previous vertex in any orientation.

Press and hold the [Shift] and the [Ctrl] key after setting the first vertex to draw a 2-point orthogonal rectangle or, pressing and holding the [Shift] and the [Ctrl] key after setting the second vertex to draw a rectangle with any base direction.

MPolyline

Menu: Vector ► Draw ► Line, Function: MPolyline
CMD: VPDRAWMPOLY <X1>, <Y1>, <X2>, <Y2> [Xn, Yn, ......]

Draws a multi polyline with any number of vertices. Complete a multi polyline by double-clicking the left mouse button or press [Enter]. Close an open multi polyline by selecting the appropriate function from the context menu. The appearance of the multi polyline depends on the actual settings in CAD Options ► MPolyline.

At the command line enter the coordinates of all vertices.

Rectangle

Menu: Vector ► Draw, Function: Rectangle
CMD: VPDRAWPOLYRECT <X1>, <Y1>, <X2>@X2>, <Y2>@Y2>

Drawing a rectangle.

In the command line enter 4 coordinates, or 2 coordinates (first corner) and width, height (@X2, @Y2).
**Spline**

Menu: Vector ➤ Draw, Function: Spline

CMD: VPDRAWSPLINE <X1>, <Y1>, <X2>, <Y2> [<Xn>, <Yn>, ......]

Draws a B-Spline through the click points. Complete the Spline by double-clicking the left mouse button or pressing [Enter].

**Arc (3-point)**

Menu: Vector ➤ Draw ➤ Arc, Function: 3 Points

CMD: VPDRAWARC3POINT <X1>, <Y1>, <X2|@X2>, <Y2|°Y2>, <X3|@X3>, <Y3|°Y3>

Draws an arc through three points:

1st click point = start point arc
2nd click point = end point arc
3rd click point = arc curvature and direction

In the command line enter 6 coordinates or 2 coordinates (start point), and twice the distance (@X2), and angle (°Y2 or <Y2) of the second and third point from the previous point.

**Arc (4-point)**

Menu: Vector ➤ Draw ➤ Arc, Function: Center, Radius, Angles

CMD: VPDRAWARCCENTRAD <X>, <Y>, <R>, <Phi1>, <Phi2>

Draws counterclockwise an arc with a defined radius and length

1st click point = center
2nd click point = radius
3rd click point = start point arc
4th click point = end point arc

In the command line enter the coordinates of the start point, the radius, and the angles to the start and to the end point.
Arc (with tangential connections, only Windows)

Menu: Vector ► Draw ► Arc, Function: Tangent, Center  
CMD: VPDRAWARCTANGCENT <X1>, <Y1>, <X2|@X2>, <Y2|°Y2>, <X3|@X3>, <Y3|°Y3>

Draws an arc with tangential connections to 2 selected line ends. After selecting the two lines, radius, position and, if desired, lengthening or shortening of the lines, a third mouse click will complete the arc element. Pressing the [Shift] key creates orthogonal connections.

Circle (Radius)

Menu: Vector ► Draw ► Circle, Function: Center, Radius  
CMD: VPDRAWCIRCLECENTRAD <X>, <Y>, <R>

Draws a circle with center point (first click) and radius (second click).

Circle (2-point)

Menu: Vector ► Draw ► Circle, Function: 2 Points  
CMD: VPDRAWCIRCLE2POINT <X1>, <Y1>, <X2|@X2>, <Y2|°Y2>

Draws a circle through two points (= diameter).

Circle (3-point)

Menu: Vector ► Draw ► Circle, Function: 3 Points  
CMD: VPDRAWCIRCLE3POINT <X1>, <Y1>, <X2|@X2>, <Y2|°Y2>, <X3|@X3>, <Y3|°Y3>

Draws a circle through three points.
**Ellipse**

Menu: Vector ▶ Draw, Function: Ellipse

**CMD:** VPDRAWELLIPSE <X1>, <Y1>, <a>, <b>, <Phi>, <Phi1>, <Phi2>

Draws an ellipse with the origin (first click), the semi major axis (second click) and the semi minor axis (third click).

In the command line enter the center coordinates, the length of the "a" and the "b" axis, the angle <Phi> of the "a" axis, and the start and end angle of the ellipse. A full ellipse is drawn if Phi1 = 0 and Phi = 360.

**Filled Rectangle (WINDOWS only)**

Menu: Vector ▶ Draw, Function: Filled Rectangle

**CMD:** VPDRAWRECTANGLE <X1>, <Y1>, <X2|@X2>, <Y2|°Y2>

Draws a filled rectangle. If Polygon Tab Specify on Draw is selected in CAD Options, a dialog pops up by starting the command which allows to set the fill pattern for each rectangle individually.

**Opacity**

Indicates the opacity/transparency factor for the Hatch style SOLID. A 100% value indicates full opacity without any transparency.

**Default:** 50%

**Angle, Scale, Spacing**

A selected Hatch Style will be displayed according to these settings.
Alignment

A selected Hatch Style will be aligned in parallel or vertical according to the rectangle’s/polygon’s longest side line.

Default: Do not align

Polygon

Menu: Vector ► Draw, Function: Polygon
CMD: VPDRAWPOLYGON <X1>, <Y1>, <X2>, <Y2> [Xn, Yn, ......]

Draws a filled polygonal area with any number of vertices. If Polygon Tab Specify on Draw is selected in CAD Options, a dialog pops up by starting the command which allows to set the fill pattern for each polygon individually (see above).

Complete the polygon by double-clicking the left mouse button or press [Enter].

Press and hold the [Shift] key to draw orthogonal vertices to a previous vertex in any orientation.

Press and hold the [Shift] and the [Ctrl] key after setting the first vertex to draw a filled 2-point orthogonal rectangle or, pressing and holding the [Shift] and the [Ctrl] key after setting the second vertex to draw a filled rectangle with any base direction.

Text

Menu: Vector ► Draw ► Text, Function: Text
CMD: VPDRAWTEXT <X1>, <Y1>, <Text>, [Height], [W2H], [Phi], [Align]

Writes text in any orientation. After selecting this function, draw a line to determine the text start point (first click) and the direction. Use the [Shift] key for orthogonal placement. A dialog box appears for the text entry.
If the option Enter String then Place Text is selected the Special Tab of CAD Options, the following dialog will pop up immediately to enter the text. Then, you need to place the text.

A new text can be entered or a previously entered text can be selected from the list.

**Text Style**

Select the appropriate text style. All text styles defined in the Text Manager for this document are available.

**Default:** <active textstyle>

**h**

Text height value. When the selected text style has a defined height unequal to 0.0 this height will be displayed. Otherwise, the last used value is displayed.

**w/h**

Width/height text value ratio.

**Default:** < from text style>

**Align**

Text orientation according to the text insertion point.

**Default:** left
Angle

Text angle position.

Default: entered angle (drawn by line) or last angle (fix angle)

Fix Angle {on/off}

If set to on for the next text you just have to define a start position.

Multiline {on/off}

If set to on you can insert additional text lines with the specified spacing after the first text line has been entered and is displayed. Type the text string for each following line into the command line and confirm with [Enter]. End the text input function with [ESC].

Erase Raster Background {on/off}

If you want to replace text in a raster image you may need to erase the original raster text. In this case check this function on and select whether to use a rectangle or a polygon for erasing.

After clicking OK in the dialog you need to define the erase area first. Then, the new text will appear. With color or gray scale images the background will not be erased. Instead, the background will be filled with the Background Color defined in Image Settings.

In the command line enter values for start point and the text, and text height, width, angle, and alignment (optional). The erase background function is not available via command line.

Multiline Text

Menu: Vector ► Draw ► Text, Function: Multiline Text

CMD: VPDRAWMTEXT <X1>, <Y1>, <X1>, <Y1> ► Dialog

Draw a rectangle to specify the text area. The dialog opens for entering and formatting the multi line text:
Text Fonts

All available system fonts can be selected and assigned to the text string or to portions of it.

Text Height

Select the text and enter the desired text height via keyboard.

Line Distance

Defines the spacing between text lines with reference to the standard line distance.

Position

With reference to the specified text area (rectangle) you have multiple choices to position the multi line text.

Bold, Italic, Underline

These options allow for modifying the selected font.

Import Text

Allows to importing text from a file.

No Wrap

If on the entered text will not be wrapped according to the drawn rectangle (text area). Otherwise linefeeds will be added where possible (e.g. at spaces) to mach the text area as far as possible.

Dimension Arrow

Menu: Vector ▶ Draw ▶ Pointing (Leader), Function: Dimension
CMD: VPDRAWARROWDIM

Places a dimension arrow at the end of a dimension line (first selection), which intersects with or ends on an extension line (second selection). The arrowhead points to the second line. See CAD Options regarding arrowhead size.
Pointing Arrow

Menu: Vector ► Draw ► Pointing (Leader), Function: Pointing Leader
CMD: VPDRAWARROWPOINT

Places a pointing arrow on a line. The First mouse click selects the line where you want to place the arrowhead.

If in your CAD Option the checkbox Set to Nearest End Point is on the arrowhead will be directly placed at one of the ends of the line. Otherwise the Second mouse click determines the position of the arrowhead. See CAD Option regarding arrowhead size.

Point

Menu: Vector ► Draw, Function: Point
CMD: VPDRAWDONUT <X>, <Y>

Places a point element at the selected position. Point styles and sizes can be defined in a dialog:

Point Style

Choose a point style family from the combo box. Available are the *Default style, which contains only a filled donut as point style, the *ACAD style, which contains the AutoCAD typical point styles, and any True Type Font which is installed on the computer. Click one of the buttons below in the combo box to select the desired Point Style. The number of this Point Style is displayed beneath the Symb. Number.
Fonts...

A dialog pops-up which allows you to pre-select these point style families, which should be offered in the combo box.

Default: <all available fonts>

Elevation:

Specify the elevation (Z-Coordinate) for the point(s) to be inserted.

Default: 0.0

Size

Specify the Size of the Point in base units.

Default: 3.0

Absolute {on/off}

If set on the specified size is absolute, otherwise it is relative, which means the point is always displayed with the same size, regardless of the current zoom state.

Snap to Line/Intersection {on/off}

When on an automatic snap is active to lines and/or to line intersections which lay inside the cursor box of the click position while placing a point.

Default: on

Stamp

Menu: Vector ► Draw, Function: Stamp

CMD: VPSTAMP <X>, <Y>, [/XALIGN|XA <XALIGN>], [/YALIGN|YA <YALIGN>], [/INI|I <INI>], [/FILE|D|F <FILE>], [/BLOCK|B <BLOCK>], [/REVIEW|P|R]

Inserting a stamp into a document. If the stamp is defined as a block attributes can be assigned automatically or manually prior to the stamping process (e.g. user name, date, project name, etc.). The stamp will be rasterized immediately when any raster data is contained in the document.

Any file format supported by VPindex can be used as a stamp. For stamp blocks an INI file (text file) can be used which contains values for a block. Settings can be defined in CAD Options or via command line input. See also CAD Options - Stamp Tab above in this section.
Stamping may be set up via the command line as follows:

- **X, Y**
  - Insertion point of stamp block
  - Default: 0.0 / 0.0

- `/xAlign|xa <xAlign>`
  - x-alignment of stamp block according to document. Values for `<xAlign>`:
    - none: absolut coordinates
    - left: left aligned
    - right: right aligned
    - center: centered vertically
  - Default: none

- `/yAlign|ya <yAlign>`
  - y-alignment of stamp block according to document. Values for `<yAlign>`:
    - none: absolut coordinates
    - left: left aligned
    - right: right aligned
    - center: centered vertically
  - Default: none

- `/Ini|i <Ini>`
  - File containing values for stamp.
  - Default: see CAD Options

- `/File|d|f <File>`
  - File containing stamp block.
  - Default: see CAD Options

- `/Block|b <Block>`
  - Name of stamp block. When the stamp file contains several blocks a specific stamp block can be selected with `<Block>`.
  - Default: see CAD Options

- `/Review|p|r`
  - Check values before insertion.
  - Default: see CAD Options
Hatch (Fill)

Menu: Vector ► Hatch, Function: Hatch
CMD: VPMAKEHATCH ► Dialog

After selecting this function, a dialog pops up to specify a hatch style and a creation mode.

Hatch Style
Select a fill pattern from the list of hatch styles.

The fields Opacity, Scale, Angle, and Spacing are available for editing depending on the selected style. There are three predefined Hatch Styles:

- SOLID: the edit field Opacity is available for entering a value from 0-100%
- LINES: the edit fields Angle and Spacing are available to specify a line based fill pattern.
- CROSSHATCH: the edit fields Angle and Spacing are available to specify a crosshatched fill pattern.
For all other **Hatch Styles** the edit fields **Angle** and **Scale** are available to rotate or to stretch/squeeze a fill pattern.

**Default:** SOLID  
**Opacity:** 50%  
**Scale:** 1.0  
**Angle:** 45°  
**Spacing:** 1.0

**Creation Mode**

**Select Border:** Select the bordering lines of the desired area in sequence. Pressing [Enter] or Create creates the hatch inside the borders according to the **Hatch Style** settings. Selected text strings inside the borders will be isolated from the hatch.

A warning pops up in case the hatch area is not completely enclosed by bordering lines

**Pick Area:** Pick into the desired area which is enclosed by existing vector entities. The hatch inside the borders will be created according to the **Hatch Style** settings.

A warning pops up in case a completely enclosed hatch area cannot be computed from the pick point.

**Show/Hide Style List**

Switches the preview of the available **Hatch Styles** on/off.

**Edit Hatch**

**Menu:** Vector ► Hatch, Function: Edit Hatch  
**CMD:** VPHATCHEDIT

Select the hatch to edit its entities. Depending on the type of the selected hatch different edit modes are available.

If the selected hatch was created by several lines with the **Combine to Hatch** function (see section 9) or it was created by an automatic **Raster to Vector Conversion** (see **Section 13**), the following toolbar appears and the selected hatch appears highlighted.
Select **Add Lines**, **Remove Lines**, or **Edit Lines** and select then the appropriate lines. Finish editing with **End Edit** or **[Return]**. Then select the next hatch to edit. Leave the command with **[ESC]**.

If the selected hatch was created by the **Hatch** command or by the **Draw Rectangle, Draw Polygon** command the **Hatch** dialog appears (see before) to specify another hatch style / fill pattern.

### Hatch Style Manager

Menu: **Vector ➤ Hatch**, Function: **Hatch Style Manager**

**CMD:** VPHATCHSTYLEMANAGER

A dialog pops up and displays a list of all available **Hatch Styles**.

**Load from File…**

Opens an **File Open** dialog to specify a *.*PAT file. VPindex supports the import of AutoCAD compatible hatch pattern files.

**Show/Hide Style List**

Switches the preview of the available **Hatch Styles on/off**.
Make Corner

Menu: Vector ► Edit, Function: Make Corner
CMD: VPCORNER ► Select 2 Entities

The end points of two selected entities (line, polylines, arcs) are lengthened or shortened to form a corner. Click-select each of the two entities close to the end to be modified.

An error message appears when it is impossible to execute this function.

Trim

Menu: Vector ► Edit, Function: Trim Elements
CMD: VPTRIM ► Select Entities

Trims entities to cutting edges.

Select the cutting edges (lines, polylines, arcs, circles, and ellipses) and confirm the selection with [Enter]. The selected entities appear highlighted.

Now, click an entity to trim at the next intersection with the edges. The click point defines the part of the entity to be removed. If this part lies between two cutting edges then this segment will be deleted and the entity will be transformed into two entities.

Pressing [CTRL] while selecting an entity, having no intersections with the cutting edges, extends the edges to find additional intersections.

Pressing [SHIFT] while selecting an entity, switches to the Extend mode and extends the entity to the next cutting edge instead of trimming it.

End the function with [Enter] or select End Command from the context menu.

An error message appears when it is impossible to execute this function.
**Extent**

Menu: **Vector ▶ Edit**, Function: **Extent Elements**
CMD: **VPEXTENT ▶ Select Entities**

Extends entities to boundary edges.

Select the boundary edges (lines, polylines, arcs, circles, and ellipses) and confirm the selection with [Enter]. Now, click on an entity for extension to the next boundary edge. The click point defines the part of the entity to be extended.

Pressing [CTRL] while selecting an entity having no intersections with the boundary edges, extends the edges to find additional intersections.

Pressing [SHIFT] while selecting an entity, switches to the Trim mode and trims the entity to the next intersection with the cutting edges.

End the function with [Enter] or select **End Command** from the context menu.

An error message appears when it is impossible to execute this function.

**Auto Trim**

Menu: **Vector ▶ Edit**, Function: **Auto Trim**
CMD: **VPAUTOTRIM ▶ Select Entities**

Adjusts entities to boundary/cutting edges.

Select the boundary/cutting edges (lines, polylines, arcs, circles, and ellipses) and confirm the selection with [Enter]. Select one or more entities to adjust them to the boundary/cutting edges. If an entity can be trimmed as well as extended, the mode causing the smallest modification will automatically be used.

Pressing [CTRL] while selecting an entity having no intersections with the boundary/cutting edges, extends the edges to find additional intersections.
End the function with [Enter] or select End Command from the context menu.

An error message appears if it is not possible to execute this function.

**Cut**

Menu: Vector ► Edit, Function: Cut Element
CMD: VPCUT ► Select Entities

Cuts an entity into two new entities.

Select an entity (line, polyline, arc, circle). Specify the cutting point by clicking on the entity or by selecting a reference object.

**Break**

Menu: Vector ► Edit, Function: Break Element
CMD: VPBREAK ► Select Entities

Breaks an entity at two points and remove the section in between.

Select an entity (line, polyline, arc, circle) by clicking it. This first click point also defines the first break point. Specify the next point to break the entity into two and erase the section in between.
Blocks (Windows only)

General Information

In the following sections, the distinction between a block definition and a block should be well understood:

- A **block definition** defines the geometric structure of a block as well as the number and types of its attributes. A block definition is unique and part of the document, but it is not visible in the displayed drawing.

- A **block** is a reference to a block definition (= the image of a block definition) at a given position. It can be rotated and scaled (isotropic and non-isotropic). Any number of blocks of a block definition can be inserted in a drawing.

- **Blocks** can be composed of vectors and/or raster elements/objects. However, all elements (vectors and raster elements) of a block are referenced as vectors. If an inserted block is rasterized, all block elements will be rasterized.

Selected elements can be combined to a block. Create a new block from previously selected elements by using the **Combine to new Block** command. In addition, you can import block definitions (**Import - DXF/DWG**) that have been created in a CAD system. These block definitions become part of the document and blocks can be placed at any location using **Insert Block**. If you plan to use the block definition(s) for other documents, we recommend to save the block definition(s) to the **prototype drawing**. This way, the block definition becomes available when you use the prototype drawing (**Options ► System Settings ► Tab Files/Paths**).

For preparing a new prototype drawing containing block definitions loaded from external DWG/DXF files just import the file(s) and then save the new drawing in RVD format under a name of your choice. If this file is used as a prototype drawing, the block definitions become permanently available.

To achieve the same effect with block definitions that are created from drawing elements via **Create Block**, delete all drawing elements (raster and vectors including all blocks) and then save the "empty drawing" as described above. If you want to add additional block definitions to an existing prototype drawing, start with the prototype drawing (click on **New**). Then, create or load blocks, erase them, and save the "empty drawing/document" as a new RVD file.

**Attributes** can be assigned to a block definition. The procedure and functionality are similar to AutoCAD. Assignment of attributes is especially important for the **Symbol Search** function, since replacing the found symbols by a block allows for assigning symbol text strings to attributes.
Create Block

Menu: Vector ▶ Block, Function: Create Block
CMD: VPMAKEBLOCK ▶ Select Entities ▶ Dialog

Creates a new block definition from the selected elements and inserts a block at the position of the selection. A dialog opens to specify the block definition:

Dialog in advanced display

Block definition Properties

Name

Name of a new block definition. A warning message appears if the name already exists or if the entry is left empty.

Default: Block001
Base Point

The insertion point of a new block definition. The default position is the geometric center of all selected elements. With Pick you can set the insertion point to a new position by clicking in the drawing.

Change Color of Members to ByBlock

If this parameter is enabled, all elements will be displayed in the color of the inserted block. If switched off all members keep their own colors.

Default: off

Attributes

Open/Close the dialog with an advanced display for editing attribute definitions (see below).

Text / Attribute Definitions

Attribute definitions can be converted from existing text, or they can be added from scratch. Available text and new attribute definitions are listed in the table’s upper right. Text and attribute definition properties of a selected entry will be displayed in the respective fields and can be modified (see below).

Selected attribute definitions or text are highlighted with grips in the preview window. They can be moved, rotated, and scaled in size.

Convert selected Text to Attribute Definition

A green checkmark (✓) indicates a selected text to be converted to an attribute definition. The mark can be set and deleted in different ways:

- Select/De-Select the option Convert selected Text to Attribute Definition.
- Double click on a text entry.
- Single click on the first column (green checkmark) of a text entry.

On creation of a block definition all checkmarked text will be replaced by attribute definitions.
New Attribute Definition

- Inserts a new attribute definition. New attribute definitions will always be checkmarked, A de-
  selection is not available.

- Deletes a new attribute definition. Text cannot be deleted.

Change Order

These buttons allow for moving table entries up and down.

Attribute Definition Properties

- Active only when a new attribute definition or text to be converted has been selected.

  Name A name of an attribute definition may only be used once per block definition. A warning
  message appears on double naming.

  Prompt Is displayed upon block insertion. The name will be displayed when left empty,

  Default Preset attribute value upon block insertion. Default values can be selected and
  assigned from a list:

  @Circumference Calculates and sets the circumference of the block as attribute value
  @Area Calculates and sets the area of the block as attribute value
  @Angle Assigns the insertion angle of the block as attribute value
  @Y-Position Assigns the y-coordinate as attribute value
  @X-Position Assigns the x-coordinate as attribute value
  @Name Assigns the name of the block as attribute value
  @User Assigns the Windows user name as attribute value
  @Date Assigns the current date as attribute value

Mode

  Invisible Attribute will not be displayed in an inserted block
  Constant attribute value cannot be edited or positioned in a block
  Verify AutoCAD Flag: here, no significance
  Preset AutoCAD Flag: here, no significance

Basic Properties (Text Properties)

You can modify text specific properties of a selected attribute definition or of a selected text:
Textstyle, Layer, Color, Align, Angle, Height, Width.
Combine to (Existing) Block

Menu: Vector ▶ Block, Function: Combine to Block
CMD: VPCOMBINEBLOCK ▶ Select Entities ▶ Dialog

Replaces the selected elements with a block which references a specified, already existing block definition. A dialog opens to specify the block properties.

Selected elements will be grayed in the preview display. See the selected block definition displayed above. With the block definition's grips you can move, rotate, or scale it in size.

Name

Name of the selected block definition. Other block definitions can be selected from a list. The last block definition applied is offered by default.

Attributes

Attribute definitions of the selected block definition. When a selected text element is underlaying an attribute definition, this will be assigned as an attribute value. If no text can be assigned the attribute definition’s default value will be used. Click on the value for desired changes.

Insertion Point

Insertion point of the new block. The geometric center point of selected elements is offered as default. With Specify on screen you can place the new block with the mouse after OK.
Scaling

Scaling of the new block. An isotropic scaling of 1.0 is offered as default. With Specify on screen you can scale the block with the mouse after OK.

Adjust Block Size to Selection

The block size is adjusted automatically to the overall size of selected elements.

Default: off

Rotation

Rotation angle of the new block. 0.0 degrees are offered as default. With Specify on screen you can rotate the block with the mouse after OK.

Block Properties

Layer and Color of the new block. Currently active settings are offered as default.

Modifying Block definitions

Menu: Vector, Function: Block definitions

CMD: VPSHOWBLOCKDEFS ➤ Dialog

Opens a dialog showing all block definitions of the current drawing and provides several functions for modifying one or more selected block definitions.

Show hidden Block definitions

Block definitions with a name starting with * (formerly used for hatching, measuring, etc.), will be displayed or hidden.

Default: off
Delete

Deletes one or more selected block definitions. If the drawing contains blocks referring to one of the selected block definitions a dialog will appear with options to proceed as required.

**Delete Blocks** Referenced blocks will be deleted from the drawing.

**Explode Blocks** Referenced blocks will be exploded, i.e. block elements will be inserted in the drawing while the block will be deleted.

**Skip / Continue** The current block definition will not be deleted. The process continues with the next selected block definition.

**Cancel** No further block definitions will be deleted.
Exchange

All blocks of the document referring to this block definition can be changed to another block definition which you can choose in the dialog.

Previous values will be assigned to attributes bearing the same name. All other attributes receive the new definition's default values.

Offset

Moves a block's base point according to the entered value.

Default: No offset

Scaling

A new block can be inserted with the original scaling of the former block, or it can be assigned an additional or a new scaling.

Default: Original scaling

Rotation

A new block can be inserted with the original rotation of the former block, or it can be assigned an additional or a new rotation.

Default: Original rotation
Modify

Applies to a single block definition. Opens a dialog to modify the insertion point and attribute definitions:

Base Point
The coordinates display x/y values which refer to the block definition’s geometric center. 0.0/0.0 indicate a base point in the block definition’s center point. Values can be modified directly. With the option Move Base Point you can move the base point on a grip with the mouse.

Attribute Definitions
Available attribute definitions can be modified or deleted. New attribute definitions can be added.

New Attribute Definition Creates a new attribute definition. If the drawing contains blocks which are referenced with this block definition, new attributes will be added to these blocks, including their default values.

Delete Attribute Definition Deletes the selected attribute definition. If the drawing contains blocks which are referenced with this block definition, the respective attributes will be deleted from these blocks.

Change Position Move a marked entry up/down in the table list.
Attribute Definition Properties

See above: Create Block ► Attribute Definitions ► Attribute Definition Properties.

General Text Properties

You can modify text specific properties of a selected attribute definition or of a selected text: Textstyle, Layer, Color, Align, Angle, Height, Width.

Rename

Renames the selected block definition(s):

A New Name will be assigned on OK. If the name is already in use a respective message appears to enter a unique name.

Copy Block Definition

Copies a selected block definition:

Enter a name for a new block definition. If the name is already used in the current document a message appears to enter new name.
Review

This functions allows for checking the attributes of all blocks of the selected block definition. A message appears if the block definition does not contain attribute definitions. The function zooms to the first block of that block definition and opens this dialog:

![Dialog](image)

Use **Previous** and **Next** to go through all blocks. You can modify the currently displayed attributes or **Explode** the block.

Insert Block

Menu: **Vector ► Block**, Function: **Insert Block**

**CMD:** VPINSERTBLOCK ► Dialog

**CMD:** VPINSERTBLOCK <Name> <X> <Y> [/xs|xScale <value>] [/ys|yScale <value>] [/a|Angle|phi <value>]

Inserts one or multiple block(s). This function is only available if block definitions are contained in the current document.
Dialog **Insert Block** with expanded block preview:

Select a block from the list (**Name**) or click a thumbnail to select from the preview. The selected block will be displayed in the preview.

A block’s **Insertion Point**, **Scaling** and **Rotation** can be readily assigned or you can specify settings on screen (**Specify on Screen**).

With **OK** the dialog closes and the block will be inserted. A second dialog will open to enter attribute values if the selected block contains attributes.
The selected block is positioned (insertion point) or attached to the cursor for placement (specify on screen) directly. If you have selected Specify on Screen for the Insertion Point, again the attribute dialog will pop-up for the next block and/or the next block is again attached to the cursor for placement (repeat mode).

Select another Block (from dialog: Attributes, or from: context menu) will interrupt the repeat mode, and you can select another block for insertion.

Finish the function with [Esc].
SECTION 9
HYBRID EDITING TOOLS

General Information

With VPindex the formerly sharp line between raster and vector vanishes.

Clicking on (picking) a "line" - regardless if it is a vector or a raster line as part of a raster structure - this "line" is highlighted as an individual entity. It receives grips for moving, copying, rotating, stretching, or whatever is required. In the properties dialog the entity is indicated as a "line", including specific features (layer, color, width).

VPindex allows for editing raster and vector entities in the same way. While using the hybrid functions you will almost forget about the difference between the raster and the vector world. Still, there are some differences to note:

- Vector entities are usually drawn with 0.00 width and may receive a width while they are printed/plotted (according to the layer settings "Print"). Raster entities always have a width assigned to them, even a width 0.00 is interpreted as 1 pixel width.
- When you select raster entities (pick, window, or crossing) they are temporarily converted into vectors (having assigned the width of the raster). Later, after finishing an edit command, the entities will be rasterized back into the image.
- If you modify the properties of a "raster" entity it remains a vector with a width assigned. It needs to be rasterized (right mouse menu) if you want it to become a raster entity again. However, you may leave it as a vector anyway.
- If you assign a vector layer to a raster entity (by modifying the properties) it will receive the width of this layer (usually 0.00). It now appears as any other vector entity residing in that vector layer.
- You can mix raster and vector entities/objects in the same layer if you define the layer width "By Entity".
- To rasterize selected vector entities the rasterize settings of the relevant vector layers have to be adjusted.

The standard right mouse menu, containing editing commands offers these functions (the menu structure may vary, depending on which particular functions are currently used):

<table>
<thead>
<tr>
<th>End Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Raster...</td>
</tr>
<tr>
<td>Delete Entity(s)</td>
</tr>
<tr>
<td>Move</td>
</tr>
<tr>
<td>Rotate</td>
</tr>
<tr>
<td>Split</td>
</tr>
<tr>
<td>Copy</td>
</tr>
<tr>
<td>Properties...</td>
</tr>
<tr>
<td>Make Entity(s) (Cut)</td>
</tr>
<tr>
<td>Make Entity(s) (Copy)</td>
</tr>
<tr>
<td>Rasterize...</td>
</tr>
<tr>
<td>Cancel Menu</td>
</tr>
</tbody>
</table>
Raster Text

Menu: Edit, Function: Raster Text
CMD: VPRTEXT ➤ Dialog

Provides direct editing of text in raster images.

Text can be selected by rectangle selection (rotated or non-rotated) and is transferred to the OCR (text recognition). A dialog appears displaying the recognized text in a preview window. In the preview window the text can be adjusted (move, rotate, scale) directly according to the raster image. Also, text properties and output mode can be defined.

Recognized text is displayed and can be edited in the Text field.

Special characters (if configured) are directly accessible pressing this button or via the keys [Alt+1] thru [Alt+9] and [Alt+A] thru [Alt+O].

Start Point
The text insertion point (lower left corner) in the document.

Angle, Height, Text Style, Layer, Color, Alignment
Options defining text properties.

Lock / unlock Value
Locked values remain unchanged with continuous use of the Raster Text function. This will e.g. result in creating text with a uniform height value.

New Selection
Closes the dialog and cancels the current selection. Use this function to select a new raster text due to a previous wrong selection.
Output Tab

Defining the text insertion mode:

<table>
<thead>
<tr>
<th>Properties</th>
<th>Output</th>
<th>Selection Mode</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Vector Text</td>
<td>New text will be inserted as vector text</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default: on</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Rasterize Text

New text will be inserted and rasterized.

Default: on

Adjust Text on OK

When **on** text will be inserted with grips and can be adjusted (move, rotate, scale). The action terminates with [Return] or with a right mouse click and End Command. Text will be inserted according to the defined options.

Default: off

Erase Raster Background

When **on** the selected raster will be erased **before adjusting text** or **after adjusting text**.

Default: on, after adjusting text
Selection Mode Tab

Defining how to select raster text:

![Selection Method for Raster Text](image)

**2-Point Rectangle**

Best for non-rotated text. A rectangle will be drawn with two points (start point, opposite corner). The text angle is 0°.

Default: off

**3-Point Rectangle**

For rotated and non-rotated text. A rectangle will be drawn with three points (start point, angle, and height). Text angle is defined by the rectangle’s angle. With holding the [SHIFT] key the angle input is limited to steps with 45°; a temporary switch to 2-Point Rectangle selection is provided with holding the [CTRL] key

Default: on

Switching between selection modes is provided via the context menu (right mouse).
Display Tab

Defining display options for the preview window:

![Display Tab settings](image)

**Display New Text In Window**

When on the original raster and new text will be displayed in the preview window.

**Default:** on

**Use Default Text Color**

When on new text will be displayed in the default color. Changes to the color with **Change**. When off new text will be displayed according to the settings in **Properties**.

**Default:** off

**Opacity**

Defines the opacity level of new text displayed in the preview window.

**Default:** 50%

**OK** inserts new text according to the selected modes.
Search Raster Symbols

Menu: *Edit*, Function: *Raster Symbols*

CMD: VPRSEARCH ➤ Dialog

Searching for symbols or structures in a raster image defined by their size. Elements detected can be transferred into a new raster image or they can be converted into polylines.

After starting the function the following dialog appears to set up options for Raster Symbol Search:

**Symbol Size**

Defining the search for elements by their **Min. Size** and **Max. Size** in user units.

**Default:**
- 0.0 User Units (Min. Size)
- 5.0 User Units (Max. Size)

**Extract To New Raster Image**

All elements detected will be transferred to a new raster image. The extents of the new image correspond with the size of the original raster image. The new image will be placed on the target layer.

**Default:** on
Vectorize Outline

The contours of each element detected will be converted into polylines. Polylines will be placed on the target layer.

Default: off

Erase Symbol From Raster

Elements detected will be deleted from the original raster image.

Default: on

Transfer Results to Layer

Target layer for the new raster image or for polylines created.

Default: Layer 0

Search Area

Defining the search area in the original raster image. With options Rectangular Area and Polygon Area the respective area can be defined after OK.

Default: Whole Drawing

Review Results

When switched off all elements detected will be processed immediately (new raster image or conversion into polylines).

When switched on all elements detected will appear in a green color display. Elements can be excluded by window selection; they may be included again by holding the [SHIFT] key during window selection. Processing continued with [RETURN].

Default: off
Edit Object(s)

Move

Menu: Edit ➤ Edit Object(s) Function: Move

CMD: VPMOVE

Activate this function and select the entities/objects you want to move. Confirm the selection with [Return]. You may also select the entities/objects first and then call the function. For object selection, use the function Select Raster from the context menu (right mouse click).

First, a base point needs to be specified by clicking or entering at the command line. Alternatively, you can switch to Relative mode with R. Elements/objects will then be attached to the cursor and can be moved together to a new position. For precision moving see Section 3, Command Line, Entering Coordinates.

Raster entities are cut out of the raster image. Intersections with other entities will be filled.

Vector entities can be rasterized on the fly into the active image using the context menu function Rasterize.

Raster entities can be vectorized into the active vector layer using the Make entity(s) function from the context menu.

Copy

Menu: Edit ➤ Edit Object(s) Function: Copy

CMD: VPCOPY

Activate this function and select the entities/objects you want to copy. Confirm the selection with [Return]. You may also select the entities/objects first and then call the function. For object selection, use the function Select Raster from the context menu (right mouse click).

First, a base point needs to be specified by clicking or entering at the command line. Alternatively, you can switch to Relative mode with R. Elements/objects will then be attached to the cursor and can be copied together to a new position. For precision copying see Section 3, Command Line, Entering Coordinates.

Vector entities may be rasterized on the fly into the active image using the context menu function Rasterize.
Delete Entities

Menu: *Edit ➤ Delete* Function: *Delete Entities*
CMD: VPDELETE

Deletes the selected entities. You can also use [DEL] on your keyboard.

Explode Entities (Origin)

Menu: *Edit* Function: *Explode Entities*
CMD: VPEXPLODE

Breaks up the structure of the selected elements. Blocks, Hatch, Polylines, Splines, and Text are exploded and separated into their composing base elements. This allows for corrections of misinterpretations resulting from a vectorization.

Scale

Menu: *Edit ➤ Edit Object(s) Function: Scale*
CMD: VPSCALEENT

Activate this function and select the entities/objects you want to scale. Confirm the selection with [Return]. You may also select the entities/objects first and then call the function.

For raster selection, use the function *Select Raster* from the context menu (right mouse click). Define a base point. Then, dynamically scale the entities to the desired size.

Raster entities are cut out of the raster image. Intersections with other entities will be filled.

Vector entities can be rasterized on the fly into the active image using the context menu function *Rasterize*.

Raster entities can be vectorized into the active vector layer using the *Make entity(s)* function from the context menu.
Rotate

Menu: Edit ► Edit Object(s) Function: Rotate
CMD: VPROTATEENT

Activate this function and select the entities/objects you want to rotate. Confirm the selection with [Return]. You may also select the entities/objects first and then call the function. For raster selection, use the function Select Raster from the context menu (right mouse click). Define a base point. Then, dynamically rotate the entities to the desired position.

Raster entities are cut out of the raster image. Intersections with other entities will be filled.

Vector entities can be rasterized on the fly into the active image using the context menu function Rasterize.

Raster entities can be vectorized into the active vector layer using the Make entity(s) function from the context menu.

Mirror

Menu: Edit ► Edit Object(s) Function: Mirror
CMD: VPMIRRORENT

Activate this function and select the entities/objects you want to mirror. Confirm the selection with [Return]. You may also select the entities/objects first and then call the function. For raster selection use the function Select Raster from the context menu (right mouse click). You are prompted to specify a mirror axis. Either draw a line with two points or select an existing line (command line option [s]). When the mirror operation is completed you are prompted to keep or delete the original objects (only valid for original vector objects).

Array

Menu: Edit ► Edit Object(s) Function: Array
CMD: VPARRAYENT

This function allows a multiple copy and positioning of raster and/or vector entities in a rectangular or circular order.

Activate this function and select the entities/objects you want to array. Confirm the selection with [Return]. You may also select the entities/objects first and then call the function. For raster selection, use the function Select Raster from the context menu (right mouse click).
A dialog pops up for specifying the array structure:

**Array**

**Rectangle**

The selected entities will be arranged on a rectangular grid.

**Row**

Specify the number of **rows** and the **Offset** between each array entity.

- Default: 1
- Default Value: 1.0 [mm]

**Column**

Specify the number of **columns** and the **Offset** between each array entity.

- Default: 1
- Default Value: 1.0 [mm]

**Orientation**

Choose between:
- upwards to the left
- downwards to the left
- upwards to the right
- downwards to the right

- Default: upwards to the left

**Angle of Array**

The angular orientation of the array (not the array entities!) to the grid.

- Default: 0.0°
Polar
The selected entities will be arranged along an imaginary circle.

Center Point
The center point of the imaginary circle.

Total number of objects
The number of additional entities (plus one for the original selection) to be arranged.
Default: 1

Angle to fill
Specify the angle of the imaginary circle. Entities will be positioned alongside accordingly.
Default: 360° (full circle)

Arrange objects with rotation {on/off}
The copied objects will be rotated around their center point according to their position on the imaginary circle.
Default: on

Offset

Menu: Edit ➤ Edit Object(s) Function: Offset
CMD: VPOFFSETENT

This function allows to copy Raster and/or vector entities such as lines, arcs, circles, and ellipses and to position the copied entities parallel to their original(s) with a specified distance.

Activate this function and select the entities/objects you want to copy with an offset. Confirm the selection with [Return]. You may also select the entities/objects first and then call the function. Then, specify with two clicks the distance (the offset) between the original(s) and the later position of the copied entities. With a third click you determine to which side of the original entities the copies should be placed.
Combining Elements

These functions allow you to combine selected entities (raster or vector) to form a complete, or even a new entity. These functions can be applied to raster or vector entities particularly generated by the vectorization process, as well as to manually drawn entities.

In this sense, "to combine" means to group entities, for example, two or more lines segments to form a single line or a complete single arc. Due to a poor original or inaccurate drawing, the vectorization process may often result in broken lines, several arcs fractions instead of a circle, etc. Using the Combine to commands, clean-up can be accomplished easily, quickly and at high precision.

If several entities are combined to create a new entity, the new entity is calculated according to the method of the least square error. For example, the outer end points of two lines being joined are not necessarily identical to the endpoints of the new line.

If entities with differing properties (e.g. layer or line type) are combined, the properties of the resulting object are determined by the dominant (i.e. largest) entity.

There are two basic methods for combining entities:

- Select the entities first, then click on the function icon (single call).
- Select the function by clicking on the icon, then select the entities and complete the function by pressing [Enter]. The function remains active for subsequent operations (multiple call).

Combine to Line

Menu: Vector ► Combine to, Function: Line
CMD: VPCOMBINETOLINE ► Select Entities

Combines the selected entities to a single line. The angle of the resulting line is the mean angle of the combined entities. Arcs can be combined to lines as well.

Combine to Orthogonal Line

Menu: Vector ► Combine to, Function: Orthogonal Line
CMD: VPCOMBINETOOORTHOLINE ► Select Entities

Combines the selected entities to an orthogonal line. This function can be used to deskew individual and non-orthogonal lines.
Combine to Polyline

Menu: Vector ➤ Combine to, Function: Polyline
CMD: VPCOMBINETOPOLYLINE ➤ Select Entities

Combines the selected entities to a polyline. Use this command to combine individual polyline segments (e.g. on a map) to a single polyline.

Combine to Closed Polyline

Menu: Vector ➤ Combine to, Function: Closed Polyline
CMD: VPCOMBINETOCLOSEDPOLYLINE ➤ Select Polyline

Combines the selected entities to a closed polyline or closes a selected polyline.

Combine to MPolyline

Menu: Vector ➤ Combine to, Function: MPolyline
CMD: VPCOMBINETOMPOLYLINE ➤ Select Elements

Links selected elements to a multi-polyline. Other elements than lines will be exploded in raw vectors first. The command allows for combining single polyline fragments (e.g. in maps) to a multi-polyline.

Combine to Closed MPolyline

Menu: Vector ➤ Combine to, Function: Closed MPolyline
CMD: VPCOMBINETOCLOSEDMPOLYLINE ➤ Select Elements

Links selected elements to a closed multi-polyline or closes a selected multi-polyline.
Combine to Polygon

Menu: Vector ▶ Combine to, Function: Polygon
CMD: VPCOMBINETOPOLYGON ▶ Select Entities

Combines the selected entities to a polygon. Use this command to combine individual polygon entities (e.g. on a map) to a single polygon.

Combine to Spline

Menu: Vector ▶ Combine to, Function: Spline
CMD: VPCOMBINETOSPLINE ▶ Select Entities

Combines the selected entities to a B-spline.

Combine to Closed Spline

Menu: Vector ▶ Combine to, Function: Closed Spline
CMD: VPCOMBINETOCLOSEDSPLINE ▶ Select Entities

Combines the selected entities to a closed B-spline or closes a selected spline.

Combine to Arc

Menu: Vector ▶ Combine to, Function: Arc
CMD: VPCOMBINETOARC ▶ Select Entities

Combines selected entities to an arc.

Combine to Circle

Menu: Vector ▶ Combine to, Function: Circle
CMD: VPCOMBINETOCIRCLE ▶ Select Entities

Combines selected entities to a circle.
Combine to Ellipse

Menu: Vector ▶ Combine to, Function: Ellipse

CMD: VPCOMBINETOELLIPSE ▶ Select Entities

Combines selected entities to an ellipse.

Combine to Elliptical Arc

Menu: Vector ▶ Combine to, Function: Elliptical Arc

CMD: VPCOMBINETOELLIPTICALARC ▶ Select Entities

Combines selected entities to a partial ellipse.

Combine to Text (Interactive Text Recognition)

Menu: Vector ▶ Combine to, Function: Text

CMD: VPCOMBINETOTEXT ▶ Select Entities ▶ Dialog

Processing selected raster or vector elements with text recognition. A dialog appears displaying the recognized text in a preview window. In the preview window the text can be adjusted (move, rotate, scale) directly according to the raster image. Also, text properties and output mode can be defined.

Recognized text is displayed and can be edited in the Text field.
Start Point
The text insertion point (lower left corner) in the document.

Angle, Height, Text Style, Layer, Color, Alignment
Options defining text properties.

Lock / unlock Value
Locked values remain unchanged with continuous use of the *Combine to Text* function. This will e.g. result in creating text with a uniform height value.

Flip
Rotates the selection by 180° and starts recognition process again.

New Selection
Closes the dialog and cancels the current selection. Use this function to select a new raster or vector text due to a previous wrong selection.

Output Tab
Defining the text insertion mode:

Create Vector Text
The new text will be inserted as vector text.
Default: on

Rasterize Text
New text will be inserted and rasterized.
Default: on
Adjust Text on OK

When on text will be inserted with grips and can be adjusted (move, rotate, scale). The action terminates with [Return] or with a right mouse click and End Command. Text will be inserted according to the defined options.

Default: off

Erase Raster Background

When on the selected raster will be erased before adjusting text or after adjusting text.

Default: on, after adjusting text

For Display Tab see Raster Text above in this section.

OK inserts new text and deletes the original selection.

Combine to MText (Multiline Text Recognition)

Menu: Vector ► Combine to, Function: Multiline Text
CMD: VPCOMBINETOMTEXT ► Select Entities ► Dialog

Transfers selected entities to the multiline text recognition routine. If raster and vectors are selected together, then only the vectors are processed. The multiline text editor dialog appears, displaying the recognized text strings for formatting:

Text Fonts

All available system fonts can be selected and assigned to the text string or to portions of it.

Text Height

Applies the entered height to the marked text strings.
Line Distance

Defines the spacing between text lines with reference to the standard line distance.

Position

With reference to the specified text area (rectangle) you have multiple choices to position the multi line text.

Bold, Italic, Underline

These options allow for modifying the selected font.

Import Text

Allows to import text from a file.

Combine to Hatch

Menu: Vector ➤ Combine to, Function: Hatch
CMD: VPCOMBINETOHHATCH ➤ Select Entities

The selected line entities are combined to form a hatch.

You can add additional lines to a hatch by selecting these lines and the hatch and then activate this function again.

Combine Options

Menu: Vector ➤ Combine to, Function: Settings
CMD: VPCOMBINESETTINGS ➤ Dialog

Options to set up selection and input modes for all Combine To functions.
Output Tab

Defining how combined elements will be inserted.

Create Vectors
Combined elements will be inserted as vectors.

Rasterize
Combined elements will be rasterized directly.

Auto Mode
Insertion mode depends on the selection.

Only raster elements selected: elements will be rasterized.
Vector(s) included in selection: elements will be inserted as vectors.

Default: Auto Mode

These options do not apply to functions Combine to Text and Combine to MText.
Properties Tab

Defining properties of combined elements (layer, color, etc.). These options refer to inserted vector elements only.

**Use Properties of first selected entity**

The new element receives the same properties as the first selected element. Use this function to add several elements to a main element without changing its properties.

**Fixed**

Independent from the selection. Current property settings in the document apply to combined elements.

**Automatic**

Depending on selection. Properties of the dominant element in the selection (i.e. the largest or longest element) will apply to the new element.

**Standard: Automatic for all**

⚠️ These options do **not** apply to functions **Combine to Text** and **Combine to MText**.
Accuracy Tab

Curves

Circle, arcs, splines, and ellipses will be exploded into short line segments. These will form the new combined element. **Tolerance** refers to the maximum distance of the line segments to the original curve.

Lower tolerance values will result in an increased accuracy, however, will also create more data.

**Default:** 1.00 User Units

Angle Correction

Applies to function **Combine to Line**. The option will correct angle positions of lines to 0° or 90° when a maximum deviation is defined for this correction.

**Default:** off

Remove redundant vertices

Refers to function **Combine to Polygon**. Vertices of overlaying (double or multi) line segments will be deleted.

**Default:** on
Adjust Text

These functions allow you to align and/or adjust height, angle, and line space of text entities. Other text properties, such as text style, layer, or color remain unchanged.

The functions can be used in two operation modes:
- Select text entities first, then execute a command, or
- Select the command first, then select text entities.

⚠️ Only single line text can be edited. Multiline text or other entities will be ignored.

Align Left

Menu: Vector ▶ Adjust Text, Function: Align Left
CMD: VPADJUSTLEFT ▶ Select Entities

Specify a point (on-screen or in the command line) to define the X-value the text shall be left aligned to. The Y-value, height, and angle of the text remain unchanged.

Align Right

Menu: Vector ▶ Adjust Text, Function: Align Right
CMD: VPADJUSTRIGHT ▶ Select Entities

Specify a point (on-screen or in the command line) to define the Y-value the text shall be left aligned to. The X-value, height, and angle of the text remain unchanged.

Center Horizontally

Menu: Vector ▶ Adjust Text, Function: Center Horizontal
CMD: VPADJUSTXCENTER ▶ Select Entities

Specify a point (on-screen or in the command line) to define the X-value the text shall be centered (=half of the text width) to. The Y-value, height, and angle of the text remain unchanged.
Align Top

Menu: Vector ► Adjust Text, Function: Align Top
CMD: VPADJUSTTOP ► Select Entities

Specify a point (on-screen or in the command line) to define the Y-value the text shall be aligned to at the upper edge(s). The X-value, height, and angle of the text remain unchanged.

Align Bottom

Menu: Vector ► Adjust Text, Function: Align Bottom
CMD: VPADJUSTBOTTOM ► Select Entities

Specify a point (on-screen or in the command line) to define the Y-value the text shall be aligned to at the lower edge(s). The X-value, height, and angle of the text remain unchanged.

Center Vertical

Menu: Vector ► Adjust Text, Function: Center Vertical
CMD: VPADJUSTYCENTER ► Select Entities

Specify a point (on-screen or in the command line) to define the Y-value the text will be centered (=half of the text height) to. The X-value, height, and angle of the text remain unchanged.

Align with Line Space

Menu: Vector ► Adjust Text, Function: Align with Line Space
CMD: VPADJUSTLINESPACE ► Select Entities
After text selection the following dialog opens:

![Align Text dialog box]

**Line Space**

Enter a **fixed value** (0.5 up to 4 times the text height), or select **Align on screen** to adjust text interactively (see below) after the dialog closes.

**Default:** Align with fixed value  
**Value:** 1.0x

**Text settings**

Specify the desired uniform **Text height** and a mutual alignment (left, right or centered).

**Default:** 3 [mm], Left

After confirmation of the values with **OK** a grip is shown near the top text for group positioning. If **Align on screen** was selected the line space can be adjusted with a second grip near the bottom text.

The modifications are accepted with **[Enter]** or selecting **Enter** from the context menu. Discard the changes with **[ESC]** or select **Cancel** from the context menu.
Assign Same Height

Menu: Vector ► Adjust Text, Function: Assign Same Height
CMD: VPADJUSTHEIGHT ► Select Entities

Specify the new text height for all selected text entities. The height can be entered in the command line or it can be specified by drawing a reference line on-screen.

Assign Same Angle

Menu: Vector ► Adjust Text, Function: Assign Same Angle
CMD: VPADJUSTANGLE ► Select Entities

Specify the new angle for all selected text entities. The angle can be entered in the command line or it can be specified by drawing a reference line on screen.
Special Tools

Review Text

Menu: Vector ► Edit, Function: Review Text
CMD: VPREVIEWTEXT ► Dialog

Allows for reviewing and editing of text in a drawing or from a selection. You can review vectorized text and manually entered text.

Dialog Text Review with expanded Properties bar:

Current text will be displayed in the preview window along with the underlaying raster, if any. Text can be moved, rotated, and scaled in size in the preview window.

The current text will be zoomed in the drawing. The zoom factor depends on the size of the text. From this value, choose Zoom to increase/decrease this factor: For vectorized text the assembled vectors will be displayed, instead of the actual text.

When reviewing vectorized text all those vector entities to be replaced by the ASCII text can be included by selecting those entities. If you've selected an entity by mistake, deselect it with [Shift] and click on the highlighted entity(s). On occasion, you may want to explode a text back into the vector entities, since the interpretation could be wrong: simply delete the text and press OK to restore the original vector(s). This is another way of exploding.
In the dialog you can change all text properties and edit the text directly (using the keyboard). Using the **Shortcuts** button, you can enter special characters or text strings.

- **Undo/Redo last changes.**
- **Jump to first/previous text.**
- **Indicates which text is reviewed in the current sequence.**
- **Jump to following/last text**
- **Deletes current text. Original vectors will be restored with vectorized text.**
- **Pause:** Review will be interrupted and dialog is closed. All modifications are saved. Pressing again will continue the review run at the current text position.
- **Close:** Review will be closed. All modifications are saved. Using **Review Text** function again will continue the review run at the current text position.
- **Displays/closes the properties bar.**
- **Lock / unlock values:** Locked values remain unchanged for following text. This will e.g. result in creating text with a uniform height value.

**Review Text - Settings**

**Review Mode**

You can specify which kind of text will be reviewed. Change the mode when a warning message appears.

**Default:** Review all Text

**Preview Window**

Set color and transparency for the preview display.
SECTION 10
DIMENSIONS

General Information

VPindex offers extensive features to create dimension in your drawings - for both vector and raster. By adapting individual dimension styles you can generate CAD-style dimensions in up-to-date standards.

In general, dimensions are created in the Active Layer with the Active Dimension Style.

Dimension Modes

To create dimensions four different modes can be selected by turning the switches Manual Mode and Text Mode on or off. These modes may be changed at user’s discretion while a dimension function is active.

Manual Mode {on/off}

Menu: Vector ► Dimensions, Function: Manual Mode

CMD: VPDIMMANUAL

If set to on the origin points of the dimension are set manually. Otherwise, an entity (raster or vector) has to be selected to create a dimension. Then, the origin points are defined by the geometry of the selected entity.

Default: off

Text Mode {on/off}

Menu: Vector ► Dimensions, Function: Text Mode

CMD: VPDIMTEXT

If set to on the user may enter or modify dimension text when creating a new dimension. Otherwise, the measurement figure of the drawing is used as text. The text properties symbolize the measurement figure with “<>”.

In addition, the dimension text may be extended by the dimension type (e.g. “R” for radial) or style (e.g. tolerances).

Default: off
Dimension Style

Dimension Style Manager

Menu: Vector ➤ Dimensions, Function: Dimension Style

CMD: VPDIMSTYLE

The following dialog opens:

![Dimension Style Manager dialog](image)

All currently available dimension styles are displayed.

**Active**

After selecting a dimension style from the list it can be defined as the active dimension style by clicking **Active**. You may also change the selection at any time using the dimension style selection box from the toolbar.

**New**

A new dimension style can be created with **New**. The following dialog opens:

![New Dimension Style dialog](image)
New Name:

Enter the desired name for the new dimension style.

Begin with

Choose whether the new dimension style should be preset with the Default Settings or with the properties of an existing dimension style.

Next

Click Next to proceed with the creation of the new dimension style. The dialog Dimension Style opens (see below) to define the properties of the new dimension style.

After closing the dialog with OK the newly created dimension style is added to the list of available dimension styles in the Dimension Style Manager where it can be set to active.

Cancel

No new dimension style will be created.

Modify

The Dimension Style dialog opens (see below) for modifications of the dimension style properties.

Delete

The selected dimension style will be deleted. A respective message appears in case this style is already used in the current document, or if this style is the currently active dimension style.

OK / Cancel

OK closes the Dimension Style Manager and accepts all modifications. Cancel discards all modifications.

Dimension Style Properties for modifications of the dimension style selected in the Dimension Style Manager.
Tab Lines and Arrows

Dimension Lines

**Color**
Choose the desired color for the dimension line and the arrow heads (arrow or line) from the list.

Default: White

**Linewidth**
Select the line width for the dimension line.

Default: 0.00 [mm]

**Baseline Distance**
Enter the distance between two dimension lines in the dimension type **Baseline Dimension**.

Default: 3.75 [mm]
Extension Lines

**Color**
Choose the desired color for the extension lines from the list.

Default: White

**Linewidth**
Select the line width for the extension lines.

Default: 0.00 [mm]

**Extend beyond dim lines**
Specify how much the extension lines should protrude the dimension lines.

Default: 1.25 [mm]

**Offset from origin**
Specify the distance to offset the extension lines from the origin points that define the dimension.

Default: 0.63 [mm]

Arrowheads

**Arrows**
Choose between a **Closed filled** arrow (Mechanical) and an **Oblique** tick (Architectural).

Default: Closed filled

**Arrow Size**
Specify the length of the arrow or oblique tick.

Default: 2.5 [mm]

Tab Text

![Dimension Style dialog box](image)
Text Appearance

Text Style  Select the desired text style for the dimension text from the list (see Text Style, Chapter 4).
Default: Text

Text Color  Select the desired text color for dimension text from the list.
Default: White

Text Height  Specifies the desired text height for dimension text.
Default: 2.50 [mm]

Text Placement

Vertical  Specifies the position of the dimension text on the dimension line. Choose between Centered, Above, or Outside.
Default: Above

Horizontal  Specifies the position of the dimension text along the dimension line. Choose between Centered, At Ext Line 1, or At Ext Line 2.
Default: Centered

Offset from Dim Line

Specifies the distance of the dimension text from the dimension line when Above or Outside is selected for the horizontal text position.
Default: 0.63 [mm]
Tab Primary Units

The following settings are only valid when the dimension text is to show the actual measurement figure, i.e. the text contains “<>”. Otherwise, the dimension text will be displayed as entered.

![Dimension Style Dialog Box]

**Linear Dimensions**

- **Precision**
  Choose the number of decimal places in dimension text from the list.
  Default: 0.00

- **Decimal separator**
  Choose between ‘.’ Period, ‘,’ Comma and ‘ ’ Space as separator for the decimal format.
  Default: ‘.’ Period

- **Round off**
  The step size for rounding the dimension text, e.g. at a value of 0.25 the dimension text 10.73 is rounded off to 10.75.
  Default: 0.00 (no round off)

**Zero Suppression**

- **Leading {on/off}**
  If set to on a dimension text with a value less than 1 starts with the decimal separator (e.g. 0.50 => .50).
  Default: on

- **Trailing {on/off}**
  If set to on all trailing zeros of a dimension text are suppressed.
  Default: on
Tab Tolerances

Tolerance Format

Method
Choose between the tolerance methods None, Symmetrical, Deviation, Limits and Basic from the list.
Default: None

Precision
Choose the number of decimal places for tolerance values from the list.
Default: 0.0000

Upper Value
Specifies the value for the deviation with method Symmetrical or the upper value for methods Deviation and Limits.
Default: 0.00
Lower Value

Specifies the lower tolerance value for methods Deviation and Limits.

Default: 0.00

Scaling of height

Specifies a scale factor for text heights. This value is multiplied with the dimension text height to define the text height for tolerance values.

Default: 1.0

Zero Suppression

Leading {on/off}

If set to on a dimension text with a value less than 1 starts with the decimal separator (e.g. 0.050 => .050).

Default: on

Trailing {on/off}

If set to on all trailing zeros of a dimension text are suppressed.

Default: on

Transfer to Current Dimension Style

Menu: Vector ► Dimensions, Function: Transfer to Current Dimension Style

CMD: VPSHIFTDIMSTYLE <NAME>

Selected dimensions are transferred to the current or specified dimension style.
Dimension Types

Linear Dimension

Menu: Vector ► Dimensions, Function: Linear

CMD: VPDIMLINEAR

The dimension line is always horizontal or vertical. The extension lines may possess different lengths.

At first the origin of the two extension lines (and with that the length of the dimension line) is determined. Either select the entity to dimension (line, arc, circle, or polyline segment) or -only in Manual Mode - specify the origin of the first and second extension line.

The dimension line is now moveable in order to set the extension lines’ lengths. Specify the position of the dimension line by mouse click or enter the coordinates at the command line. The dimension will be added to the drawing.

In Text Mode the dialog for entering the dimension text is displayed after specifying the origin of the extension lines.

Aligned Dimension

Menu: Vector ► Dimensions, Function: Aligned

CMD: VPDIMALIGNED

The dimension line is parallel to the entity. Therefore, the extension lines always possess the same length.

At first the origin of the two extension lines (and with that the length of the dimension line) is determined. Either select the entity to dimension (line, arc, circle, or polyline segment) or -only in Manual Mode - specify the origins of the first and second extension line.

The dimension is now moveable in order to set the extension lines’ lengths. Specify the position of the dimension line by mouse click or enter the coordinates at the command line. The dimension will be added to the drawing.

In Text Mode the dialog for entering the dimension text is displayed after specifying the origin of the extension lines.
Radial Dimension

Menu: Vector ► Dimensions, Function: Radius

CMD: VPDIMRADIUS

At first the value of the radius is determined. Select the entity to dimension (arc or circle). Now, the dimension line can be rotated around the center. At the same time, specify the position of the dimension text and angle of the dimension line by mouse click or enter the coordinates at the command line. The dimension will be added.

In Manual Mode specify two points for center and length (angle included in this) by mouse click or at the command line. Now, position the dimension text with a third point. The dimension will be added.

In Text Mode the dialog for entering the dimension text is displayed after specifying the radius value.

Diameter Dimension

Menu: Vector ► Dimensions, Function: Diameter

CMD: VPDIMDIAMETER

At first the value of the diameter is determined. Select the entity to dimension (arc or circle). Now, the dimension line can be rotated around the center. At the same time specify the position of the dimension text and angle of the dimension line by mouse click or enter the coordinates at the command line. The dimension will be added.

In Manual Mode specify two points for start and end point of the diameter (angle included in this) by mouse click or at the command line. Now, position the dimension text with a third point. The dimension will be added to the drawing.

In Text Mode the dialog for entering the dimension text is displayed after specifying the diameter value.
Angular Dimension

Menu: Vector ► Dimensions, Function: Angular
CMD: VPDIMANGULAR

Specifies the dimension of the angle between two lines, an arc, or of a circle segment.

Angle between two lines:
Select two lines. The dimension line arc is attached to the cursor to specify its position and the extension lines' lengths. A mouse click adds the dimension to the drawing.

Angle of a circle segment:
Select a circle. The click position of the selection also determines the start of the segment and the origin of the first extension line. Specify the end of the segment and the origin of the second extension line by clicking again. Now, the dimension line arc is attached to the cursor to specify the extension lines' lengths and the position of the dimension line arc. Clicking the left mouse button adds the dimension to the drawing.

Angle of an arc:
Select an arc. Now, the dimension is attached to the cursor to specify the extension lines' lengths and the position of the dimension line arc. Clicking the left mouse button adds the dimension to the drawing.

Manual Mode
The first point sets the center. The second and third points define the start and end points of the dimension line arc together with the origins of the extension lines. Specify the extension lines' lengths and the position of the dimension line arc with the fourth point.

In Text Mode the dialog for entering the dimension text is displayed after specifying the angle.
Continue Dimension

Menu: Vector ► Dimensions, Function: Continue

CMD: VPDIMCONTINUE

Continue the dimension from the second extension line of the previous dimension. In Manual Mode the dimension to continue has to be selected first. Only the dimension types Linear, Aligned, and Angular can be continued. The length of the new dimension line is specified by mouse click or by entering the coordinates at the command line. The dimension is added to the drawing and may be continued.

Exit the function by clicking the respective icon again or by hitting [Esc].

In Text Mode the dialog for entering the dimension text is displayed after specifying the dimension line.

Baseline Dimension

Menu: Vector ► Dimensions, Function: Baseline

CMD: VPDIMBASELINE

Above the previously inserted dimension an additional dimension of the same type is added. In Manual Mode the dimension has to be selected first. Only the dimension types Linear, Aligned, and Angular can be used for this function. The distance between the dimension lines is defined by the specified Baseline Distance in the Dimension Style. The length of the new dimension line is specified by mouse click or by entering the coordinates at the command line. The dimension is added to the drawing and an additional dimension may be entered.

Exit the function by clicking the respective icons again or by hitting [Esc].

In Text Mode the dialog for entering the dimension text is displayed before specifying the dimension line.
SECTION 11
TABLE RECOGNITION

General Information

The Table Recognition offers you enhanced functions to modify text tables in raster files: adjust the content and the shape of an existing table to adapt it to your requirements. Additionally, you can convert tables into vector format and export it to other applications.

The Table Recognition can be applied to b/w images as well as to gray scale or colored images.

Table Recognition

Menu: Vectorize, Function: Table Recognition
CMD: VPTABLEREC

After starting the function the table needs to be selected. Draw a rectangle around the table region. If you are working on a gray scale or colored image the active color has to be specified first (see chapter 4: Image Settings).

Then, the following dialog appears:

The upper area displays the original raster for control purposes, while in the lower area you can modify the recognized table interactively.
Output settings

These settings determine in which way the modified table will be inserted into the document. Select **Rasterize Table** to delete the original table and replace it with the modified table. Select **Make Vector Table** to convert the modified table into vectors. Choose whether to keep or erase the original table.

If the original table in the raster image shall be erased (**Rasterize Table** or **Make Vector Table** with option **Erase Original Raster** switched on) a colored rectangle is shown in the upper area of the dialog. You can move the border lines of the rectangle to change its size.

Content of table / Text

To create or modify text click into a cell - a blinking cursor appears identifying this cell as the active cell. The active cell is also marked in the raster table in the upper area.

The Table Recognition is operating "line based", i.e. when modifying the text format this will always affect the entire line (of a cell) indicated by the blinking cursor (active line). Select multiple lines to modify more than one line.

⚠️ A text must fit completely into a cell and in between the set indents. Formatting or changing text with non-fitting sizes will be stopped automatically. A warning message will appear in the status bar of the dialog. Right-click on the status bar to open a context menu with the warning settings.

Textstyle

Change the textstyle to modify the display of text. For more information see **CAD-Options** below.

Indent

With the indent markers you can set horizontal and vertical indents:

![Indent markers](image)

The indent shown refers to the active line. If multiple lines are selected the minimal indents of all lines are shown. Changes are applied to the active line / selected lines.

If you have selected multiple lines in one column the new indents will be assigned to all lines. Selected lines in more than one column are modified individually so that the indents of each line are changed by the same factor.

Text in the selected lines will be re-adjusted.
Line Distance
The line distance of the active line is displayed. There is no display when multiple lines with different line distances are selected. Changes are applied to the active line / selected lines.

Text Height
The text height of the active line is displayed. There is no display if multiple lines with different text heights are selected. Changes are applied to the active line / selected lines.

Adjust Text
The horizontal adjustment of the active line is displayed. There is no display if multiple lines with different settings are selected. Changes are applied to the active line / selected lines.

The vertical adjustment of the active line is displayed. There is no display if multiple lines with different settings are selected. Changes are applied to the active line / selected lines.

The adjustment refers to the indent markers.

Cut, Copy, Paste
Use these functions to cut or copy text and to paste it to different locations. Formatting options at the insertion point will be applied to the new text.

CAD Options
These options are necessary only if a table shall be converted to vectors (except: Textstyle). The default setting for all text is the Active Textstyle, the Active Layer, and the Active Color.

Textstyle
The textstyle of the active line is displayed. To change the textstyle choose an entry from the list or select Other... to open the Textstyle Manager (see chapter 4: Textstyle Manager).

Layer
The layer of the active line is displayed. To change the layer, choose an entry from the list, or select Other... to open the Layer Manager (see chapter 4: Layer Manager).
Color
The color of the active line is displayed. To change the color choose an entry from the list.

Shape of Table / Cells
Use the following functions to modify the shape of the table. Cells, rows, or columns may be resized, added, or erased.

⚠️ If you are going resize a table do not forget to resize the erase rectangle in the upper area, too.

⚠️ While cells are modified text cannot be selected or modified.

Display original raster in the lower area
The selected raster table is displayed in the lower area for checking purposes.

Select cells
Click into a cell to select a complete row or column.

Create cells
Create new cells by drawing border lines in the lower area. The new lines are snapped to existing border lines.

Delete cells
Delete cells by removing their border lines. Click on the line to be removed or window-select multiple lines. Only empty cells can be deleted.

Adjust cell size
Applies the same width or height to all selected cells. The average value of widths and heights will be used.

Resize cells
Resize cells by moving their border lines.
Copy raster structures

The Table Recognition function will only create lines and texts automatically. If your table contains other raster structures (e.g. images, logos) which you would like to keep in the new table then use this function to copy these structures. Start the function and draw a rectangle around the desired raster structure in the upper area. It will copy the raster selection into the lower area. Use the mouse for correct positioning.

Finish the Table Recognition

Click Ok to close the dialog. According to the Output Settings the new table will be inserted into the raster file or converted in vectors. Cancel will discard all changes.
SECTION 12
INTERACTIVE TRACING

General Information

The trace functions allow for interactive raster-to-vector conversion.

The active raster file should be cleaned or corrected before proceeding. Depending on the type of original, the **CAD Trace** function can be used to generate CAD elements, such as lines, circles or arcs, typical for technical drawings. The **Contour Trace** function creates polylines and offers a conversion into splines, preferably for GIS applications. On drawings that contain intersecting contours the function **Interactive Trace** is useful to create connected polylines or splines with maximum control: at each intersection the user can decide on the direction to continue the contour.

Tracing is also provided for **color** and **grayscale raster data**. Their interpretation will refer to the settings definitions in **Image Settings** (see Section 4).

The traced raster elements can be erased automatically from the raster image by using the option **Erase Raster Background** (see below).

Trace Settings

Menu: **Vectorize**, Function: **Trace Settings**

**CMD:** VPTRACESETTINGS

A dialog box opens to define the trace settings for Contour Trace and Interactive Trace.
General Tab

The parameter **Straightening** defines how precise the trace process follows a raster line. **Medium** or **High** reduces the number of vertices significantly. However, it also reduces the precision of the line following process. The highest precision (especially when tracing contour lines) is achieved by setting straightening to **None** and selecting **Exact** in the Image Settings dialog. Hence, these settings will generate significantly more vertices in polylines.

**Default:** Weak

**Remove Artifacts {on/off}**

When **Remove Artifacts** is activated, short line segments or line spurs ("artifacts") are automatically removed, which otherwise would lead to unwanted trace results. The size of these artifacts can be entered via keyboard or measured using the **F2** key.

**Default:** off

**Default value:** 1[mm] or 0.04[inch]
Gap Jump \{on/off\}

Small interruptions in the raster image, very often due to faded and old originals, will be closed automatically up to a reasonable distance.

⚠️ If the value is set too high neighboring contours may be connected unintentionally!

Default: \textit{off}
Default value: 0.1[mm] or 0.004[inch]

Assign Raster Width to Contour \{on/off\}

The width of the underlying raster will be assigned to the traced entity. Otherwise, the active \textit{Pen Width} is used.

Default: \textit{on}

Contour/Interactive Trace Tab

Stop at Intersections \{on/off\}

The line following process will stop at each crossing/intersection. Otherwise, the most probable direction will be taken and the line following process continues.

Default: \textit{off}
Assign Elevation {on/off}

After tracing a polyline or spline you are prompted for an elevation value. The tracing process attempts to find elevation numbering information that interrupts the contour. If successful, the elevation is presented in the dialog as the default value and the contour is continued across the gap. In the Interactive Trace mode the gap will not be closed automatically. The [Shift] key can be used to append the continuation to the traced contour. This way you can create 3D models of a contour map for other applications.

Default: off

For reviewing the elevation model use the function Check Elevation.

⚠️ Since VPindex can only display 2D entities you will not see this additional spatial information. Instead, load the data into a CAD system capable of displaying three-dimensional vector data.

Append Mode {on/off}

After tracing a polyline or spline a dashed line between the cursor and the end of the trace entity appears. It indicates that the element traced next will be appended. For example, if you have broken raster lines this option allows for an easy combination of traced elements.

Holding down the [Shift] key interrupts this mode to start a new line.

If Pan to Entity End is on, the system pans to the nearest end of the last traced contour line automatically. This will help to find the next line to continue with.

Default: off

Instead of activating the permanent Append Mode you may also press the [Shift] key whenever you want to append a new element to the previous one. This intermediate append status will be indicated by a "+" sign at the trace cursor.

Produce Splines {on/off}

Generates splines instead of polylines.

Default: off

⚠️ The program can generate splines with an arbitrary number of vertices. However, not all CAD programs are able to process splines with a large number of vertices.
Trace Dashed Lines {on/off}

For tracing dashed contours activate this option and enter a representative **Max. Dash Length** and a **Max. Gap Length**. For best results use the [F2] key and measure the correct values from the drawing. Increase the **Tolerance** value if the tracing process leaves out dashes.

Default Tolerance: 50.0%

**Additional Interactive Trace Tools**

**Show Zoom Window {on/off}**

A small window shows a detailed view of the intersection and the possible directions as **green** (most probable and therefore preferred direction) and **red** (optional) arrows.

Default: on

**Confirm Contour {on/off}**

When reaching the end of a contour the cursor changes to the **OK?** symbol for confirmation or modification. Click the left mouse button to accept the contour result or use **Back** from the context menu to go one trace step back.

Default: off

**Stop at Closed Contours {on/off}**

Tracing will stop when the contour forms a closed loop.

Default: off

**Erase Raster Background**

Menu: **Edit**, Function: **Erase Raster Background**
CMD: **VPERASERASTER**

To erase raster elements automatically while following the tracing routine, click the **Erase Raster Background [Ctrl+E]** icon prior to starting the tracing. All traced raster elements will be deleted from the raster image.

With color or gray scale images the background will not be erased. Instead, the background pixels to be erased will be filled with the **Background Color** defined in **Image Settings**.
CAD Trace

Menu: Vectorize, Function: CAD Trace
CMD: VPCADTRACE

CAD trace allows to recognizing the CAD elements line, circle, and arc and assigning them to the current layer. Special CAD elements, such as ellipses, arrows, donuts, line types, small circles, hatches, or text can be drawn or combined from the traced data using the editors. (See Section 8 + 9).

After clicking the CAD Trace icon, a Needle and Thread cursor appears to directly click on the raster data for element tracing. Pressing the [Shift] key (adding a "+" sign to the cursor and displaying a dashed line to the traced element) links the last traced CAD element to the next one, while preserving the element type (line, arc, circle) of the element initially traced. Arcs covering an angle of close to 360° will be closed and converted to a circle automatically.

Clicking the right mouse button opens the following context menu where you can force the system to recognize a particular element:
Contour Trace

Menu: Vectorize, Function: Contour Trace
CMD: VPCONTOURTRACE

Use this function to trace polylines or splines in the currently active layer.

Click with the Nail cursor on the raster line. The trace module runs from this point in both directions, until it reaches the end of the line or stops at an intersection where the directions of the branches do not meet the internal angle tolerance.

Pressing the [Shift] key while clicking on the next raster line piece allows to continue the previous polyline. In this case, the Nail cursor appears with a "+" sign and a dashed display line is drawn to the traced contour.

If you are in Append Mode, the cursor is linked by a dashed line to the end of the traced line and the next part will be appended automatically. Pressing the [Shift] key will interrupt the append mode and a new line can be traced, although the Append Mode still is active.

In order to add new vertices to a traced contour line at the current position press the [Ctrl] key. A "pin" cursor appears linked by a dashed line to the end of the traced contour. Clicking the left mouse button generates a new vertex at the click position, regardless if there is an active raster below. This allows for tracing across longer interruptions. From here, the tracing may continue.

In Append Mode you can add vertices by just clicking into an area without an active raster, i.e. without using the [Ctrl] button.

Clicking the right mouse button opens the context menu for editing as described below.

Contour Trace Edit Commands

At any point during the contour tracing operation you may click the right mouse button to open the context menu. The editing commands interrupt the tracing, but they will not abort it.
Edit Contour

Apart from the **Undo**, **Redo**, and the **Zoom** functions use **Edit Contour** for modifying the last traced contour. The **Cancel Menu** item closes the menu and re-activates the tracing process.

After selecting **Edit Contour** the last contour will be displayed with moving grips at each vertex and the **Edit Polyline/Spline/Polygon** toolbar pops up. While holding down the **[Ctrl]** key you can add new vertices by clicking on the contour, or remove a vertex by clicking on the vertex to be removed. Without holding the **[Ctrl]** key you can move vertices by clicking and dragging. For details of the function **Edit Polyline/Spline** see below.

Clicking again the right mouse button activates the edit contour menu which contains the same functions as the toolbar:

![Edit Polyline/Spline/Polygon toolbar](image)

**Edit Vertices**

In this mode vertices can be moved (holding down the left mouse button and dragging), added, or removed (**[Ctrl]+Click**). End this function by selecting a different function from the toolbar or from the context menu. Leave the menu with **End Command**.

**Cut**

Cuts the polyline/spline at the clicked position. The result will be two separate contour lines. A closed contour (closed polyline) can be opened using this command. End this function by selecting a different function from the toolbar or from the context menu. Leave the menu with **End Command**.
Append Vertices
Add vertices one by one at the current click point by joining them to the nearest end of the contour. A dashed line indicates on which end the vertex will be added. To append to the far end hold down the [Ctrl] key. End this function by selecting another function from the toolbar or from the context menu. Leave the menu with End Command.

Remove Previous Vertices
Deletes vertices at the nearest line end. A dashed line indicates on which end of the contour the vertex will be removed. With each click one more vertex will be removed. To remove vertices from the far end hold down the [Ctrl] key. End this function by selecting another function from the toolbar or context menu. Leave the menu with End Command.

Remove Vertices up to
Deletes vertices at the nearest line end up to the vertex clicked. A dashed line indicates on which end of the contour the vertices will be removed. To remove vertices from the far end hold down the [Ctrl] key. End this function by selecting another function from the toolbar or context menu. Leave the menu with End Command.

Close Polyline/Spline
Connects both ends of a contour with a line to form a closed contour.

Explode Polyline
Breaks a polyline into single line segments and leaves the editing mode.

Edit Next Entity
Accepts the changes and allows for selecting the next entity to be edited.

Combine with Polyline
The cursor switches to the selection mode. Select a polyline to combine it with the one, which is currently edited.

Undo
The last modification will be undone.
Redo
The last *Undo* operation will be redone.

End Command
Use this command or hit [Enter] to leave the edit mode and return to the trace process.

Change Branch
Allows correcting the automatic routing of the trace function at junctions or crossings in the case that the auto tracing selected an unwanted direction. Just click onto the desired direction. This will result in an "Undo" of the tracing by returning to the junction where the correct (user selected) direction branches off.
Interactive Trace

Menu: Vectorize, Function: Interactive Trace

CMD: VPTRACEINTERACTIVE

Use this function to trace polylines or splines in the currently active layer.

Click with the Nail cursor on the raster line. The trace module runs from this point in both directions, until it reaches the end of the line or stops at an intersection. At Intersections arrows appear for selecting the next tracing direction (if the option Show Zoom Window is switched on the arrows are also visible in the zoom window). Click on the respective arrow to continue the contour in the desired direction. When hitting the [Enter] key instead, the tracing follows the most probable direction indicated by a green arrow.

In case it is not desired that the contour continues over branches use Stop Here from the context menu. The contour may be continued from the other end if there is a branch, too.

Selecting Stop All creates a contour reflecting the current trace state – tracing will stop at both ends of a contour.

Back returns to the last intersection.

Pressing the [Shift] key while clicking on the next raster line segment allows to continue the previously created polyline/spline. In this case, the Nail cursor appears with a "+" sign and a dashed line is drawn from the cursor to the traced contour.

If you are in Append Mode, the cursor is always linked by a dashed line to the end of the traced line and the next section will be appended automatically. Pressing the [Shift] key will interrupt the append mode and a new line can be traced, although the Append Mode remains active.

In order to add new vertices to a traced contour line at the current position press the [Ctrl] key. A "pin" cursor appears linked by a dashed line to the end of the traced contour. Clicking the left mouse button generates a new vertex at the click position, regardless if there is an active raster below. This allows for tracing across longer interruptions. From here, the tracing may continue.

In Append Mode you can add vertices by just clicking into an area without an active raster, i.e. without using the [Ctrl] button.

When tracing a contour, clicking the right mouse button opens the context menu for editing as described in section Contour Trace above.
Use this function to edit polylines, splines, and polygons. If no entity is selected upon execution of this function you are asked to select an entity for modification. The selected entity is displayed with moving grips at each vertex and the Edit Polyline/Spline/Polygon toolbar pops up.

The initial mode is **Append Vertices** which lets you append vertices to the nearest end of the entity. If the entity is closed the **Edit Mode** will be activated instead.

Clicking the right mouse button activates the edit contour menu which contains the same functions as the toolbar and additional zoom commands:

**Edit Vertices**

In this mode vertices can be moved (holding down the left mouse button and dragging), added, or removed ([Ctrl]+Click). End this function by selecting a different function from the toolbar or from the context menu. Leave the menu with **End Command**.
Cut
Cuts a polyline/spline at the click position. The result will be two separate contour lines. A closed contour (closed polyline) can be opened using this command. End this function by selecting a different function from the toolbar or from the context menu. Leave the menu with End Command.

Append Vertices
Adds vertices one by one at the current click point by joining it to the nearest end of the contour. A dashed line indicates on which end the vertex will be added. To append to the far end hold down the [Ctrl] key. End this function by selecting another function from the toolbar or context menu. Leave the menu with End Command.

Remove Previous Vertices
Deletes vertices at the nearest line end. A dashed line indicates on which end of the contour the vertex will be removed. With each click one more vertex will be removed. To remove vertices from the far end hold down the [Ctrl] key. End this function by selecting another function from the toolbar or context menu. Leave the menu with End Command.

Remove Vertices up to
Deletes vertices at the nearest line end up to the vertex clicked. A dashed line indicates on which end of the contour the vertices will be removed. To remove vertices from the far end hold down the [Ctrl] key. End this function by selecting another function from the toolbar or context menu. Leave the menu with End Command.

Close Polyline/Spline
Connects both ends of a contour with a line to form a closed contour.

Explode Polyline
Breaks a polyline into its line segments. The function Edit Polyline/Spline will be terminated.

Remove Area (for Polygons only)
Excludes an area from a polygon. Click inside or on the outline of the area to remove it from the polygon.

Edit Next Entity
Accept the changes and select the next entity to edit.
Combine with Polyline
The cursor switches to the selection mode. Select a polyline to combine it with the one, which is currently edited.

Undo
Undo the last modification.

Redo
Redo the last *Undo* operation.

End Command
Use this command or hit [Enter] to leave the edit mode and confirm the modifications.
SECTION 13
BATCHMANAGER / BATCHEXECUTOR
SCRIPTING
USER COMMANDS

**BatchManager** provides a setup of tasks that can be applied to file sets, e.g. to all files residing in a directory and their subdirectories, etc. The **BatchExecutor** executes these tasks in a background process without user interaction.

You can also write your own **Script File** to interactively perform tasks that have a defined sequential order. Scripts can be executed on command level or as part of the BatchExecutor.

The toolbar **User Commands** allows for assigning up to 10 commands or scripts to buttons in the toolbar. With this feature work flow routines can easily be integrated and commands can be made better and faster accessible!

### BatchManager

Menu: *File*, Function: **BatchManager**

CMD: VPBATCH ➤ Dialog
CMD: VPBATCH <NAME.BJB>

The supplied batch job file is opened and executed, or a dialog box opens. Batch Jobs can be created, modified, deleted, saved, loaded, and executed:

If no batch job has been created, yet, the job list appears empty.
Create Batch Job

Creates a new batch job (see below).

Modify Batch Job

The settings of a selected Batch Job can be modified.

Delete Batch Job

A selected Batch Job is deleted from the job list.

Load Job List

Loading a previously saved Batch Job from file.

Save Job List

Saves a Batch Job to a file.

Run BatchExecutor

Starts the BatchExecutor and executes the current job list.

Create Batch Job

A file and task set can be defined to create a new Batch Job. The dialog **Select Files** opens to select the source files for the desired batch process.

Base Path

Type in the location of the source files or use the button for browsing.

Select single or multiple files in the **Preview** area and add them to the **Selection** list using the button **Add** or **Add All**.

To remove selected single or multiple files from the **Selection** list use the button **Remove**.
Wildcards

To show only files in the Preview that match a specified wildcard pattern, type the pattern into the edit field Wildcards. For example, if you want to see only files that start with the character "b" you can use wildcard patterns like \*b\*, \*b\*\.tif, \*.tif, etc. (according to standard conventions). The wildcard character "?" is a variable for a single character, thus the pattern test?.tif would find the file test1.tif. However, neither the file test20.tif, nor the file test.tif would be included. Without entering a specific pattern, the default pattern "\*\.*" is used instead, finding all files which have a file extension and which can be loaded using the available import filters.

Include Subdir.

If this checkmark is on the preview recursively shows all found files and all subdirectories in Base Path.

Add Wildcards

Use this button to add a source to the Selection list that uses Wildcards. You can use this feature to create a batch job that works on a specific directory, rather than on a specified set of files. For example, you can create a batch job for the directory c:\scanned files\*.tif. No matter which files were residing in the directory at the time of the batch job creation, whenever the batch job is executed, all files residing in the directory will be processed.

Settings

Pressing this button allows for defining the appearance and display of the files in the Preview:

You can either choose to List or to display Thumbnails (Images). The columns' arrangement defines the size of the thumbnails. The Autoload function can be limited, in order to prevent loading large files for display which might take too much time.

Finally, Tool Tip information, displayed when moving the cursor over the source images' display, can be defined individually in Displayed File Details.

Click OK to return to the Select Files dialog.
Task Setup

In the Select Files dialog click OK once all files have been assigned for processing to the Selection list. Next, the Task Setup dialog opens where you can create the batch process.

Task Sequence

Gradually select the standard or user defined tasks and add them to the task list using the Add > button. Depending on each specific task a dialog comes up for setting up parameters. See the corresponding sections of this manual for a detailed description.

In the Custom/Script parameter dialog you can enter commands with parameters as you would do in the program's regular command line. You can also Load or paste commands from an existing script file. Be sure not to use commands that would require user input. Otherwise, these commands cannot be executed.

Use the < Remove button to delete a selected task from the Task Sequence.

Task Path

Enter or browse to a Task Path for saving the custom parameters of a task.

Delete Task

Deletes a selected user defined task file. The standard tasks cannot be deleted.

Modify Parameters

To review and modify the parameters of a task, select the task in the Task Sequence list and click on Modify Parameters.

Task Order

The Up and Down buttons can be used to change the process order of the tasks.
Output Options

Click **Next** to specify the output options. The output dialog opens:

Path

Type in or browse to the directory where the processed files will be saved. If **Keep Directory Structure** is checked on the processed files will be saved in subdirectories of **Path** in the original order of the source files.

File Name

The name of target files can be composed of the original file name and a prefix and/or a suffix:

\(<\text{Prefix}\><\text{Original File Name}\><\text{Suffix}\>

If desired select the corresponding option(s) **Add Prefix/Add Suffix** and enter the character strings. When working with multi page files you can use the special sequence %02d to write out the page number. You can omit 0 if you do not want trailing zeros. 2 is the number of digits the page number should have.

File Type

The result of a batch process can be saved either as single files or as a single multi page file.

**Save as Single Files:**

If **Preserve File Type** is checked on the source file's format will also be used for output. To save all information to the internal hybrid file format select **Internal Format**.
With Export as processed files can be saved in two basic format categories. Raster Format offers file formats that are capable of saving raster, Vector Format offers file formats for saving vector data. Thus, you may produce two separate files for raster and vector information.

Note: the file format should be selected carefully. Saving information to an unsuitable format will generate empty files!

Save as Multipage File:
To produce one multi page file instead of single files select Save as Multipage File and enter a file name. Select the desired multi page file type from the list (usually the TIFF format).

Print
Activate the Print option to send the resulting files to a printer. If No File Output is checked files will be printed, but not saved.

You can change the printer and the print options by clicking Settings.

Misc. Options
By switching Change Layers on you can apply layer settings from a specified Prototype Drawing to the source files. This way you can easily adapt e.g. layer widths and colors to certain standards of an organization or to a general norm.

Click Finish to complete the job setup. The Batch Manager dialog re-appears.
BatchExecutor

To start the BatchExecutor, click on Run BatchExecutor in the BatchManager (which also executes the job list) or double click the icon in the VP program group.

You may also start the BatchExecutor from the windows command line prompt. A job file and other options can be specified by parameters. Enter

```
BatchExecutor.exe /?
```

to display the available options.

Load

If you have started the BatchExecutor from the BatchManager the setup jobs are loaded automatically. Otherwise, you first need to load a previously saved job list using the Load button. Already displayed jobs will be deleted.

Run!

Clicking Run! starts the job execution. All displayed files will be processed sequentially. The Status for each file changes from Ready to Running and, after process execution to Finish.

Stop

Aborts the processing immediately.

Output

The Output window displays the currently executed commands.

Exit when finished

Close the BatchExecutor when all jobs are finished. The output messages are redirected to a log file residing in the SUPPORT subdirectory of the VPindex installation directory. In the example above (Job 1) the log file is named Job 1_log.txt.
All VPindex commands which can be executed from command line level can also be assembled into a plain text file to define the order of consecutive tasks for batch processing. This script can be executed from the command line, in a batch, or automatically on program start.

The syntax and available parameters of a particular command will be displayed in the command window on entering the desired command with the parameter "/?".

Procedure

Use an editor (e.g. the Windows Notepad) and type each command into a separate line (like you would do in the command line window).

The following example opens a raster file (the file name may include drive and path if necessary), despeckles the file using the automatic despeckle option, deskews the file, and exports the cleaned file to a new file:

```
VPopen <File Name>
VPspeckles /a
VPautoDeskew
VPexport <New File Name>
```

Save this script file as plain text with an arbitrary extension, e.g. "CleanFile.TXT".

Depending on the commands the execution will stop and prompt the user for input, e.g. if you don't enter the parameter <File Name> the open dialog will open for selection. Instead of <New File Name> you can also use pre-defined wildcard characters to reflect the original <File Name>:

- `%FILEPATH%` Path of current file
- `%FILENAME%` Name of current file (without path and file extension)
- `%FILEEXT%` File extension of current file

Especially, this may be helpful when scripts are used in a batch process. Example: With the following command, each processed file is saved into the folder c:\tmp, adding a suffix to the original file name, and keeping the original file extension:

```
VPexport "c:\tmp\%FILENAME%_ready. %FILEEXT%"
```

For execution of the script on program start call the VPindex main program `MAIN.EXE` with the parameter `/b` and the script file name. For example:

```
Main.exe /b c:\Scripts\CleanFile.txt
```
The dialog *Workflow Configuration* opens.

The dialog is divided into two sections. The commands on the left side in *Available Settings* allow for managing user commands in setting files. The right section of the dialog shows the 10 available commands of the loaded setting.

### Available Settings

**Directory**

Specifies the directory that is used for searching existing setting files. Found files are displayed in the list. All files with the extension `.wfl` are shown while their extension is suppressed in the list.

**Create...**

A new settings file is created in the specified directory. Enter an unused Name in the upcoming dialog. The currently active **Commands** will be taken over automatically.

**Load**

The selected settings are loaded and displayed in the **Commands** list. If the currently active commands contain unsaved modifications a safety dialog opens to confirm that the new settings shall be loaded.

**Save**

The **Commands** are saved with the selected name. Existing commands are overwritten without safety prompt.

**Delete...**

The selected settings are deleted from the **Settings Directory**. Deletion has to be confirmed in a safety prompt.
Commands

The **Commands** list displays the currently active definitions for the available 10 user commands. The column **Command** shows the fixed name of the command for a unambiguous identification (**user0** - **user9**). **Alias** displays the user defined synonym for the command. The column **Definition** contains the commands which will be executed when the user command is started. **Bitmap** is an optional path to a Windows Bitmap file (.bmp) or a DLL containing bitmaps, which will be used as an icon for the command in the toolbar.

**Modify...** The dialog Modify Command opens for modification of the selected commands' properties.

![Modify Command Dialog]

- **Command**: The unique name of the command as it is used by the system. It cannot be changed by the user.
- **Alias**: A synonym for the user command. It should not contain blanks or special characters in order to avoid the necessity of quoting the command in the command line or in scripts!
- **Image**: A preview of the image specified in **Image Location**.
- **Image Location**: The path to an image file that has been saved in Windows Bitmap format (.bmp). The image should not exceed 16 pixels in width and height. Otherwise, only the upper left part of the image will be displayed in the toolbar! Alternatively, you may specify the path to a DLL or VPX containing bitmaps. Clicking **Pick** opens a dialog to select the target bitmap.
**Definition**

Enter a command as used in the VPindex command line input or as a path to a Windows application or as a file as used in the Windows command line input in the **Definition** field.

**Examples:**

1. A single command (load a prototype drawing)
   
   Open "C:\My Documents\A4\Frame.rvd"

2. Processing a sequence of commands (see **Command Script** in this section for creation of a script file)
   
   Script "C:\scripts\cleanfile.txt"

3. Execution of an application (e.g. Windows Notepad)
   
   `c:\windows\notepad.exe`

4. Start of an application through a registered file type
   
   http://www.softelec.com (start standard Internet browser)
   
   or
   
   `c:\database\Drawings.mdb` (start MS Access with Drawings.mdb)

As an additional option the file name of the active document can be passed on to the application using `<File>`. For example, you can print in the background in a second program instance: "C:\programme\vpview\main.exe" /p <File>
SECTION 14
REDLINING

General Information

Redlining is a powerful feature to insert mark-ups into an existing drawing. These mark-ups can be used to highlight inaccuracies of the drawing, required modifications, or just any kind of information for other viewers, e.g. production process handling information, design remarks, etc. The redlining entities may be visible to all viewers or hidden at any time.

In addition to the general redlining functions, VPindex offers the possibility to restrict the access (view, modify, etc.) to these entities on a user/password basis (see Section 3 System Settings - Redlining Tab).

Redlining Functions

The Redlining toolbar offers the following functions:

- Activate/Deactivate Redlining Mode
- Import Redlining Data
- Export Redlining Data
- Redlining Settings
- Review Redlining Data
- Delete Redlining Data
- Insert Ellipse
- Insert Cloud
- Insert Arrow
- Insert Transparent Rectangle

Activate Redlining

Menu: Redlining, Function: View Redlining

CMD: VPRDLON

Use this command to activate or close the Redlining functionality. Depending on the access rights (see Section 3 System Settings - Redlining Tab), a user will see all the redlining entities of that document, or some, or none. When access restrictions are set-up, the user will be prompted to enter a user name and a password for logon.
Redlining will be activated automatically by loading a drawing which contains redlining information.

**Import**

- **Menu:** Redlining, Function: **Import**
- **CMD:** VPRDLIMPORT ► Dialog
- **CMD:** VPRDLIMPORT <File Name>

Allows for importing redlining data from an RLF file.

**Export**

- **Menu:** Redlining, Function: **Export**
- **CMD:** VPRDLEXPORT ► Dialog
- **CMD:** VPRDLEXPORT <File Name>

Redlining data may be exported to RLF, RVD, DWG, DXF, DGN, or CGM file formats. Except for the native RVD format, only the redlining data will be exported! RLF is VPindex's internal format for redlining data with access restriction information.

Use the native RVD format if access restrictions have been set-up and the whole drawing, including redlining information, should be saved to an unrestricted file (e.g. to send the data to another party for reviewing). All other export formats will only contain the currently visible (see below) redlining entities. These are treated as blocks with attributes, separated on different layers depending on the way they have been created.

**Settings**

- **Menu:** Redlining, Function: **Settings**
- **CMD:** VPRDLSETTINGS ► Dialog

Specifies the standard settings for the creation of redlining entities. A dialog opens containing two tabs.
General Tab

Define **Text Height**, **Arrow Size**, and **Opacity** of the color for the redlining entities. Select the **Color**. These settings apply to the creation of new entities.

**Text Height** and **Color** can be modified individually for each entity.

Filter Tab

Defines which redlining entities are displayed in the document depending on the user restrictions.

**Filter**

**By Owner** allows for displaying either the redlining mark-ups of:

- All  
- From: Selected creators.

**By Type** allows the selection of the entities according to their status:

- all entities,  
- revised entities,  
- not revised entities,  
- approved entities,  
- not approved entities.
Redlining Review

Menu: **Redlining**, Function: **Review Redlining**

**CMD:** VPRDLREVIEW ➤ Moves to 1st redlining entity and opens redlining properties.

Starts or continues the review of the redlining mark-ups. The program zooms in automatically on each redlining entity and displays the properties in a dialog box. Depending on the access rights the user may edit the text of each entity or revise/approve the mark-up.

Next, Previous

Use **Next** to review the next redlining item and **Previous** to go back to the last entity reviewed.

Stop

**Stop** closes the dialog box. If the review function is called again it will start at the last item reviewed. The next entity of the list will be displayed.

Delete Redlining Entities

Menu: **Redlining**, Function: **Delete Redlining Entities**

**CMD:** VPRDLDELETE ➤ Select Entities.

Deletes the selected redlining entities.
Insert Ellipse

Menu: Redlining, Function: Insert Ellipse
CMD: VPRDLELLIPSE ▶ Requires 2 mouse clicks to define the position and size of the ellipse.

Inserts a redlining entity with the shape of an ellipse. The size of the ellipse is adjustable in both directions by moving the mouse.

Short Text, Comment

On the second mouse click a dialog box opens to enter a Short Text (headline, which is permanently displayed with the entity) and a Comment for the entity. Text Height and Color for this entity may be modified from their default values (defined by the Redlining Settings).

After pressing OK the Short Text can be placed on the drawing.

Insert Cloud

Menu: Redlining, Function: Insert Cloud
CMD: VPRDLCLOUD ▶ Requires 2 mouse clicks to define the position and size of the cloud.

Inserts a redlining entity with the shape of a cloud. Same handling as Insert Ellipse.

Insert Arrow

Menu: Redlining, Function: Insert Arrow
CMD: VPRDLARROW ▶ Requires one mouse clicks to define the position of the top of the arrow.

Inserts a redlining entity with the shape of a pointing arrow. Same handling as Insert Ellipse.
Insert Transparent Rectangle

Menu: Redlining, Function: Insert Transp. Rectangle

CMD: VPRDLTRECT ► Requires 2 mouse clicks to define position and size of the rectangle.

Inserts a redlining entity with the shape of a transparent colored rectangle area. Same handling as Insert Ellipse. If required, use the Properties to modify the transparency of a selected rectangle.
Redlining Configuration

In some applications it may be of interest to limit the access of users with redlining.

Imagine the following situation: A company has a support center which creates redlining mark-ups (e.g. modification demands or improvement requests from customers) into an existing drawing. The support staff should only insert new entities, but not remove or modify items inserted by other employees. At a higher level a manager reviews these entities, and marks those as Revised which should actually go into re-design etc. Then, the "revised entities" are disabled from any modification. The draftsman in charge may modify the drawing according to the redlining mark-ups and their comments, but he may not modify the redlining or even remove the entities. At a final supervision level another manager checks the document modifications and compares them with the redlining mark-ups. He then approves the modifications checking Approved or he may erase these entities from the drawing if no further check or approval is necessary.

To achieve this structure, restrictions can be set up for each user depending on his function inside the company hierarchy. Use the program RLCFG.EXE located on the CD in the directory \Redlining. Copy the program to any location on your hard disk.

If the program is called the first time it will show the following dialog:

Specify a path for the configuration file and press New to create a new configuration setting. If a configuration file has already been set up, just enter the path where it is located and press OK.

For proper operation of the Redlining Configuration file it is demanding that the administrator and all added users have read/write access rights to the location of the configuration file!

After generation of a new configuration file only one user is available by default: the ADMINISTRATOR (no password). You can start to add and/or modify users and/or groups. On Exit the configuration file will be updated and saved.

When calling the program again a Logon and Administrator Rights are required to open the program.
Configure Redlining Users/User Groups

The user management is similar to the one used with Windows NT/2000/XP. **User Groups** having specified rights may be created and **Users** may be assigned to the groups. A user can only be a member of one group and has the rights specified for that group!

The following rights can be specified:

- **Admin** - All rights are assigned to an Administrator. This user can also create, modify, and delete users and groups.
- **View** - The user can only view (look at) the redlining entities and their properties.
- **Print** - The user can print the redlining entities. If this right is switched off, the redlining entities will not be printed even though the entities are displayed.
- **Export** - The user can export the redlining data to an unrestricted vector or hybrid file.
- **Create** - The user can create/add new entities. He is allowed to modify, edit, or erase these entities created by himself (he is the owner) until they are revised.
- **Modify** - The user can modify (move, change) any redlining entity which is not revised.
- **Edit** - The user can edit the text/comment of any redlining entity which is not revised.
- **Erase** - The user can erase any redlining entity.
- **Revise** - The user can set the 'revised' flag to an entity.
- **Approve** - The user can set the 'approved' flag to an entity.
- **No Rights** - User has no redlining rights at all. He will not even see redlining entities on a document.

**List Users**

Displays a list of all users, their groups, and access rights.
New User

Creates a new user. Enter the user name and the password. Assign the user to any available group as a new member.

Edit User

Edits an existing user. You can modify his password or the group assignment.

Delete User

Deletes an existing user.

An error message appears if the last user or the ADMINISTRATOR should be deleted! This is not possible.
New Group

Creates a new group. Specify a group name and the access rights for this group.

Edit Group

Edits an existing group. Modify the rights of that group. Any changes apply to all users of the group.

Delete Group

Deletes a group. A group can only be deleted if there are no users assigned to it!
SECTION 15
PROCESS SETTINGS

General Information

The entire process consists of two main parts:

1. Setup of process settings (parameters)
2. Process run

This section describes how settings are generated and how these settings can be changed. The following section describes how to run a process.

Before running a process individual process settings need to be defined and saved. This can be done with the help of a “Wizard” which will offer input assistance for each required process step:

- Selection of drawing files to be processed
- Loading a sample drawing file as a reference for parameter selection
- Definition of necessary raster clean-up operations to be executed on each file
- Generation of new indexing templates or assigning already defined templates
- Definition of the template cells and linking cells to data fields
- Configuration of data export to a database
- Setting-up general output options

One individual settings file may refer to an arbitrary number of paper formats and indexing templates. The operator defines from which cells of a template the contained information shall be extracted. Also, each cell can be linked to a particular data field, e.g. of an existing database (EDM system). The indexing results are then transferred directly to the database.

Existing settings may be re-used for identical paper formats. Existing settings may also be saved with a new name and may be used for future projects with other drawings.

There are two basic processing modes which will work in different ways: Only Indexing and Cleanup and Indexing. Both modes may be used for Interactive Processing or for Unattended Processing. When using interactive processing the process will stop and directly prompt for control and/or revision of indexing results for each drawing, while unattended processing will leave this step to a separate subsequent review run.
Create Settings with Wizard Support

Start Wizard

Menu: Indexing, Function: Indexing Wizard
CMD: VPINDEX → Dialog

Start the Wizard – the **Welcome** page will appear:

This page may be suppressed. The Wizard will then start with the page **Create, Load or Modify Settings**. From here you may also return and re-activate the Welcome page using the Back button.

**Create, Load or Modify Settings**

On this page you can define to create new settings or to load and modify existing settings. The Wizard may be activated for assistance to modify existing settings. Otherwise, settings will be displayed in a general Tab overview.
Settings File

Name and path of an existing settings file. A click on the arrow symbol on the right will open a list box containing previously loaded or created settings files.

New Settings – Processing Mode

This page will only show when new settings are to be created. Depending on the following selections process functions will be offered or suppressed.

Only Indexing

Original files of a current process will not be saved but, at best, copied, moved or renamed. With appropriate settings files can also be left entirely unchanged (see Output options). Cleanup functions may still be used, e.g. Rotation to improve on readability, but will not affect the document. A respective warning message will appear which can be ignored at user’s discretion.

Cleanup and Indexing

Files will be cleaned, indexed and saved according to all required processing and Output settings.

⚠️ Saving file types like DWG (AutoCAD) or PDF may result in a loss of content details as existing in the original files, such as paper layouts (DWG) or specific colors and color gradients (PDF). To prevent this you must opt for Only Indexing.

Interactive Processing

After an initial processing of a drawing the process will stop in order to review results or to enter additional data. Then, data will be exported and the process continues with the next drawing. Since this is the only mode available in VPindex lite there are no other modes being offered.
Unattended Processing

All drawings will be processed automatically while extracted data will be stored in an intermediate directory. In a second step this data can be reviewed before a final export.

Settings File

Name and path of the file containing settings. The Next button is grayed when no file name has been assigned or a file name already exists.

Check Wizard Tasks

Here you can activate the tasks you want to set up for a new process. As default all tasks are switched on. The activated tasks are indicated by check marks.

On Next the Wizard will continue with the tasks marked.

Navigation View

On each Wizard page of a task a Navigation View lists all tasks marked. The currently active task is highlighted respectively:

By clicking onto one of the listed tasks you can navigate forth and back between all tasks.
Drawing File Selection (Task 1)

A Settings File can be generated even when no drawings are selected for process. When starting a process the File Selection dialog will open automatically. This method may be used for applying existing settings for an arbitrary number of processes.

Retrieve drawings interactively from scanner

Select this mode to process each drawing interactively after it has been scanned. Do not use this option for the unattended mode!

Retrieve drawings from existing directories

This mode supports processing of multiple drawing files and is especially required for the unattended mode. For file selection see below.

Delete files from input directory after processing {on/off}

If this check box is on, each file in the input directory will be deleted after it has been successfully processed, i.e. a new cleaned-up archiving file will be generated.

Import Options

A dialog opens to select import layout mode definitions for DWG/DXF drawing files.
Add/Remove Drawings

Use the **Wizard** button to select drawing files for the current process or add drawing files to the existing list. The dialog opens:

![Dialog for Add/Remove Drawings](image)

The left side of the dialog shows the specified path/directory and all contained files a selection can be made from. The default view for the source files is a thumbnail view (this can be changed in **Settings**). A progress bar indicates the status of loading when generating the thumbnails. To switch into another directory press the **Browse** button or type directly into the path field. When using the **Browse** button only existing directories can be selected.

The edit field **Wildcards** allows to filter a specific file pattern of the selected **Base Path**. If you want to select only from available TIF files of the directory you can type `*.tif` into the wildcards field and only matching files will be shown. The "*" symbol will be replaced by any number of character(s), including none, whereas the "?" symbol will be replaced by only one character.

The file selection procedure follows Windows Explorer conventions: click with the left mouse button, expand the selection by holding down the [Ctrl] or [Shift] key respectively while clicking other files. Finally, move the files to the **File List** window by pressing the "Add" button in the dialog box. To remove files from the list use the same selection process and press the "Remove" button. Use the "Add All" button to select all files in a specified directory.

When using the "Add Wildcards" button all filtered files will be added to the **File List** when starting the current process. Check **Include Subdir.** on if you want to expand the file search and to display these subdirectories of the **Base Path** in the **Preview** area as well.

The selection by **wildcards** can be very useful if you want to process batches of different files repeatedly without the need of going through the file selection process each time. Use `*.*` instead and save this setting to your parameter file together with the path setting. Then, whenever the indexing process is executed using this parameter file, all files (regardless of their file name or extension) residing in the **specified directory** will be processed. This way, the parameter setting becomes independent of a particular job.
To enlarge the view of single files double click the file in the **Preview** window. A preview window opens. It can be closed with [Esc] or by clicking on the **Close** button.

Moving the cursor over a thumbnail displays additional information for this file. The extent of information can be configured with **Settings**.

The button **Stop Loading** ends the process of generating thumbnails for all files in the selected directory (it may take some time to generate all thumbnails if the directory contains a large number of files!). You may load them later by selecting one or more files and then using the **Load Thumbs** button.

Return to the Wizard with **OK**.

**Settings**

A dialog box opens to determine display options of the **Select Files** dialog box.

**View**

**Thumbnail** generates and displays thumbnails. **List** lists the names of the **Source Files**. The option **Only file names (fast)** can speed up the list display of available files considerably. However, no further file information will be displayed.

**Images**

**Columns** controls the number of thumbnails in a row.

- **Range:** 1 thru 10
- **Default:** 3

Activate **Auto Load** to prevent a thumbnail generation of raster files larger than the specified value. Files that exceed the size limit may be loaded on demand with the **Load Thumbs** function.

- **Default:** 1500 [kByte]
Displayed File Details

Select the information to be displayed as Tool Tip Information whenever the cursor is moved to a file in the Source File window. The checkbox **Show Tool Tips** in the menu **Options – Toolbars** must be activated for this function. The number of columns for the list display mode can also be specified.

Return to the **File Selection** with OK.

Load Sample Drawing (Task 2)

Before defining Raster Cleanup functions a sample drawing needs to be loaded. It serves to determine which functions are necessary for all drawings in the current process. All selected cleanup functions will be executed on the sample. This way you can anticipate the later results on all drawings.

From Selection Set

Select a drawing file from the file selection in Task 1.

Other

Select a drawing file from an arbitrary location. This is necessary when drawing files have been selected using wildcards.

Use already loaded drawing

If you have already loaded a reference drawing you can use this option.

Click **Next**. The selected file will be loaded and displayed.
Raster Cleanup (Task 3)

In this task you can define the cleanup operations for the drawing files. The selected operations are listed.

Stop after cleanup for additional editing

Only relevant for Interactive processing: This option may be activated to use additional raster functions in a process. It will be most suitable when some of the selected drawing files differ from others, e.g. by color inversion.

Use the Wizard to select the desired cleanup functions or to add functions to the existing list. The following dialog boxes appear one after the other for selecting and defining the available functions. Please note that the available cleanup functions are limited in VPindex lite. For details on cleanup functions see Section 5: Raster File Editing, Cut to Drawing Format, 4 Point Drawing Calibration.

Mirror/Invert Dialog
Dirt Removal Dialog

Rotation Dialog

By Paper Format

The rotation of a drawing file will be linked to its paper format. For each paper format there are options to rotate the drawing file if the layout differs from the expected paper format orientation. The necessary rotation of the loaded sample file will be executed after clicking **Next**.

If no fitting paper format has been defined, yet, a message appears and it is possible to rotate the loaded file manually.

When a fitting paper format has already been defined the sample drawing will be rotated automatically on **Next**.
By Title Block

Similar to a rotation according to the paper format the title block can also be used to perform a rotation of the drawing file. If a title block template has already been defined the drawing will be rotated accordingly after clicking **Next**.

If no active title block has been defined, yet, a message appears and it is possible to rotate the loaded drawing manually.

![VIndex](image)

**Manual**

Rotation will be performed manually as required.

⚠️ Do not use this mode in an unattended batch process!

**None**

No rotation.

Calibrate to Paper Format

![Raster Cleanup](image)

**Automatic**

The first option will automatically select the best fitting paper format from the **Paper Format List** (see below) and rubber sheet (4 point calibration) the raster file accordingly to fit to this paper format. If no fitting paper format has been selected, yet, a dialog opens on **Next** prompting to calibrate the sample drawing manually.
If **VPindex** cannot assign any fitting paper format in an unattended process this file will not be processed. Instead, a message will be generated in the error log file and the raster drawing will be moved to the directory for unprocessed files.

**Manual**

The operator needs to select the paper format for each drawing. The following selection dialog opens. It also allows for a definition of new formats:

Once the format has been selected, click **Finish** to proceed to the 4-point rubber sheeting execution.

**Paper Format Selection**

When Rotation or Calibration has been selected for a specific paper format a message appears and prompts for a paper format. By default, this is the paper format of the sample drawing.
Deskewing Dialog

This dialog only comes up when Paper Format Calibration function has not been selected. An automatic alignment is already part of this function.

Click on Finish in order to finish the Raster Cleanup Wizard.

A list of all selected Cleanup functions is now displayed. This list can be expanded or modified with the Wizard at any time.

Click on Next to select paper formats (VPindex), or to advance to the Template setup (VPindex lite).
Paper Format Selection (Task 4)

This dialog displays the selected paper formats for the current process. The paper format selection according to the occurring paper formats in an indexing project is only required if one of these cleanup options have been activated:

- Rotation by Paper Format
- Automatic Calibration to Paper Format

The first column displays the names of paper formats. The second and third columns indicate height and width of a paper format in [Base Units]. The following two columns contain the defined rotation for vertical or horizontal oriented raster files. Example:

- Paper Format: DIN/ISO A0 (1189 x 841 mm)
- Paper Height: 1189.00 [mm]
- Paper Width: 841.00 [mm]
- Rotation for vertical Raster Files: 90°
- Rotation for horizontal Raster Files: 0°

Add

A sub dialog box opens. Paper formats can be selected from the list of standard formats.
Check

This function allows to determine the best fitting format for those drawings different from the current sample drawing. To proceed a respective drawing needs to be loaded and cleaned. The program will then calculate a fitting paper format automatically.

First, a dialog appears to load a drawing whose format is to be determined.

Clicking **Next** loads the raster and the interactive **Raster Cleanup** dialog opens:

Double-click any desired function to be executed on the loaded drawing for preparation.

Use only those functions that have been previously selected in **Step 3**. This will make sure that the correct paper format will be assigned to this type of drawings.

The option **Start predefined cleanup** is not available for this step.
Close the dialog after the drawing has been cleaned. The dialog Check Paper Format opens showing the sample file and the best fitting format (red frame).

![Check Paper Format dialog](image)

When clicking Finish this format will be added to the selection list and the Paper Format Selection dialog re-opens.

**New**

A new paper format can be defined and added to the paper format selection list. For details on how to create a new format see below.

**OK**

The selected formats will be added to the Paper Format list.

**New/Modify**

A new paper format can be defined or existing formats (select the desired format first) can be modified. A dialog opens for specifications:

![Modify Entry dialog](image)

The default name for a new format is **NewPaperFormat**.

The **Width**, **Height** and **Margin** values are displayed in **Drawing Units** (mm or inch). For details see Section 5: Calibrate to Paper Format.
Automatic Rotation of raster drawings according to the desired orientation after processing can be defined for landscape and portrait layouts. Click the desired rotation for each layout option.

Default Width: 297 [mm]
Default Height: 210 [mm]
Default Margins: 10 [mm]
Default Rotation by Portrait: +90°
Default Rotation by Landscape: 0°

Clicking OK brings you back to the Paper Format Selection dialog.

Delete

Deletes the selected paper format from the selection list.

Indexing Templates (Task 5)

In Indexing Templates you can determine the information details to be recorded (indexed) and their position in the drawings. There are two types of templates to set up:

- templates which include the layout pattern of a title block
- templates which include only isolated areas (Cells) and which can be specified at any position.

The function option Rotation By Title Block requires an indexing template of the first type.

All indexing templates selected for the current process will appear in the Templates list. The list is empty when no templates have been defined, yet.

Click on a template to display the defined cells and a preview:
The Wizard (see below) will assist in adding templates to the list or in removing templates from the list.

To use selected templates in a current process click on Next and continue with Data Field Definition (Step 6).

Drawings with different paper formats may still contain the same title block layout. It is therefore possible to use identical indexing templates for different paper formats. However, this is only valid for templates which include the layout pattern of a title block. For templates which include only isolated cells a „best fit“ will be determined according to the extents of the drawing used for the template’s creation.

Select existing Templates / Create new Templates with the Wizard

For activating other existing templates or creating new templates click the Wizard button.

A dialog opens to display all existing templates of the Template Library and those templates already selected for the current process. Click on a template entry to display a preview.

With >> one or more templates can be selected/activated for the current process. They will be added to the list Templates for current process.

Create

Creates a new indexing template (see below).

Modify (existing) Template

Use this function to modify created indexing templates, or to test whether templates do match with a sample drawing (Test Template/Search). The workflow is similar to the one in function Create (New Template).
Remove Template

Removes/deletes the selected template. Templates in the right list (Templates for current process) will be removed from the current settings, thus, they will not be used for the current process. Templates in the left list (Templates) will be deleted from the Template Library directory.

⚠️ Templates deleted from the Template Library will be lost for future processes.

Save to Library

This function can only be used when templates are marked in the list Templates for current process. These templates will then be saved to the Template Library.

Print

Prints a selected indexing template.

Close the indexing template Wizard with OK.

Load Sample Drawing

Click the Create button. If no reference drawing has been loaded the Load Sample Drawing dialog opens for selection.
Select a new drawing containing a title block you want to use for creating a template. The dialog **Raster Cleanup** appears to execute cleanup functions. The dialog will not appear when the already loaded sample drawing is used.

With a double click on a function from the list this function will be executed on the selected sample drawing. With **Start predefined cleanup** all functions previously determined in **Step 3** will be executed.

⚠️ Use only the functions previously determined in **Step 3**. This way you ensure that a correct paper format will be assigned for this type of drawings.

**Close** the dialog after the drawing has been cleaned.

**Create - Create Indexing Template**

In **Indexing Templates** you can determine the information details to be recorded (indexed) and their position in the drawings. There are two types of templates to set up:

- templates which include the layout pattern of a title block
- templates which include only isolated areas (Cells) and which can be specified at any position.

**Templates which include only isolated areas (Cells):** Skip the dialog with "Next".

**Templates which include the layout pattern of a title block:** The sample drawing's title block will be marked and a template will be created. Then, if necessary, the template can be also be optimized.
Mark Title Block

For generating a new indexing template click **Mark Title Block**. The dialog disappears and you need to draw a window around the title block of the sample drawing. Then, **VPindex** generates a vector model of the layout pattern of the title block and displays it together with a cut out section of the title block.

**Background/Template Display {on/off}**

Switches the corresponding displays on or off.

**Zoom Icons**

These Icons allow for changing the current preview. In the preview window you can also use wheelmouse commands for zooming or panning.

**Draw/Erase Title Block Template Design**

Use these functions to add orthogonal lines or to erase lines by clicking on a line. This allows to improve/correct the automatically generated model of the title block.

⚠️ Usually, missing lines in the generated model do not affect the title block search as much as wrong lines or wrong line connections/directions do!

**Position of Title Block**

If the position of the title block in the drawings is always similar to the position in the reference drawing check **Similar to Sample**. Otherwise, check **Variable** in order to increase the search tolerance. Be aware, however, that the search time may increase.

**Test Title Block Search**

Click this icon if you want to test a title block template on a sample drawing. When passed successfully the template will overlay the sample drawing and this message appears:
Otherwise, this message appears:

Click **Next** to finish. You will then proceed to select/define title block cells for data extraction.

**Create - Define and Name Template Cells**

Areas in drawings to record data from during an indexing process are called „cells“. Thus, cells are the major components of an **Indexing Template**. If a layout pattern of a title block has been set up (displayed as a pattern of vertical and horizontal lines) cells can be defined and named by picking them in the preview window.

Template cells that are not part of a title block layout pattern can be defined with the function **Create Isolated Cell**. Defined cells will be displayed in a transparent color.

The example on the left shows a generated layout pattern for a title block, yet without selected cells. The example on the right shows an indexing template with defined cells:
Click Cell to Name (Select Title Block area)

This icon is active by default. The design of the cursor changes into a "pointing hand". To select a template cell just click into the cell (box-like area) in the title block. Assign a cell name in the Template Cells list on the right.

Clicking on a template cell at any time selects the cell and switches into the edit mode.

Delete Cell

Click on this icon prior to deleting a selected data cell. The cursor design changes. Click into the cell you want to delete. The cell's transparent coloring and the assigned name in the list disappear.

Create Isolated Cell

This function allows for defining cell areas at any position where information is needed to record from a drawing. Thus, these areas do not need to be part of a title block, but may as well be. Cell areas are simply defined by drawing a rectangle with the mouse. In vector files a cell can also be defined just by clicking on a vector text.

After all required cells have been defined click Next to save an indexing template to the Template Library.

OCR Options (text recognition)

Options for OCR can be specified for each cell, e.g. only numbers, only special characters etc. Selection options include None, Barcode, Checkbox and pre-defined or new defined settings for text recognition (e.g. only numbers, only special characters etc. New defined options are saved and will be available for following processes.

Available default settings:

None

Text recognition will not be activated for this cell. However, to facilitate direct data entry or during a review run (see Section 16) the cell area will be displayed just the same.

Barcode

A barcode recognition will be activated for a defined cell area. It will return the equivalent numbering as data. The following barcode standards are supported: EAN, ITF, Code 39, Code 128, Codabar and Postnet.

Checkbox

For a defined cell area a OMR (Optical Mark Recognition) will be activated. It will detect whether a check mark is set in a square or rounded checkbox. The return value will either be yes or no accordingly.
GlobalOCRSettings

The current OCR settings (changes can only be made in Options - OCR Options).

AnyChar

All characters will be considered by OCR.

NumbersOnly

To be selected when only numbers occur in a cell.

Default: GlobalOCRSettings

GlobalOCRSettings are related to the current OCR options. Changes to these options in between two process runs may result in different recognition results.

Creates new OCR settings. After assigning a name the dialog OCR Settings opens.

Opens the dialog OCR Settings for changes of the current settings.

Deletes the selected setting.

Settings

For each cell you can specify individual text recognition settings. Text Angle refers to the position of text inside a cell. Choices include angles of 0, 90, 180, and 270 degrees. You can also specify whether small text - normally standard text labels in a title block cell – shall be ignored, or whether the full text content shall be captured as data.

Default: 0°, Ignore cell title / small text
Create - Save Indexing Template

Select the desired path and directory – by default the VPindex subdirectory Support – and click Finish. The dialog Indexing Templates reappears displaying all defined indexing templates for selection.

Data Field Definition (Task 6)

This dialog allows to organize the data export of the extracted template cell contents. If nothing has been defined, yet, an empty dialog opens:

Import Fields from Existing Database

Imports data field definitions from existing databases (see below).
Import Fields from Indexing Template File
- Generates data field definitions from the cells of indexing template files (see below).

Add New Data Field
- Opens a dialog to define new data field definitions (see below).

Modify Data Field Properties
- Select a data field and then click this icon. A dialog opens to modify a data field definition. Also see: *Add new data field*.

Delete Data Field
- Deletes the selected data field.

Modify Field Order
- Allows to move a data field up or down in the list order.

Import Fields From Existing Database
- Click this icon and select a data source file of an ODBC compliant database.

![Select Data Source](image)

On **OK** the dialog for selecting an existing table of the database opens. The field definitions of one table at a time can be imported.
In the dialog **Select Data Fields** clear the checkmarks of fields you do not want to import.

In some cases the **Field Type Definition** dialog shows up for modifying the field type. This happens if the field type used in the database is non-standard and therefore not recognized by VPindex:

The data fields will be imported and displayed with their field specifications.

### Import Fields from Indexing Template File

Opens a dialog to select an indexing template file (*.tbt). The contained cell names and definitions will be offered to adopt them as field definitions. Dialogs **Select Data Fields** and **Field Type Definition** will follow.(see above).
Add New Data Field

Clicking this icon opens a dialog to specify a new data field:

![New Data Field dialog]

Enter the desired field **Name** and specify **Type**, **Length/Scale**, and **Precision** if necessary.

Standard ODBC field types are:

- **Char**
- **Numeric**
- **Decimal**
- **Integer**
- **Small Int**
- **Float**
- **Real**
- **Double**
- **Date Time**
- **Var Char**

Special **VPindex** field types include:

- **Counter**: Const., Primary Key, NOTNULL, Incremented
- **Filename (Out)**: Const., Archive Filename of Drawing
- **Path (Out)**: Const., Archive Full Path of Drawing
- **Path+Filename (Out)**: Const., Archive Full Path and Filename of Drawing
- **Filename (Out/Modifyable)**: Modifyable Archive Filename of Drawing
- **Path+Filename (In)**: Const., Archive Full Path and Filename of Source DWG
- **Processing Date**: Const., Actual Date of Archiving

A **Default Value** will be used for a field if it is not linked to a Template cell, or if the OCR option **None** is defined for the cell.

Each data field can be defined as

- **Required** {on/off}
- **Visible** {on/off}
- **Constant** (value) {on/off}
- **Export to Database** {on/off}

The check box **Ask for Default** {on/off} allows to stop and ask for a value required by the database system when the indexing process extracts the data from the first drawing of the process.

Field content with a setting **Export to Database**{off} will not be exported to a database. However, it can still be used in the process, e.g. for assigning a new output file.
Link Template Cells with Data Fields

In this dialog you can link data fields to the corresponding data cells of the indexing templates. Each activated template with the assigned data cells is listed on the left side. "Unused for Indexing Output" indicates that a data field has not been assigned to a data cell, yet. The linking happens automatically for those cell names that are identical with data field names.

When clicking a data cell on the left a list box opens on the right for selecting a corresponding data field:

Export to Database (Task 7)

In this dialog you define one or more database(s) to export indexing results (data tables) to.

If no database export filter has been defined, yet, the display is empty.
Add

Opens a dialog showing the available database filters for selection:

Select the desired filter and click OK. The corresponding configuration dialog opens to specify the data export.

If the export to a HTML file is selected, a dialog opens to define this output:

Output File

Define the HTML output file name and path or use the browser.

Image Output

Specify how the processed drawing should appear in the HTML file. You can choose between:

None: The drawing does not appear at all
Thumbnail: The complete drawing appears as a thumbnail
Title Block: The title block will be cut out and displayed

The size of each image (Width, Height) and File Name and Path need to be set up. Otherwise, use the browser for selection.

With pressing OK the dialog closes and you will return to the Export to Database dialog.
Delete

Deletes the selected database export filter from the list.

Configure

Allows to configure the database export filter.

**General Output Settings (Task 8)**

In this section various output options can be defined and specified.

**File Format Conversion**

You can specify a file format all processed raster files will be converted to and saved. The dialog will be grayed if **Only Indexing** is selected as processing mode, since files will only be copied, moved or renamed.

Switch on **Convert to Multi Page Tiff** if all processed files should be saved to one multi page TIFF raster file.

The option **Keep Pages of Multipage Files** should be selected when single pages from a multipage file are going to be processed while the overall structure of the file is to remain unchanged.

Also, select an "auxiliary" file format for those input file formats which can be read (loaded and processed) but not saved to.
Output Directory, File Name Definition

Root Directory
Define the **Directory** for saving the processed files.

File Name
The field **File Name** serves to format the output filename for all processed drawings. Additionally, a new file name may be formatted containing collected data, even in a combination.

Use the Wizard to define the output file name assignment model:

Compose the output file name from data fields and the input file name as required. Select between assigning a data field as output name or the input file name. When using multi-page files (TIF or DCX) as source files you may also select the page number as part of the output file name.

If this field remains blank the input file name will be used.

In an **Only Indexing** process the settings **Output Directory** = <input directory> and **File Name** = <INFILENAME> will prevent processed files from being copied, moved or renamed.
Error / Logging Root Directory

Specify whether error and log messages should be saved in the output directory or in any other directory.

Ready to Go

The indexing process setup is now completed and ready for execution.

Finish terminates the Wizard assistance and displays all process settings in a Tableau overview.

Here, all settings can again be reviewed or modified (see below: Settings in Tableau Overview).
Save as
Opens a dialog to save all settings in a new file. Use this option when you have modified existing settings without overwriting the original settings file.

Go
Starts a process with the current settings. When settings are intended to be used for future processes, use Save & Go to start and save the settings.

Save & Go
Saves the current settings and starts the process.

Save & Close
Saves the current settings and closes the Tableau overview.
Settings via Tableau

Menu: **Indexing**, Function: **Indexing Wizard**

CMD: VPINDEX ➔ Dialog

Start the Wizard – the **Welcome** page will appear:

This page may be suppressed. The Wizard will then start with the page **Create, Load or Modify Settings**. From here you may also return and re-activate the Welcome page with **Back**.

On this page you can define to create new settings or to load and modify existing settings. The Wizard may be activated for assistance to modify existing settings. Otherwise, settings will be displayed via the Tableau overview.
If you want to create a new parameter set the Wizard will guide you automatically through all settings (see Create Settings with Wizard Support). If a parameter file already exists and you want to review or modify the settings without Wizard support, clear the checkmark. Then, the Tableau Overview opens.

**Process Settings**

There is a total of 10 tabs organized in a way that each tab contains the necessary settings for functions or options. Click a tab to display the settings and modify as required. For some tabs click the Wizard icon for modifications. Other tabs allow for a direct changing of settings. This will be indicated for each tab.

We refer to Create Settings with Wizard Support above for details on the available options. At any time during review or modification the current settings can be saved or used for initiating a process run:

**Save as**

Opens a dialog to save all settings in a new file. Use this option when you have modified existing settings without overwriting the original settings file.

**Go**

Starts a process with the current settings. When settings are intended to be used for future processes, use Save & Go to start and save the settings.

**Save & Go**

Saves the current settings and starts the process.

**Save & Close**

Saves the current settings and closes the Tableau overview.
Tab: General

Choose the processing mode for either **Only Indexing** or **Cleanup and Indexing**. Also, specify whether you want to run an interactive or automatic (unattended **Batch Mode**) process. When selecting the unattended mode a name for the intermediate directory is required. Indexing data and related thumbnails of all processed drawings are saved to that directory for later review/correction and final approval prior to exporting data.

Tab: Files

Click the Wizard icon to modify the file selection.

See also: **Drawing File Selection (Task 1)**
Tab: Cleanup

Click the Wizard icon to modify the raster cleanup functions or to add new functions by selecting a function in the left window (Available Commands). Drag and drop it (keep left mouse button pressed) into the window Selected Commands.

Modify Execution Order

Allows to move a cleanup function up or down in the list order.

Delete Cleanup Function

Deletes the selected function.

See also: Raster Cleanup (Task 3)

Tab: Paper
Add
Allows to add other standard formats to the list or to specify a new format.

Modify
The selected paper format can be modified.

Delete
Deletes the selected paper format from the selection list.

See also: Paper Format Selection (Task 4)

Tab: Templates (Indexing Templates)

Click the Wizard icon to modify the title block template selection and field definitions.

See also: Indexing Templates (Task 5)
Tab: DB Fields

Import Fields from Existing Database

Click this icon and select an ODBC compliant database.

Import Fields from Indexing Template File

Generates data field definitions from the cells of indexing template files (see below).

Add New Data Field

Clicking this icon opens a dialog to specify a new data field:

Modify Data Field Properties

Select a data field and then click this icon. A similar dialog as above opens containing the field properties for modifications.

Delete Data Field

Deletes the selected data field.

Modify Field Order

Allows to move a data field up or down in the list order.

See also: Data Field Definition (Task 6) HIDD_IDX_WZ_DBFIELDS
Tab: Cells - Fields

This tab allows for linking indexing template cells (on the left) to data fields. Clicking into a data field on the right opens a list box containing the available data fields for assignment.

See also: Link Template Cells with Data Fields

Tab: DB Export

Select and define one or more database(s) to which the indexing results will be exported.

See also Export to Database (Task 7)
Tab: Output

Define output path and name assignment for the processed raster files. Use the Wizard for the file names related to database data.

Specify the conversion format for files if required.

See also General Output Settings (Task 8):
- File Format Conversion
- Output Directory, File Name Definition

Tab: Log

In this dialog the file names for gathering process data and error information can be defined. Also, the directory for files which could not be processed can be selected.
Use Paths relative to Output Directory {on/off}

If this checkmark is on all output settings of this dialog refer to the previously defined output directory for the processed drawing files.

Errors

A log file will be generated listing all appearing errors during an indexing process in sequential form. Enter the name for a new file or search for an existing file. In that case new error information will be appended to existing data.

Click this icon to review an existing error log file.

LogfileInfo

This file contains information about the indexing process execution. Enter the name for a new file or search for an existing file. In that case new log information will be appended to existing data.

Click this icon to review an existing log file.

Unprocessed

All drawing files which could not be processed will be copied to this directory.

Click on this symbol to list all files in the selected directory.

The structure of both log file types is similar. Each indexing process is separated from a previous one by a title block and a trailer, indicating date and time and the parameter file used. Also, the processing time for each indexed file is listed. In case of errors a short error information is also noted.
Listing of a Log File

# Started indexing job (C:\Program Files\softelec\VPindex V4\Samples\IndexSettings1.vpi; 02.03.2011 13:02:39): #

Processing "C:\Program Files\softelec\VPindex V4\Samples\DinA2-1.TIF"; Page 1 (02.03.2011 13:02:39):
import "C:\Program Files\softelec\VPindex V4\Samples\DinA2-1.TIF" /p 1 /m 1 /x 0.000000 /y 0.000000 /sx 1.000000 /sy 1.000000 /a 0.000000
SPECKLES /a AUTORUBPAPER ROTATEHEADER
Data retrieval/Title Block recognition.
export "C:\Indexing\Output\Intermediate\Temp_1.TIF" /p -1

Processing "C:\Program Files\softelec\VPindex V4\Samples\DinA2-2.TIF"; Page 1 (02.03.2011 13:02:45):
import "C:\Program Files\softelec\VPindex V4\Samples\DinA2-2.TIF" /p 1 /m 1 /x 0.000000 /y 0.000000 /sx 1.000000 /sy 1.000000 /a 0.000000
SPECKLES /a AUTORUBPAPER ROTATEHEADER
Data retrieval/Title Block recognition.
export "C:\Indexing\Output\Intermediate\Temp_2.TIF" /p -1

Processing "C:\Program Files\softelec\VPindex V4\Samples\DinA4-2.TIF"; Page 1 (02.03.2011 13:03:01):
import "C:\Program Files\softelec\VPindex V4\Samples\DinA4-2.TIF" /p 1 /m 1 /x 0.000000 /y 0.000000 /sx 1.000000 /sy 1.000000 /a 0.000000
SPECKLES /a
Error: AUTORUBPAPER
Error: No matching drawing frame found!
Error: Copied file from "C:\Program Files\softelec\VPindex V4\Samples\DinA4-2.TIF" to "C:\Indexing\Output\unprocessed\DinA4-2.TIF".

#############################################################################
Processing time for "C:\Program Files\softelec\VPindex V4\Samples\DinA2-1.TIF"; Page 1: 06s
Processing time for "C:\Program Files\softelec\VPindex V4\Samples\DinA2-2.TIF"; Page 1: 05s
Processing time for "C:\Program Files\softelec\VPindex V4\Samples\DinA4-2.TIF"; Page 1: 01s
Processing time for all files: 12s
#############################################################################

Error: Not all input files were processed. A list of unprocessed files follows:
Error: "C:\Indexing\Output\unprocessed\DinA4-2.TIF" <1>
Error: # Finished indexing job (C:\Program Files\softelec\VPindex V4\Samples\IndexSettings1.vpi; 02.03.2011 13:03:02) #
Listing of the corresponding Error Log File

# Started indexing job (C:\Program Files\softelec\VPindex V4\Samples\IndexSettings1.vpi; 02.03.2011 13:02:39): #

# Processing "C:\Program Files\softelec\VPindex V4\Samples\DinA4-2.TIF"; Page 1 (02.03.2011 13:03:01): #
   Error: AUTORUBPAPER
   Error: No matching drawing frame found!
   Error: Copied file from "C:\Program Files\softelec\VPindex V4\Samples\DinA4-2.TIF" to 
"C:\Indexing\Output\unprocessed\DinA4-2.TIF".
   Error: Not all input files were processed. A list of unprocessed files follows:
   Error: C:\Indexing\Output\unprocessed\DinA4-2.TIF <1>
   Error: C:\Indexing\Output\unprocessed\DinA4-2.TIF <1>

# Finished indexing job (C:\Program Files\softelec\VPindex V4\Samples\IndexSettings1.vpi; 02.03.2011 13:03:02): #

#
SECTION 16
RUNNING A PROCESS

General Information

A process can be executed in two ways:

• **Unattended process (VPindex only):** this mode sequentially executes all defined process steps for all selected drawings and saves the results for subsequent reviewing. In the separate review process you can check and make necessary corrections to the intermediate results before the final result is produced. Especially, extracted data of title blocks can be checked, corrected and approved for every single drawing before transferring the information, e.g. to a selected database.

• **Interactive process (VPindex and VPindex lite):** in this mode all operations are carried out sequentially for each drawing, including title block data extraction (if selected) and their immediate approval with the need of an operator attendance. Since this process mode requires permanent operator observation, it is also possible to activate manual cleanup functions in the process settings.

Both processing modes require individual settings (see Section 15). The process can either start immediately after settings have been defined or at any other time. In the latter case selecting and loading the appropriate settings file will always be the first step.

Start Indexing

<table>
<thead>
<tr>
<th>i</th>
<th>Menu: <strong>Indexing</strong>, Function: <strong>Indexing Wizard</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD: <strong>VPINDEX</strong> → Dialog</td>
<td></td>
</tr>
</tbody>
</table>

Start the setup for the indexing process by clicking this icon or select the item **Indexing Wizard** from the menu **Indexing**. The welcome page appears first if not switched off.

The **Command Line Input** allows to start a process with a previously saved settings file. In that case the following dialogs will be skipped and the execution starts according to the desired mode.
The next dialog allows to select the parameter file you want to use for this indexing process. Do not switch the Wizard support to on.

Clicking Finish opens the Process Settings dialog:

If necessary, Settings can be modified.

Click Go to start the process according to the current settings.
Unattended Process

Go

First, **VPindex** checks if the intermediate directory is empty. This is important regarding a later review and approval of all processed files prior to saving the results. If the directory is not empty, the following message appears:

Click **Yes** to delete all files residing in that directory and start the process. Clicking **No** aborts the process.

Now, the indexing process starts. The first drawing is loaded and the following dialog appears indicating the current drawing and the current operation:

The dialog shows that the first of six drawings is currently being processed and the current operation no.4 of a total of 5 is **Rotate by Title Block**.

Pause

Pressing the **Pause** button interrupts the process after completing the current operation. The following dialog appears:

Abort All

Stops any further processing of the selected, yet unprocessed files. All processed files can be reviewed separately by pressing the review icon or selecting the menu item **Indexing → Indexing Review**. Files which have been copied to the **Unprocessed** directory because of process errors will not be included for the review function!

Skip

Skips the currently processed file and starts processing the next drawing file.
Pause

Saves the current state and terminates the process.

Then, by starting the indexing function again you can continue with a terminated process or you can start with a new process.

Press Yes to continue the interrupted process.

Continue

 Returns to continue with the current process.

End

After an unattended process has finished the following dialog appears:

The example indicates that the process has ended with an error: one file could not be processed and was copied to the directory Unprocessed. The whole process time was 18 s.

Review will immediately start a review run of all processed files and the collected indexing results (see below). Click on Close to start the review run later; in this case the following message appears:
Clicking **Details** opens the log file for detailed information:

```
# Started indexing job (C:\Program Files\softelec\VPindex V4\SUPPORT\IdxQuickStart2000-1.vpi; 02.03.2011 13:48:16): #
#                                                                                                                                   
Processing "C:\Program Files\softelec\VPindex V4\Samples\DinA2-1.tif" (02.03.2011 13:48:16):
  import "C:\Program Files\softelec\VPindex V4\Samples\DinA2-1.tif" /p -1
  SPECKLES /a
  AUTORUBPAPER
  ROTATETITLE BLOCK
  Data retrieval/Title Block recognition.
  export "C:\Indexing\intermediate\Temp_1.tif" /p -1

Processing "C:\Program Files\softelec\VPindex V4\Samples\DinA2-2.tif" (02.03.2011 13:48:23):
  import "C:\Program Files\softelec\VPindex V4\Samples\DinA2-2.tif" /p -1
  SPECKLES /a
  Error: AUTORUBPAPER
  Error: No matching Frame found!
  Error: Copied existing file from "C:\Program Files\softelec\VPindex V4\Samples\DinA2-2.tif" to "C:\Indexing\Output\unprocessed\Din30.tif"!
  Error: Copied file from "C:\Program Files\softelec\VPindex V4\Samples\DinA2-2.tif" to "C:\Indexing\Output\unprocessed\DinA2-2.tif".

Processing "C:\Program Files\softelec\VPindex V4\Samples\DinA3-2.tif" (02.03.2011 13:48:30):
  import "C:\Program Files\softelec\VPindex V4\Samples\DinA3-2.tif" /p -1
  SPECKLES /a
  AUTORUBPAPER
  ROTATETITLE BLOCK
  Data retrieval/Title Block recognition.
  export "C:\Indexing\intermediate\Temp_4.tif" /p -1

Processing "C:\Program Files\softelec\VPindex V4\Samples\DinA4-1.TIF" (02.03.2011 13:48:34):
  import "C:\Program Files\softelec\VPindex V4\Samples\DinA4-1.TIF" /p -1
  SPECKLES /a
  AUTORUBPAPER
  ROTATETITLE BLOCK
  Data retrieval/Title Block recognition.
  export "C:\Indexing\intermediate\Temp_5.TIF" /p -1

# Processing time for "C:\Program Files\softelec\VPindex V4\Samples\DinA2-1.tif": 07s
# Processing time for "C:\Program Files\softelec\VPindex V4\Samples\DinA2-2.tif": 02s
# Processing time for "C:\Program Files\softelec\VPindex V4\Samples\DinA3-2.tif": 04s
# Processing time for all files: 18s
#                                                                                                                                   
Error: Not all input files were processed, list of unprocessed files follows:
Error: "C:\Indexing\Output\unprocessed\DinA2-2.tif"
Error: "C:\Indexing\Output\unprocessed\DinA2-2.tif"
Error: "C:\Indexing\Output\unprocessed\DinA2-2.tif"

# Finished indexing job (C:\Program Files\softelec\VPindex V4\SUPPORT\IdxQuickStart2000-1.vpi; 02.03.2011 13:48:42): #
#                                                                                                                                   
```
Review

Click this button to start the review process for approving and/or correcting the results of an unattended process. A dialog opens pointing at the directory with files to be reviewed. Files are referred to the last performed indexing process.

You can specify whether the title block area or the whole drawing will be displayed during the review run.

**OK** will start the review run. In case the process has finished with errors the review run will start with unprocessed files first.

Unprocessed Files

If there are unprocessed files as a result of errors during cleanup and/or title block recognition, then these unprocessed files are manually processed again in the first step of the review. The automatic functions are replaced by manual operations to allow an interactive cleanup and indexing data extraction, including database export approval.

Position Template

The following dialog appears in case of an un-matching template for the current file in the process. This may be due to, e.g. a faulty rotation, a title block displacement, etc.
VPindex

Raster Cleanup

Opens an interactive dialog. Select required cleanup functions to prepare the current file for appropriate data retrieval.

Position Template

The selected indexing template can be positioned with the mouse. Confirm the desired template position with a left click to start data retrieval. Press [ESC] to abort and to return to the dialog.

Continue without Template

Closes the dialog and prompts for manual Data Retrieval, since a matching indexing template would be needed for an automatic retrieval.

After all files are processed the following message appears:

![Indexing Finished](image)

Click Close to start the review of the successfully processed drawings with their extracted title block data.

Data Retrieval

A dialog is displayed with all data automatically extracted with the help of an indexing template. To prevent the dialog from covering parts of the current drawing it can be docked below, above or next to the main window. All zoom commands are available in the main window.
The dialog **Enter Data** shows the results for approval or correction.

The Data Fields are listed on the left side, the extracted title block data on the right. Empty fields indicate that either the recognition failed or data needs to be entered manually (here: **Revision**).

The first database field is selected automatically and the respective title block cell changes in color to Magenta. The other cells are marked in Cyan. Recognized data is also highlighted for editing. Using the **[Return]** key allows to quickly check each database field entry in a sequential mode. The corresponding title block cell changes in color to Magenta. Enter new data via your keyboard into empty fields. All fixed data cannot be edited and are grayed. Clicking a database field changes the corresponding cell in the title block to Magenta.

A **right** mouse click in the dialog will display the following context menu:

- **Zoom to active cell {on|off}**

  With the option **on** the zoom is set to the active cell. Select a zoom state with settings 1:1, 2:1 or 4:1. The entire area of the indexing template will be displayed with the option off.

  **Default:** on
Large Font {on|off}

With the option on text will be displayed by 50% larger in the dialog. Re-setting this option may become effective only with the following drawing.

Default: off

Show Template {on|off}

With the option on an indexing template’s layout pattern (if available) will be displayed. This may be helpful in case a presumably wrong pattern has been tried to match with the current drawing.

Default: off

Entry History

For each line of entries there is a drop-down list on the right containing previous entries. Each keyboard entry will be checked whether identical initial characters have been used already. If so, these will be prompted automatically in order to speed up the recording of re-occurring data.

Manual OCR

Click this icon or press the <F2> key to re-apply a text recognition (OCR) on a specific cell area. Drag a window rectangle around the required text area in the drawing. The result will be returned for the current cell.

After reviewing/approving all data sets and results the data sets are transferred according to the database definitions. All processed drawings are saved to the output directory. If deletion of the input files has been activated, these files will also be deleted.

OK /Next

Once the review of a data set is completed and approved click this button to move on to the next drawing and data set.

Pause /Close

Interrupts the review process and closes this operation. The error log file opens. To restart the review click the review icon.

Modify

Highlights the data entry section (on the right) of the selected database field for modifications.
Abort

Stops the review process and opens a dialog for further options:

Raster Cleanup

Opens the cleanup selection dialog. Any raster cleanup function can be activated with a double click. The selected function processes the current drawing file. These functions are useful with unprocessed drawings or in the interactive indexing mode.

Re-Load Drawing

The current drawing will be loaded in its original state. If needed, a manual Raster Cleanup may be carried out. This function is only available in interactive processing mode to render corrections possible when results do not show as desired.
Interactive Processing

Start

On start the first drawing will be loaded and the following dialog appears in the foreground indicating the current drawing and the current operation:

The dialog shows that the first of six drawings is in process and the actual operation no.4 of a total of 5 is **Rotate by Title Block**.

If a manual cleanup function has been selected (e.g. Manual Cut to Paper Format) the program will stop and waits for user interaction to execute such a function. The program will also stop if a raster cleanup function cannot be performed, e.g. because of a mis-matching paper format. Then, the program continues.

Pause

Pressing the **Pause** button interrupts the current process after completing the current operation. The following dialog appears:

Abort All

Stops any further processing of the selected, yet unprocessed files. All already processed files and approved data sets are saved.

Skip

Skips the currently processed file and starts processing the next drawing file.

Pause

Saves the current state and terminates the process.
Then, by starting the indexing function again you can continue with a terminated process or you can start with a new process.

Press Yes to continue the interrupted process.

Continue
   Returns to continue with the current process.

Data Retrieval

When all processing steps are finished data retrieval will start for the current drawing (see above Review – Data Retrieval). A related dialog appears in the case of an un-matching template for the current drawing. An indexing template may be selected and positioned accordingly (see above Review – Position Template).

When all data entries are confirmed the process continues with the next drawing. When all drawings have been processed a message appears and the process is completed.
Indexing Results

Once the indexing process has finished the results will be saved to a database according to the specified settings. The new archived drawing files reside in the specified output directory.

Sample Access Database

<table>
<thead>
<tr>
<th>Drawing-Name</th>
<th>Drawing-ID</th>
<th>Drawing-Number</th>
<th>Revision</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>CASE</td>
<td>974114801</td>
<td>DRW 160 AZ22 835.101</td>
<td>John</td>
<td>C:\Indexing\Output\DinA2-1-cleaned.tif</td>
</tr>
<tr>
<td>B-17 FLYING FORTRESS</td>
<td>974129001</td>
<td>DRW 140 AZ 005 - 710.105</td>
<td>John</td>
<td>C:\Indexing\Output\DinA3-1- cleaned.tif</td>
</tr>
<tr>
<td>HALTER</td>
<td>9741124</td>
<td>DrW 160AZ010 - 620 108</td>
<td>John</td>
<td>C:\Indexing\Output\DinA4-1- cleaned.tif</td>
</tr>
<tr>
<td>PUMP STATION</td>
<td>974114701</td>
<td>DRW 160 AZ 022 835.101</td>
<td>John</td>
<td>C:\Indexing\Output\DinA2-2- cleaned.tif</td>
</tr>
<tr>
<td>B-17 FLYING FORTRESS</td>
<td>974125801</td>
<td>DRW 140 AZ 005 - 211.002</td>
<td>John</td>
<td>C:\Indexing\Output\DinA3-2- cleaned.tif</td>
</tr>
<tr>
<td>PEILSTAB</td>
<td>DrW 160 AZ D 018 -210.209</td>
<td>John</td>
<td>C:\Indexing\Output\DinA4-2- cleaned.tif</td>
<td></td>
</tr>
</tbody>
</table>

Sample HTML Review

Indexing Results

<table>
<thead>
<tr>
<th>Image</th>
<th>Info</th>
</tr>
</thead>
</table>
| ![Image](DinA2-1-cleaned.1.tif) | Drawing-Name: CASE  
Drawing-ID: 974114801  
Drawing-Number: DRW 160 AZ22 835.101-101  
Revision: 0  
Path: C:\Indexing\Output\DinA2-1-cleaned.1.tif |
| ![Image](DinA2-2-cleaned.1.tif) | Drawing-Name: PUMP STATION  
Drawing-ID: 974114701  
Drawing-Number: DRW 160 AZ 022-835.101 |
Indexing Quickstart

Menu: **Indexing**, Function: **Indexing Quickstart**

CMD: **VPIDXQSTART** [S|Settings File <File>] [F|Input File <File>] [O|Output directory <Directory>]

 Starts a process with the current settings. Neither the Wizard nor the tableau overview of the Process Settings is displayed.

Selected files in the current indexing settings will be ignored. Instead, the **Select Files** dialog appears. This way the same indexing settings can be used again for another collection of files.

If wildcards (e.g. `c:\idx\*.tif`) are saved in the current indexing settings instead of single files the indexing process will start immediately. This way files from a specific directory can be processed while the directory is going to be re-filled continuously.

A dialog appears to select a required indexing settings file when starting the function with the [Ctrl] key pressed:

Additional process parameters can be entered via the command line:

**/s (Settings File):** Specifies the indexing settings file (*.vpi) for an indexing process. Currently active settings will be ignored.

**/f (File Selection):** Assigns one or more files to an indexing process. A dialog for file selection will not appear.

**/o (Output Path):** Assigns a new output directory for an indexing process.

*Example:* `vpidxqstart /s "c:\idx\idx settings.vpi" /f "c:\idx\001.tif" /f "c:\idx\002.tif" /o "c:\result"

Process parameters may offer an even more flexible process control when used in combination e.g. with **User Commands** or **Scripting** (see **Section 13**).

Current Settings File

Name and path of the settings file which will be used for the Indexing Quickstart. The list box contains a history of recently created or modified settings files. A new or modified settings file will be offered automatically as the Current Settings File.
### SPECIFICATIONS

#### General Specifications (VPindex / VPindex lite)

<table>
<thead>
<tr>
<th>Import / Export Formats</th>
<th>See Appendix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanner Interface</td>
<td>TWAIN</td>
</tr>
<tr>
<td>Raster Image Formats</td>
<td>No real limitation: 16 million x 16 million pixels max.</td>
</tr>
</tbody>
</table>
| Indexing                       | Wizard-guided title block template generation  
|                                | Definition of database fields          |
|                                | Recognition of field contents (using OCR) |
|                                | Indexing Quickstart                    |
| Database                       | Interface to ODBC compliant database (SQL, etc.)  
|                                | Export to ASCII delimited format (CSV)    |
| Indexing Output                | Edited raster file in desired format to archive  
|                                | Review of indexed data for approval before export |
|                                | Title block contents to customer database and/or HTML index file |
|                                | Protocol and error log files            |
| General Functions              | Multi document interface               |
|                                | Multi page documents                   |
|                                | User coordinate system (user units, scale, origin) |
|                                | Measure: distance, angle               |
|                                | Undo, redo, Redraw                     |
|                                | Cut/copy/paste                         |
|                                | Window/Polygon cut, crop,              |
| Functions of Raster Editor     | Deskew raster file                      |
|                                | Rotate raster file: 90°, 180°, 270°     |
|                                | Despeckle raster file/window: 1 thru 128 pixels |
|                                | Fill holes in raster file/window: 1 thru 128 pixels |
| Graphical User Interface       | Command input via mouse                |
|                                | DDE/OLE interface                      |
|                                | Toolbars moveable and customizable     |
|                                | Online help                            |
| Graphical Display              | Graphical resolution according to OS and hardware |
|                                | ZOOM and PAN function                  |
|                                | Overlay of raster data and vectors     |
|                                | Modification of presentation colors (foreground, cursor, background, grips, etc.) |
| Plot, Print                    | Whole drawing, current view, paper format  
|                                | Scaling: fit paper/custom scaling factor |
|                                | Raster data and/or vector data, selectable through layer settings.  
|                                | Linewidth table                        |
|                                | Preview                                |
Operating Systems  Windows XP/Vista/7
Recommended Hardware  Pentium III/4, 1+ GHz
                  256/512 MB RAM for b/w or small color images
                  512/1024MB RAM for standard or larger color images
                  400+ MB free hard disk space (for color drawings)
                  1024x768 SVGA adapter with windows accelerator

VPindex (additional Specifications)

Direct Scanner Interface  CalComp, Colortrac, Contex, Océ, Vidar, Xerox
CAD Settings  Object snap modes
                  Length of pointing and dimension arrowhead
                  Hatch: single/cross, angle, line distance, solids
                  Transparency: on/off, fix/variable
Add. General Functions  Command line interface
                  Layer, linetype, text style, color manager
                  Project bar
                  Image settings
                  Coord snap
                  Grid, grid snap
                  Ortho, polar, tangent, perpendicular snap
                  Raster and vector snap
                  Drag’n drop
                  Properties (view, modify)
                  Select, delete entities
                  Quick selection
                  Scale drawing
                  Symbol library
                  Rasterize entities
                  Color conversion RGB/PAL, PAL/RGB, view palette
                  Trim, autotrim, extend entities
                  Cut, break entities
                  Build corner between entities
                  Stamp
User Commands  Customize toolbar commands
                  Execute single commands, command sequences, scripts,
                  other applications
Table Recognition  Modify shape and content of raster tables
                  Convert table in vectors
Functions of Raster Editor
- Auto Deskew and Despeckle
- Automatic Cut
- Cut to drawing format,
- Rotate raster file: arbitrary angle
- Mirror, Invert raster file
- Click-select, raster entities
- Select raster objects
- Modify, move, copy, combine raster entities/objects
- Split raster file
- Merge, adjust 2 raster files
- Rubber sheeting (4 point, multi point)
- Smooth entities with raster selection (arc, circle, line)
- Fill raster (b/w, colors)
- Filter: morphology, smooth raster

Raster Editing
- Select raster (pick, window, polygon),
- Copy, Move, Erase raster
- Draw raster entities
- Edit text

Raster Object
- Copy to, Paste from symbol library
- Create Raster Object with raster selection
- Raster Object separation
- Move, Copy, Scale, Rotate raster object

Functions of Vector Editor
- Select vector entities
- Modify/Match layer assignments
- Draw: line, polyline, spline, arc, circle, ellipse,
  quadrangle or polygon area
- Insert: arrowhead, point with style
- Entities: adjust, move, copy, scale, rotate, mirror
- Text: create, move, rotate, scale
- Direct text edit: text, multiline text
- Multiline Text: create, move, rotate, scale
- Edit objects: Array, offset
- Edit, combine, adjust:
  line, polyline, spline, arc, circle, ellipse
- Edit linetypes, text
- Review texts
- Create/edit, explode, insert blocks
- Create and edit block attributes
- Create, explode, erase hatch/solids
- Build corners between elements
- Trim elements
- Smooth transitions between elements
- Assign elevation
- Adjust, align text

Dimensions
- Linear, aligned, radial, diameter, angular, continue,
  baseline
- Dimension style manager
- Automatic mode, manual mode
| **Color Operations** | Automatic binarisation  
Filter: pre-defined (Median, Sharpen, etc.)  
custom filter up to size 7x7 pixels  
Color reduction: automatic/interactive/minor colors  
Color separation  
Color classification  
Load/save palette  
Contrast/brightness/gamma correction |
|----------------------|------------------------------------------------|
| **Tracing** | On b/w or active color  
With or without erasure of raster background (b/w):  
CAD entities (line, arc, circle)  
Contour line  
Dashed contour line |
| **Settings** | Image settings for definition of the active color  
Produce splines  
Straightening parameter  
Assign elevation  
Vectorization method |
| **OCR** | Choose character set from 28 languages  
Special characters, handwritten text recognition |
| **Color Transparency** | Draw quadrangle or polygon area and fill with selectable transparent color.  
**Settings** | 0 thru 100 % transparency |
| **Redlining** | Redlining objects:  
Ellipse, arrow, cloud, transparent rectangle  
Head line and comment text input  
Free positioning of head line text  
User access control and rights configuration  
Redlining save and export |
| **Batch Processing** | General | Execute scripts  
Vector | Rasterize  
Raster | Automatic Cleanup (Despeckle/Fill holes),  
Automatic Deskew,  
Smooth,  
Invert, Mirror (horizontal),  
Rotate: 90°, 180°, 270°,  
Despeckle: 1 thru 128 pixels,  
Fill holes: 1 thru 128 pixels,  
Convert to other raster formats  
Rubber sheeting (multi point) execution  
Cut to paper format |
| **Graphical User Interface** | Command input via keyboard (command line) |
| **Graphical Display** | Bird's eye |
## Supported Raster Formats

(R = only Import; W = only Export; R / W = Import + Export)

<table>
<thead>
<tr>
<th>Extension</th>
<th>Format Name</th>
<th>Black&amp;White</th>
<th>Color</th>
<th>Multipage</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP</td>
<td>Windows Bitmap</td>
<td>R / W</td>
<td>R / W</td>
<td></td>
</tr>
<tr>
<td>B4</td>
<td>Boeing EDMICS</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C4</td>
<td>EDMICS</td>
<td>R / W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAL, CG4, RST</td>
<td>Cals Raster</td>
<td>R / W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CIT, RLE, TG4</td>
<td>Intergraph</td>
<td>R / W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COT, CRL</td>
<td>Intergraph</td>
<td>R / W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DCX</td>
<td>DCX Raster</td>
<td>R</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>G3, G4, RLN</td>
<td>GTX Raster</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GIF</td>
<td>Internet GIF</td>
<td>R / W</td>
<td>R / W</td>
<td></td>
</tr>
<tr>
<td>GP4</td>
<td>Cals Raster</td>
<td>R / W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GR4</td>
<td>ABB Group 4</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HRF</td>
<td>Hitachi Raster</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IFF, ILBM</td>
<td>Amiga IFF</td>
<td>R</td>
<td>R</td>
<td></td>
</tr>
<tr>
<td>IG4, IGS</td>
<td>Image Systems</td>
<td>R</td>
<td>R (Gray)</td>
<td></td>
</tr>
<tr>
<td>IM1</td>
<td>Sun Raster</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IM8</td>
<td>Sun Raster</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JPG, JPEG</td>
<td>JPEG</td>
<td>R / W</td>
<td>R / W</td>
<td>Yes</td>
</tr>
<tr>
<td>MIL</td>
<td>Cals Raster</td>
<td>R / W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NIF</td>
<td>Navy TIFF</td>
<td>R</td>
<td>R</td>
<td></td>
</tr>
<tr>
<td>OPT</td>
<td>Optigraphics</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PDF</td>
<td>Adobe PDF</td>
<td>R/W</td>
<td>R/W</td>
<td>Yes</td>
</tr>
<tr>
<td>PNG</td>
<td>PNG Raster</td>
<td>R / W</td>
<td>R / W</td>
<td></td>
</tr>
<tr>
<td>PCX</td>
<td>PCX Raster</td>
<td>R / W</td>
<td>R / W</td>
<td></td>
</tr>
<tr>
<td>RAS</td>
<td>Sun Raster</td>
<td>R</td>
<td>R</td>
<td></td>
</tr>
<tr>
<td>RLC</td>
<td>Image Systems</td>
<td>R / W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RLE</td>
<td>Intergraph</td>
<td>R / W</td>
<td>R / W</td>
<td></td>
</tr>
<tr>
<td>RLN</td>
<td>M.O.S.S. RLN</td>
<td>R / W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RNL</td>
<td>GTX Raster</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUN</td>
<td>Sun Raster</td>
<td>R</td>
<td>R</td>
<td></td>
</tr>
<tr>
<td>TGA</td>
<td>Targa Graphics</td>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIF, TIFF</td>
<td>TIFF Raster</td>
<td>R / W</td>
<td>R / W</td>
<td>Yes</td>
</tr>
<tr>
<td>VIF</td>
<td>ABB Raster</td>
<td>R</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Supported Vector Formats

<table>
<thead>
<tr>
<th>Extension</th>
<th>Format Name</th>
<th>Vector</th>
<th>Hybrid (Raster + Vector)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CGM</td>
<td>Computer Graphics Metafile</td>
<td>R / W</td>
<td>R / W</td>
</tr>
<tr>
<td>DGN</td>
<td>Microstation Design File</td>
<td>R / W</td>
<td>R / W</td>
</tr>
<tr>
<td>DWG</td>
<td>AutoCAD</td>
<td>R / W</td>
<td>R / W</td>
</tr>
<tr>
<td>DWG</td>
<td>Raster-DWG</td>
<td>R / W</td>
<td>R / W</td>
</tr>
<tr>
<td>DWT</td>
<td>AutoCAD</td>
<td>R</td>
<td></td>
</tr>
<tr>
<td>DXF</td>
<td>AutoCAD</td>
<td>R / W</td>
<td>R / W</td>
</tr>
<tr>
<td>HP2, PLT, PRN</td>
<td>HPGL/2 Plot File</td>
<td>R</td>
<td></td>
</tr>
<tr>
<td>IGES</td>
<td>2-D IGES</td>
<td>R</td>
<td></td>
</tr>
<tr>
<td>SVG,SVGZ</td>
<td>Scaleable Vector Graphics</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>RVD</td>
<td>Softelec Native Format</td>
<td>R / W</td>
<td>R / W</td>
</tr>
<tr>
<td>VCF</td>
<td>Old Softelec Native Format</td>
<td>R</td>
<td>R</td>
</tr>
<tr>
<td>VCI</td>
<td>Old Softelec Native Format</td>
<td>R</td>
<td>R</td>
</tr>
</tbody>
</table>

Individual Extensions for File Formats (Alias Extensions)

VPindex allows you to load and process files which were saved in one of the above file formats, however, with other extensions (e.g. files in the TIFF Raster format with the extension *.TR). In order to load and process these files you have to create a text file named VP.INI in your program directory (e.g. c:\program files\softelec\vpindex v4) with the following content:

[Import]
TR="My TIFF File (*.TR),*.TIF"

General:

Alias Extension>="<File Description> (*.<Alias Extension>),*.<VP Extension>"

'Alias Extension' specifies the individual extension of a saved file. 'VP Extension' specifies one of the standard VP file formats.
## Supported Scanners

The following table contains the currently supported large format scanners via the direct scanner interface:

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>BW / Grayscale</th>
<th>Color</th>
</tr>
</thead>
</table>
| CalComp      | ScanPlus III x00
              ScanPlus III 80
              ScanPlus III x00 -T
              ScanPlus III 800 - T PLUS
              ScanPlus III 800 - T COPY | ScanPlus III x10 - C
                                ScanPlus III x10 - C Copy |
| Colortrac    | CT 36-400
              340 GX+
              360 CX / GX (+)
              380 CX / GX
              3640 GX / 3680 GX
              4260 GX / 4280 GX
              4860 GX / 5480 GX
              SmartLF 4080 M/C/E
              SmartLF Cx M/C/E
              SmartLF Gx 25/42 (T) M/C/E | |
| Contex       | FSS x000 MP
              FSS x200 ^DSP
              TDS 8000 ^DSP
              FSS x300 (COPY/PLUS) ^DSP
              FSS 225x PANORAMA
              All Crystal Models
              All Premier Models | FSC x000 ^DSP
                                   FSC x010 (COPY) ^DSP
                                   FSC x040 CHROMA
                                   FSC x050 MAGNUM
                                   All Chameleon Models
                                   All Chroma Models
                                   All Copymate Models
                                   All Cougar Models
                                   All Hawk-eye Models
                                   All Magnum Models
                                   All Puma Models
                                   All Toucan Models
                                   All HD Models
                                   All SD Models |
## Supported Scanners

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>BW / Grayscale</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP</td>
<td>All Contex OEMs</td>
<td>All Contex OEMs</td>
</tr>
<tr>
<td>Océ</td>
<td>G60x5</td>
<td>4770 / 4780</td>
</tr>
<tr>
<td></td>
<td>G60x5-S</td>
<td>CS 40xx</td>
</tr>
<tr>
<td></td>
<td>G6035-Sx</td>
<td>CS 41xx (Q / S)</td>
</tr>
<tr>
<td></td>
<td>G6045-S</td>
<td>CS 4052</td>
</tr>
<tr>
<td></td>
<td>47xx</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MS 403x</td>
<td></td>
</tr>
<tr>
<td>Vidar</td>
<td>TruScan 800</td>
<td>TruScan Spectra</td>
</tr>
<tr>
<td></td>
<td>TruScan Flash</td>
<td>TruScan TITAN</td>
</tr>
<tr>
<td></td>
<td>TruScan Select</td>
<td>All Select Models</td>
</tr>
<tr>
<td></td>
<td>Flash 600 (e+)</td>
<td>All Atlas Models</td>
</tr>
<tr>
<td></td>
<td>Surveyor 600 (e)</td>
<td>All Latitude Models</td>
</tr>
<tr>
<td></td>
<td>TruScan Select</td>
<td>All Lynx Models</td>
</tr>
<tr>
<td></td>
<td></td>
<td>All Nova Models</td>
</tr>
<tr>
<td></td>
<td></td>
<td>All Spectra Models</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Titan H36 (+) / 600e</td>
</tr>
<tr>
<td></td>
<td></td>
<td>All HD Models</td>
</tr>
<tr>
<td></td>
<td></td>
<td>All SD Models</td>
</tr>
<tr>
<td>XEROX</td>
<td>7346</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7356</td>
<td></td>
</tr>
</tbody>
</table>

If your scanner is not listed above or has been updated and requires a new driver/interface, please visit our website for news regarding third party scanners. You can download new drivers, which may support your scanner or improve the support.

### TWAIN Interface

VPindex offers a TWAIN interface. If your Scanner does also supply a TWAIN interface it can be used to connect to VPindex. You should find further information on the TWAIN interface in your Scanner documentation.
Default Command Alias Names

<table>
<thead>
<tr>
<th>Command Header English</th>
<th>Alias Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>VPAUTODESKEW</td>
<td>RAD</td>
</tr>
<tr>
<td>VPCLEAN</td>
<td>RCL</td>
</tr>
<tr>
<td>VPCROP</td>
<td>RCR</td>
</tr>
<tr>
<td>VPCUTWINDOW</td>
<td>RC</td>
</tr>
<tr>
<td>VPDESKEW</td>
<td>RD</td>
</tr>
<tr>
<td>VPDRAWARCCENTRAD</td>
<td>A</td>
</tr>
<tr>
<td>VPDRAWARCTANGCENT</td>
<td>AT</td>
</tr>
<tr>
<td>VPDRAWARROWDIM</td>
<td>AR</td>
</tr>
<tr>
<td>VPDRAWARROWPOINT</td>
<td>ARP</td>
</tr>
<tr>
<td>VPDRAWCIRCLE2POINT</td>
<td>C2</td>
</tr>
<tr>
<td>VPDRAWCIRCLE3POINT</td>
<td>C3</td>
</tr>
<tr>
<td>VPDRAWCIRCLECENTRAD</td>
<td>C</td>
</tr>
<tr>
<td>VPDRAWCPOLY</td>
<td>PC</td>
</tr>
<tr>
<td>VPDRAWDONUT</td>
<td>D</td>
</tr>
<tr>
<td>VPDRAWELLIPSE</td>
<td>E</td>
</tr>
<tr>
<td>VPDRAWLINE</td>
<td>L</td>
</tr>
<tr>
<td>VPDRAWMTEXT</td>
<td>M</td>
</tr>
<tr>
<td>VPDRAWOPTIONS</td>
<td>DO</td>
</tr>
<tr>
<td>VPDRAWPOLY</td>
<td>P</td>
</tr>
<tr>
<td>VPDRAWPOLYGON</td>
<td>PO</td>
</tr>
<tr>
<td>VPDRAWRECTANGLE</td>
<td>R</td>
</tr>
<tr>
<td>VPDRAWSPLINE</td>
<td>SP</td>
</tr>
<tr>
<td>VPDRAWTEXT</td>
<td>T</td>
</tr>
<tr>
<td>VPEXIT</td>
<td>X</td>
</tr>
<tr>
<td>VPHMIRROR</td>
<td>RH</td>
</tr>
<tr>
<td>VPINVERT</td>
<td>RI</td>
</tr>
<tr>
<td>VPMORPHO</td>
<td>RM</td>
</tr>
<tr>
<td>VPNEXTPAGE</td>
<td>N</td>
</tr>
<tr>
<td>VPOPEN</td>
<td>[Ctrl-O]</td>
</tr>
<tr>
<td>VPPOLYCROP</td>
<td>RCRP</td>
</tr>
<tr>
<td>VPPOLYCUT</td>
<td>RCP</td>
</tr>
<tr>
<td>VPPREVPAGE</td>
<td>PV</td>
</tr>
<tr>
<td>VPRFE</td>
<td>RR</td>
</tr>
<tr>
<td>VPROTATE</td>
<td>RO</td>
</tr>
<tr>
<td>VROTATE90</td>
<td>R9</td>
</tr>
<tr>
<td>VPSAVE</td>
<td>[Ctrl-S]</td>
</tr>
<tr>
<td>VPSAVEAS</td>
<td>SA</td>
</tr>
<tr>
<td>VPSCALE</td>
<td>RSC</td>
</tr>
<tr>
<td>VPSMOOTH</td>
<td>RSM</td>
</tr>
<tr>
<td>VPSPECKLES</td>
<td>RS</td>
</tr>
<tr>
<td>VPVMIRROR</td>
<td>RV</td>
</tr>
</tbody>
</table>

Use this format for modifying or entering new Command Aliases saved to the file ALIASES.PGP (SUPPORT subdirectory):

```
VP<AliasName>,^<CommandName>
```
Keyboard Shortcuts

All keyboard shortcuts are listed in the menu next to their commands, too

Function keys

[F1] Help
[Shift] + [F1] Context Help
[F2] Measure
[F3] Properties
[Shift] + [F3] Image Settings
[F4] Show / hide Raster
[F5] Show / hide Vectors
[F8] Raster Selection Settings
[Shift] + [F8] Drawing Aids
[F9] Coord Snap on/off
[Shift] + [F9] Show / hide Grid
[F10] Ortho Snap on/off
[Shift] + [F10] Polar Snap on/off
[F11] Vector Snap on/off
[F12] Raster Snap on/off

Cursor control keys

[↑] Scroll up
[↓] Scroll down
← Scroll left
→ Scroll right
[Shift] + [↑] Page up
[Shift] + [↓] Page down
[Shift] + ← Page left
[Shift] + → Page right

Zoom functions

[Mult] (Numeric keypad) Zoom all
[Div] (Numeric keypad) Zoom pixel
[5] (Numeric keypad) Zoom window
[Space] + left mouse button pressed Pan dynamic

Multipage functions

[Pg Up] Previous page
[Pg Dn] Next page
[Home] First page
[End] Last page

Draw order

[Shift] + [Pg Up] Draw in front
[Shift] + [Pg Dn] Draw in background
Various functions

[Ctrl] + [A]        Select all
[Ctrl] + [C]        Copy
[Ctrl] + [E]        Erase raster background
[Ctrl] + [F]        Quick select
[Ctrl] + [N]        New
[Ctrl] + [O]        Open
[Ctrl] + [P]        Print
[Ctrl] + [R]        Redraw
[Ctrl] + [S]        Save
[Ctrl] + [T]        Combine to text
[Ctrl] + [V]        Paste
[Ctrl] + [X]        Cut
[Ctrl] + [Y]        Redo
[Ctrl] + [Z]        Undo

[Ctrl] + [Ins]      Copy
[Shift] + [Del]     Cut
[Shift] + [Ins]     Paste

[Shift] + [Enter]   Show / activate command line

[Del]               Delete
[Esc]               Cancel

[Alt] + [Backspace] Undo

[Win Menu]           right mouse click
DDE and OLE

VPindex features a Windows compliant DDE and OLE interface that allows other applications to communicate with it. This may be useful in conjunction with, for example, a database application, which manages files that can be viewed and processed with VPindex. Specifically, you can:

1. Create a VPindex object via OLE automation and execute commands on it.
2. Establish a DDE link to VPindex to execute commands via DDE.

Note: You can not link or embed a VPindex object in an OLE container application (OLE compound file)!

To 1: OLE Automation capable programs (like Microsoft Excel) may create and operate on a 'VP.Document' object (OLE short name). The available automation functions are (written in C):

- `long GetProcessID ();`
- `short Execute (BSTR pszCommand);`
- `long GetDocumentCount ();`
- `BSTR GetDocumentName (long lDocumentNumber);`
- `boolean CloseDocument (BSTR lpszDocument);`
- `long ShowWindow (BSTR lpszDocument, long iShow);`
- `long GetLastError (BSTR* pszErrorString, long lErrorLength);`

There’s a type library called VP.TLB installed in the VPindex directory, which can be read by software development tools (like Microsoft Visual C++). In this case, the function prototypes listed above will be automatically generated in your target language.

To 2: VPindex is a DDE server that accepts the start of a conversation with the following data:

- **Application:** VPxx
- **Topic:** System

The DDE interface can handle WM_DDE_EXECUTE commands with the following syntax:

```
[command1][command2][command3]...
```

Do not omit the brackets ('[...]')! This way, you can execute an unlimited number of commands at once.

The commands that are available for DDE execution are all commands you can use from the command line of VPindex.
Example, OLE via Visual Basic:

```vba
Sub InvertWithVPOLE(strFile)
    Dim strImp As String
    Dim strExp As String
    Dim VP As Object
    Set VP = CreateObject("VP.Document")

    strImp = "open " & Chr(34) & strFile & Chr(34)
    strExp = "export " & Chr(34) & strFile & Chr(34) & " /p -1"

    VP.Execute (strImp)
    VP.Execute ("invert")
    VP.Execute (strExp)
    VP.Execute ("closealways")
    VP.Execute ("exit")

    MsgBox "File has been inverted and exported with OLE!"
End Sub
```

The above Visual Basic program uses OLE to invert a drawing. Only the most important command you can use with VPindex and OLE has been used in this example: Execute. With Execute you can start all commands that are available via the command line.

Note: closealways closes a document even if it is still modified. You should always use the exit command to close down the OLE application when you no longer need it.

OLE generally works on invisible documents. There are two possible scenarios: 1) The application is already started: OLE opens an new, but invisible document. 2) The application is not yet started: The application is started completely invisible. Thus OLE is restricted to batch processing. For interactive task you can use DDE or scripting.

Example, DDE via Visual Basic:

```vba
Private Sub InvertWithVPDDE(strFile)
    Dim intChan
    Dim strImp As String
    Dim strExp As String

    'Use System Topic to connect to VP
    'VP must be running in order to connect
    intChan = DDEInitiate("VPxx", "System")

    strImp = "[open " & Chr(34) & strFile & Chr(34) & "]"
    strExp = "[export " & Chr(34) & strFile & Chr(34) & " /p -1]"

    DDEExecute intChan, strImp
    DDEExecute intChan, "[invert]"
    DDEExecute intChan, strExp
```
DDEExecute intChan, "[closealways]"

MsgBox "File has been inverted and exported with DDE!"

'Terminate DDE conversation
DDETerminate intChan

End Sub

The above Visual Basic program uses DDE to invert a drawing. Note the square brackets, that must be used to encapsulate all commands. All commands you can start from the command line can be used.

Example, DDE with Windows Explorer:

Windows Explorer is able to link to VPindex. The setup of this feature is different depending on the version of your operating system. In this example we will setup an association for TIF files with VPindex. You then will be able to click on a TIF file in Windows Explorer and select a new command via the right mouse button menu. This command will open the drawing with VPindex invert the drawing and save it back to the original location.

This example is for Windows 2000, for other operating systems please see the operating systems' manual.

1. Open the Windows Explorer.
2. Select the menu  "Tools->Folder Options..."
3. In the appearing dialog switch to the tab "File Types"
4. Under “Registered Filetypes” navigate to “TIF” and select it.
5. Click on the button “Advanced”.

Example, DDE with Windows Explorer:
6. To create a new Action click on “New…”

7. Fill out the fields in the following dialog. Make sure the checkmark “Use DDE” is set!

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Invert with VPindex</td>
</tr>
<tr>
<td>Application used to perform action:</td>
<td>Path to the main.exe of VPindex in quotes followed by “%1” e.g.: &quot;C:\Program Files\VPindex V4\main.exe&quot; &quot;%1&quot;</td>
</tr>
<tr>
<td>DDE Message:</td>
<td>Commands that are started when the application is already running; for our example: [open &quot;%1&quot;] [invert] [export &quot;%1&quot; /p -1] [closealways]</td>
</tr>
<tr>
<td>Application:</td>
<td>Name of your VPindex product, e.g.: VPindex</td>
</tr>
<tr>
<td>DDE Application Not Running:</td>
<td>Commands that are started when the application is not yet running; for our example: [invert] [export &quot;%1&quot; /p -1] [closealways] [exit]</td>
</tr>
<tr>
<td>Topic</td>
<td>Always has to be</td>
</tr>
<tr>
<td></td>
<td>System</td>
</tr>
</tbody>
</table>
Close all open dialogs using OK.

Now you are able to click onto a TIF drawing in Windows Explorer and select the command “Invert with VPindex”. The file is opened, inverted and saved back under the original name. When the software was already running only the new drawing window is closed. If the software was not started, the software is started and closed again. You find the commands that are invoked in the table above in the fields “DDE Message” (application already running) and in “DDE Application Not Running:” (application not yet running). When the application is not running the file is loaded automatically when the application starts through the “%1” parameter in the field “Application used to perform action:”!

To perform different tasks you can choose any commands you can start from the command line with DDE you are even able to use interactive commands, which is not possible with OLE, as OLE always works on an invisible document.

E.g. you could use the command [rotate90] to start the rotate quadrantal command. Now the user can click with the mouse to perform the rotation. In contrast the command [rotate90 1] needs no user interaction and the drawing is rotated without any further user interaction. The commands behave just if you would have typed them into the command line of VPindex.
INDEX

4 Point Drawing Calibration ..................................174

A
Active Image .............................................116
Active Image only ....................................210
Active Layer ............................................. 91
Active Linetype ......................................... 97
Active Text Style ......................................100
Alias Extensions ........................................398
Align Text
  Align with Line Space ................................276
  Assign Same Angle ..................................278
  Assign Same Height ..................................278
  Bottom ..................................................276
  Center Horizontal ..................................275
  Center Vertical .....................................276
  General Information ................................275
  Left .....................................................275
  Right ....................................................275
  Top .......................................................276
All Raster Operations ..................................155
Array .....................................................262
Arrowhead ...............................................214
Assign Current Color ..................................105
Assign Current Linetype ................................ 99
Assign Current Text Style ..............................102
Auto Cleanup ..........................................147
Auto Save ..................................................64
Auto Trim .................................................238
Autodeskew ..............................................149
Automatic Color Cleanup (Reduction) ..............193
Automatic Cut ..........................................147

B
Batch
  BatchExecutor .........................................319
  BatchManager .........................................313
Blocks
  Combine to existing Block ............................244
  Create ..................................................241
  General Information ................................240
  Insert ...................................................250
  Modify Block Definitions ............................245
Break Element .........................................239

C
CAD Options .............................................213
CAD Tools ................................................210

CAD Trace ..............................................304
CGM Export Options .................................52
Change Properties .......................................136
Close without Safety Prompt ..........................39
Cmd Echo ..................................................62
Color Classification ....................................207
Color Filter
  Custom Filter .........................................201
  Filter Table ...........................................202
  Median and Blur (Average) Filters ..................200
  Sharpen Filter .........................................200
  Start .....................................................199
Color Filter Operations ................................199
Color Image Conversion .................................204
Color Manager ..........................................103
Color Palette Transformation .........................194
Color Reduction
  Automatic Reduction ..................................189
  Convert to B/W .......................................191
  Export Selected Colors ..............................191
  Fill Function .........................................192
  General ..................................................182
  Interactive Reduction ...............................189
  Modify a Color ........................................188
  Single Pixel Pen .....................................193
  Start .....................................................184
Color Separation .......................................182
Combine to
  Arc .......................................................267
  Circle ...................................................267
  Closed MPolyline ....................................266
  Closed Polylne .......................................266
  Closed Spline .........................................267
  Ellipse ..................................................268
  Elliptical Arc .........................................268
  Hatch .....................................................271
  Line .......................................................265
  MPolyline ..............................................266
  MText .....................................................270
  Orthogonal Line .....................................265
  Polygon ..................................................267
  Polyline ................................................266
  Settings ................................................271
  Spline ...................................................267
  Text .......................................................268
Combined Mouse Keyboard Operation ..................29
Combining Elements .....................................265
Command Line ..........................................29
Contour Trace ..........................................305
Copy .......................................................260
Create B/W Image ........................................ 118
Create Settings with Wizard Support .......... 335
Crop Window, Crop Polygon ....................... 148
Current Indexing Settings File .................... 392
Cut Element ............................................. 239
Cut to Drawing Format .............................. 158
Cut Window, Cut Polygon ........................... 148
Cut/Copy/Paste ....................................... 132

D
Default Command Alias Names ................. 401
Default Text Font ..................................... 61
Delete Entities ....................................... 131, 261
Deskew .................................................. 149
DGN Export Options ................................. 50
DGN Import Options ................................. 48
Dialog Boxes .......................................... 23
Dimension Style
  Lines and Arrows .................................... 284
  Manager .............................................. 282
  Primary Units ...................................... 287
  Text .................................................. 285
  Tolerances .......................................... 288
Dimensions
  Aligned Dimension .................................. 290
  Angular Dimension ................................ 292
  Baseline Dimension ................................ 293
  Continue Dimension ................................ 293
  Diameter Dimension ................................ 291
  General Information ................................ 281
  Linear Dimension .................................. 290
  Manual Mode ....................................... 281
  Radial Dimension .................................. 291
  Style ................................................ 282
  Text Mode .......................................... 281
  Types ............................................... 290
Direct Raster Selection
  Activate ........................................... 119
  Arc .................................................. 120
  Circle ............................................. 120
  Line ............................................... 120
  Pick .............................................. 120
  Polygon ........................................... 120
  Rectangle ......................................... 120
  Settings ........................................... 121
Display B/W Image ................................... 118
Display Control Functions ....................... 24
Document Functions/Settings ................... 81
Drag & Drop .......................................... 131

Draw
  Arc ................................................ 224
  Circle .......................................... 225
  Closed Polyline .................................. 223
  Dimension Arrow .................................. 230
  Ellipse .......................................... 226
  Filled Rectangle ................................ 226
  Hatch (Fill) ..................................... 234
  Line ............................................. 222
  MPolyline ........................................ 223
  Multiline Text .................................... 229
  Pixel ............................................. 221
  Point ............................................. 231
  Pointing Arrow .................................. 231
  Polygon ......................................... 227
  Polyline ......................................... 222
  Rectangle ........................................ 223
  Spline .......................................... 224
  Stamp ............................................ 232
  Text .............................................. 227
  Draw Functions .................................. 221
  Draw Order
    Above Entity ..................................... 137
    Behind Entity ................................... 137
    General ........................................ 136
    In Front ....................................... 137
    To Back ........................................ 137
  Drawing Units ..................................... 61
  DWG/DXF Export Options ......................... 47
  DWG/DXF Import Options ......................... 45
  Dynamic Width .................................... 211

E
Edit Hatch .......................................... 235
Edit Object(s) ....................................... 260
Edit Polyline/Spline ................................ 310
Entities
  Auto Trim ........................................ 238
  Break ............................................ 239
  Cut .............................................. 239
  Extent .......................................... 238
  Make Corner ..................................... 237
  Trim ............................................. 237
  Entity Selection and Handling .................. 119
  Erase Online ..................................... 212
  Erase Raster Background ....................... 211, 303
  Exit ............................................. 60
  Explode ........................................... 131, 261
  Export ........................................... 39
Export Options
- CGM ................................. 52
- DGN ................................. 50
- DWG/DXF ......................... 47
- Geo Referencing ............... 40
- GIF .................................. 40
- JPEG ............................... 40
- PDF ................................... 44
- SVG/SVGZ ............................ 53
- TIFF .................................. 42
- Extent Entities ..................... 238

F
- File Load Settings ................. 340
- File Menu ............................ 33
- Fill Color ............................ 203

G
- Geo Referencing ................. 40
- GIF Export Options .............. 40
- Gray Scale Reduction .......... 184

H
- Hatch Style Manager .......... 236
- Help Menu ........................ 21
- Horizontal Mirror .............. 150
- Hybrid Editing Tools .......... 253

I
- Image Palette ..................... 117
- Image Settings
  - Active Color Map .............. 115
  - Define Background Color ..... 116
  - Define Foreground Color ..... 116
  - Foreground/Background Definition .... 111
- Image Settings .................. 109
- Import ............................... 36
- Import Options
  - DGN ............................... 48
  - DWG/DXF ......................... 45
- Indexing Quickstart .......... 392
- Indexing Results ............... 391
- Individual Extensions for File Formats .... 398
- Installation
  - Hardlock Driver ............ 6
  - Introduction .................. 5
  - VPindex ...................... 7

Interactive Processing .......... 389
Interactive Text OCR ............ 268
Interactive Trace ............... 309
Invert .................................. 149

J
- JPEG Export Options ........... 40

K
- Keyboard Shortcuts .......... 402

L
- Layer Manager .................. 90
- License/Network Control .... 66
- Line Space ....................... 277
- Line Width ....................... 210
- Linetype Manager .......... 97
- Load Extensions ............... 60

M
- Make Corner between Entities .... 237
- Measure Distance ............... 133
- Merge Raster Files .......... 179
- Mirror ............................ 262
- Mirror Raster
  - Horizontal .................. 150
  - Vertical ...................... 151
- Morphology .................... 156
- Mouse Functions ............ 28
- Move ................................ 260
- Multi Point Rubber Sheeting
  - Input of Reference Points .... 171
  - Settings ..................... 164
  - Start .......................... 163
  - Target Reference Points .. 165
- Multiline Text OCR ........... 270

N
- Navigation View ................. 337
- New .................................. 33
- New Raster ....................... 138

O
- OCR Options ...................... 73
- Offset ................................ 264
Online Help ............................................... 21
Open ......................................................... 33

P
Page Control
   General .................................................. 81
   Import .................................................. 83
   Insert / Delete ....................................... 82
   Moving Pages ....................................... 85
   Organise ............................................. 88
   Scanning Pages .................................... 87
Palette Functions
   Save Palette ........................................ 194
Palette Transformation
   Functions ............................................ 196
   General Information ................................ 194
   Start .................................................. 194
   Table .................................................. 198
Pan Functions ......................................... 27
Paper Format Manager .............................. 79
PDF Export Options ................................ 44
Pick Box Size ......................................... 62
Place / Adjust Data .................................. 108
Print ..................................................... 57
Process Settings ..................................... 334
Program Start ....................................... 19
Project Bar ........................................... 94
Properties ............................................. 135
Prototype Drawing .................................. 65

Q
Quick Selection ....................................... 123

R
Raster Edit Settings .................................. 210
Raster File Editing ................................... 144
Raster Fill Function .................................. 203
Raster Formats ....................................... 397
Raster Object Selection
   Arc ..................................................... 122
   Circle ............................................... 122
   Crossing ............................................ 123
   Fence ............................................... 123
   Inside Window ..................................... 123
   Isolated Raster Objects.......................... 123
   Line ................................................... 122
   Pick ................................................... 122
   Pick CAD Entities ................................ 122
Polygon ................................................. 122
Rectangle ............................................. 122
Start ...................................................... 121
Raster Text ............................................ 254
Rasterize ............................................... 140
Rasterize Functions .................................... 138
Rasterize Online ...................................... 212
Rasterize to Paper Format ......................... 141
Redlining
   Activate ............................................. 324
   Configuration ...................................... 330
   Delete Entities .................................... 327
   Export ............................................... 325
   General Information ................................ 324
   Import ............................................... 325
   Insert Entities ..................................... 328
   Review ............................................. 327
   Settings ............................................ 325
   User Groups ....................................... 331
Redo ....................................................... 130
Redraw .................................................. 134
Remove Speckles ..................................... 151
Resample Settings .................................... 144
Review Indexing Results............................ 384
Review Text ........................................... 279
Rotate ................................................... 262
Rotate Arbitrary ..................................... 150
Rotate Quadrantal ................................... 150
Rubber Sheeting
   4 Point Drawing Calibration .................... 174
   Functions ............................................ 161
   General Information ................................ 161
   Multi Point ......................................... 163
Running a Process .................................... 379

S
Save ....................................................... 37
Save As .................................................. 39
Scale ..................................................... 261
Scale a Raster File ................................... 160
Scan ...................................................... 54
Scanning Colors ..................................... 183
Scripting ............................................... 320
Search Raster Symbols ............................. 258
Select All ............................................. 126
Settings via Tableau .................................. 368
Shortcuts .............................................. 402
SHX-Font File Search Paths ....................... 65
Smooth Raster ......................................... 154
Snap Functions ...........................................127
Software License Control (Hardlock) ........ 5
Special Tools ...........................................279
SPECIFICATIONS ...................................393
Split a File
  VPHybridCAD ......................................177
Status Display ........................................... 24
Support Path ............................................. 65
Supported Formats .................................. 397
Supported Scanners .................................. 399
SVG/SVGZ Export Options ....................... 53
Symbol Library .......................................... 75
System Requirements .............................. 10
System Settings
  Auto Save ............................................. 64
  Colors .................................................... 63
  Files/Paths ............................................ 64
  General ................................................. 61
  License .................................................. 66
  Open/Save ............................................. 66
  Prototype Drawing .................................. 65
  Raster Image .......................................... 67
  Raster Selection ..................................... 68
  Redlining ............................................. 70
  Shortcuts ............................................. 71
  User Interface Look ................................ 72

T
Table recognition .................................... 294
Task 1: Drawing File Selection .................. 338
Task 2: Load Sample File .......................... 341
Task 3: Raster Cleanup ............................... 342
Task 4: Paper Format Selection .................. 347
Task 5: Indexing Templates ......................... 350
Task 6: Data Field Definition ..................... 358
Task 7: Export to Database ......................... 362
Task 8: General Output Settings ................. 364
Text settings ............................................ 277

Text Style Manager ..................................100
TIFF Export Options ..................................42
Toolbars ..................................................21
Tracing
  CAD Trace ............................................. 304
  Contour Trace ....................................... 305
  Edit Commands ...................................... 305
  General Information ................................299
  Interactive Trace .................................... 309
  Settings .............................................. 299
Transfer to Current Dimension Style ......... 289
Transfer to Current Layer ......................... 93
Trim Entities ......................................... 237

U
Unattended Batch Process ....................... 381
Undo ...................................................... 130
Uninstalling ......................................... 10
Updating / Upgrading / Service Pack ....... 10
USER COMMANDS ..................................321
User Coordinate System ......................... 106
Using the Mouse .................................... 28

V
Vector Formats ...................................... 398
Vector/Raster .......................................... 119
Vertical Mirror ....................................... 151
VPLicenseManager
  Installation ........................................... 11
  Monitoring .......................................... 12
VPNetManager ......................................... 12

Z
Zoom Functions ....................................... 25
Zoom-In on First Click ............................ 62